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KNK Zing de   / Zing Air  con Programa  Make the  Cut 
Octubre 2015 

Este manual esta  basado en el programa  Make the  Cute  (MTC), version 4.6.1. Recomendamos  no imprimir  todo  

el  manual, por que  existen  actualizaciones regulares. Pero  puede  leer  en la pantalla o imprimir las paginas  que 

usted necesita  en cualquier  momento. 

TENGA EN CUENTA  QUE LOS COMANDOS DEL PROGRAMA MTC  ESTAN EN INGLES, AL LADO DE LA TRADUCCION 

ESTARAN LOS COMANDOS  EN INGLES 

LOS VIDEOS POR EL MOMENTO ESTAN EN INGLES. 

 

Caracteristicas  en línea  interactivas  con el manual de  usuario. 

Cambiar Pagina: Para  
cambiar de paginas, haga click en la flecha, escriba 
el numero de pagina, o haga  clic en los triángulos 
a la derecha  o izquierda  de  los lados de las 
paginas. 

   Activar pantalla completa: Haga clic 
para el modo  de pantalla completa. Pulse Esc o 
haga clic en el icono para volver al modo  normal 
 

 Impresión: Seleccione las paginas  para 
imprimir. Recomendamos no imprimir  todo el  
manual por que cada  6 meses  existen  
actualizaciones. 

  Marca  en Catalogo: La  Tabla  de contenido 
están  abiertos y usted puede hacer click en 
cualquier  capitulo, sección, o subsección para  
acceso inmediato. 

 Miniaturas: Muestra las imágenes en 
miniatura para todas las páginas en el libro 

  Sonido : Haga  clic  para  apagar  o  volver   
al sonido de la pagina 

  Zoom:  Acercar y alejar, según sea 
necesario.  
También puede hacer  doble clic en una página 
para acercar o alejar.  
Cuando el zoom este  activado  mueva el ratón de 
forma automática y desplazara la página hacia 
arriba y abajo. 

 Buscar: Usted  puede  buscar  cualquier 
palabra (s) en el manual. Haga  click en el  icono 
buscar, escriba  la palabra (s). y  todas las  paginas 
con cada  palabra con palabras en la lista. Click  
en la lista y  lo llevara a la pagina. 

VIDEO  VIDEO: Este  manual de usuario contiene  numerosos links para  videos  en línea (online). Haga  
click en el icono verde  que dice video para abrir el link en youtube  o Vimeo y aprenda  la sección 
particular  del  manual.  Pasadas  experiencias   demuestran que al ver videos  puede tener  un 
beneficio estupendo para aprender el programa  y  las aplicaciones de corte. 

 

Donde  Empezar 

 Gracias  por escoger a  Klic –N-Kut   troqueladora   digital .Antes  de  usar  la  cuchilla de su nuevo corte, 

nosotros sugerimos  que usted  lea los capítulos 1 y 2 y  vea los videos  que provee los  enlaces en estos  

capítulos. 

 Si usted  tiene  dificultades  con el funcionamiento de  KNK, desconecte  y busque una solución en este manual. 

Tenga en cuenta que el Apéndice B es una sección de solución de problemas. Si continúa teniendo preguntas 

técnicas o problemas, por favor póngase en contacto con su proveedor KNK Zing tan pronto como sea posible. 

 Para obtener asistencia adicional, por favor visite nuestro grupo de Yahoo en: 

http://groups.yahoo.com/group/KNK_Zing/ y nuestro foro de soporte en: http://knkusa.com/forums/. 

http://groups.yahoo.com/group/KNK_Zing/
http://knkusa.com/forums/


2 
 

 Joe Rotella, propietario de Create & Craft, creó un excelente video de una hora para que los nuevos 

propietarios de KNK Zings 

VIDEO 

© 2011, 2012, 2013, 2014 Accugraphic Sales, Inc., Derechos reservados. 

 

Tabla  de  Contenido. 

SE  REALIZARA  A TERMINAR TODO EL CATALGO!!! 
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1.Desempacando, Instalando y  Ensamblando 
 

1.01. Desempacando 

 

 Compruebe que ha recibido todo el  contenido. Hay una lista de comprobación en la caja. Por favor notifique a su 

proveedor KNK Zing inmediatamente si falta algo. 

 Retire todas las piezas de espuma y otros empaques antes de encender el KNK Zing. Actualmente hay dos protectores 

de espuma  en cada extremo y 3 piezas de espuma internos más pequeños, así como dos piezas de plástico negro 

que apoyan la pieza de corte. 

 Utilice el lápiz prueba adjunta para experimentar y familiarizarse con el funcionamiento de la KNK Zing.Utillice  papel  

para la tabla de corte para simplemente dibujar formas en lugar de cortarlas. Esto evitará posibles daños a la cuchilla 

de corte, a la tabla  de corte y tiras de corte a medida que aprende  las formas corte y los procedimientos básicos de 

funcionamiento. 

 No desconecte el cable USB de su ordenador o desde el KNK a menos que primero apaga la unidad. 

 Apague siempre el Zing cuando no esté en uso. Dejando el cortador encendido por períodos prolongados de tiempo 

puede posiblemente dañar la máquina. 

 

1.02 Contenido 

 

 
 
 Su paquete KNK Zing viene con lo siguiente: 

Maquina  de  corte KNK Zing      Estuche soporte  para cuchilla 

Guía de inicio rápido      Cuchilla  45˚(tapa roja) 

PIN  de  activación para MTC     Cuchilla  60˚ ( tapa  azul) 

Tabla  de corte       2 tintas de boligrafos pequeños   

Cable USB y Adaptador  de  Bluetooth 

Boligrafo Prueba 

 

1.03 Elementos a tener en cuenta (Por favor leer!) 

 

 Cuchillas: Las cuchillas utilizadas por los cortadores son extremadamente frágiles. No deje caer o incluso volcar la 

cuchilla en cualquier superficie dura, ya que pueden danarse fácilmente. Cuando no está en uso, retire la cuchilla 

del soporte de  cuchilla  y cubra la punta de la cuchilla con la tapa de plástico blando. Tenga cuidado de mantener 

estas pequeñas cuchillas  en un lugar seguro. 

 Garantía: La garantía  de un año cubre defectos del fabricante solamente y no incluye el desgaste normal . Si requiere 

trabajo de garantía, el propietario es responsable de los gastos de envío hacia y desde Ventas Accugraphic. Si una 

maquina KNK Zing se daña durante el envío, a continuación, su distribuidor deberá ser notificado tan pronto como 

sea posible. Si los daños se reportan después de  tres semanas de la entrega, entonces será responsabilidad del 

propietario el envio  dela maquina KNK dañada a Accugraphic para su reparación. 

 Los   propietarios de Zing fuera de EE.UU. deben ponerse en contacto con su distribuidor para procedimientos con 

respecto al trabajo de garantía o daños durante el transporte. 

http://www.youtube.com/watch?v=IM3qxFekC-Y
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 Transporte: Cuando transporte la maquina KNK , mueva las palancas de apoyo  posición hacia arriba. Quite los 

accesorios de la Zing y póngalas  en una bolsa separada. También recomendamos mantener las cajas originales con 

las inserciones de espuma en caso de que tenga que transportar el KNK Zing. 

  Además: 

 NO  toque o atasque el area del plotter mientras está en funcionamiento. Si la cuchilla está dañada, es 

responsabilidad si la cuchilla  se dana. 

 NO  agite la cortadora mientras esté en funcionamiento. 

 NO corte cualquier material que tengan grapas u otros adornos adjuntos. 

 NO toque el cortador con un imán. 

 NO permita que objetos pequeños caigan en el cortador. 

 APAGUE la maquina cuando no esté en uso. 

 

1.04 Partes de la  KNK Zing Air 

Frente  
                                                                                                                                                                  Botón de encendido 

                                                  Interruptores de límite      Soporte de herramienta Nivel           Palancas de ruedas  

 

   Guías Mat / Materiales  Carro de la cuchilla 

 

  

 

 

 

 

 

 

    Tira de corte    Tornillo delantero 

 

 Carro de la cuchilla: Mueve el soporte  de la  cuchilla  de izquierda y derecha 

 Soporte de herramienta: Mantiene el soporte de la cuchilla, pluma  de prueba, marcadores y otras herramientas 

 Tornillo delantero: Aprieta soporte de la cuchilla, pluma  de prueba, marcadores, y otras herramientas del soporte  

de la herramienta. 

 Tira de corte: Protege la cuchilla de corte de metal por debajo 

 Interruptores de límite: Proporcionar un amortiguador entre carro cuchilla y la tapa 

 Guías Mat / Materiales: Se utiliza para colocar la alfombra 

 Ruedas de presión: Mueven  la tabla de corte o material para su corte y  de movimiento al  material de entrada y 

salida 

 Nivel  Palancas de ruedas: Para que las ruedas de presión de elevación hacia arriba y abajo para la carga de la tabla 

de corte o material 

 Botón de encendido: Activa o desactiva la maquina 

 Presion de anillos: Ayudan a mantener el material en posición correcta durante el corte 
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ESPALDAR 

           
                        Puerto de poder Puerto USB 

 

 

1.05 Accesorios 

 

Prueba del soporte  de la pluma 

 La prueba debe ser utilizada hasta que se sienta cómodo con el funcionamiento del KNK Zing y sabes, con certeza, 

donde las formas cortarán. Para montar la pluma prueba, retire la tapa superior, deslice el resorte en la parte 

superior medio de la pluma insertar y luego soltar la pluma insertar en la mitad inferior de la titular de la pluma. 

Deslice la tapa sobreel inserto de la pluma, lo que permite insertar la pluma para caber a través del agujero en la 

parte superior de la tapa. Tornillo en su lugar.  

 

 

Cuchillas incluidas en la compra de la maquina KNK Zing Air 

 Hay dos tipos de cuchillas incluidas con la  KNK Zing. La cuchilla  de 45˚ de tapa roja es adecuada para el corte de 

materiales más delgados, tales como papel y vinilo. La cuchilla  de  60˚ con tapa azul  es para  mucho más tiempo 

y  para cortar materiales más gruesos, como la espuma del arte, tableros de partículas, y el material de plantilla 

de diamantes de imitación. 

 Adicionalmente, existen otras herramientas que se venden por separado, incluyendo la cuchilla  de tela, 

herramienta de buril  y de  repujado y soporte  de la pluma. Los detalles de estos se tratan en el Capítulo 10 y en 

la siguiente video:  

Instalacion de  Cuchilla  

 
 La cuchilla debe ser insertada cuidadosamente en el soporte de la cuchilla. Hacer esto sobre una superficie blanda 

(por ejemplo en una mano o también toalla). Es importante proteger la cuchilla por que es  frágil! 

 Los pequeños resortes que vienen con las cuchillas son fáciles de perder, lo cual es otra razón para hacer esto 

sobre una toalla de modo que un resorte caído no ruede fuera de la mesa. Retire la tapa de color de la hoja y 

deslice el resorte  sobre el extremo afilado de la cuchilla: 

 

http://www.youtube.com/watch?v=IM3qxFekC-Y
http://www.youtube.com/watch?v=IM3qxFekC-Y
http://www.youtube.com/watch?v=IM3qxFekC-Y
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El resorte está colocado sobre la cuchilla 

 Hay diferentes formas de instalar la cuchilla. Este es el método que prefiero, pero experimente con otros métodos 

si quiere. Una vez más, lo importante es simplemente tomarlo con calma! 

Apriete la parte principal del soporte de la cuchilla girándolo hacia la derecha hasta que quede a mitad  

cerrado: 

    

 

 

 

  

Coloque la cuchilla en el pequeño agujero en la parte principal del soporte de la cuchilla: 

      

 

Guia suavemente la tapa sobre la parte superior de la cuchilla y luego puede comenzar a atornillar la tapa. NO 

trate de forzarla. Puede que tenga que mover la tapa ligeramente en el resorte para colocarlo y para la tapa para  

atornillar en la parte principal del soporte de la cuchilla: 

 

Tornillo de la tapa firmemente. Luego, a medida que el tornillo de la parte principal del soporte de la cuchilla (la 

parte superior), la cuchilla comenzará para mostrar a través del agujero en la tapa. Sólo necesita un poco de  

cuchilla expuesta como sea necesario para penetrar  el material que se está cortando. Más cuchilla no se traduce 

en un mejor corte. De hecho, el opuesto es cierto. 

Gire la parte superior del 

soporte hasta un 1/8 " 

IMPORTANTE! No fuerce la tapa. Gire 

suavemente hasta que enganche 
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 Por favor, lea el Capítulo 2 antes de cortar. Hay algunos consejos sobre cómo ajustar la exposición cuchilla, así 

como otra información importante que necesita para tener éxito con su corte. 

Tabla  de Corte 
 Siempre usar la tablade corte para sostener el material a cortar a menos que el material tiene su propia hoja 

protectora. Por ejemplo, papel, tela y pasta de goma requiere una hoja de soporte, mientras que la pared del vinilo 

y transferencias térmicas no. Además, de ancho tendrá que ser colocado sobre una estera de cualquier material que 

son menos de ~ 13 pulgadas de modo que las  ruedas puede alimentar adecuadamente el material. 

 Al colocar el material que va a cortar sobre la tabla de corte, puede localizar el material en cualquier lugar que tenga 

pegamento. 

 Cuando a tabla de corte  comienzan a perder su pega, se pueden lavar. Use un detergente lavavajillas suave, agua  

tibia y un cepillo para limpiar a fondo la superficie. Luego deje que se seque completamente. Normalmente, la tabla 

de corte recuperara su pegajosidad inicial. Pero si no, puede aplicar un adhesivo reposicionable según sea necesario. 

IMPORTANTE: No rociar adhesivos alrededor de su KNK! No sólo se puede conseguir el adhesivo pegue  a partes 

importantes de su Zing, también por que estos adhesivos sólo deben utilizarse en lugares bien ventilados. Respirar 

en el adhesivo puede ser perjudiciala tu salud! 

 Si la tabla de corte recién aplicado el spray pegante queda  demasiado pegajosa, causando dificultad en la 

eliminación de elementos de corte y sin fisuras, colocar un viejo  paño de cocina limpio, lateral difusa hacia abajo, 

sobre la superficie de la tabla y presione con un rodillo. A continuación, tire hacia arriba. Prueba el nivel de pegante  

y repita hasta que la tabla de corte  sea más apropiado para su material. Sólo tome unos prensados para reducir en 

gran medida la adherencia, como fibras de tamaño micro se presionan a la superficie. 

 

 

 Si ha cortado elementos o restos que no se puede quitar fácilmente de la tabla, puede utilizar Un -du o incluso o 

acetona (quitaesmalte) para mojar temporalmente el material y desactivar  el adhesivo. Evite raspar la tabla de 

corte mientras está húmedo y dejar secar al aire. 

 Si tiene que quitarle  a su  tabla el adhesivo, utilice removedor. Humedezca la totalidad superficie de la tabla con el 

removedor y dejar reposar durante unos 30 segundos. A continuación, utilice un metal o de plástico firme raspador 

para raspar el adhesivo hasta que la superficie esté limpia. 

 

 

1.06  Registro e instalación de hacer el corte de Software 

Registro de hacer el corte        IMPORTANTE  POR FAVOR LEA ESTA SECCION!!! 

 Su KNK Zing viene con un pin de activación para hacer el corte (MTC) de software. Esto NO es el código que utilizar 

en el software. 

 Si ya dispone de MTC, usted es libre de vender este Pin Activación o regalarlo y puede continuar utilizando su 

registro actual. Si este es el caso, vaya a la sección de Instalación. 

 Si usted es nuevo en hacer el corte, entonces usted debe utilizar esta Activacion de  Pin para registrar el software 

para obtener el código correcto para entrar en el software. 

La profundidad de la hoja debe ser 

sólo un poco más largo que el 

espesor del material que se está 

cortando. 

Gire a la derecha para 

exponer más de la 

cuchilla. Gire a la 

izquierda para retraer 

la cuchilla 
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 Vaya al siguiente enlace para registrar su PIN de activación: 

https://www.make-the-cut.com/register.aspx 

 Complete el formulario utilizando el PIN de activación. Introducir cuidadosamente su dirección de correo 

electrónico, ya que podría necesitar solicitar su número de registro de nuevo en el futuro y que se enviará a esa 

dirección. Al término de la forma, se le proporcionará un número de registro. Este es su número de registro 

permanente de los ordenadores del propietario. Puede dejar esta ventana abierta hasta que se instaló MTC o 

puede verificar que el número tiene. También ha enviado por correo electrónico a usted. 

 Instalación en Windows 
 Todos los nuevos propietarios deben descargar e instalar la última versión del software y el último plug-in para el 

KNK Zing. Vaya al siguiente enlace para descargar la última versión de MTC: 

http://www.iloveknk.com/Support/Software/Make-The-Cut/MTC-Windows/ 

 A continuación, haga clic aquí para descargar el plug-in para el KNK Zing: 

http://www.iloveknk.com/Support/Software/Make-The-Cut/Plugins/Zing/ 

 Instalar el software y el plugin. A continuación, abra MTC. Cuando se le pregunte si se desea registrar o seguir 

utilizando el modo de prueba, introduzca el número de registro que se proporcionó cuando se registró. 

 Si se ha perdido abrir el software cuando se le pregunte, puede encuentrarlo en  el icono en el escritorio   (o 

puede localizarlo desde  Inicio de Windows>  Menu Todas Programas). 

 Si usted pierde su número de registro y necesita instalar MTC en otro computador, favor visitar el mismo enlace 

anterior y haga clic en “Recuperar Pin”.  

 
 
 
Instalación en un Mac 
 Hay tres cosas para instalar: el programa MTC, el Puente de MTC, y el KNK Zing plug-in. Estos soncontenida en un 

archivo que se puede descargar aquí: 

http://www.iloveknk.com/Support/Software/Make-The-Cut/MTC-Mac/ 

 Antes de la instalación, por favor, lea y siga las instrucciones en materia de software de Apple (Los usuarios de Mac, 

por favor, tengan en cuenta el siguiente error) en el siguiente enlace: 

http://knkusa.com/resources/ 

 Después de la descarga se haya completado, abra la carpeta Descargas y ejecute el archivog MTC descargado. 

 Una ventana azul se abrirá con instrucciones de uso para la instalación del software y el puente. Ver la siguiente 

primer grafico para que mejor pueda visualizar lo que hay que hacer.  

https://www.make-the-cut.com/register.aspx
http://www.iloveknk.com/Support/Software/Make-The-Cut/MTC-Windows/
http://www.iloveknk.com/Support/Software/Make-The-Cut/Plugins/Zing/
http://www.iloveknk.com/Support/Software/Make-The-Cut/MTC-Mac/
http://knkusa.com/resources/
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1.07 Conexión del KNK Zing y Zing Air a la computadora 

 Coloque la maquina KNK en una superficie horizontal sólida. Conecte el cable de alimentación a la parte posterior 

de la cortadora y enchufe en una toma de pared o estabilizador de energia. Encienda el aparato con el interruptor 

de encendido en la parte superior. 

1.07.1 Conexión de un PC con Windows 
(Pase a la Sección 1.07.2 si usted es dueño de un Mac) 

 Usted tiene dos opciones para conectar  Zing Air a su equipo: Bluetooth o USB. Se requiere que sigapaso a paso,  las 

siguientes secciones presentes para cada tipo de conexión. Si se encuentra con problemas de conectividad, póngase 

en contacto con su distribuidor KNK primero. Si su concesionario no está disponible, por favor póngase en contacto 

con KNK EE.UU. para obtener ayuda. 

A. Conexión Uso de Windows - Bluetooth 

 Hay tres situaciones para Bluetooth: (1) Usted debe estar seguro que  el equipo tiene Bluetooth, (2)Saber con 

seguridad que su equipo no tiene Bluetooth, o (3) no está seguro. Así que consulte la sección apropiada: 

Mi equipo tiene Bluetooth disponibles 

(1) Haga clic en la flecha Mostrar iconos ocultos en la bandeja del sistema de Windows. 

(2) Haga clic derecho sobre el icono de Bluetooth y seleccione Agregar dispositivo Bluetooth. Si usted no 

tiene esta opción, pero, en cambio, verá una opción para “Abrir Mi Bluetooth”, a continuación, 

seleccione eso y luego vaya al paso (10). Si lo hace y No ve el icono de Bluetooth, vaya a la sección: “No 

estoy seguro de si mi equipo tiene Bluetooth.” 

(3) Compruebe la opción que dice “Mi dispositivo está activo y listo para ser detectado.” Haga clic en 

Siguiente. 

(4) Si se encuentra el Zing Air que se mostrará como CUTTER  

or   

Mire  el video. 
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(5) Seleccione este dispositivo y haga clic en Siguiente. 

(6) Aparecerán las opciones de emparejamiento. Seleccione el que dice Ingrese Opción emparejamiento del 

dispositivo (o, si   su equipo está ejecutando XP, dirá Utilice la clave de acceso que se encuentra en los  

documentos). 

(7) Escribe en 1234 y haga clic en Siguiente. 

(8) Un mensaje  dira que el dispositivo se ha agregado  y ahora debería aparecer. 

(9) Dos puertos COM se asignan con una conexión Bluetooth con el Zing Air: un puerto de salida y un puerto 

entrante. Por lo general, el número de puerto COM inferior es la que se necesita en el MTC. Al llegar al 

punto de seleccionar el puerto COM de la lista desplegable en el MTC abajo, seleccione el número más 

bajo de los dos Puertos COM que tanto leer Serial Standard a través de Bluetooth. Consulte la Sección 

1.11 para más instrucciones y para probar la comunicación. Usted ha terminado con esta sección y no es 

necesario para leer el Paso (10). 

(10) Haga clic en Búsqueda de dispositivos. Cuando se encuentra el Zing Aire, debe ser etiquetado como 

cortador. Haga doble    clic en este icono y se instalará automáticamente. Ahora debería ser capaz de abrir 

MTC y usted encontrara la conexión Bluetooth en la lista desplegable de puertos serie,  cuando va a la 

ventana de corte. 

Mi ordenador no tiene Bluetooth disponibles 

(1) Un adaptador USB para Bluetooth viene con su Zing Air. Conecte este adaptador a un puerto USB libre de su 

computadora. 

(2) El dispositivo se instalará automáticamente en Windows. Sin embargo, puede tomar alrededor de 30 - 60 

segundos para que el icono de Bluetooth aparezca en los iconos ocultos de Windows. El icono Bluetooth se 

ve así:  

(3) Ir a la sección anterior: Mi ordenador tiene Bluetooth disponible y proceder a través de los pasos. 

No estoy seguro de si mi equipo tiene Bluetooth 

(1) En el ordenador, haga clic en el botón Inicio y seleccione Dispositivos e impresoras. 

(2) Haga clic en Agregar un dispositivo. Si se encuentra el Zing Air que se mostrará como CUTTER o Cortador  

 or  

(3) Nota: es posible que pasen un tiempo corto para Agregar el dipositivo en  Windows, así que tenga paciencia. 

Si no se encuentra, entonces verificar que el Zing Air está encendido y se encuentra dentro de 30 pies sin 

obstrucciones o dentro de 10 pies si un interior de pared que separe el cortador de la computadora. Si  Zing 

Air todavía no  lo encontró, a continuación, cierre la ventana y vaya  a la sección anterior: Mi ordenador no 

tiene Bluetooth disponibles. 

(4) Seleccione el icono de corte y luego haga clic en Siguiente. 

(5) Aparecerá una selección de tres opciones de emparejamiento. Seleccione la segunda: Introduzca Opción 

emparejamiento del dispositivo (O, si su equipo está ejecutando XP, dirá Usar la clave de acceso que se 

encuentra en el documento). 

(6) Escriba en 1234 y luego haga clic en Siguiente. 

(7) Un mensaje que dice que el dispositivo se ha agregado ahora debería aparecer. 

(8) Dos puertos COM se asignan con una conexión Bluetooth con el Zing air: un puerto de salida y un puerto 

entrante. Por lo general, el número de puerto COM inferior es la que se necesita en el MTC. Al llegar al punto 

de seleccionar el puerto COM de la lista desplegable en el MTC abajo, seleccione el número más bajo de los 

dos Puertos COM que tanto leer Serial Standard a través de Bluetooth. Consulte la Sección 1.11 para más 

instrucciones y para probar la comunicación. 
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Problemas 

 Si el equipo no localiza  Zing air, compruebe que el Zing air está encendido, Bluetooth habilitado y el Zing Aire está 

a 30 pies de su ordenador (sin obstrucciones) o dentro de 10 pies Si una pared interior separa el cortador de la 

computadora. 

Conexión mediante Bluetooth a otro equipo 

 Si necesita desconectar el Zing Aire de Bluetooth, haga clic en el icono de Bluetooth en la barra de tareas y seleccione 

Mostrar dispositivos Bluetooth. Dispositivos e impresoras se abrirán y usted pueden seleccionar el  cortador a 

continuación, haga clic en Eliminar dispositivo. 

B. Conexión de Uso de Windows - USB 

 Conecte el cable USB a la parte posterior de la cortadora y en un puerto USB disponible en su computadora. Nosotros 

No  recomiendamos  el uso de un concentrador USB. Sin embargo, si no tienes otra opción, entonces el centro debe 

ser del tipo que es accionado por separado. 

 Una vez que se conecta el cable USB, el administrador de hardware de Windows identificará la conexión USB.si la 

ventana de instalación de hardware de Windows se abre, vaya y acepte  todos los valores predeterminados. 

1.07.2 Conexión en un Mac 

 Si bien es posible conectar a un Mac a través de Bluetooth, es muy recomendable que se use USB en su lugar. La 

conexión Bluetooth en un Mac puede resultar en corte irregular y una necesidad de ajuste de datos, ajuste del 

data basado tanto en la propia Mac, así como el archivo se envía a cortar. Si aún desea probar Bluetooth en tu 

Mac, entonces por favor consulte el Apéndice D para obtener instrucciones. 

 En la carpeta Aplicaciones, lanzar el programa Puente MTC. La siguiente ventana se abrirá. Bajo COM1,seleccione 

la lista  que dice “serie usb”: 

 
 

 Haga clic en Guardar en la parte inferior antes de hacer clic en Cerrar. 

 Ir a la carpeta Aplicaciones y mantenga presionada la tecla Ctrl mientras hace clic en el icono de la MTC. Elija Abierto 

del menú desplegable. 

 Introduzca el número de registro que recibió cuando se registró el software. 

 Si usted pierde su número de registro y necesita instalar MTC en otro equipo, por favor vaya Al mismo enlace donde 

primero descargado MTC y haga clic en “Recuperar Pin”. 

1.08 Pinch Palancas ruedas 

 

Seleccione tty en 

la conexion 

Y haga clic 

en guardar 

http://www.youtube.com/watch?v=IM3qxFekC-Y
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 Hay dos palancas de rueda, una a cada lado, justo dentro de las tapas de los extremos. Estos se utilizan para levantar 

y bajar las tres ruedas de presión. 

 Presione hacia abajo las palancas.  Tenga en cuenta que ambas partes no necesitan elevarse al mismo tiempo, pero 

sí es necesario que las ruedas estén hacia arriba  antes de insertar la base de corte o sus materiales respaldados. 

 Después de insertar la base de corte o material, voltear las palancas para bajar las ruedas de presión sobre la 

colchoneta o material. Observe que hay dos insertos de plástico negro a cada lado de la barra de rodillo de presión 

que necesitan estar  de manera correcta que la barra del rodillo bajará en el lugar correcto. 

 Si usted encuentra que sus palancas son difíciles de operar, por favor consulte el Apéndice B Solución de 

problemas Preguntas frecuentes. 

 

 

 

1.09 Mat Guías / Materiales 

 Hay dos guías para el  material en la parte delantera de la maquina (consulte el diagrama de partes en la Sección 

1.04). No son un requisito para el uso, sino más bien proporcionado para realizar el posicionamiento de la  tabla 

de corte o material más fácil insertarse. 

 En el momento de escribir estas líneas, ambas guías se mueven hacia la derecha cuando los Zings se empaca. Estas 

guías debe ser colocadas  de nuevo con uno a cada lado de la esterilla o material de respaldo. Al desenroscar una 

guía hacia la izquierda, será luego deslice libremente izquierda o la derecha. 

 Si el carro de la cuchlla está impidiendo un acceso fácil a las guías, a continuación, apague el Zing. Ahora puedes 

hacerlo de forma manual deslice el carro de la cuchilla a la izquierda para que pueda acceder más cómodamente 

estas guías. 

 Si bien las guías se pueden colocarse en cualquier lugar, tenga en cuenta que la primera vez que encienda el Zing y 

la cuchilla del carro llega a su origen a casa, esa posición marca el comienzo del área de corte de 14 “. Por lo tanto, 

no quiera posicionar su guía derecha demasiado hacia la izquierda o podrá tener  el riesgo de no tener un rango de 

corte 14 pulgadas que podria necesitar. 

 Coloque la guía derecha donde usted lo desea, gire hacia la derecha para bloquear en su lugar. Al insertar la tabla 

de corte o materiales, deslice hacia la derecha para alinear con esta guía. Si lo desea, puede mover la guía de 

izquierda a solo tocar el lado izquierdo de la tabla o material. Una vez más, no es necesario utilizar el izquierdo a 

menos que, por alguna razón, se desee utilizar la parte izquierda para la alineación inicial de la tabla de corte o 

material. Pero una vez más, tenga cuidado de no tratar de cortar demasiado a la izquierda, ya que puede hacer que 

el carro cuchilla para golpear el límite lado izquierdo. 

1.10 Dibuje Prueba Formas 

 Los nuevos propietarios tienden a ser ansiosos de probar sus cortadores. También es importante para poner a 

prueba su cortador para asegurar que los datos se envía correctamente desde su ordenador a la máquina y todo 

está funcionando correctamente. Los siguientes pasos le permitirá hacer algunas pruebas con la pluma de prueba. 

Pero tenga en cuenta que los siguientes pasos son para dibujo, no corte. Antes de insertar el soporte de la cuchilla 

en el KNK Zing, por favor lea la Sección 2.01. 
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1.10.1 Configuración de Dibujo 

Landscape  ( horizontal )VS Portrait  ( Vertical ): ¿Cuál le gusta más? 

 Con base en su propia experiencia pasada con MTC u otros programas de corte y cortadores, usted puede tener un 

modo particular (horizontal o vertical) que usted está acostumbrado a usar. No existe el derecho o el modo 

equivocado, sólo el modo en que funciona mejor para usted; el modo que tiene más sentido! 

 Para algunas personas es más fácil trabajar  en contra el otro al visualizar donde las formas se corten. Por esta 

razón, los tutoriales de este manual se presentarán en ambos modos, para que pueda utilizar lo que le parece más 

fácil. 

 En MTC, la orientación se establece en Virtual Mat  en la barra principal Main Menu. Se presentan los ajustes de 

esta ficha en detalle en la Sección 3.04. Por ahora, sólo tenga en cuenta la ubicación de los ajustes de configuración 

Mat Configuration  para horizontal o vertical . 

 

 

 

 

 

 

 

 

 

 

 Modo Horizontal- Landscape  

 

         

 

 En el modo horizontal, la flecha en la tabla de corte virtual apunta a la izquierda. Al dibujar o cortar el “ABC” 

se muestra en la tabla virtual Horizontal (Landscape virtual mat), que se dibujara  o cortara de  arriba a abajo, 

según se mira la Zing: 

Esta flecha indica la 

dirección del Mat  Real 

dentro  de la maquina  

Zing 

Seleccionar 

Landscape 
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 Modo  Vertical -  Portrait 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           

 

Inserte el Mat como esta 

indicando la flecha 

dentro de  Zing 

La forma de ubicación será 

exacta  según los ajustes 

descritos en la sección 2.07 

Esta flecha indica la 

dirección del Mat  Real 

dentro  de la maquina  

Zing 

 

Seleccionar 

Portrait 
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 En el modo vertical, la flecha en el tapete virtual apuntar hacia arriba. Al dibujar o cortar el “ABC”se muestra 

en la tabla de corte virtual, se dibuja o se corta izquierda a derecha, según se mira la Zing: 

    

 

1.10.2 Dibujo Tu Primera Forma 

 Esta primera prueba le mostrará cómo funciona el modo de Punto de cuchilla  Knife Point. Se trata de un entorno 

muy útil, ya que es fácil saber dónde están sus formas que cortarán en su material, además de que economiza el 

uso de sus materiales. En lugar de corte de formas en que se encuentran en la tabla de corte virtual, las formas se 

pueden mover y cortar donde se define el origen del material, utilizando la punta de la cuchilla (no la luz láser). 

1. Coloque una hoja de 8.5 “x 11” de papel en la tabla de corte, usando cualquiera de las líneas de la 

cuadrícula. Coloque el papel en la tabla como este: 

 

 

2. Inserte la tabla de corte en el cortador, entre las guías de material. Deslice la tabla hacia el espaldar  y use 

cualquiera de las marcas horizontales en la parte delantera de la Zing para alinear la tabla. Luego levante las 

palancas para soltar las ruedas de presión sobre la base de corte. La mayor parte de la tabla y el papel debe 

ser estar detrás de la cuchilla, no en la parte delantera: 

 

Inserte el Mat como 

esta indicando la 

flecha dentro de  Zing 

La forma de ubicación 

para cortar (Portrait) será 

exacta  según los ajustes 

descritos en la sección 

2.07 

 

El Mat  debe  

estar  en esta 

dirección en la 

máquina Zing 
Alinee el material a 

largo de una de las 

líneas de cuadricula 
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3. Antes de instalar la pluma de prueba, asegúrese de que la pluma escriba haciendo  garabatos en papel de 

desecho. Luego afloje el tornillo frontal en el asiento del soporte de la cuchilla e inserte la herramienta de la 

pluma. Asegúrese de que la punta del lápiz sea ligeramente superior a la superficie de corte de manera que 

no se arrastre a través del papel. Apriete firmemente el tornillo. (Nota: con Zing desactivado, puede deslizar 

manualmente el carro de la cuchilla a la izquierda de modo que usted puede comprobar pluma o pieza final 

altura, según sea necesario) 

 

 
 

4. Seleccione modo  Horizontal (Landscape) o Vertical (Portrait), en la Virtual tabla de corte, en función de sus 

preferencias personales 

(Como se describe al principio de esta sección):  

 

 

Seleccione su  modo de preferencia : Landscape  o  Portarit 

 

                     
 

5. Antes de añadir una forma de dibujar, haga doble clic en la zona cuadriculada en la pantalla para el cursor 

llamada Caret. Este determinará dónde se importará la forma: 

 

Solamente la parte  

delantera  del  mat  y el 

material debe estar en 

frente de la máquina. 

Levante  el lápiz suficientemente  

alto como para que la punta del lápiz 

este encima del material, luego 

apriete el tornillo. 
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6. Vaya a Archivo> Importar> De Formas básicas (File>Import>From Basics Shapes) y seleccione la categoría de 

los llamados flechas (Arrows). Haga doble clic en cualquiera de las formas de flecha para añadir en la forma 

de la pantalla. Una flecha le ayudará a comparar mejor donde la forma se dibuja frente a lo que se ve en la 

pantalla. 

 

 
 

7.  Ahora usted tendrá una flecha en su tabla virtual que se ve así:  

 

                     

                                                        Landscape Virtual Mat                                                       Portrait Virtual Mat 

8. Para abrir la ventana de control de corte, ir a la Corte Proyecto Con ...> Klic-N-Kut Zing. (Cut Project 

With…>Klic-N-Kut  Zing) .  Una nueva ventana abira pidiendo  que modelo KNK Zing que desea utilizar. 

Seleccione el modelo correcto y es posible que desee desactivar  la casilla para que no pop-up cada vez que 

entra a la ventana de corte. (No se preocupe, hay una manera de conseguir de nuevo esta  ventana, si alguna 

vez siente que va a necesitar. Consulte la Sección 2.10.)     

 

Haga doble click para el cursor que  

estará como una línea vertical roja, la 

cual sera también sestara su mat virtual. 

Haga  doble click  en cualquiera de las 

formas de flecha para adherir a su  pantalla 
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9. La ventana de corte se abrirá ahora. Se explicara en detalle en las Secciones 2.2 a 2.8. Pero para los fines de 

este tutorial rápido, haga los siguientes cambios en la velocidad (Speed), la fuerza (Force) y Blade Offset. Para 

cambiar  mantenga pulsado el botón izquierdo del ratón y arrastre el botón o  hacia abajo o arriba con el ratón 

o haga clic en el dial de una vez y luego utilice las teclas de flecha del teclado para ajustar la configuración:  

 

 

 

 

 

10. Si, en lugar de ver “Conectado 

(Connected) (COM X)”, aparece “No conectado”( Not Connected), entonces el equipo no 

identifico la maquina  Zing. Haga lo siguiente: 

a.  Apague la maquina Zing. Desconecte y vuelva a conectar el cable USB, tanto en  Zing y el ordenador 

para asegúrese de que el cable está bien enchufado. 

b.  Prenda la  maquina  Zing  de nuevo. 

c.  Haga clic en el botón No conectado ( Not Connected), seleccione la conexión ()( Connection) y 

seleccione actualizar Puertos (Refresh Ports). Repita para volver a esta ventana y seleccione la 

conexión que dice COMX (USB Serial Port). Si no hay ninguna opción que dice USB Serial Port (como 

se muestra más abajo), a continuación, consulte el Apéndice B - Problemas de comunicación.  

 

 
 

11. A continuación, establezca el origen haciendo clic en el botón . La siguiente ve (Set Blade Origin)   y una 

ventana  se abrirá:  

Haga click para su  modelo 

original de knk Zing 

Puede seleccionar para  que esta 

ventana  no vuelva  aparecer. 
Haga click si usted  tiene un 

modelo  KNK  Zing Air 

Set de velocidad para 15-10 en 

la original zinc 

Set de fuerza para 50-60 

Haga click en la luz 

para apagar el Offset 

Escoja Knife POint 

Abra la ventana de 

Set Blade origin 

Verifique si este  

botón dice conectado 
Haga click aquí para 

sus ajustes originales 

para cortar su forma 

Este puerto COM esta 

asignado a ZIng 
Este puerto COM  NO 

ESTA asignado a Zing 

Haga  click en las flechas verdes para que el 

soporte de la cuchilla  se mueva  dentro o 

fuera del mat 
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IMPORTANTE: En el modo de Knife Point, que va a utilizar la punta de la pluma  para establecer el l origen, 

no la luz láser (que se utiliza en el WYSIWYG o Imprimir y modos de corte). 

 

 

12. Haga clic en las flechas para mover la pluma a la esquina inferior derecha del papel. Usted no tiene que ir 

exactamente en la esquina. De hecho, establezca la punta de la pluma sólo un poco en. Luego haga clic en 

Finshed para establecer esta nuevo origen y cerrar la ventana Blade Set Origen. Más detalles acerca de esta 

ventana se presentan en la Sección 2.08.    

 

 

   

 

 

 

 

 
 

 

Ajuste  para mover en 

pasos largos o pequenos. 

Haga click en Finished 

para  un set  nuevo 

Mueve  el lápiz 

hasta la  esquina 

del material 
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13. Haga clic en  Cortar Proyecto (Cut  Project)  y su forma de flecha se dibujará en el nuevo origen que ha 

establecido. Luego  el corte es completo, la ventana de corte se cerrará. Su flecha se dibuja como se 

muestra, con la dirección en relación con si usted eligió originalmente Horizontal o Vertical para su tabla de 

corte  virtual:  

                   
 

 

 

 

14. Para dibujar de nuevo, volver a la ventana de corte y selecciona un origen diferente. Practique moviendo el 

origen en diferentes lugares. Así es como funciona el modo de Knife Point. Si desea que la imagen para dibujar 

debe tenerlo en la tabla de corte  virtual, entonces usted necesita para cambiar al modo WYSIWYG y utilizar 

el láser para establecer el origen en lugar de la pluma. Consulte la Sección 2.07 para más detalles sobre el 

control de las imágenes de corte 

IMPORTANTE  :  POR FAVOR  LEA LA  SECCION 2.01 ANTES DE CORTE 

1.11 Mantenimiento  
Las máquinas Klic-N-Kut no requieren ningún tipo de lubricación o controles de rutina. Sin embargo, aquí están 

algunas cosas a tener en cuenta para la operación exitosa de su cortadora: 

 Mantenga las ruedas de presión limpio. Dependiendo del pegamento que se utiliza en la base de corte, es 

posible que al pellizcar las ruedas se conviertan  pegajosas y recojan pequeños trozos de cartulina u otro 

material cortado. Esto puede conducir, en algunos casos, a la inclinación colchoneta o materiales arruinando 

Alimente  el mat  por 

esta dirección dentro 

del zing. 

Mueva el lápiz hasta 

la punta del material 

Resultados de Landscape; Esta flecha 

indica el origen y puntos dehacia abajo. 

Resultados de  Portrait. Esta flecha indica 

el origen y  puntos  hacia la derecha 
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durante los cortes posteriores. Para limpiar el pellizco ruedas, use un paño sin pelusa y un removedor de 

adhesivo tal como alcohol isopropílico  para limpiar el pellizco de las ruedas a fondo. 

 Mantenga los ejes limpios. Tan importante como las ruedas de presión, los ejes están cerca a la tabla de corte 

También debe estar libre de adhesivo y pequeños trozos de material. Ellos se pueden limpiar de la misma 

manera como la rueda. Nota: No vierta limpiador sobre un eje. En su lugar, aplique un poco de removedor 

de adhesivo sobre paño  libre de pelusa  y luego use el paño húmedo para limpiar los ejes. También puede 

utilizar pinzas para quitar cualquier material o adhesivo que se pega a un eje. 

 Mantenga la tabla  de corte limpia y pegajosa. Como se mencionó en la Sección 1.05, la base de corte se 

puede lavar con agua y jabón para eliminar pequeñas piezas invisibles de material que están reduciendo la 

pegajosidad de la tabla  de corte. Después del secado, puede agregar más adhesivo reposicionable, si es 

necesario. 

 Revise su soporte de la cuchilla, según sea necesario. Si de pronto no se puede obtener un corte limpio, 

comprobar el soporte de la cuchilla por  diminutas astillas de materiales que pueden haber sido atrapados 

por la cuchilla y alimentados en el interior del soporte de la cuchilla. 

 Las ruedas de arrastre palancas en el KNK Zing pueden necesitar ser ajustadas de vez en cuando. Si las 

palancas son difíciles de operar, utilizar un destornillador para apretar ligeramente (a la derecha)  los tornillos 

de las palancas. 

 Si mueve la maquina  con frecuencia, es posible que el láser  cambie  ligeramente. Periódicamente, es posible 

que desee hacer una verificación de la impresión y corte de precisión para asegurarse de que la calibración 

sigue siendo preciso. Consulte el Capítulo 9, si va a ser el uso de su Klic-N-Kut para aplicaciones de impresión 

y corte. 

 Si  corta  vinilo u otros materiales respaldados con regularidad, puede que tenga que reemplazar el corte 

recto en algún momento. 

• Para cualquier otra pregunta o inquietud sobre el mantenimiento de su KNK, por favor, publicarlo en nuestro 

foro de usuarios:  http://knkusa.com/forums/ 

 

 

 

 

 

 

2.Corte 

2.01 Lo que usted debe entender acerca de corte     

IMPORTANTE  POR FAVOR  LEER TODO ACERCA DE 2.01!! 

Tienes que hacer errores 

 La clave para tener éxito en el corte es  hacer un montón de él! Los que rehúsan al uso de su voluntad Zing nunca 

llegaran a la etapa de dominarlo. Es muy normal que los nuevos propietarios estén intimidados por su corte, por lo 

que recuerde los siguientes puntos clave: 

http://knkusa.com/forums/
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o No pare  los cortes de su nuevo ZING para papel, vinilo, cartón, caucho  y otros materiales de fácil  corte. Lo 

peor que podría pasar es que posiblemente se le rompe una cuchilla. Eso es todo! Y la probabilidad de que 

eso ocurra,  es baja. 

o • Tienes que empezar a cortar de manera que usted va a hacer un montón de errores! Todos hacemos 

eso. Es en  estos errores que usted comienza a aprender. Se da cuenta de que esos errores no dio lugar a un 

cortador roto. Más dejarás de cometer los mismos errores como se acuerde más de las cosas que hay que 

comprobar antes cada corte. 

o Al hacer menos errores se empieza a construir la confianza y usted comienza a tener éxito con el corte!A 

partir de ahí, se empieza a experimentar más y producir más. Por lo tanto, el mejor curso de acción es 

simplementeempezar a cortar  mucho! Pero en primer lugar, leer el resto de esta sección. 

Los errores más comunes cometidos por los nuevos propietarios 

 Todos los hacemos y todos aprendemos de ellos. Así que, por favor, tenga en cuenta los siguientes errores más 

comunes y luego terminar de leer toda esta Sección 2.01 como los detalles detrás de estos errores mencionados se 

explicará: 

 Demasiado cuchilla se expone en el soporte de la cuchilla 

 • La punta de la cuchilla esta demasiado cerca del material 

 El exceso de fuerza se está utilizando para el material a cortar 

 Olvida  establecer la hoja de compensación antes de cortar 

 El no hacer un corte de prueba para asegurarse de que los ajustes son óptimas 

 No practicar lo suficiente con el lápiz y el papel de prueba para saber dónde formas cortarán 

Comience con materiales sencillos y fáciles Formas 

 Usted no comienza su primera lección de conducción en la autopista. Probablemente comenzó a conducir en una 

granja o en un estacionamiento. Entonces progresado hasta el barrio y otras calles de poco tráfico. A continuación, 

comenzó a conducir en las principales calles y, por último, de la autopista. Piense en su corte de la misma manera 

y no comenzar sus primeros cortes con materiales difíciles de espesor o archivos de corte detalladas! En su lugar, 

empezar a cortar las formas básicas  y  bajo costo  de materiales o simplemente Recortes que tiene a mano. Su 

forma de trabajo de los cortes más difíciles después de dominar el fácil queridos. 

 

Registre sus éxitos 

 Como usted tiene cortes éxito, tome nota de los ajustes que acaba de usar, tales como la fuerza, la velocidad, la 

cuchilla tipo, número de pases, marca de material, etc. Hay un formulario en blanco al final de este capítulo que 

pueda imprimir y utilizar para registrar sus resultados. También hay ajustes sugeridos para materiales comunes al 

final de este capítulo. Utilice estos como guías de partida, pero recuerde que sus resultados pueden variar en función 

de los factores que pueden afectar el corte.  

Utilice la cuchilla  correcta para el material que se está cortando 

 La maquina  Zing viene con una cuchilla  de 45 grados (tapa roja) y una de 60 grados (tapa azul). Opcional para 

comprar la cuchilla  de tela l (tapa amarilla). Utilice lo siguiente como guía para la elección de la cuchilla apropiada 

para el material que se está cortando: 

 De 45 grados (tapa roja) se debe utilizarse para cortar vinilo, papel, más cartulina, plástico fino, transferencia 

térmica,y papel mantequilla o pergamino. 

 De 60  grados (tapa azul) se debe utilizar para cortar madera aglomerada, Grungeboard, Paño , goma espuma, 

rhinestone caucho, plástico grueso artesanía, imán autoadhesiva y foamie. 
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 La cuchilla de tela (tapa amarilla) se debe utilizar para cortar todos los tejidos y fieltro sin rigides . Tambien 

es recomendado por PhotoFrost para cortar sus hojas de la formación de hielo.icing sheets 

 Adicionalmente hay recomendaciones en la tabla de configuración sugerida al final de este capítulo. 

Ajuste la longitud de la cuchilla para que coincida con el grosor del material 

 
 La longitud de la cuchilla es la cantidad de cuchilla que está expuesta en la parte inferior del soporte de cuchilla. 

Usted desea que la longitud de esta  coincida con el espesor del material para el corte óptimo. Es controlado por 

la rotación de la parte superior del soporte de la cuchilla. Girando en sentido horario se extiende la cuchilla 

(longitud de la cuchilla más larga). Girando hacia la izquierda retrae la cuchilla (más corta longitud de la cuchilla). 

 Al ajustar la longitud de la cuchilla, mantenga el soporte de la cuchilla al lado del material antes de pulsar el material 

a la tabla de corte, de modo que usted puede establecer con mayor precisión la longitud para que coincida con el 

grosor del material. Para  materiales muy delgados , como el vinilo y papel fino, sólo la punta de la cuchilla se 

sobresale de la parte inferior de la soporte de la cuchilla. De hecho, usted debe apenas será capaz de sentir con la 

yema del dedo y no ser capaz de ver mucho. 

 Una buena forma de probar la longitud de la cuchilla es doblar un trozo de material sobre sí mismo y luego se corta 

una línea en el material a mano, como se muestra en el vídeo vinculado en esta sección. Presione con firmeza, pero 

no  demasiado, ya que más fuerza no va a determinar si la cuchilla está ajustada a la longitud correcta. Si la cuchilla 

no puede cortar a través del material, lo harás necesitar extender la cuchilla. Si la cuchilla corta a través del material 

y corta en la capa siguiente, es necesario retraer la cuchilla. Si la cuchilla corta a través del material, pero no corta 

en la capa de abajo, usted tiene la longitud perfecta. 

 Tener la cuchilla totalmente extendida no se traducirá en un mejor corte. De hecho, puede causar sesgo, desgarro 

de los materiales, daños a la cuchilla, y el daño a la tabla de corte. 

 Al realizar el corte de prueba, asegúrese de revisar su tabla de corte para líneas de corte después de la prueba. 

Usted debe ser capaz de establecer la longitud para obtener cortes limpios pero sin cortes visibles en la colchoneta. 

Si usted ve las líneas de corte en su tabla, retraer la longitud de la cuchilla girando la parte superior del soporte de 

la cuchilla ~ ¼ de vuelta en sentido antihorario. No tiene que quitar el soporte de la hoja de la Zing. Repita su corte 

de prueba. 

 

Largo Perfecto    Muy largo       Muy corto 

 

Ajuste la cuchilla  de altura por encima del material 

 
 La altura de la cuchilla es la distancia desde la punta de la cuchilla a la parte superior del material que va a cortar. 

Al insertar el soporte de la cuchilla en el asiento del soporte, que no necesariamente tiene que ser colocado con el 

borde exterior de tocar el asiento de soporte de la cuchilla. Usted tiene control sobre esa altura y puede elevar la 

cuchilla titular de un poco más arriba antes de bloquear  con el tornillo frontal en el asiento del soporte de la 

cuchilla. 

 Ajuste la altura de la cuchilla de manera que: 

o La punta de la cuchilla no se arrastra a través del material que se está cortando cuando se mueve al punto de 

inicio del corte. 

Material 

Mat 

http://www.youtube.com/watch?v=IM3qxFekC-Y
http://www.youtube.com/watch?v=IM3qxFekC-Y
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o La caída de la cuchilla invocará más fuerza a abajo ... a un punto! Más delgados materiales fáciles de cortar 

(Tal como papel y vinilo) puede tener la punta de la cuchilla bastante cerca del material. Materiales más 

densos, tales como cartulina, madera aglomerada y plástico, necesitan la punta de la cuchilla un  poco más 

alto, pero no demasiado alto:  

 

Existen varios métodos para asegurarse en  la altura cinstante  de la cuchilla en un corte: 

o Un método recomendado para conseguir la misma altura fijada para todos sus cortes es utilizar un espaciador 

de algún tipo. Coloque el espaciador en la parte superior del material que se está cortando. Afloje el tornillo 

frontal e inserte el soporte de la cuchilla de modo que la punta de la cuchilla este en contacto con la parte 

superior del espaciador. Ahora apretar el tornillo frontal y quitar el espaciador. Esta distancia proporcionará 

la cuchilla un poco de “sala de punch” para dar la fuerza adicional y el corte más consistente de su material. 

Lo que hay que utilizar para este espaciador? Para materiales tales como cartulina y tela, pruebe a utilizar 25 

Post-It hojas de la nota o 12 piezasa recortadas de papel de tarjetas. Al cortar materiales muy gruesos, tales 

como 0.03 “aglomerado, fieltro o goma espuma, use 13, publicarlo hojas de la nota o 6 piezas de cartulina en 

su lugar. 

o Un método alternativo es cortar  anillos  para deslizarse sobre la parte inferior del soporte de la cuchilla y 

luego permitir que la cuchilla  y los anillos se sienten  en la parte superior del asiento de soporte de la cuchilla. 

Utilice 1 anillo para materiales delgados (papel y vinilo), 2 anillos de cartulina, 3 anillos para los materiales de 

la plantilla del rhinestone, 4 anillos de madera aglomerada de espesor, y así sucesivamente.A diferencia del 

método anterior, usted no tiene el material en sí el levantamiento de la posición de soporte de la cuchilla  por 

lo que necesitará seguir aumentando el número de juntas tóricas para materiales más gruesos. Estos anillos 

se pueden cortar de cereales ocajas con dos pegadas entre sí para crear un anillo. El archivo de corte para 

éstos se encuentra aquí: http://www.iloveknk.com/FreeFiles/KNK/Important/ 

 

Ajuste la velocidad, la fuerza, y el número de pases basado en el material y Formas 

 Utilización de las configuraciones correctas de corte es tan importante como el tipo de cuchilla, longitud de cuchilla, 

y la altura de la cuchilla. Referirse a las Secciones 2.3 a 2.4 para más detalles. Una vez más, algunos ajustes sugeridos 

se encuentran al final de este capítulo y ajustes para el uso de las distintas herramientas accesorias Zing se 

encuentran al final del capítulo 10. 

Realizar cortes de prueba! 

 Usar la función de prueba en MTC para hacer cortes de prueba. No continúe con el corte hasta que el corte de 

prueba está limpio. ¿Cuándo corte de formas intrincadas, un corte de prueba de una imagen compleja, como una 

carta o una pequeña porción de su patrón, podría ser un mejor indicador de la configuración correcta. Consulte la 

Sección 2.09. 

Saber donde sus Imágenes se cortarán 

 Práctica con la pluma de prueba hasta que ya sepa, con 100% de confianza, donde se extraerán las imágenes. Esto 

es importante, ya que usted no quiere  adivinar cuando comience realmente cortar con una cuchilla. Referirse a 

Sección 2.07 para obtener más información y videos sobre las opciones para controlar la ubicación de los cortes. 

La punta de la cuchilla  

necesita esta arriba del 

material a cortar 

Pero no tan alta la 

cuchilla ya que no 

alcanzara el material 

http://www.iloveknk.com/FreeFiles/KNK/Important/
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Perfecto punta salida de la cuchilla que necesita 

 Que  es la salida de la cuchilla? Es la distancia horizontal desde el centro del eje de la cuchilla a la punta de la 

cuchilla. Una herramienta de la pluma o el grabado ha un desplazamiento de 0 debido a que la punta está centrada 

con el centro del eje de la herramienta de grabado pluma. Pero la cuchilla es diferente   

    

 

 

  

  

 

 

 

 Qué sucede si se establece la cuchilla salida  a 0 cuando se corta? O lo que si está demasiado alto? 

   

   

 

 Offset es muy bajo               Offset es muy bajo                                     Offset  es muy alto 

 Caminos  sin cerrar                fuera de esquinas y redondeado              dentro  y alrededor de las 

esquinas        

 Consulte la Sección 2.06 para el establecimiento de la  cuchilla Offset. 

 

Mantenga el corte limpio y Sticky Mat 

 Presione sus materiales de manera uniforme a la tabla de corte. Piense en el uso de un rodillo, tanto antes como 

después del corte. Reprimir el material después del corte puede ser de gran ayuda en la recogiendo  los residuos. 

 Cuando sea necesario, utilice  cinta  con los materiales más gruesos a la tabla  para evitar que se deslice durante el 

corte. 

 • Si se corta una serie de materiales, es posible que necesite más de una colchoneta para que pueda utilizar 

tablas  pegajosos para ciertos materiales. 

No se frustre, consiga ayuda! 

 Además de tener su propio distribuidor Zing como su primera línea de contacto, hay foros de usuarios, foros de 

mensajes, y los grupos de Yahoo donde puedes publicar preguntas y obtener respuestas de otros usuarios, 

distribuidores, y hacer que sea un expertos en corte . Utilizar estos recursos: 

o Zing Yahoo Grupo: http://groups.yahoo.com/group/KNK_Zing/ 

o Foro KNK Soporte: http://knkusa.com/forums/ 

o Hacer El Grupo Yahoo Corte: http://groups.yahoo.com/group/makethecut/ 

 

 

2.02 Cortar con Klic-N-Kut Zing y  Zing  Aire 

Imagine la línea 

pasando por el 

centro de un 

lapicero o cuchilla 

No hay 

offset en 

un lapiz 

El offset  es la 

distancia entre el 

centro de la cuchilla y 

la punta de la cuchilla 

http://groups.yahoo.com/group/KNK_Zing/
http://knkusa.com/forums/
http://groups.yahoo.com/group/makethecut/
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 Antes de acceder a la ventana de corte Zing, es necesario tener al menos una forma de la página actual para cortar. 

Si usted no tiene formas, a continuación, intentar acceder a la ventana de corte resultará en un mensaje emergente 

que indica,”No hay nada en el proyecto actual para cortar!” 

 • Para confirmar lo que va a cortar, se puede acceder a la función  Vista de corte  (Cut Preview) con los 

siguientes  pasos: 

o Haga clic en el icono Cortar Vista previa (cut Preview) en la barra de herramientas de Archivo ( File 

Toolbar)  

o Presione Ctrl + Shift + E 

o Ir a la Corte Proyecto Con ...> Cortar Vista previa.( Cut Project with… >Cut Preview) 

 La vista previa de corte mostrará las formas que se cortan. Inmediatamente la función volverá a mostrar el 

“material” con las formas cortadas . Esto también se llama a veces  el  negativo: 

                                                   Lado del Virtual mat            Lado de  corte Preliminar     Forma después del segundo click 

                                                           

 El Corte con Klic-N-Kut Zing ( Cut with Klic-N-Kut Zing) se puede acceder de las siguientes maneras: 

o Haga clic en el  icono Cortar Projecto con ( Cut Project With )en la barra de herramientas de Archivo 

( File Toolbar)  

o Presione Ctrl + Shift + C 

o Ir a la Corte Proyecto Con ...( Cut Projet With)> Klic-N-Kut Zing ... 

La siguiente ventana se abrirá preguntando qué modelo KNK Zing que desea utilizar. Seleccione el modelo correcto y 

le recomendamos que desactive la casilla para que no pop-up cada vez que entras la ventana de corte. (No se 

preocupe, hay una manera de recuperarlo si alguna vez encuentra que necesita cambiar. Consulte la Sección 2.10.)  

 

 

 

 

 A continuación, la ventana de corte se abrirá:   

 

Haga click  aquí para su 

modelo original KNK Zing 

Desmarque  para que esta 

ventana no vuelva aparecer Haga clic aquí si es 

dueño de KNK Zing Air 



27 
 

 

 

 

 

 

 

 

 Consulte los números de sección que se muestran en las instrucciones para cada ajuste. El botón Proyecto Corte ( 

Cut Project) no necesita su propia sección, ya que simplemente inicia el corte una vez que haya hecho sus otros 

ajustes. 

 Para cambiar una configuración que tiene un dial, mantenga pulsado el botón izquierdo del ratón y mueva el ratón 

hacia arriba para aumentar el ajuste o hacia abajo para disminuir el ajuste. Alternativamente, haga clic izquierdo 

en el dial de una vez y luego utilizar el arriba y flechas hacia abajo en el teclado para cambiar el ajuste. 

 El movimiento en el logo Zing se puede activar y desactivar haciendo clic izquierdo en el logo. 

 

2.03 Velocidad 

 Hay dos ajustes de velocidad: Cortar (Cut) y Up: 

 
 

 

 

 

 

 

 La velocidad de corte (Cut Speed) es la velocidad de la cuchilla (u otra herramienta instalada) mientras está en el 

“abajo” o la posición de corte. El Zing Air tiene 38 ajustes de velocidad, con 9 de ellos por debajo de 100 mm / seg. 

Laser offset Sección 9.02 

Resolución Sección 2.12 

Actualizaciones, 

Programaciones, y ayuda 

Sección 2.10 

Ajustes de velocidad 

Seccion 2.03 

Ajustes Fuerza 

Seccion 2.04 

Offset de cuchilla  

Seccion 2.06 

Tipo de corte 

Seccion 2.07 

Origen de set de 

cuchilla Seccion 2.08 

Ajustes Multicut 

Seccion 2.05 
Status de conexión  y Menu 

de corte Seccion 2.09 
Corte del proyecto: 

Iniciar el corte 

Las  marcas  blancas indican el 

inicio de la velocidades rapidas 

Velocidad de corte: La velocidad escogida 

depende del recorrido de la cuchilla y 

posición de corte Ajustes de 1-38 

Velocidad Alta:  La 

velocidad 

escogida  
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Este cortador fue diseñado para manejar una amplia gama de materiales más gruesos, más difíciles que se cortan 

con mucho más éxito con un corte más lento. 

 La configuración de la 1 a la 9 son las velocidades lentas y deben ser utilizadas cuando se corta 

Materiales dificiles, tales como madera aglomerada, plástico, estireno, y balsa. 

 El ajuste de 10 a 20 son velocidades medias y deben ser utilizados para los materiales fáciles de cortar, 

tales como cartulina, vinilo, transferencia térmica, y el material de plantilla de diamantes de imitación. 

 Los ajustes superiores a 20 son las velocidades rápidas y deben ser utilizados para el grabado, 

repujado, y el dibujo. 

 

 

 El Speed Up es la velocidad de la cuchilla (u otra herramienta instalada) mientras está en el “arriba” o posición no 

-cutting. Tiene el mismo número y rango de velocidades como la velocidad de corte. Un Speed Up está en efecto 

cuando: 

 La cuchilla está viajando desde el origen hasta el punto donde comienza el corte de una forma 

 La cuchilla se  levanta y se mueve a la siguiente ruta de acceso o la forma de cortar 

 La cuchilla está viajando de regreso al origen después de completar el corte. 

 Hay una pequeña línea blanca en la esquina superior izquierda de cada línea que indica la transición entre el lento 

velocidades y las altas velocidades. Además, el color de la barra fuera de las dos diales es de color amarillo cuando 

en una velocidad lenta  y verde cuando encuentran en un rango de alta velocidad:  

 

 
 

 Entre los diales Cortar (Cut) y (Up) hay una luz que  puede hacer clic para apagar y encender. Se habrá dado cuenta 

de que hay símbolo de  bloqueo  que es una etiqueta para la luz, para recordarle que cuando la luz está encendida, 

la velocidad de corte (Cut) y el plano Velocidad(Up) coincidirá. Si usted tiene las dos velocidades establecidas en 

diferentes niveles, convirtiendo la luz de fondo cambiará automáticamente la velocidad  (Up)hasta la misma 

configuración que la velocidad de corte(Cut speed). 

 Por qué la Corte Velocidad  (Cut Speed) y Velocidad (Up Speed) siempre tienen que ser diferente? Cuando corte 

extremadamente  materiales densos  a una de las velocidades más lentas, usted va a querer salir de la velocidad 

hasta en un nivel normal, digamos 15, por lo que  no está esperando innecesariamente para la cuchilla desde el 

origen  hasta el lugar para comenzar el corte. Si la primera forma es a través de la tabla de corte , la espera puede 

parecer interminablemente larga! 

 

 

2.04 Fuerza 

 

 La fuerza de corte (también llamada presión) afecta en gran medida la calidad del corte. Si la fuerza es demasiado 

baja, el material no puede ser cortado. Si la fuerza es demasiada alta, obtendrá un mal corte (incluso  corte 

incompleto a veces) y desgarro del material. Use  las  fuerzas recomendadas  para el material que se está cortando 
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y realice  pequeños cortes de prueba antes de cortar. Haga los ajustes con el fin de obtener un corte de prueba 

limpio antes de proceder a su corte final. 

 Los rangos de fuerza de corte 1-160 en la escala de la fuerza. El máximo de 160 representa el 750 g de la fuerza de 

corte en la maquina  Zing. Consulte el final de este capítulo para las fuerzas iniciales recomendadas para varios 

materiales. Una vez más, hay que recordar que una gran cantidad de factores que pueden afectar la fuerza de usar, 

por lo que  debe utilizar el corte de prueba como guía y ajustar, según sea necesario. 

 Las cuchillas sin filo tendrán más fuerza que las nuevas cuchillas, por tanto, anticipar el aumento de la fuerza sobre 

la vida de la cuchilla. 

 Cuando el corte de materiales que pueden utilizar ya sea la cuchilla, la cuchilla de 45 grados necesita más fuerza que 

la de 60 grados, debido al contacto adicional con el material a cortar. 

 Los materiales que absorben la humedad (como cartulina, papel, tela y madera aglomerada) necesitarán más fuerza 

(y posiblemente más de una pasada) si han sido expuestos a la humedad. Un consejo es secar estos materiales antes 

de cortar. 

 Para obtener información detallada sobre el corte de diversos materiales y el uso de herramientas de accesorios, 

consulte el Capítulo 10. 

 

2.05 Multicut 

 

 El ajuste( Multicut) causa un patrón individual en cada camino a cortar el número de serie de pases antes de la 

cuchilla mueve a la siguiente ruta de acceso para cortar. Esto es mejor que simplemente repetir  toda el corte, ya 

que cada pase repetido se corta con la cuchilla se mantiene pulsado durante los pases repetidos, lo que resulta en 

el corte más limpio. 

 Multicut  recomienda en las siguientes situaciones: 

o Corte  de materiales más gruesos, tales como tableros de partículas (Chipboard), donde múltiples 

pases permiten que la cuchilla progresivamente pueda  “tallar” a través del material. 

o Corte de determinados materiales fibrosos, tales como tela, donde un segundo pase asegurará de que 

todas las fibras han sido cortadas limpiamente. 

o Corte  de formas detalladas (como títulos de script) de ciertos materiales, con mucha textura  como 

cartulina, donde un solo paso puede dejar ciertos puntos no cortados limpiamente. 

o Corte de  material de la plantilla   de brillos rhinestone donde un segundo paso da resultados mucho 

mas  limpios en el corte. 

2.06 Cuchilla Offset 

 

 El predeterminado (Blade Offset ) de cuchilla es  de 0,25 y debería funcionar bien para la mayoría de su corte con la 

cuchilla de cubierta  roja 45˚  (para las cuchillas  cubiertas de rojo compradas antes de noviembre de 2013, utilizar 

0.35). Use una cuchilla de Offset 0,75 para la  cuchilla  de  cubierta azul de 60˚. La cuchilla de tela Zing también debe 

utilizar un desplazamiento de 0,75. Si utiliza otras marcas de soportes de cuchilla, puede que tenga que 
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experimentar con el ajuste de offset Blade. En general, una de desplazamiento de 0,30 es un buen punto de partida 

para la prueba. Refiérase a la Sección 2.01 observar lo que sucede cuando el ajuste es demasiado alto o demasiado 

bajo. 

 Al dibujar con lápices o usar otras herramientas, como el grabador y repujador, apague  el Blade Offset (Puesto a 0) 

haciendo clic en el botón debajo de la ventana de la hoja actual Offset:  

    
 Cuando Offset está activada, te darás cuenta de que un pequeño corte se   antes del carro de cuchilla se mueve la 

cuchilla para comenzar el corte de la primera forma. Este pequeño corte corrección fija la cuchilla en la dirección 

necesaria para la primera ruta. La mayoría del tiempo, la ubicación de este pequeño corte no es un problema porque 

se hace en lo que por lo general será una parte de residuos del material. Sin embargo, para algunas aplicaciones, 

tales como el corte de una plantilla, que puede no ser deseable tener este recorte en la ubicación que elija 

automáticamente. En este caso, puede o bien con cinta adhesiva un pequeño trozo de material de desecho en la 

parte superior del lugar donde se produce el corte de corrección para proteger el material por debajo, o puede 

añadir un poco de la línea pequeña justo debajo de la frontera de la tabla de corte virtual. Al enviar las formas a 

cortar, un mensaje emergente le avisará de que hay formas externas de la tabla  virtual. Haga clic en Sí (Yes) para 

continuar. La ventana de corte a continuación, puede colocar un pequeño trozo de material en el apropiado  de 

ubicación en el corte. 

 

2.07 Tipo de corte 

 Hay tres modos de control de las imágenes cortadas con la maquina  Zing. Se les llama: 

 Knife Point: Mueve las formas de reducir el origen que ha configurado en el cortador por  sí mismo. Utilice la 

punta de la cuchilla ( blade tip) para establecer el origen para el corte. 

 WYSIWYG: Corta las formas en que se colocan en el tapete virtual. Utilice la luz láser para establecer el origen- 

ya sea en la esquina de la base de corte o la esquina del material (como se describe más adelante en esta 

sección). 

 Print and Cut: Corta las  formas relativas a las marcas de registro impresas en su impresora. Consulte el 

Capítulo 9 para instrucciones completas sobre el proceso de impresión y corte. 

 

 

Knife Point  

 
 Este es el modo recomendado para la mayoría de las aplicaciones, ya que economiza el uso de sus materiales de 

corte. 

 Las formas pueden estar ubicadas en cualquier lugar de la pantalla, incluso fuera de la tabla virtual. Las formas 

serán movidas y  el corte donde se define el origen del material. El origen se ajusta con la posición de la cuchilla 

punta (Blade tip). 

 Cuando se corte más de una forma, la forma más cercana al origen se cortará en el origen y cualquier otra forma 

se puede cortar con  la distancia y la dirección desde que forma como se ve en la pantalla. La siguiente grafica  

muestra ejemplos en los que las imágenes se cortan. Utilice la flecha de la tabla  virtual (Virtual Mat)  como una 

guía para la dirección para insertar la tabla  real o material en su Zing. 

http://www.youtube.com/watch?v=IM3qxFekC-Y
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 Knife Point - Modo horizontal(Landscape Mode) 

 

   
 

 

 

 

 

 

 

 Knife Point –  Modo  Vertical (Portrait Mode)       

 



32 
 

    
 

 Si va a utilizar trozos de materiales para el corte de formas, tendrá que utilizar el modo Knife Point: 

 Coloque varios trozos (lo suficientemente grandes para las formas en la pantalla) en su tabla de corte  

en diferentes lugares, como se muestra a continuación. 

 Inserte la  tabla de corte en la  Zing y luego puede establecer el origen en la parte inferior de  esquina 

derecha de uno de los restos y corte la forma seleccionada actualmente. 

  Mueva la pluma a la esquina inferior derecha de la próximo papel  y establecer el origen existente  y 

cortar el misma forma (u otra forma, en función de lo que tienes en tu Mat virtual). Repita para los 

otros restos.Tenga en cuenta la “X” roja ‘s indican que el origen se establecería de manera que no 

interrumpa el papel.  

 

WYSIWYG 

 
 Este es el modo recomendado cuando se necesita para cortar formas en lugares muy específicos en su material 

(Como la parte central delantera de una tarjeta de felicitación). La luz láser se utiliza para establecer el origen. 

 Las formas se cortan en función de dónde se encuentran en el tapete virtual. Las dimensiones de la tabla  deben 

coincidir o bien las dimensiones  de la tabla de corte  que está utilizando y que deben coincidir con las dimensiones 

del material que se está cortando. Estas dos situaciones se tratan por separado. 

WYSIWYG – Tabla  virtual de corte con  cuadrícula sobre tabla de corte Actual 

 Crear la  típica tabla de corte  que está dimensionada 12 “x 12” y desactive la opción Mostrar Márgenes. Esta será 

una tabla que coincide con las dimensiones de la abla de corte de  Zing. Puede utilizar cualquiera de modo vertical 

http://www.youtube.com/watch?v=IM3qxFekC-Y
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u horizontal – sólo recuerde que debe colocar su material en el tapete en la orientación correcta para la 

alimentación en la Zing. 

 El origen se ajusta con la luz del láser, no la punta de la cuchilla. La luz láser se encenderá automáticamente cuando 

al ir a la ventana Blade Set Origen. Dirigir el punto rojo de la luz láser a la esquina inferior derecha de la rejilla 

descartada (Ruled Grid) (ver más abajo). Tenga en cuenta que si necesita una precisión absoluta para la ubicación 

de los recortes, será necesario calibrar el láser de desplazamiento ( Laser Offset), que se cubre en el Capítulo 9. 

 WYSIWYG –  Modo  Vertical (Landscape Mode )  

    

 

 WYSIWYG – Modo  vertical  (Portrait Mode)    

   
 

WYSIWYG - Mat virtual Partidos Material Dimensiones 

 Crea un map virtual que coincide con las dimensiones materiales. Por ejemplo, si usted está cortando de una “x 

11” hoja de cartulina 8.5, a continuación, crear un Mat virtual con esas mismas dimensiones. Puede utilizar 

cualquiera de modo vertical u horizontal - sólo recuerde colocar su material en el tapete en la orientación 

correcta para la alimentación en el Zing. 
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 El origen se ajusta con la luz del láser, no la punta de la cuchilla. La luz láser se encenderá automáticamente 

cuando se va a la ventana Blade Set Origen. Dirija el punto rojo de la luz láser a la esquina inferior derecha de su 

material (ver más abajo). Tenga en cuenta que si necesita una precisión absoluta para la ubicación de los 

recortes, será necesario calibrar el láser de desplazamiento, que se cubre en el Capítulo 9. 

 

 

 

 

 

 WYSIWYG –  Modo  Vertical (Landscape Mode )  

 

          
 

 

 WYSIWYG – Modo  vertical  (Portrait Mode)  
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Impresión y Corte  (Print  and  Cute) 

 Este es el modo recomendado cuando se quiere imprimir imágenes en su impresora y luego tener el corte en la 

maquina  Zing. 

 Es similar a WYSIWYG porque se reducirán las formas en que se encuentran en el Mat virtual. Sin embargo, en el 

proceso de impresión y corte, tres marcas de registro impresas se imprimen junto con sus imágenes. El láser se 

establece a continuación, en cada marca y el  cortador Zing entonces corta sus formas basado en la triangulación. 

Esto es mucho más preciso que WYSIWYG porque toma en cuenta no sólo la desalineación de la impresión de la 

tabla, sino también los posibles errores en la impresión. La mayoría de las impresoras no se imprimen imágenes con 

precisión en la ubicación en el papel ya que se encuentran en la pantalla. 

 Tenga en cuenta que las imágenes de mapa de bits (.jpg, .bmp, PNG, etc.) deberán ser de píxeles trazó primero de 

modo que las líneas de corte son creadas. Consulte el Capítulo 6 de tutoriales sobre cómo hacer el rastreo de píxeles 

(también llamada vectorización). 

 Consulte el Capítulo 9 de tutoriales sobre el proceso de impresión y corte, incluyendo la calibración del láser. 

 

2.08 Blade Set Origin 

 

 Al hacer clic en el botón Set Hoja Origen (Blade Set Origin)  abre la ventana Set Hoja Origen:  

 

 
 

 Cada vez que encienda el cortador  Zing, el carro cuchilla se moverá al mismo lugar. Esto se llama el Home Origen o 

[0,0].Ahora, siempre se puede utilizar ese lugar para comenzar sus cortes y nunca establecer un nuevo origen, sin 

embargo, que limita, en cierta medida, en situaciones en que es posible que realizando el corte de prueba en ese 

lugar, pero necesitará para pasar a una nueva ubicación para cortar sus formas. Además, es posible que desee cortar 

formas de varios restos de material y les gustaría poner los restos en su tabla de corte  antes de cortar. 

 La ventana Set Hoja Origen ( Set  Blade Origin) le permite mover el carro de la cuchilla a una nueva ubicación y 

definir que ubicación que el nuevo origen de ese corte: 

 Haga clic en las flechas verdes para mover el carro izquierdo y derecho y la tabla dentro y fuera de la 

Zing hasta que el carro de la cuchilla está en la ubicación que desea utilizar. 

 En el Knife  Point  va a establecer el origen basado en la ubicación de la punta de la cuchilla (u otra 

herramienta punta). 

 En WYSIWYG o Imprimir y  cortar (Print and  Cut), podrás utilizar la luz láser para establecer su origen. 

 Tenga en cuenta que también puede utilizar las teclas de flecha o el teclado en lugar de hacer clic en 

las flechas verdes en la pantalla. Esto es realmente una gran alternativa, ya que entonces puede 

mantener sus ojos en la punta de la cuchilla o  del láser en lugar de estar constantemente mirando 

hacia atrás en la pantalla para hacer clic en el lugar correcto. 
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 La jugada de marcación( Move by) determina hasta qué punto el carro cuchilla se mueve con cada clic de una 

flecha: 

  Si usted necesita mover el carro a bastante distancia a través de la tabla de corte, y luego ajustar esa 

configuración a un alto número. 

 Si usted necesita mover el carro de menos de una pulgada, y luego ajustar a un valor mucho menor. 

  Si necesita una precisión extrema, como cuando se está configurando el origen de impresión y corte 

( Print And Cut), entonces una vez que está cerca de la ubicación que usted necesita, reducir al mínimo 

de 4. 

 Tenga en cuenta que al utilizar las teclas de flecha del teclado, se puede ajustar la jugada de línea 

mediante la  la Tecla Ctrl y haciendo clic en el arriba y abajo teclas de flecha. 

 Si desea que el carro de la cuchilla vuelva al origen inicial ( Home Origen), haga clic en el botón [0,0] y el carro de 

la cuchilla va retorno inmediato a ese lugar. 

 Si desea utilizar el mismo origen que solo se utilizó en su último corte, haga clic en el uso Último botón ( Use Last) 

y el carro de la hoja volverá a la misma [X, Y] Ubicación establecido previamente. 

 Una vez que el carro de la hoja (o punto láser) está en el lugar que necesita, haga clic en el botón Terminado ( 

Finished) para establecer que ubicación  del nuevo origen y cierre esa ventana. 

 

 

2.09 Conexión, Status  y prueba  de Menú de corte( Test Cut Menu)  

 El estado de la conexión ( Connection Status) y el botón de menú de prueba ( Test  Cut Menu)  sirve varias 

funciones: 

o El botón señala si esta  Conectado (Connected) (Com X) o no está conectado ( Not Connected) 

dependiendo de si o no el ordenador ha identificado una conexión con la  Zing:  

 

 
 

o Hacer clic en este botón abrirá una ventana de menú:   

 

 
 

o El láser se puede activar o desactivar en este menú eligiendo Toggle Laser On. O, en cualquier momento 

usted está en el Corte con ventana Klic-N-Kut Zing, puede pulsar F2 para cambiar el láser. El láser también 

será encendido cuando va a la ventana Blade Set Origen.  El menú de opciones de prueba de corte contiene 

una lista de diez posibles formas de usar para su corte de prueba. Realice un corte de prueba  esencial para 

asegurarse de que los ajustes de corte, la exposición cuchilla, y la altura de punta de la cuchilla  se 

establecen correctamente antes de ejecutar su corte real. En algunas situaciones, usted tendrá que 

seleccionar una forma basada en su forma real. Por ejemplo, cortar la flor, si usted va a ser el corte de una 

forma que tiene curvas o cortar la plantilla de diamantes de imitación, si tiene que cortar un patrón de 

diamantes de imitación real para comprobar que usted conseguirá limpia deshierbe de los círculos. 

o El menú de conexión () (Connection) se abre con las siguientes opciones: 
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2.10 Actualizaciones, Presets, y ayuda 

 Las actualizaciones y ayuda en el menú desplegable se activa haciendo clic en la flecha hacia abajo en la esquina 

superior derecha del Corte con ventana Klic-N-Kut Zing:  

 

 
 

 Aparecerá el siguiente menú: 

 
 

 En este menú, puede comprobar si hay actualizaciones para el plug-in, acceder al manual de usuario Zing en línea, 

cambiar el modelo de Zing, encienda Zing Habla(Speak), y comprobar el número de versión actual del Zing plug-in 

instalado. 

  Presets son ajustes por defecto (velocidad, fuerza, Multicut, offset de hoja y corte tipo) que desea utilizar siempre 

para un material o aplicación particular: 

 Introduzca los valores que desea utilizar en el corte con ventana Klic-N-Kut Zing. Por ejemplo, para cartulina lisa 

delgada, usted podría optar por configurar los dos valores de velocidad(Speed) a los 10, la Fuerza(Force) a 

85,multicorte ( Multicut) a 1, Cuchilla Offset en 0,25 y el tipo de corte( Cut Type) a punta de bisturie ( Knife Point) 

  A continuación, acceder al menú de ajustes preestablecidos(Presets), haga clic en la flecha desplegable y 

seleccionar Presets:  

 

 
 

 Seleccione Crear preestablecido (Create Preset) y la siguiente ventana se abrirá donde puede introducir un nombre 

para su nuevo Preset y las notas  (Notes) que desea tener:  

 

 
 

 Después de hacer clic en Guardar (Save), el nuevo Preset aparece en la lista:  
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 Al hacer clic en un Preset de la lista a continuación, cambia  en la ventana la configuración actual del Corte con Cut 

with  Klic-N-Kut Zing  para la configuración que ha guardado y las notas que ha entrado no se abrirá:  

 

 
 

  Para borrar un Preset, haga clic derecho sobre el nombre de la lista y una ventana emergente le pedirá que 

confirme si desea borrar (delete). 

 

2.11 Lista de verificación adicional antes de cortar! 

 ¿Tiene su material en la tabla de corte y esta  se inserta en el Zing? (Nota: los materiales con un respaldo hoja, tal 

como vinilo o  transferencia para plancha  no requieren una tabla  para el corte) 

  ¿Tiene las palancas de rueda de arrastre planteadas en el frente (de modo que las ruedas de presión están abajo)? 

 ¿Ha ajustado la longitud de la hoja, según el espesor del material que se está cortando? 

 ¿Tiene el soporte de la cuchilla montada firmemente en el asiento del soporte de la cuchilla y la punta de la cuchilla 

a la altura correcta por encima del material? 

  ¿Ha establecido el origen en la esquina inferior derecha de su material (o dondequiera que usted necesite el origen 

)? 

  ¿Ha establecido la Fuerza? Y la velocidad? 

 ¿Ha seleccionado  el correcto  Offset 

 ¿Es necesario activar el Multi-corte para este material? 

  ¿Ha seleccionado el tipo de corte que desee utilizar? ¿Sabe usted, con confianza, donde sus formas se van a cortar? 

2.12 Resolución de calibración 

 Si se va a cortar cualquier forma particular, por ejemplo, un 10 “x 10” cuadrado, podría encontrar que en realidad 

medidas 9-15 / 16 “x 10-1 / 32”. Será muy cerca de 10 “x 10”, pero tal vez sólo un poco más pequeña o más grande 

en una o ambas dimensiones. Ahora bien, esto podría ser perfectamente aceptable para el tipo de corte que haces. 

Por lo tanto, puede incluso no ser necesario hacer esta calibración en particular. Sin embargo, si usted quiere 

asegurarse de que sus formas se cortan con precisión, el siguiente procedimiento le permitirá calibrar el KNK. 

 Tenga en cuenta que esta resolución sólo se aplica a los modos de Knife  Point y WYSIWYG. Para aplicaciones de 

impresión y corte  Print and Cut , Resolución se determina automáticamente en función de las marcas de registro, 

donde se establecen con la luz láser durante el proceso de impresión y corte. 

 Comience seleccionando la 12 x 12 en la tabla  virtual se establece en la orientación que usted prefiera. 

 Añadir una gran tamaño  a la tabla o Mat virtual (se encuentra uno bajo Formas básicas (Basic Shapes) en la carpeta 

de polígonos). Nota que cuanto mayor sea la forma, más precisa la calibración será, por ejemplo, un 10 “x 10” 

rectángulo. Si es necesario, consulte la Sección 3.13 para obtener instrucciones sobre las formas de cambio de 

tamaño. 
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 Se recomienda que utilice el lápiz para dibujar una prueba frente a la cuchilla. Esto le permitirá volver a utilizar la 

misma hoja de papel para varias pruebas, durante el proceso de calibración. Usted también necesitará una regla. 

 Haga clic en  el icono Cut Project With  y, abajo  deTipo de corte ( Cut Type), seleccione Knife Point. Establecer el 

origen basado en el pluma y haga clic en  Cut Project With tengan el cuadrado dibujado en la hoja de papel. 

 Deslice la tabla de corte  fuera, pero deje el papel en la tabla. Tenga en cuenta que a pesar de tener su Mat virtual 

establece el Horizontal o Vertical, el ancho de la tabal es la dimensión de izquierda a derecha, según se mira la Zing. 

La Altura de la plaza es el frente a la dimensión de vuelta:  

 

 
 

 Debido a que la maquina  Zing es  perfectamente exacta, solamente tomar nota si los lados son ligeramente más 

grandes de 10 “o un poco más pequeña de 10”, ya que probablemente será tan cerca que ni siquiera se puede 

medir la distancia de 10 “con una regla! En su lugar, digamos que la altura (Height) es sólo un poquito más de 10 

“. Marque ese lado como siendo 10.01 “. Digamos que el ancho (width) es menos de 10 “, más que la altura era 

inferior. Marque ese lado como 9,98 “. Ahora, si usted siente que puede medir con precisión, con una regla, y luego 

hacerlo. Pero sólo la estimación debería funcionar bien también. 

 Haga clic en  Cut Project With Con icono de nuevo, y hacer clic en el icono de llave pequeña. La ventana de 

calibración se abrirá y es  donde puede introducir sus medidas. Tenga en cuenta que si se ha utilizado una pieza  

que era más grande o más pequeño de 10 “, a continuación, asegúrese de cambiar los números de la izquierda, así 

como la introducción de los números de la derecha:  

 
 

 Haga clic en Guardar( Save). 

 Ahora, tendrá que repetir el dibujo del nuevo cuadrado  y se puede utilizar el mismo papel, siempre y cuando usted 

se mueva el origen a una nueva ubicación y asegúrese de que su nuevo cuadrado  encajará en la misma hoja. 
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 Después de dibujar la nuevo cuadrado , de nuevo, alinee con una regla para ver cómo de cerca el cuadrado  coincide 

con 10 “x 10”. Si que hipercorregido luego volver y la entrada de una corrección menor. Si no lo hizo correcto 

suficiente, entonces introducir una corrección mayor. 

2.13 Zing Speak 

¿Qué está Speak Zing?   

 

 Zing Speak  es una característica en el plug-in KNK Zing, comenzando con la versión 2.0. Se le permite comunicarse 

por voz con el ordenador para hacer preguntas y ajustes de control en la Corte  Cut with  Kic-N-Kut Zing. 

¿Por qué iba yo a querer usar Zing Speak? 

 Hay varias situaciones en las que Zing Speak es especialmente útil: 

 Aplicaciones  de Impresión y corte donde usted está parado en el Zing,y  dirige el punto láser para cada registro 

marca 

 Materiales en los que usted está haciendo cambios en los ajustes de corte y la ejecución de la prueba corta  

Test Cut Menu. Es más conveniente para estar en frente de la Zing todo el tiempo en lugar de ir y venir a la 

computadora. 

 Llamada de presets (ajustes de corte de materiales) que ya has creado y añadido para hacer el corte. 

 También es “simplemente divertirdo”, para usar! El vocabulario es rico en variaciones y puede que te encuentres 

identificado  en usarlo! 

¿Qué necesito para poder utilizar Zing Speak? 

 Usted necesitará: 

o KNK Zing  con ( Make the Cut), por supuesto! Esta es sólo una aplicación de Windows, pero que 

trabajará con Windows XP, Vista, 7 y 8. 

o Micrófono de escritorio o un auricular con un micrófono 

o Altavoces - ya sea altavoces integrados en el ordenador o altavoces accesorios conectados a su 

ordenador. 

o Propietarios XP - que probablemente tendrán que instalar Discurso SDK51. Se instala con Microsoft 

Office. Pero si usted no puede conseguir Zing Speak  al iniciar, descargar e instalar de nuevo desde 

este enlace: 

http://www.microsoft.com/en-us/download/details.aspx?id=10121 

¿Cómo instalo Zing Speak? 

 Zing Speak es una parte de la maquina de corte  KNK Zing plug-in 2.0. Sólo tienes que descargar e instalar este 

plugin. 

 Algunos usuarios pueden encontrar necesario ajustar ciertos parámetros en Windows para obtener el 

correcto auricular / micrófono reconocido y de trabajo. Consulte este tutorial para más detalles: 

http://www.iloveknk.com/Support/Tutorials/Make-The-CutSupport/Tutorials/Setup-Headset-Microphone-for-

ZingSpeak.pdf 

 

 

http://www.microsoft.com/en-us/download/details.aspx?id=10121
http://www.iloveknk.com/Support/Tutorials/Make-The-CutSupport/Tutorials/Setup-Headset-Microphone-for-ZingSpeak.pdf
http://www.iloveknk.com/Support/Tutorials/Make-The-CutSupport/Tutorials/Setup-Headset-Microphone-for-ZingSpeak.pdf
http://www.youtube.com/watch?v=IM3qxFekC-Y
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¿Cómo inicio Zing Speak? 

 Al entrar en la ventana de  Cut With Kic-N-Kut Zing,  presione F4 o haga clic en la flecha hacia abajo en la parte 

superior derecha esquina:   

 

 
 

 La siguiente ventana se abrirá: 

 

 
 Comprobar lo que por defecto se establecen para la entrada de audio ( Audio Input) y los dispositivos de salida de 

audio (Audio Output). Si no son correctos, y luego ir al Panel de control de Windows y haga clic en Sonido. 

Predeterminados se pueden cambiar allí. 

 El reconocimiento de precisión ( Recognition Accuracy) es un valor el motor de voz envía de nuevo en cuanto a la 

confianza que lo es en lo que dijo. El defecto se fija en el 80%. Por lo tanto, se ejecutará el comando si es al menos 

un 80% de confianza. Por lo tanto, si se establece en el 1%, entonces, sólo se ejecutará la mayoría de cualquier 

sistema, sin importar el grado de confianza que es. Un valor de 100% significa que nunca va a cometer un error, 

pero usted tiene que hablar perfectamente ingles. 

 Es posible que desee marcar la opción Ejecutar Zing hablará en Inicio.  Zing Habla,  sólo funciona cuando la ventana 

de Cut  with  Klic-N-Kut Zing está abierto, se ahorra tiempo de tener que cambiar automáticamente cada vez que 

esté listo para cortar. Incluso cuando se activa, usted todavía tiene la opción de cambiar la configuración utilizando 

el ratón o teclado. 

 Si esta es la primera vez que utiliza el software de reconocimiento de voz de Windows en el Zing, es altamente 

recomendable  que usted pasa por el entrenamiento de voz ( VoiceTraining). Este es un proceso fácil de la lectura 

de una serie de oraciones para que el equipo aprenderán cómo se pronuncia ciertas palabras. Es posible que desee 

también hacer segunda sesión y podrás ver la opción de hacerlo, después de haber terminado la primera. Esta 

claramente  mejora el reconocimiento de comandos cuando se utiliza Zing Speak. 

 

¿Cómo utilizo Zing Speak? 

 Una vez que haya completado el entrenamiento de voz, ya está listo para ser usando Zing ¡Habla! Usted puede 

pedir preguntas acerca de los ajustes, cambiar la configuración, establezca el origen, encender / apagar el láser, 

realice un corte de prueba, llame un preset, compruebe su conexión y ejecutar un corte. 
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 Los comandos disponibles se han escrito para permitir variaciones. Por ejemplo, cuando se pregunta sobre la fuerza 

de la corriente, y pregunta en cualquiera de las siguientes maneras: 

 ¿Cuál es la fuerza? 

 ¿Cuál es la fuerza ? 

 ¿Cuál es mi fuerza actual? 

 Por favor, ¿cuál es mi fuerza? 

 ... y otras variaciones similares 

 Del mismo modo, cuando se cambia un ajuste, hay un número de maneras diferentes para instruir el software, 

tales como:  

 Establecer fuerza a 80 

 Por favor ajuste la fuerza a 80 

 Gire la fuerza a 80 

 Fuerza para 80 

 Vaya por delante y establecer la fuerza a 80 

 ¿Podría definir la fuerza a 80 

 ... y otras variaciones similares 

 Apéndice C contiene una referencia rápida para utilizar a medida que aprende Zing Speak. Se muestra una muestra 

por cada consulta o comando disponible. 

 Una guía más completa, pero opcional Vocabulario de palabras y términos disponibles está disponible para 

descargar Aquí: 

http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/ 

 Es posible que ni siquiera tenga que utilizar la Guía completa de vocabulario. Si se descarga el archivo, por favor no 

se deje intimidar por la magnitud de la lista. El propósito de un extenso vocabulario , es simplemente cubrir muchos 

usuarios y las  formas como  pueden indicar lo mismo. Por ejemplo, es posible que prefiera utilizar el “giro” verbo 

y no “Set”. Eso está bien! Es posible que prefiera decir “¿Cuál es mi presión? en lugar de “¿Cuál es la fuerza?” Una 

vez más, eso es perfectamente aceptable. Un gran agradecimiento a Andy por darnos tantas alternativas! 

 

 

 

¿Qué más necesito saber? 

Presets 

 La configuración de presets pueden ser ajustados usando Zing hablar, pero para salvar a una nueva, tendrá que 

manualmente ir al menú desplegable en la parte superior de  la ventana  Cut with KNK Zing  o presione F5 y luego 

entrar en el nombre del preset. A partir de ese punto, sin embargo, puede utilizar Zing hablar con tirar de los ajustes 

para ese preset diciendo “Uso predeterminado <nombre del preset>” o “Por favor, use preestablecido <nombre 

del preset>” (y otras variaciones). 

Establecer  Origen de la cuchilla. 

 Como se muestra en la referencia rápida, hay diferentes formas de configurar los Pasos (steps) (Mover 

configuración / Move By  Settings). Puedes especificar un número exacto de pasos de los límites de 4-1016 (por 

ejemplo Set Pasos 50) o, si usted necesita para ponerlo en el límite más bajo o más alto, a continuación, sólo decir 

“Set Pasos mínimo” o “Set Pasos máximo.” Al igual que con otras funciones, también se pueden utilizar otros 

http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/
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términos, como el más pequeño y más grande. Una vez más, podrás adaptar Cuantas términos son más fáciles de 

recordar. 

 Cuando se mueve el carro de la cuchilla usted puede comenzar con la palabra “Mover”, como en “Mover 7 

izquierda” (mover 7 pasos a la izquierda) o simplemente dicen “7 izquierda.” Cuando se mueve hacia delante o 

hacia atrás, hay una serie de alternativas, tales como “delante”, “adelante”, “arriba”, “atrás”, “hacia atrás”, “abajo”, 

etc. Tenga en cuenta que también se utilizan estos mismos comandos cuando se realiza una aplicación de impresión 

y corte. 

Desactivación 

 A veces es posible que desee salir de la ventana abierta Cut with KNK Zing, pero preferiría no tener Zing Speak 

activo . Hay un número de maneras de tener Zing Speak cerró temporalmente, como diciendo “me Ignorar” o “No 

prestes atención a mí”. Habrá una confirmación y luego Zing Speak esperará para la reactivación mediante un frase 

como: “Presten atención a mí.” También puede desactivar Zing Hable con varias frases diferentes. Una vez más, 

asegúrate de revisar la Guía de Vocabulario para sus opciones.  

 

 

 RECORDAR  QUE TODAS LAS INSTRUCCIONES  DE VOZ SON  EN INGLES, NO EN ESPANOL 
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Settings Form for Cutting Materials/Ajustes para materiales para corte 

Material Type 
Material Brand or 

Source 
Blade Force Speed  

Blade 

Offset 

# 

Passes 
Ht Other Comments 
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1 © 2009 - 2014 Sandy McCauley, All Rights Reserved 

 

Ajustes de corte sugeridos para diversos materiales sobre KNK Zing / Zing Air*Number of Post-It notes 

used to set blade tip distance from material 

© 2009 - 2014 Sandy McCauley, All Rights Reserved  

 Number of Post-It notes used to set blade tip distance from material  

© 2009 - 2014 Sandy McCauley, All Rights Reserved  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

© 2009 - 2014 Sandy McCauley, All Rights Reserved 

 Number of Post-It notes used to set blade tip distance from material  

© 2009 - 2014 Sandy McCauley, All Rights Reserved   
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 Number of Post-It notes used to set blade tip distance from material  

© 2009 - 2014 Sandy McCauley, All Rights Reserved Number of Post-It notes used to set blade tip distance from material  

© 2009 - 2014 Sandy McCauley, All Rights Reserved 
  



47 
 

 

3. Fundamentos de MTC 
 

Este capítulo se basa en la versión 4.6.1. del Manual del usuario Corte . Como se señaló en la primera página, este 

pretende ser un manual interactivo en línea. Refiérase a la página de características para usar durante la lectura 

en línea. Es muy recomendable que usted no imprima todo el manual. Se actualiza con frecuencia como adiciones 

y se realizan cambios en el software. Además, se añaden hipervínculos a los nuevos videos en línea con cada 

actualización. Estos se proporcionan para mejorar su experiencia de aprendizaje. Siempre que vea un icono verde 

grande “Vídeo”, haga clic en él para vincular automáticamente y abrir un video relacionado con el tema que sigue: 

 

3.01 Principales MTC pantalla 

A continuación se muestra una captura de pantalla de la pantalla principal de MTC identificar las barras de 

herramientas, barras y otros elementos importantes enla p antalla. Tenga en cuenta los nombres específicos de 

los elementos que aparecen a medida que se hace referencia en este manual de usuario: 

 

 

Barra  de herramienta de archivo 
Barra  de  herramienta Importar 

Menu Seleccion de propiedades 
Barra  Principal 

Cursor 

Menu Pagina   Barra de pestanas    Barra de Menu 

Modo activado Node 

Barra de herramientas Node 

Notas de Proyecto windows 

Barra de estado 

Menu herramientas Magicas 

Barra  de capas 
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 Arriba se muestran cuatro barras de herramientas, siete bares, una ventana, dos reglas, dos formas, y un 

símbolo de intercalación. 

 Algunos de los elementos que se muestran, como las reglas, Notas de  ventana, así como algunas de las barras 

de herramientas y Bares, se pueden activar o desactivar al ir  a Ver de la Barra de Menú. 

 Al pasar el ratón sobre cualquiera de los iconos de la pantalla aparecerá el icono del nombre y / o la función y 

el acceso directo clave. La identificación de estos iconos también se presenta en las secciones 3.02, 3.03 y 

7.06. 

 La mayoría de los bares y barras de herramientas se pueden mover a diferentes lugares de la pantalla. 

Mantenga pulsado el botón izquierdo del ratón botón en los puntos grises a lo largo del lado izquierdo de la 

barra o barra de herramientas y arrastre. Para colocar estos bares y barras de herramientas verticalmente, 

arrastre el borde izquierdo o derecho de la pantalla. 

 Las formas  (Shapes) son los objetos o imágenes que se le añade a sus proyectos. Pueden ser creados desde 

cero o importados de otras fuentes. Como se verá a lo largo de secciones de este manual de usuario, usted 

tiene muchas opciones y recursos disponibles para usted! 

 El signo de intercalación (Caret)  indica dónde se colocará una forma importados o pegado y la altura de esa 

forma. Al moverlo, haga doble clic en cualquier lugar deseado en el screen. El tamaño de la  intercalación se 

puede cambiar en la ficha de la tabla virtual (virtual mat) (consulte la Sección 3.04). 

 La Ventana de Notas ( Notes Windows) (también llamado Proyecto Notas (Project Notes)) se abre desde Vista 

(View) en la barra de menús (Menú Bar). Esto se utiliza para proporcionar información, como instrucciones o 

condiciones de uso, y adjuntar archivos. Consulte la Sección 8.15. 

 También hay una ventana de letras ( Lettering Delights) que se puede abrir desde Vista ( View) en la barra de 

menús  ( Menu Bar). La primera vez al abrir MTC, una ventana emergente puede preguntarle si desea abrir 

esta ventana. Para obtener más información acerca de la ventana de letras, consulte la última parte de la 

Sección 4.07. 

 No todas las funciones en MTC aparecen como iconos. Por lo tanto, compruebe las subpartidas dentro de la 

Tabla de Contenidos para encontrar más funciones para utilizar en el diseño de sus archivos de corte. 

3.02 Barras de herramientas ( Toolbars) 

 Hay cuatro barras de herramientas en MTC: Archivo (File), Importar  (Import), mágia   (Magic), y el modo de nodo 

( Node Mode). En esta sección, sólo identificara los individuales  iconos. Para obtener más información sobre el 

uso de las funciones, consulte el manual de usuario  en las etiquetas indicados. 

 

Barra de herramientas de archivo ( File Toolbar) 

 La barra de herramientas de archivos, de forma predeterminada, se encuentra en la parte superior izquierda de la 

pantalla. Se puede activar y desactivar bajo Ver en la barra de menús. ( Menu Bar)  
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Abrir Archivo 

3.06 

Corte de 

portapapeles 

3.10 Copiar 

3.10 

Pegar en el 

lugar 3.10 Zoon In 

3.05 

Abrir Notas de 

Windows 8.15 

Corte Previo 

2.02 

Nuevo 

Archivo 3.08 
Guardar 

Archivo 3.07 

Pegar 3.10 

Deshacer 3.11 

Rehacer 3.11 

Zoo Out 3.05 Cortar Proyecto 2.02 
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 Barra de herramientas de importación ( Import Toolbar) 

 Usar la Barra de herramientas (Import Toolbar)  para importar los siguientes tipos de archivo:   

 

 

 

 

 

 

 

 

Barra de herramientas de Magia 

 La barra de herramientas Magia ( Magic Toolbar) contiene las funciones que se utilizan en la edición y el diseño: 

 

 

 

 

 

 

 

 

 

 

Modo Nodo Toolbar 

 El modo de barra de herramientas (Node Mode Toolbar) contiene las funciones usadas en la edición de rutas y 

nodos en imágenes vectoriales. Puedes nunca consideró necesario utilizar estas herramientas. Pero si usted 

necesita la capacidad de modificar las imágenes en el nivel  más básico, las herramientas están disponibles y su 

funcionalidad. Consulte la Sección 7.06 para la identificación de los iconos individuales y cómo utilizarlos. 

3,03  Bares ( Bars) 

Hay siete bares en MTC, que se presentan a continuación. En esta sección, se identifican sólo los iconos individuales. 

Para aprender más sobre el uso de las funciones, consulte las secciones del manual de usuario como se indica. 

Barra de menús  ( Menu Bar) 

 Como la mayoría de las aplicaciones de Windows, la barra de menús en MTC ofrece acceso a la mayoría de las 

funciones en el software. Los siguientes cuadros de texto indican las funciones principales que se encuentran en 

cada una de las opciones de la barra de menús: 

Dibujar con  JPG, BMP, TIF, 

PNG, GIF archivos: 

 4.08, 6.02 

Lettering Delights: 

4.07 

MTC Galleia: 4.02 

SCUT, SCUT2 Archivos 

4.05 

Fuente de 

archivos:  

4.06, 5.02, 5.11 

PDF, AI, EPS, PS 

Archivos : 4.04 

Formas basicas  

3.08 

SVG, SVGZ 

Archivos : 4.03 

WPC 

Archivos :  

4.05 

GSD 

Archivos:  

4.05 

Seleccion todo: 

3.09 

Dar vuelta 

: 3.15 

Romper 

7.01 

Unir: 5.08, 

7.01 

Boolean Join: 

8.07 

Conical Warp 

8.10 

Lattice 8.11 Avanzado 7.02 

– 7.05 

Espejo: 

3.15 

Rotar 90o: 

3.13 

Layer 

7.01 

Blackout 

7.01 

01 

Weld: 5.04, 

8.06 

Bézier Warp: 

5.08 

 

Shadow 8.05 Rhinestone 

8.12 

Dividir: 5.04, 

7.01 

TextureaSnap

shot 8.13 
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Sel. Barra Propiedades  ( Sel. Properties Bar) 

 El Select Barra Propiedades muestra la ubicación y el tamaño de la forma o formas  seleccionadas: 

 

 

 

 

 

  

 

Bar  Principal (Main Bar) 

 El bar principal tiene dos fichas: Tabla de corte  Virtual (Virtual Mat) y texto y fuentes  ( Text And Fonts). La ficha 

Mat virtual le permite establecer el tamaño y la apariencia visual de la tabla de corte  real, así como la orientación, 

la aparición de formas, el ajuste a la rejilla, y Tamaño Caret. Consulte la Sección 3.04. La ficha Texto y Fuentes le 

permite seleccionar una fuente, abrir una nueva fuente, y escribir texto. Consulte la Sección 5.02.  

 

 

Capa Bar  (Layer Bar) 

 La capa bar  es una de las funciones más importantes para entender en MTC. Se utiliza para organizar formas en 

capas para la presentación visual, manipulación más fácil, y la selección que da forma a imprimir o cortar. Todas 

las formas en una capa puede ser re-coloreado, oculto a la vista, bloqueado, borrado, y se movió hacia arriba o 

hacia abajo. Consulte la Sección 3.1 para obtener más información sobre el uso de la barra de capa.  

Ton y Off de menus, barra 

de herramientas,, windows, 

zoom, y  colores 

  Abrir, Cerrar, Salvar, 

Imprimir, Importar, 

exportar. 

Corte Previo y Cortar 

 

Manipulacion & edicion de 

formas y disenos 

Window y control del 

programa 

Registrar, ayuda, 

tutoriales, usar  forum, 

Guardado automatico, 

backup, restaurar, 

drivers.  

Navegar y organizer en 

wiondows y arreglar iconos 

Close bar 

X,Y  lugar mat , Seleccion 

formas: 3.09 

Ancho y Altura de las 

formas seleccionadas: 3.13 
Bloquear y 

desbloquear : 3.13 
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Barra  de Pestana  (Tab Bar) 

 En MTC, se abren  los archivos también se denominados Proyectos (Projects). La barra de pestañas muestra todos 

los proyectos abiertos actualmente. Bajo Windows en la barra de menú, puede elegir la forma de ver los proyectos 

abiertos, con opciones de visualización similares que se encuentra en otros programas de Windows (como Cascada, 

Mosaico Horizontal, Mosaico vertical, etc.).  

 
Open Projects (Files): 3.06 

 

 Haga clic derecho en cualquier nombre de proyecto en la barra de pestañas y un menú de opciones aparecerá. 

Esta captura de pantalla indica las secciones del manual de usuario donde esta vez se le haga referencia:  

 

                                                           

 

Página Bar ( Pagina  Bar) 

 La  Página Bar  le permite mover formas o capas en las páginas individuales dentro del mismo archivo de proyecto. 

Cada página tendrá su propia pestaña y las páginas se puede cambiado de nombre o eliminado, si lo deseas.  

 

 

 Haga clic derecho en cualquier nombre de página (Page) en la página bar  ( Page Bar) y un menú de opciones 

aparecerán:  

 

 

 

3.06 

 

3.07 

4.01 – 4.08 

 

9.02 

4.09 – 4.14 

 

Close MTC 

Most recent files 

Haga click aqui para adherir 

una  nueva pagina blanca 
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Cuando se selecciona la opción Duplicar (Duplicate), se hará una copia de la página actual, dándole el mismo 

nombre con un asterisco añadido. La nueva página duplicada se encuentra inmediatamente a la derecha del 

original: 

 
 

 

 

Barra de estado (Status  Bar) 

 La barra de estado  en la parte inferior de la pantalla, ofrece diferentes conjuntos de información, dependiendo de 

donde el cursor del ratón se posiciona: 

o • Si usted tiene su cursor en la principal parte abierta de la pantalla, la barra de estado muestra 

la ubicación del cursor del ratón, la ubicación y el tamaño del Caret, y que de desplazamiento  ( Scrol 

Locks) están actualmente activado:  

 

 

 

    

 

 

 

 

o Si pasas el ratón sobre uno de los iconos en una barra o barra de herramientas ( ToolBar) o si abre 

una de las de menús de la barra de menús (Menu Bar), la barra de estado normalmente proporciona 

información adicional acerca de la finalidad de ese icono o menú a elegir. Por ejemplo, apoyando el 

puntero del ratón sobre el icono de la rotura ( Break), hace que en el  Estado Bar  (Status Bar)  

visualizase  la siguiente: 

 

Mover pagina actual o mover y 

ponerla atras en  Page Bar 

Nombre pagina actual 
Duplicar la pagina actual 

Opciones para cortar, copier 

y pegar paginas para 

diferente lugar en pagina Bar 
Pegar  todas las formas en  Cut page en 

la actual pagina 

Borrar  pagina actual 

Haga las formas  en la pagina 

actual visible a otras  paginas 

Click  derecho y 

seleccione  Duplicate 

Duplicar la pagina  es insetarla aqui con nombre 

Lad izquierdo de  Status Bar Lado derecho de  Status Bar 

 

Lugar actual del cursor  

del  Mouse 

Lugar actual del 

caret 

Actual tamano 

del  Caret 

Aqui indica activados las siguientes 

funciones  Cap Lock, Num Lock and 

Scroll Lock   
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3.04  Tabla de corte  virtual ( Virtual Map) 

Ajustes virtuales Mat:  VIDEO                      Creación de la tabla de corte  virtual personalizado: Video 

 El Mat virtual sirve como un área de diseño de software, así como para indicar, en algunos modos de corte, 

en el que se cortan las formas. 

 Para cambiar la apariencia de la tabla, haga clic en  Virtual Mat en la barra principal  (Main Bar): 

 

 

  
 

 

 Usted también tiene la opción de crear sus propios tamaños  de tabla de corte para añadir a la lista 

desplegable. Seleccione Personalizado Mat (Custom Mat)  desde el menú desplegable y la siguiente ventana 

se abrirá: 

 

 

  

 

 

 

 

 

 

 

 Importante: Ajuste siempre la dimensión más larga de su base de corte como el ancho. Por ejemplo, en la 

anterior captura de pantalla, un ancho de 22 “y una altura de 13” y se introducen la configuración  se verá 

como la siguiente, en función de si se ajusta a la orientación vertical u horizontal . 

 

Nivel de Zoom  

Seleccione las 

dimensiones 

Escoja entre los 8 

colores del mat. 

Escoja como quiere mostrar 

su diseno  Fill, Outline o los 

dos. 

Hacer Click  para 

propiedades de un Nuevo 

proyectoult 

Opcion reglas circulas  

Escoger  snap para 

pocisionar. 

Seleccione Portrait o 

Landscape  

Escoja Caret Size para  

escojar el tamano que desea 

para  pegar e importar las 

formas. 

Opcion reglas cuadriculadas  

Ingrese el nombre   para su 

nuevo mat. Use el Nuevo 

nombre para cada mat! 

Con un  KNK mat,no 

marque en esta caja. 

 

Ingrese las dimensioness (Width and 

Height) para su Nuevo mat. Nota 

Width Arriba y  hacia abajo y  Height 

muestra dimensiones de izquierda a 

derecha. 

Haga Click en  Save para 

salvar al terminar 
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     Portrait  Vertical  Landscape    Horizontal 

         
 

 

 

 Utilice un nombre único para cualquier tabla de corte  personalizado. Repitiendo el mismo nombre, si usted 

tiene la misma dimensiones, pero una inversión de la W (horizontal) y H (Vertical) pueden causar la tabla de 

corte  original a aparecer, incluso en  la selección de la nueva versión. 

 • Si desea eliminar un tapete personalizado en el menú desplegable ( drop down menú), seleccione y 

después pulse la tecla Suprimir ( delete) o simplemente haga clic derecho sobre el nombre  y una opción para 

eliminar se abrirá. Si ha guardado un archivo con una tabla prediseñada y después comparte el archivo con 

otro propietario MTC, se agregará su tabla  a su / su menú desplegable en MTC. 

 En el momento de escribir las medidas, no hay ninguna opción para la métrica Mat Virtual . Aquí hay un enlace 

de vídeo para un trabajo en torno a la solución:  VIDEO 

 

3.05 Zoom y Paneo 

 Cualquiera de los métodos siguientes le permitirá ampliar y reducir en 10% los incrementos del 20% a 1000%: 

 Mantenga presionada la tecla Ctrl mientras gira la rueda del ratón. El zoom se centrará en donde el cursor del 

ratón 

Actualmente se encuentra en la pantalla. 

 Recorra el ajuste de zoom en la ficha la Tabla virtual (virtual mat) en la barra principal  ( Main Bar) 

 Pulse los  botones + y - en el teclado. 

 Haga clic en la Acercar (zoom in) y Alejar  ( Zoom  Out) botones de la barra de herramientas  (File  

Toolbar)  
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 Otra manera de acercar y alejar es utilizar una de las 4 teclas de acceso directo (también disponibles bajo Ver 

(View)> Zoom To): 

1.  ( pulse el botón central del ratón): Zoom a 100% 

2.  Zoom a 20% 

3.  Zoom para centro de formas corrientes seleccionado utilizando el nivel de zoom actual 

4.  Zoom a 300% 

5.  - 0: Zoom a 500%, 600%, etc., para 1000% 

Ctrl + 3 - Zoom para Mat virtual 

Ctrl + 4 - Zoom para todas las formas que aparecen en pantalla 

 

 

 Para mover el espacio de trabajo de arriba a abajo, gire la rueda del ratón. 

 Para desplazarse, presione la barra espaciadora mientras arrastra el botón izquierdo del ratón. 

 

 

 

3.06 Apertura  Archivos MTC  

 

3.06.1 La apertura de un nuevo archivo / Proyecto 

 

 Cuando inicie MTC, una nueva Mat virtual en blanco aparecerá con un nuevo proyecto en blanco abierto. En 

cualquier momento, otro nuevo proyecto se puede abrir, en una nueva ventana, usando cualquiera de los 

siguientes: 

 Haga clic en el icono “+” en la barra de pestañas (Tab Bar)  

 Haga clic derecho en una ficha de proyecto en la barra de pestañas ( Tab bar) y seleccione Nuevo 

(New) en el menú. 

 Haga clic en el icono Nuevo  (New)  en la barra de herramientas Archivo  ( File Toolbar)  

 Presione Ctrl + N 

 Vaya a Archivo ( File)> Nuevo (New) 

 

3.06.2 Abrir un archivo existente MTC 

 

 Un archivo existente se puede abrir en el MTC mediante el uso de cualquiera de los siguientes pasos: 

o Haga clic en el icono Abrir (Open) en la barra de herramientas Archivo (File Toolbar)   

o Haga clic derecho en una ficha de proyecto en la barra de pestañas (File Bar) y seleccione Abrir  

(Open) en el menú 

o Presione Ctrl + O 

o • Vaya a Archivo (File) > Abrir (Open) 

o Haga doble clic en un archivo de MTC en el Explorador de Windows (consulte la Sección 3.06.3  para 

obtener instrucciones sobre la instalación y utilizando el visor de archivos MTC ( MTC File Viewer)) 

o Haga doble clic en un archivo adjunto MTC a un correo electrónico 

o Arrastrar y soltar un archivo de MTC en una instancia en ejecución de MTC 

o Importar de MTC Galería (consulte la Sección 4.02). 
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 En todos los casos, se abrirá una ventana donde se puede navegar para localizar el archivo que desea abrir: 

 

 

 
 

  

 También hay una biblioteca a disposición de formas básicas (Basic Shapes) (Consulte la Sección 3.08). Además 

otros formatos de archivo (como .svg,.eps y .ai) podrán importarse en MTC. Consulte las Secciones 4.1 a 4.8. 

 Al abrir nuevos proyectos o archivos existentes, la barra de pestañas (Tab Bar) se mostrará cada proyecto   

 

 

 

 

  

                                       
 

 Haga clic en cualquiera de las pestañas y se mostrará la ventana del proyecto. Puede desplazarse / pestaña a 

través de los proyectos, utilizando cualquiera de los siguientes: 

o Presione Ctrl + F6 

o Presione Ctrl-Tab 

o Ir a Ventana ( window) > Siguiente Ventana ( Next Window) 

 Todos los proyectos se pueden visualizar a la vez, en ventanas separadas, eligiendo una de las distintas 

opciones bajo la ventana (Window) en la barra de menús ( Menu Bar) 

 

 

3.06.3  Vista previa de miniaturas de archivos existentes MTC 

 

 Una aplicación descargable está disponible para ver las miniaturas de archivos .mtc  en el Explorador de 

Windows o cuando vaya a Archivo  (File)> Abrir (Open) en MTC. Tenga en cuenta que sólo funciona con 

Windows Vista, 7 y 8: 

Make the  Cut! File  Viewer 

 Después de descargar e instalar el archivo, tendrá que borrar también la caché de miniaturas en 

Windows.Para hacer 

 ello, haga clic en el botón Inicio de Windows y, a continuación, vaya a: 

Localizador de  carpeta Una vista previa del 

archive aparecera aqui. 

Haga clck aqui para abrir  una 

ventana que mostrara lo largo 

del archivo 

Haga Click en  Open para abrir  

y y salvar el archivo  en un 

Nuevo proyecto. 

Haga Click en el 

archivo y aparecera 

debajo del archivo File 

name: 

Este Proyecto es guardado 

usando el nombre que aparece. 

Este  Proyecto  sera guardado usando el 

nombre que se muestra con el nombre 

mostrando con asterisco indica que cambios  

. 

Este  es el Nuevo Proyecto 

que sera guardado. 
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Todos los programas> Accesorios> Herramientas del sistema> Liberador de espacio en disco 

 (En Windows 8, vaya a Panel de control> Herramientas administrativas> Liberador de espacio en disco) 

 Aparecerá la siguiente ventana, si usted tiene más de una unidad en su computadora, y usted desee asegúrese 

de que muestra su unidad c. Luego haga clic en OK:  

 

 Después de varios minutos, una nueva ventana se abrirá. Desplácese hacia abajo en el menú de esta ventana 

y asegúrese que Las miniaturas se comprueban y luego haga clic en Aceptar en la parte inferior de la ventana: 

 

 
 

 Se le preguntará si desea eliminar permanentemente estos archivos. Haga clic en Sí. Después de que se 

termine esto, podrás  reiniciar Windows. 

 Una vez que Windows se ha reanudado, abra Windows Explorer y vaya a una carpeta que tiene los archivos 

de la MTC. Nuevas miniaturas ( New Thumbnails)  ahora se crean y se pueden tardar varios minutos si tiene 

cientos de archivos MTC dentro de esa carpeta. Algunas características a tener en cuenta acerca de estas 

miniaturas:   

 
 

      
 

 

 Para los archivos con múltiples páginas, usted será capaz de obtener una vista previa en miniatura de cada 

página      

Primero busque y haga clic en Mostrar el icono del panel de vista previa (Show the Preview Pane).  para abrir 

el panel más a la derecha en Windows. A continuación, utilice la siguiente página ( Next Page) y  página 

anterior  ( Previous Page) para desplazarse a través del archivo: 

 

No se indica  el archivo en 

una sola banda en el top y  

fondoindicando el archivo 

es en Portrait modo. 

La  banda ancha  indica  que 

esta  el archivo en Landscape 

modo. 

Dos puntos indicant el 

archive de dos paginas. 

No indica el archive en 

una sola pagina 
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 Archivos comprimidos no se mostrará miniaturas de los contenidos del archivo. Por lo tanto, usted tendrá 

que extraer archivos comprimidos por primera vez para  tener estas miniaturas. 

 Las capas ocultas no aparecerán en las imágenes en miniatura. Por lo tanto, antes de guardar sus archivos, es 

posible que desee hacer toda las capas visibles. Consulte la Sección 3.12. 

 

 

3.07  Guardar  MTC Archivos 

 Un archivo se puede guardar en formato MTC mediante el uso de cualquiera de los siguientes pasos : 

 Haga clic en el icono Guardar  (Save) de la barra de herramientas Archivo ( File Toolbar)  

 Haz clic derecho en la ficha del proyecto en la barra de pestañas (Tab bar) y seleccione Guardar (Save) 

o Guardar como  ( Save as) en el menú. 

 • Presione Ctrl + S 

 • Vaya a Archivo (File)> Guardar (Save) o Archivo  (File)> Guardar como ( Save As) 

 Si usted tiene cambios realizados y desea guardar con un nombre de archivo diferente, seleccione Archivo 

(File)> Guardar como  (Save As). Nombre del archivo, elegir una ubicación, y haga clic en Guardar (Save). 

 Si desea guardar todos sus proyectos abiertos, vaya a Archivo (File)> Guardar todo (Save All) o haga clic 

derecho en una ficha de proyecto en la pestaña (Tab Bar) y seleccione Guardar todo (Save All) en el menú. 

Las diversas ventanas en el que se han realizado cambios se abrirán,en secuencia, con la opción para guardar 

los cambios o no, o cancelar el proceso de guardado para ese archivo. 

 También puede activar una opción de guardado automático, vaya a Ayuda (Help)> Avanzada (Advanced)> 

Configuración avanzada  (Advanced settings). El ajuste se encuentra bajo Ahorro automático de Proyecto ( 

Enable Automatic Saving). Marque la casilla junto a Activar ahorro automático.  

 

  
 

 Esta es una muy buena idea al hacer extensivo el diseño o edición de archivos. No es inusual para programas 

graficos  por la posibilidad de un corte de luz repentino que se produzca. Una vez que comprueba la opcion, 

la ventana de configuración siguiente se abrirá: 

 

Haga click en algunos de los 

botones para ver otra pagina 

sn el archivo 

Check box to bring up Automatic 

Saving settings 
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 • Para cambiar el guardar los ajustes, desactive la casilla Activar ahorro automático ( Enable Automatic 

Saving) y luego vuelva a revisar la caja para que la ventana Ajustes de Guardar automática ( Automatic Save 

Settings) volverá a abrir y  los cambios pueden hacerse. 

 

3.08 Apertura Formas básicas   

VIDEO 

 MTC cuenta con una amplia  selección de formas básicas disponibles. Para acceder a la biblioteca de uso Formas 

básicas  (Basic Shapes)  use uno de los siguientes pasos : 

 Haga clic en el icono de importación de formas básicas (Import Basic Shapes) en la barra de 

herramientas de importación  (Import Toolbar) o en el modo de barra de herramientas (Node Mode 

Toolbar)  

 • Presione Ctrl + Shift + B 

 • Vaya a Archivo (File) > Importar  (Import) > De Formas básicas  ( From Basic Shapes) 

 

 

 A continuación, puede seleccionar una de las categorías predefinidas y se mostrarán todos formas dentro de esa 

categoría. Haga doble clic en una forma para importar directamente sobre la pantalla a la misma altura y la misma 

ubicación que el Cursor.  

  

 

 

 

 

 

 

 

 

 

 Tenga en cuenta que una de las categorías, después de que usted la ha configurado, tiene la etiqueta “Sus formas 

(Your shapes)”,que le permite asignar la forma a esa categoría para un acceso rápido. Si usted tiene una forma 

que se utiliza en varias ocasiones, y luego guardarlo en el menú Formas básicas   ( Basic Shapes) ahorrará tiempo 

en el futuro. Consulte la Sección 4.10. 

 • La biblioteca  de Formas básicas ( Basic Shapes) también puede abrirse  desde la barra de herramientas Modo 

de nodo (Node Mode). El uso de este acceso, frente las formas descritas anteriormente, le permitirá arrastrar el 

puntero del ratón libremente para ajustar la altura y la anchura de la forma,así como darle la vuelta. Consulte la 

Sección 7.07. 

Intorduzca  la 

sincronizacion de  

frecuencia salva 

secuencia  

derequency of saves 

Ingrese la ubicacion  de 

sus   backupsque quiere 

salvar 

Ingrese Maximum Saves antes  

de  borrar   Click en  OK 

Seleccione 

Category 

Ingrese  la parte  de nombre de 

archivo que busca La forma  estara  en la 

mismo lugar donde esta 

ubicado el caret. Con el 

mismo  tamaño  indicado  

del caret tambien 

Arrastre el boton de windows  para  

ampliar este  cuadro lo que necesite 

Doble click en la 

forma para 

importar 
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3.09 Selección, mover y Formas de Borrado 

Selección 

 Para seleccionar una forma, haga clic en cualquier lugar dentro del área de delimitación o caja de delimitación, que 

se indica por el rectángulo que aparece alrededor de la forma:  

 

 
 

 Hay varias formas de seleccionar más de una forma: 

o Seleccione la primera forma y mantenga presionada la tecla Mayús (Shift) mientras hace clic en 

formas adicionales. Tenga en cuenta que como su ratón se mueve sobre una forma, aparecerá un 

contorno rojo. Esto hace que sea más fácil para seleccionar una forma que es la superposición de otras 

formas. Si usted está teniendo dificultades para seleccionar una forma particular, es posible que tenga 

que ocultar otras formas alrededor de ella. Consulte la Sección 3.12. 

o Mantenga pulsado el botón izquierdo del ratón y arrastre el ratón para formar una “caja imaginaria” 

en torno a las imágenes quieres seleccionado. Siempre asegúrese de que inicie claramente fuera de 

los límites de las imágenes que desea seleccionar. Si una parte de la forma es fuera de la selección de 

esa forma, no será seleccionada. Este método de la selección se conoce como una marquesina de 

selección a través de este manual. 

o Si todas las formas están en la misma capa, haga clic en la miniatura de la capa. Consulte la Sección 

3.12. 

 El Caret o cursor  desaparecerá mientras tiene una forma (o formas) seleccionando, pero volverá a aparecer en la 

parte superior derecha esquina de la última forma seleccionada, una vez seleccionada. 

 • Si desea seleccionar todas las formas en la pantalla, hay varias opciones: 

 Presione Ctrl + A 

 Haga clic derecho en la pantalla y elija Seleccionar todo ( Select All) en el menú 

 • Haga clic en el botón Seleccionar todo (Select All) en la barra de herramientas de la Magia 

(Magic Toolbar).  

 Vaya a Edición (Edit)> Seleccionar todo (Select All). 

 Para desplazarse a través de las formas, hacia adelante (o hacia atrás), utilice cualquiera de los siguientes: 

 Haga clic derecho en la pantalla y pulse Siguiente Forma (Next shape) (o seleccione Forma Anterior ( 

Previous Shape)) 

  Pulse Mayús + Tab (o pulse Mayús + Esc)  Mayus: Shift 

 Vaya a Edición (Edit)> Siguiente Forma (Next Shape)(o vaya a Editar  (Edit)> Forma anterior  (Previous 

Shape)). 

 Para anular la selección de todas las formas, utilice una de las siguientes dos maneras:\ 

o • “clic de distancia” - haga clic en cualquier otro lugar en la pantalla y las formas  anulan  su 

selección 

o Pulse la tecla Esc 

o • Vaya a Edición  (Edit)> Anular selección (Select None) 

 

La caja delimita el  exterior 

del rectangulo 
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Desplazamiento 

 Para mover una forma seleccionada, mantenga pulsado el botón izquierdo del ratón en cualquier lugar dentro del 

área de delimitación y arrastre para otra ubicación. 

 También puede mover una forma seleccionada en incrementos pequeños pulsando las teclas de flecha del teclado. 

Además, si mantiene pulsada la tecla Ctrl mientras pulsa las teclas de flechas, la forma se moverá en grande si se  

incrementa con cada pulsación de tecla. 

 Con una forma seleccionada, el Sel. Barra Propiedades (Properties Bar) indica la ubicación exacta de la esquina 

superior izquierda del área de tu forma de delimitación bajo X e Y: (Tenga en cuenta que la ubicación es 0,0 en la 

esquina superior izquierda de la parte cuadriculada de la tabla de corte). Puede introducir valores en una o ambas 

de la X e Y: ventanas para mover el dar forma a una nueva ubicación.  

 

 

  
 

 

 

 

 

También puede utilizar las reglas (Rulers) para identificar donde se encuentra una forma, así como las dimensiones 

de la forma. En este caso, las pequeñas flechas negras en las Reglas muestra la ubicación actual del cursor del 

ratón. Por lo tanto, si desea a saber, por ejemplo, la ubicación en el centro de una forma, coloque el puntero del 

ratón sobre el icono central de la forma: 

 

 
 

 

 

BORRADO 

 Para eliminar una forma seleccionada, utilice cualquiera de las siguientes opciones: 

 Pulse la tecla Supr 

 Presione Ctrl-X 

 Haga clic derecho en la pantalla y elija Eliminar  (Delete) en el menú 

 • Vaya a Edición  (edit)> Eliminar   (Delete). 

X,Y locacion de la izquierda del top izquierdo  de la selección de la forma 

 

X  es la ubicacion 

central de la figura  

seleccionada 

La  ubiccion  Y  ldel 

centro seleccionado 

de la  figura 

Ubique  el cursor del 

mouse en el centro de 

la figuara, para 

envontar  en las reglas  

los  centors exactos   

 

Guias  verticals y 

horizontals tabien dan 

forma y poueden 

ayudar en la alinecion 

de formas. 
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 Ubicado en  la forma en la capa a la que se le asigna y haga clic en el icono Borrar Forma  (Delete 

Shape):  

 Para eliminar todas las formas en el proyecto actual, utilice cualquiera de las siguientes opciones: 

 • Haga clic derecho en la pantalla y elija Eliminar todo  (Delete All) en el menú 

 • Pulse Mayús + Supr 

 • Vaya a Edición (Edit) > Eliminar todo (Delete All). 

 También puede eliminar una capa de formas a la vez de la barra de capa ( Layer Bar). Consulte la Sección 3.12. 

 Para eliminar todas las pequeñas formas no deseadas en su proyecto, utilice cualquiera de los siguientes para 

acceder al borrado por Opción Área  (Delete by Area): 

 Haga clic derecho en la pantalla y elija Eliminar por área en el menú (Delete by Area): 

 Presione Ctrl-Shift-R 

 • Vaya a Edición (Edit)> Eliminar por Área (Delete by Area):. 

 • Al Eliminar por  Área  (Delete by Area): le permite seleccionar el tamaño, por área, de los objetos que desea 

eliminar del proyecto. Al desplazarse para aumentar el tamaño, podrás ver las formas que  comienzan a 

desaparecer del proyecto. 

Cuando se eliminan las formas deseadas, haga clic en Aplicar (Apply): VIDEO  

 

 
 

 

 

 

3.10 Cortar, copiar, pegar, Duplicación 

3.10.1 corte en el Portapapeles 

 Para cortar formas en el portapapeles, primero seleccione la forma o formas y luego use cualquiera de los 

siguientes pasos: 

 • Haga clic en el icono de  Corte de Portapapeles  (Cut to Clipboard)  situado en la barra de herramientas 

(File toolbar)  

 Haz clic derecho en la pantalla y seleccione Cortar (Cut) 

 Presione Ctrl + X 

 Vaya a Edición  (Edit) >  Cortar (Cut). 

 

3.10.2 Copia de Formas y copia en el Portapapeles VIDEO 

 Una forma rápida de hacer una copia de cualquier forma (s) seleccionado, es  mantener oprimida la tecla Ctrl 

y la tecla Shift y luego arrastre la forma (s) seleccionada con el ratón. 

Desplace hasta el tamano 

maxinmo de los objetos  

para borrar 
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 Para copiar formas en el portapapeles, primero seleccione la forma o formas y luego usar cualquiera de los 

siguientes pasos : 

 Haga clic en el icono  Copiar al Portapapeles  (Copy to clipboard)  situado en la barra de herramientas  

(File toolbar)  

 Haga clic derecho en la pantalla y seleccione Copiar  (Copy) 

 Presione Ctrl + C 

 Vaya a Edición  (Edit)> Copiar  (Copy). 

 Para hacer varias copias, se refieren a la función Duplicar  (Duplicate) describe más adelante en esta sección. 

 

3.10.3 Pegar desde el portapapeles 

 La función Pegar en portapapeles (Paste from Clipboard) en MTC funciona un poco diferente de la mayoría 

de los programas de Windows. Cuando selecciona Pegar (Paste), la forma en el portapapeles se colocará en 

la ubicación del Caret o cursor  y dimensionado de la misma altura, como el Caret. Si Pegar  pega en su lugar 

(Paste in Place) se utiliza en lugar, entonces la forma pegada será el mismo tamaño que la original y colocado 

en la ubicación del original (en el momento  que se aplica la copia). 

 Para pegar formas desde el portapapeles, utilice cualquiera de los siguientes pasos: 

 Haga clic en el icono Pegar del portapapeles ( Paste from Clipboard) se encuentra en la barra de 

herramientas de Archivo (file toolbar)  

 Haga clic derecho en la pantalla y seleccione Pegar (Paste) 

 Presione Ctrl + V 

 Vaya a Edición  (Edit)> Pegar (Paste) 

  Para pegar en lugar de formas desde el portapapeles, utilice cualquiera de los siguientes pasos: 

 Haga clic en el icono Pegar en el lugar (Paste in place) que  se encuentra en la barra de herramientas 

de Archivo (File toolbar)   

 Haga clic derecho en la pantalla y seleccione Pegar en el lugar (Paste in place) 

 Presione Ctrl + Shift + V 

 Vaya a Edición (Edit)> Pegar en el lugar (Paste in place)  . 

 Tenga en cuenta que una vez que pulse Pegar en el lugar (Paste in place), verá un oscurecimiento de la imagen 

original (si no se ha movido la imagen original y la copia 

 

 

3.10.4 Duplicado - Duplicar 

 

 La función Duplicar (Duplicate) le permite hacer varias copias de una forma alineados en filas y / o columnas, 

depende del espacio que usted desea. Para acceder duplicado, primero seleccione la forma (s) y luego usar 

cualquiera de los siguientes pasos: 

 Haga clic derecho en la pantalla y seleccione Duplicar (Duplicate)> Duplicar (Duplicate) 

 Presione Ctrl + D 

 Vaya a Edición (Edit)> Duplicar (Duplicate)> Duplicar (Duplicate). 

 Para rellenar la cuadrícula con imágenes, mover la forma (s) seleccionado a la esquina superior izquierda de la parte 

cuadriculada del Mat virtual. Con la forma (s) todavía seleccionado, utilice Ctrl-D (u otras opciones anteriores) para 
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abrir el duplicado Forma ventana. Introduzca los totales deseados en cada fila y en cada columna, más el espaciado. 

Haga clic en Aceptar  

 

             

 

 

 Para crear una sola fila de repeticiones, establezca el valor de Filas a 1. Para una sola columna de repeticiones, 

establezca  en la Columna valor a 1. Para superponen las repeticiones, introduzca un número negativo bajo 

espaciado. Consulte la Sección 8,06 para un tutorial sobre cómo esta función se puede utilizar para crear una 

frontera. 

 

 

3.10.5 Duplicación - anidada Duplicar 

 La función anidada Duplicar (Nested Duplicated) le permite realizar múltiples contornos, con el espacio que usted 

desea. Para acceder al duplicado, primero seleccione la forma (s) y luego usar cualquiera de los siguientes pasos: 

o Haz clic derecho en la pantalla y seleccione Duplicar (Duplicate) > Duplicar anidada  (Nested 

Duplicated) 

o Vaya a Edición (Edit)> Duplicar (duplicate)> anidados Duplicar (Nested Duplicated) 

 

Esquemas y inlines 

 En el primer ejemplo, se selecciona  un círculo con diseno y  accediendo a la función anidada Duplicar  (Nested 

Duplicated). La siguiente ventana se abre con la configuración por defecto: y los ajustes se hacen para crear 4 

repeticiones al comienzo del círculo festoneado, cada 1 mm de diferencia:  

 

 

Incremente las filas y 

columnaspara el ll Virtual 

Mat y cambio de  Spacing, si 

lo desea o necesita. 
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 Si desea tener un total de 6 formas anidadas, por lo que 5 se introduce como  Dupe Count (duplicados añadidos). 

La separación se cambia a 2 mm y la Sombra Marco  (Shadow Settings) establece en angulo interno ( Mitered). 

Antes de aceptar, haga clic en el Botón Vista previa (Preview) para ver los duplicados:  

 

              

 

 

 

 

 

 

 

 

 

 

 

 

 Con el fin de crear, en lugar de contornos, y realizar las líneas negativas  para el negativo de apertura ( Dupe Gap 

):  

Selectcione la 

forma para 

duplicar 

duplicate 

Numero de duplicados para realizar 

Espacio entre los duplicados 

Haga click en  Preview 

observar los cabios 

Iniciando con By Shadowing 

Escoja el estilo de formas  

paraduplicadas (Escoja entre: 

Rounded, Mitered, o Beveled), a 

lo largo de opciones de  Limited 

Click en  Accept cuando 

termine 
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Sombreado Versus Escala 

 Hay tres opciones de cómo las formas se pueden duplicar en duplicación anidada (Nested Duplicate):  

o El Sombreado (Shadowing): duplicar patrones siempre a la misma distancia del duplicado antes y 

puede ser necesario cambiar de forma con el fin de hacerlo. Esto es evidente en el ejemplo anterior 

con la flor donde tanto el esquema y los inlines cambiaron la forma de la más que se duplicaron desde 

el original. Esto no es  el caso de formas básicas, tales como círculos o polígonos:   

 

        
 

   
 

 

o Escalado por Ancho (Scaling by Width): Duplicar la forma para mantenerse a escala en el original y el 

ancho se pueden cambiar según la brecha seleccionada. La altura resultante puede resultar en una 

brecha diferente de un duplicado a la siguiente. La flor demuestra una vez más la diferencia con 

bastante claridad. Un círculo no será diferente. Sin embargo, la notificación cómo responde el 

rectángulo con el fin de mantener la misma relación de aspecto entre la altura y la anchura:   

 

      
 

o Escala de Altura (Scaling by Height): es básicamente el mismo que Escalado por Ancho ( Scaling by 

Width). Una vez más, el círculo no es diferente y la flor, siendo simétrica no varía de la Escala por la 

opción Ancho. Pero el rectángulo es bastante diferente:  

Valor 

Negativo 

Duplicados con 

distorcion 

No distorcion en 

duplicados 

No distorcion en 

duplicados 
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Ajustar color 

 También existe la opción de crear un degradado de color usando la opción Ajuste de color (Adjust Color). En el  

Mat virtual, encienda Rellene (Fill) a continuación, introduzca un color al  Inicio (Start) y Finalizar (Finish) para 

crear algo como esto:  

      

 

 

 

 El valor Textura (Texture Hue) se puede utilizar para aplicar un grado de color en duplicados anidados que 

contienen una textura. Consulte la Sección 8.13 para un ejemplo. 

 

3.10.6 Duplicado - Girado Duplicado  VIDEO 

 La función de rotación de duplicados (Rotated Duplicate) le permite hacer copias dispuestas en un círculo o 

un patrón de círculo parcial. Para acceder girado duplicado, primero seleccione la forma (s) y luego usar 

cualquiera de los siguientes pasos : 

o Haz clic derecho en la pantalla y seleccione Duplicar (Duplicate) > Girado Duplicar (Rotated Duplicate) 

o Vaya a Edición  (Edit)> Duplicar (Duplicate)> Girado Duplicar  (Rotated Duplicate). 

 Para ilustrar cómo funciona esto, comenzar con un pequeño círculo de Formas básicas. Seleccione y luego 

activar la Función Duplicar girado (Rotated Duplicate) utilizando cualquiera de los métodos que acabamos de 

mencionar. La siguiente ventana se abrirá: 

  

 

 

 

Marque  Adjust Color y luego 

seleccione empezar  y finalizar 

para el grado dgrade 
Haga Click en  

Preview y  Accept 

cuando termine. 
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(Radio) 
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 Para crear un semicírculo, por ejemplo, 10 formas aumentando el Dupe Count  a 9. Luego haga clic en el 

pequeño icono de sigma  que se cambie el valor dentro de la rotación por la ventana (Rotate By) para 

que una perfecto patrón semicircular de formas equidistantes se cree:  

    

 

 Si desea que las formas realicen un círculo completo,  al doblar  la Rotación Al establecer (Rotate By). En este 

caso, deberá introducir 36 grados (2x 18). Si luego quieres superponer los círculos, disminuir el 

Desplazamiento Y  (Offset Y) a ellos se encuentra más cerca del centro:  

  

    
 

 

 El valor (Offset X) se moverá cada forma  la distancia en la dirección X. Nota cómo un aumento del valor de X 

afecta  la forma de flecha en esta duplicación   

 
     

 Las posibilidades de diseño son ilimitadas con esta magnífica característica! Asegúrese de ver el vídeo 

vinculado al  principio de esta sección. 

 

Entre 9  Haga click 

Haga click en  Accept 

cuando termine. 

Cambia a 

36 

Decrease 

to 20 

Offset X: 0 Offset X: 15 Offset X: 30 
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3.11  Deshacer / Rehacer ( Undo / Redo)  

 

Deshacer 

 Como con la mayoría de aplicaciones de Windows, hay una función Deshacer  (Undo) para revertir los pasos 

más recientes realizados. Puede utilizar cualquiera de los siguientes pasos para ejecutar la función Deshacer:   

 Haga clic en el icono Deshacer (Undo) de la barra de herramientas de Archivo  (File Toolbar)  

 Presione Ctrl-Z 

 Vaya a Edición  (Edit) > Deshacer (Undo). 

 Si usted está experimentando los accidentes de software debido a las limitaciones de memoria, dos soluciones 

están disponibles: 

o Vaya a Edición (Edit)> Borrar historial de deshacer (Clear Undo History). 

o Limite el número de Deshacer (Undo) / Rehacer (Redo) pasos almacenados en la memoria. Para hacer 

esto: 

  Vaya a Ayuda  (Help)> Avanzada  (Advanced)> Configuración avanzada (Advanced Settings). 

Bajo (Undo / Redo Tamaño del búfer (limiti Undo/Redo Size), marque la casilla junto para Limitar 

deshacer / rehacer Tamaño:  

 

 
 

 Al marcar esta casilla, la siguiente ventana se abrirá: 

 

 

 

 

  Introduzca el número máximo de pasos a  salvo. A continuación, tendrá que guardar los archivos 

actuales y cierre / reapertura de ellos para que el cambio surta efecto. 

  Si desea cambiar esta configuración, tendrá que desactivar la casilla Límite de tamaño de 

deshacer / rehacer (Limit Undo/Redo Size) y después comprobar de nuevo para que aparezca la 

ventana de configuración. 

Rehacer 

 Al igual que con la mayoría de aplicaciones de Windows, también hay una función Rehacer (Redo) en caso de 

Deshacer (Undo) tenga  demasiados pasos o simplemente cambiar de opinión. Puede utilizar cualquiera de los 

siguientes para ejecutar la función Rehacer: 

 Haga clic en el icono Rehacer  (Redo) de la barra de herramientas de Archivo (File Toolbar)  

 Presione Ctrl-Y 

 Vaya a Edición> Rehacer. 

 

 

Mira esta caja 

Ingrese el maximo nnumero 

de  Undo (desde  0 hasta 

ilimitado) 

Click en Set 
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3.12 Capa Bar (Layer Bar) 

Parte 1  VIDEO   Parte 2 VIDEO   Parte 3  VIDEO 

 La  capa  bar (o de propiedades de capas de  Bar (Layer Properties Bar)) se utiliza para asignar o grupo de figuras 

en capas separadas para una mejor organización de  su archivo, más fácilmente aplicar los cambios a un grupo de 

formas, seleccione una forma o una capa de formas en la pantalla, y para controlar lo que se envía a la cortadora 

o una impresora. Esta barra se puede encender y apagar bajo Ver (View) en la barra de menús (Menu Bar). Lo más 

probable es que usted va a querer tener esta barra que muestra en todo momento. 

 Usted no tiene que preocuparse acerca de cómo agregar formas a la barra de capa. Ellos serán asignados 

automáticamente a la capa actual o una nueva capa a medida que los agrega. Usted tendrá que aprender a moverse 

formas a nuevas capas o combinar formas en la misma capa, dependiendo de las circunstancias. 

 Estos son algunos ejemplos  cuando usted quiere tener formas en diferentes capas: 

 Empalme de papel o proyectos de forma sombreados donde se cortarán algunas formas de un color 

y otras formas de otro color (o un número de otros colores). 

 Proyectos de dobleces (cajas, sobres, tarjetas emergentes, etc.), donde las líneas de plegado 

necesitarán tener diferentes ajustes y / o diferentes herramientas utilizadas que sus líneas de corte. 

 Imprimir y  corte de proyectos, donde puede que tenga que enviar ciertas capas que se imprimirán 

pero otras capas sean para cortar. 

 Proyectos de plantilla que usted necesita para cortar dos plantillas diferentes, como un relleno que 

será  hacer en un color de diamantes de imitación y un esquema en otro color. 

 Otros beneficios de la asignación de las formas de capas incluyen: 

 Capacidad para seleccionar, con un solo clic del ratón, todas las formas asignadas a una capa sin 

seleccionar otra formas. 

 Capacidad para ocultar o bloquear capas para que no se seleccionan de forma inadvertida las formas en 

esa capa, movido, cambiar de tamaño, etc. 

 Capacidad para cambiar el color, estilo de línea y / o textura en todas las formas asignados a un particular, 

capa. 

 La siguiente captura de pantalla se utiliza para mostrar cómo se pueden aplicar las funciones Capas de barras:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Seleccion para la nueva pagina 

 Opciones Menu Hoja Borrar hojas o capas vacias 

Visible Toggle menu 

Layer Name Nombre 

de hoja (tambien 

muestra  el numero de 

formas 

Mover  hoja hacia abajo 

Mover hacia arriba 

Hide Layer (Mestra la hoja) 

Set Coloes  para todas las formas en la 

hoja (tambien  Textura y Estilo de linea) 

Protejer la hoja (o  

Desbloquear la hoja) 

Borrar la capa u hoja 

Crear nueva capa Bloquear  Toggle menu 

Click on thumbnail to 

select all shapes on layer 
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 En el lado derecho de la barra de capa, cada capa tiene una vista previa o la miniatura que muestra las 

formas asignado a esa capa. Clic  en miniatura y  todas las formas de esa capa serán seleccionados. 

 A la izquierda de cada capa de nombre (Layer Name), hay un pequeño signo “+”. Haga clic en él y el “+” 

se convertirá en un “-“ y que capa se abrirá para revelar cada forma individual asignado a esa capa. 

 Haga doble clic en un nombre de capa y se puede cambiar el nombre de la capa. Apoye el cursor del ratón 

sobre una capa a nombrar y aparecerá el número de formas en que la capa. 

 Ocultar y aparecer  capas haciendo clic en los iconos de ojo  (Ocultar (Hide Layer)   y  aparecer ( 

Move Layer Up) . A escondidas se  mostrará las formas en las versiones pálidas de sus colores reales y 

también evitará cualquier movimiento o cambiar el tamaño, etc., de esas formas. Además, cualquier 

forma que se esconden no serán enviados a su cortador o impresora. 

 Cambiar el orden de las capas usando los iconos de flecha (Mover Capa abajo( Move Layer down) y 

Mover capa hacia arriba ( Move Layer Up) ).Formas asignadas a una capa superior aparecen estar en 

la cima de las formas asignadas a una capa inferior. Esto es una  característica útil para mostrar cómo un 

proyecto de empalme de papel se verá cuando esté terminado. 

 Bloquear y desbloquear capas haciendo clic en el icono de bloqueo ( bloquear capa (Lock Layer)  y  

desbloquear capa (Unlock layer ) ). Una capa cerrada impide que las formas en que la capa de 

inadvertidamente ser trasladen  o cambien  de tamaño. También permite que la forma se muestre sin un 

cuadro de límite exterior. 

 Cambiar el color, la textura, y / o estilo de línea para todas las formas asignados a una determinada capa 

haciendo clic en el icono de la paleta de colores (juego de color para todas las formas).  

 • Eliminar una capa (y todas las formas asignados a esa capa en particular) haciendo clic en el icono 

Eliminar capa (Delete Layer)  

 Las formas individuales también se asignan a sus propias capas dentro de una capa. Aviso a continuación 

cómo las palabras “KNK” y “Zing” son capas individuales dentro de la capa por defecto que muestra ambas 

palabras juntas. Algunas de los mismas funciones que se utilizan para las capas están disponibles para ser 

aplicadas a las formas individuales dentro de una capa.  

 

 
 

Cambia color de  forma(tambien 

textura y estilo de linea) 

Mueve la figura  hacia  

arriba 

Haga  Click para 

seleccionar esta forma 
Mueve  la  forma  

hacia abajo 

Formar figura 
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 Al iniciar un nuevo proyecto, las  formas serán automáticamente asignados a una capa por defecto. Para 

mover una forma a una nueva capa, selecciónela y haga clic en la selección de Nuevo icono de capa ( 

Selection To New Layer)  

 Las nuevas formas que se crean automáticamente sera asignado a la capa seleccionada actualmente (con 

la excepción de algunas situaciones). Para crear una nueva capa vacía, haga clic en el icono Crear nueva 

capa.  

 Al agregar texto, una nueva capa se creará y el nombre de la capa será el tipo de letra utilizado para que 

el texto (como se muestra más arriba, donde la fuente utilizada para KNK Zing se llama 1 ADN Sprout 

Bean). 

 Para eliminar completamente una capa que se muestra, pero al mismo tiempo no eliminar la capa, mueva 

la capa de su propia página, usando el menú de Opciones de capa ( Layer Options  Menu) en la parte 

inferior de la barra de capa (Layer Bar)  

 Haga clic en el icono Eliminar capas vacías (Delete Empty Layers)    para eliminar las capas que no 

contienen formas. 

 Haga clic en el menú Activar Visible (Visible Toggle)   para ofrecer opciones para mostrar todas las 

capas (Show All), ocultar todas las capas o ToggleV isible que revertir la situación oculta/ mostrar actual 

de todas las capas (es decir ocultar capas actualmente visible y capas que actualmente no son visibles). 

 Haga clic en el menú de bloqueo de palanca (Lock Toggle)  para ofrecer opciones para bloquear todas 

las capas (Lock All), desbloquear todas las capas (Unlock All) o Toggle Lock que invierte el estado de 

bloqueo / desbloqueo actual de todas las capas (es decir desbloquear capas actualmente bloqueadas y 

capas de bloqueo que se desbloquean en la actualidad). 

 Haga clic derecho en un nombre de capa (Layer Name) o haga clic derecho sobre la miniatura de la capa 

(o seleccione la capa (Layer Options Menu)  y luego haga clic en el Opciones de capa icono de menú) 

y el siguiente menú se abrirá:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Para combinar dos capas, haga clic en la miniatura de una de las capas. Mantenga pulsada la tecla Mayús y 

haga clic en la Miniatura de la otra capa, añadiendo esas formas a la selección. Luego, haga clic 

Estas opcion pmueve toda imagen 

seleccionada en la hoja para una nueva   

 

Muchas de estas  funciones deben 

explorarlas 

Corte y  Pegue  puede usarlo para las capas 

 .  
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inmediatamente en la Selección de Nuevo icono de capa ( Selection to New Layer). Esto creará una nueva 

capa que contiene todas las formas de las dos capas. 

 
 

 

3.13 Redimensionar, Rotar, Inclinación y  Deformación.  

• El cambio de  funciones de tamaño, rotación, inclinaciones  y deformaciones  se presentan juntos, porque los 

cuatro pueden aplicarse fácilmente a cualquier forma seleccionada. 

 Cuando se selecciona por primera vez una forma, te darás cuenta de que el cuadro delimitador tiene flechas 

de dos cabezas en los cuatro esquinas y en el centro a lo largo de cada uno de los cuatro lados. Un doble clic 

dentro del área de delimitación de la forma va a cambiar los iconos a otras opciones, lo que resulta en tres 

modos diferentes:  

              
 

 

 

 

 

3.13.1 Cambio de tamaño 

 

VIDEO 

• Con la forma seleccionada, utilice el ratón para arrastrar cualquier rincón de la forma de cambiar el tamaño 

proporcionalmente. Al arrastrar la flecha de doble cara en uno de los cuatro lados le permitirá cambiar el 

tamaño vertical u horizontalmente mientras dejando la otra dimensión constante. 

• En función de la configuración actual de Snap Posición en el Mat virtual, el cambio de tamaño se producirá en 

incrementos  de esa preferencia. Para cambiar el tamaño libremente la forma, cambiar de posición para Snap  

de rotura. 

• Si desea liberar la relación de aspecto mientras arrastra una esquina, pulse la tecla Ctrl mientras arrastra. Este 

permite a la altura o anchura de la forma a ser cambiados libremente sin cambiar la otra dimensión. 

• Si usted necesita  hacer la forma de un tamaño exacto, a continuación, introduzca la dimensión en el cuadro 

de W o H en  Propiedades de barra ( Sel. Properties Bar). El icono de bloqueo se puede activar en función de 

si desea o no que para mantener la relación de aspecto constante:  

 

 

 

 

 

 

 

 

 

Resizing Mode 

ode 

Rotating / Slanting       

Mode 

Warping Mode 

Ingrese la dimension, incluya  el punto de decimal y 

presiona   Enter. 

Sangría para mantener la relación de aspecto; fuera-

dentro  y permitir W o H para ser cambiado sin 

cambiar automáticamente el otro 
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Cuando ingrese las medidas 

,que no sean pulgadas, debe 

especificar la unidad de 

medida al final 

 

 

• Las dimensiones también se pueden introducir en mm o cm siempre que esas unidades se introducen junto 

con el valor:  

 

 

 

 

 

   

 

 En este momento, no es posible visualizar estos ajustes en métrica. Si usted necesita saber el W y H de una 

forma particular, ya sea en centímetros o milímetros, por favor consulte la Sección 7.08.  

 Los porcentajes también se pueden utilizar en la configuración de dimensión. Por ejemplo, si usted quiere 

doblar el tamaño de una forma, usted puede entrar  un 200%  

 

 

 

 

 

     

 

 Los porcentajes también se pueden introducir con una “R” añadida para calcular el recíproco. Por ejemplo, al 

introducir “200% R” se traducirá en el tamaño se reduce  a la mitad. Entrando 300% R hará que el tamaño 

resultante tercera, etc. 

 Las fracciones también se pueden introducir con un espacio entre el número y la fracción. Por ejemplo, 

podría 6,5 puede ser introducido como 6 ½  

 

 
 

 

    

   

   

 En las versiones de MTC anteriores a 4.5.2, cambiar el tamaño de una forma textura se requiere mantener 

pulsada la tecla Mayús mientras arrastra una esquina. Esto cambia  el tamaño de la textura, así como la 

forma. 

 

El tamano en  pulgadas  ( Inches)  sera calculado 

automaticamente y lo mostrara. 

Ingrese  200%  para 

duplicar tamano

ode 

Las  nuevas dimensiones 

doblemente grandes 

Tamano para 

empezar

Tamano inicial

Ingrese 6 ½ no lvide 

el espacio).  

El valor de 6.5  

sera  mostrado 

aqui.  

Tel valor  H de altura  estara  en  

1.0  por que el Aspect Ratio no 

esta  bloqueado 
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Angulo de rotacion 

Rotacion del 

cuadrado 

3.13.2 Giratorio y de inclinación 

 

VIDEO 

 Con la forma seleccionada, arrastre cualquiera de las cuatro esquinas y  permitirá la rotación libre de la 

forma. la forma se bloqueará temporalmente en su centro y girará en torno a ese centro. A medida que 

gira, el ángulo de giro aparece en la parte inferior de la pantalla:  

 

 

 

 

 • Si se mantiene pulsada la tecla Mayús mientras arrastra una de las cuatro esquinas, la forma será 

ubicada  en la diagonal de la esquina opuesta y girará en torno a esa esquina. Si mantiene presionada la 

tecla Ctrl mientras arrastra uno de las cuatro esquinas, la forma girarán en 15 grados incrementados. 

Ctrl + Shift + Rotate  girarán alrededor de la esquina opuesta en 15 grados de incremento. 

 • Si tiene que girar en incrementos distintos de 15 grados , Vaya a Ayuda (Help)> avanzadas 

(Advanced)> Configuración avanzada ( Advanced Settings) y  cambie el valor por defecto para el 

incremento deseado (1-180 grados): 

 

 Una forma seleccionada también se puede girar exactamente 90 grados o a las agujas del reloj, 

mediante el uso de cualquiera de los siguientes: 

 • Haga clic en el Girar 90 grados ( Rotate 90) Icono de las agujas del reloj en la barra de 

herramientas de Magia ( Magic Toolbar)  

 • Presione Ctrl + G 

 • Vaya a Editar  ( edit)> Forma Magia (Shape Magic)> Rotar 90 (Rotate90) 

 Si arrastra una de las flechas de doble cabeza a lo largo de un lado, frente a una esquina, puede 

inclinar la forma en lugar de girárla:  

 

 

    

 

 

 Tenga en cuenta que si está utilizando una versión anterior de MTC, a continuación, se refieren a estos 

dos vídeos: VIDEO  VIDEO  

 

Inclinacion del 

cuadrado 

 

Arrastre  la  

punta para  

rotar 

 Arrastre el lado para 

inclinar 
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El texto 

empezara a 

desformarse.  

Trate de 

desformar las 

esquinas 

también. 

Rotación de imágenes de mapa de bits en el MTC 4.2 o anterior: 

3.13.3  Deformar (Warping) 

 

 En el modo de deformación, las formas pueden transformarse drásticamente arrastrando el “+” 

maneja en las esquinas. Arrastrando largo de los lados resultados en los mismos efectos que la 

inclinación anterior, pero se puede combinar con el arrastrado  de las esquinas para crear muchas 

variaciones diferentes en la forma original 

 

            
 

 

 Manteniendo pulsada la tecla Mayús o la tecla Ctrl mientras arrastra una esquina permite la 

deformación de amplia aún más! 

 

 
 

 • Nota: En este manual de usuario, capturas de pantalla de formas a veces aparece sin las líneas de 

división del tapete virtual en el fondo y sin los cuadros delimitadores alrededor de la forma (s). Esto se 

hizo para hacer que las imágenes aparezcan  más claras y menos desordenadas. 

 

3.14 Cambio de color, textura y estilo de línea 

 Hay tres formas de acceder a las funciones para cambiar el color, la textura o el estilo de línea de una 

forma seleccionada : 

 Haga clic derecho en la pantalla y seleccione Cambiar color ( Change Color) / textura (Texture) / Línea 

(Line Style) 

 En la barra de capa (Layer Bar), abra la capa, busque la forma, y haga clic en el icono de cambio de color 

(Change Shape Color) de la forma  

 Presione Ctrl + Shift + U (Color), Ctrl + Mayús + O (textura), Ctrl + Mayús + Y (Estilo de línea) 

Cambio de color 

 En la ventana de color, puede hacer clic en cualquiera de los colores básicos (Basic) o cree un color personalizado. 

 

Arrastre en la  

esquina para  

deformar 
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 Tenga en cuenta que un nuevo color  (Custom Color)personalizado sólo se guardará y  será disponible en el 

proyecto actual. 

 

Cambio de textura 

 En lugar de utilizar un color sólido, también puede llenar formas con texturas, que son por lo general los archivos 

de mapa de bits, como .bmp, .jpg, .png, importado en MTC. Al acceder a la función Cambiar la textura (Change 

Texture), la ventana que abre dependerá de si o no usted ya tiene una textura disponible de otra forma en su 

proyecto. Si no lo hace, a continuación, cuando se va a cambiar la textura, la imagen abierta para la ventana 

texturizando (Open image for Texturizing) se puede navegar por su ordenador para abrir un archivo de textura, 

escanear una en MTC, o pegar uno de los Portapapeles de Windows: 

 
 

 
 Después de importar este primer textura, o si ya existía una textura abierta en el proyecto actual, entonces el abre  

la ventana de escoger la textura (Choose Texture). En esta ventana, usted tiene opciones para: 

o Azulejode  la textura (llenar una forma con una versión modificada de la textura) 

o verticalmente u horizontalmente voltear la textura 

o • Offset o mover la textura dentro de la forma 

o Ajuste el color y el brillo de la textura 

o Cambiar el tamaño de la textura con o sin cambio de tamaño de la forma  

 
 

Opcion 1: Seleccione 

un clor basico o 

algun color creado 

para su proyecto 

Opcion 2:  Haga click en 

la ventana  y  desplazar 

hacia  arriba y abajo  

para  claro u oscuro el 

color deseado. 

Opcion 3:  Ingrese  el  valor  

RGB  o  Hue, Sat, Lum 

 

Haga Click  en Add to 

Custom Colors, si lo desea 

Opcion 1: En el 

buscador para 

localizer el forder y 

archive que contiene 

la textura que desea 

realizar 

Opcion 2: Haga click 

en  TWAIN para 

escanear  una 

texture  en  MTC 

Opcion 3:  Haga Click en 

PASTE para   pegar la 

imagen del clipboard de 

windows 
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 Después de hacer clic en Aceptar, su forma seleccionada llenará con la textura elegida. He aquí dos ejemplos:  

 
 

 Estos  son dos ejemplos donde las formas fueron rediseñadas  con la escala de a textura. En el próximo ejemplo el 
texto de pingüino  esta creado e importado de la imagen del pingüino:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Opcion 1: Seleccionar una textura ya 

existente para su proyecto 

Opcion 2: En el buscador del 

computador localice el archive o 

carpeta que contenga la textura que 

desea para  su proyecto. 

Ajustes para texturas  incluyendo 

flipping, rotacion, modificacion de 

color y  offsetting 

Escala:  Barra de desplazamiento  para nuevo tamano de 

textura Scale Paths: Marque  las opciones para  marcar  

si desea rotar o aumentar o disminuir el proyecto luego 

de rediseñar las textuta 

 

Vista previa de 

imagen 

importada 

imported image 

Configuracion por 

defecto 
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 Para crear un patrón de repetición del pingüino, en un tamaño mucho más pequeño y con otras personalizaciones, los  
siguientes cambios se realizan en la ventana Cambiar Texturas (Change Textures):  

 

             

 
 

 

 

 Después de hacer clic en Aceptar, la forma llena de la nueva textura personalizada: 

 
 

 

Eliminacion  de una textura 

 Si desea eliminar la textura de una forma, haga clic derecho en la forma y seleccione Cambiar Color / textura / 

Línea y luego seleccione Quitar Texturas (Remove Texture). 

Cambio de Estilo de línea 

video  

 La ventana Elegir estilo de línea (Choose Line Style) le permite crear líneas de puntos en vez de líneas continuas, 

según sea necesario. Similar a elegir la textura,  El Estilo de línea ofrece la opción de crear un nuevo estilo o usted 

puede escoger un Estilo de línea que ya están en uso en su proyecto actual: 

 

 

Vista previa  de 

textura usando 

los ajustes 

actuales  

Haga clic en Adjust 

Color y se abrira 

esta ventana . 

Ajustes de  cambio 

de colory deseados, 

y luego seleccione 

Apply. 

Revisar  Tile Texture , ajuste  y puede rotar  Rotate  45 grados  y 

escala  Scale para 18%,  y haga click en  Adjust Color. 

Option 1: Select a line style already 

present in your project 

Option 2: Create a new line style by 

setting desired Dash length and 

Space between dashes 
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 Después de hacer clic en Aceptar, su forma seleccionada aparecerá con el estilo de línea que ha elegido. Aquí hay 

dos ejemplos: 

 

 

 
 
 

3.15 Otros Manipulaciones de  Forma 

Alineación 

 Hay once funciones utilizadas para alinear formas uno con el otro. Después de seleccionar dos o más formas, estas 

funciones se puede acceder utilizando cualquiera de los siguientes: 

 Haga clic derecho en la pantalla y seleccione Alinear y Espacio  (Align and Space)> Alinear (Align)> 

 Vaya a Edición  (edit)> Alinear y Espacio  (Align and Space) > Alinear (Align)>. 

 Para algunas de las funciones no hay teclas de acceso directo y éstas se indican en los incisos detallados abajo. 

 Los siguientes tres formas, en sus posiciones relativas actuales, se utilizarán para ilustrar lo que sucede cuando 

cada función de alineación se aplica: 

  
 

Alineación  Central 

 Hay tres funciones de centrado diferentes. Una vez más, con las formas seleccionadas, haga clic derecho y vaya a 

Alinear y Espacio ( Align and space)> Alinear  ( Align)> 

 Centro Vertical ( Vertical center) (pulse V) se alinea las  formas verticalmente y se coloca al centro vertical 

media del grupo. 

 Centro horizontal (Horizontal Center) (pulse H) se alinea formas horizontalmente y se coloca al centro 

horizontal promedio del grupo. 

 Agrupar (Stack) (pulse S) se alinea formas de ser centrada horizontalmente y verticalmente entre sí. 
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Alineación exterior 

 Hay cuatro funciones de alineación diferentes utilizados para alinear las formas de los bordes exteriores. Una vez 

más, con las formas seleccionadas, haga clic derecho y vaya a Alinear y Espacio (Align and space) > Alinear  

(Align)>: 

 Derecha (Right) (presione R) se alinea formas a lo largo de sus lados derecho y se coloca a la forma del 

extremo derecho del grupo. 

 Izquierda(Left) (presione L) se alinea formas a lo largo de su lado izquierdo y se coloca a la forma del 

extremo izquierdo del grupo. 

 Superior (Top) (pulse T) se alinea  las formas a lo largo de sus lados superiores y se coloca a la forma más 

alta del grupo. 

 Inferior (Bottom) (pulse B) se alinea formas a lo largo de sus lados inferiores y se coloca a la forma más baja 

del grupo.  

 

 

                        
   

 

 

Centro Vertical  (V) 

 

Centro Horizontal  (H) 

 

Amontonar (S) 

 

Derecha (R) alinea las 

figuras  al lado 

derecho  lado del 

aznillo azul 

Izquierda (L) alinea 

las formas al lado 

izquierdo como el 

mono purpura  

Top (T) alinea las figuras 

enla parte superior como 

el mono purpura 
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Alineamiento de borde 

 Hay cuatro funciones de alineación adicionales utilizados para alinear las formas de una manera ligeramente 

diferente. Una vez más, con las formas seleccionadas, haga clic derecho y vaya a a Alinear y Espacio (Align and 

space) > Alinear  (Align)>: 

 Lado Izquierdo ( Edge Left) alinea formas a lo largo del borde izquierdo de la forma más a la derecha del 

grupo. 

 Lado Derecho ( Edge Right) alinea formas a lo largo de su lado derecho de la forma más a la izquierda del 

grupo. 

 Lado Superior (Edge Top) alinea formas a lo largo de su borde inferior de la forma más superior del grupo. 

 Lado inferior ( Edge Bottom) alinea formas a lo largo de su borde superior de la forma más inferior del 

grupo. 

 

 

 

          

 

Inferior (B) alinea las 

formas  en la parte  inferior 

como el mono purpura 

 

 

Borde Izquierdo / Edge 

Left alinea las formas al 

borde izquierdo como el 

anillo azul 
Borde Derecho/Edge Right 

alinea las formas al borde 

derecho como el mono 

purpura 

Edge Bottom/Borde  

Inferior (B) alinea las 

formas  en la parte  

inferior como el mono 

purpura 
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Espaciado 

 Hay dos funciones de alineación  que se utilizan para igualmente formas espaciales, ya sea horizontal o 

verticalmente. Después de seleccionar tres o más formas, estas funciones se puede acceder utilizando cualquiera 

de los siguientes: 

 Haz clic derecho en la pantalla y seleccione Alinear y espacio  ( Align and Space) > Espacio (Space)> Vertical 

(u horizontal) 

 Pulse [o] (véase más adelante) 

  Vaya a Edición (Edit) > Alinear y espacio ( Align and Space) > Espacio (Space)> Vertical (u horizontal) 

vertical (u horizontal). 

 Verticalmente (pulse [) igualmente los  espacios moldean entre el superior e inferior las  formas en la 

selección. 

 Horizontalmente ( pulsa ]) igualmente los  espacios de las  formas entre la izquierda y las formas más a la 

derecha en la selección. 

 Otra forma de aumentar o disminuir el espaciado entre un grupo seleccionado de formas, es mantener el 

Ctrl y arrastrar  el medio: 

 

 

         

 

 Este mismo método puede ser utilizado para el espaciamiento vertical, también. Las formas no tienen que 

ser las mismas. Usted podría igualmente el espacio, por ejemplo, una estrella, una letra “B”, y una línea 

recta. 

 

Efecto espejo (Mirroring) y   (Flipping) 

 Para reflejar horizontalmente una forma, selecciónela y luego usar una de las siguientes opciones: 

 Haga clic en el icono de espejo (Mirror) en la barra de herramientas de Magia ( magic toolbar)  

 Haz clic derecho en la pantalla y seleccione Forma Magia (Shape Magic)> Espejo (Mirror) 

 Presione Ctrl + M 

 Vaya a Editar (Edit) > Forma Magia (Shape Magic)> Espejo (Mirror)   

Edge Top/Borde 

superior (T) alinea las 

figuras en la parte 

superior como el 

corazón rosado 

 Oprima la tecla Ctrl  y arrastre 

con las fechas rojas  hacia la 

derecha. 

Ahora las estrellas  

tendrán mas espacio 

entre ellas 
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SCUT, SCUT2 Archivos: 

4.05 

 
 

 Para voltear verticalmente una forma, selecciónela y luego usar una de los siguientes pasos: 

 Haga clic en el icono del tirón (Flip) en la barra de herramientas de Magia (Magic toolbar) 

 Haga clic derecho en la pantalla y seleccione Forma Magia (Shape Magic)> tirón (Flip)  

 Presione Ctrl+F 

 Vaya  a  Edit>Shape Magic>Flip.  

 

 

 

 

4. Importación y exportación 

4.01 Acceso a las opciones de importación 

 Vaya a Archivo (File)> Importar (Import) y seleccione una de las opciones de importación disponibles. Tenga 

en cuenta las teclas de acceso directo para los diversos tipos de archivos: 

 
 

 

 

 

 

 

 También puede hacer clic en el icono correspondiente en la barra de importación (Import Bar). Tenga en 

cuenta las secciones del manual de usuario incluido con cada etiqueta:  

 

 

 

 

 

 

 

 

 Alternativamente, haga clic derecho sobre la pestaña proyecto sobre la barra de pestañas (Tab Bar) y 

seleccione Importar (Import) en el menú. Esto es el mismo que ir a Archivo (file)> Importar (Import). 

Para  todas las formas Abre  LD’s  Web para acceso a  usuarios con cuenta y 

poder comprar archivos  e  importer gratis 
Para compartir todos los archivos  

de  duenos de  otros MTC Formas incluidas en  MTC,. 

Listo  para  cortar en 

formatos de 

vectores 

Abrir tipos de letras  no instaladas  en windows 

Trazo de Pixel  de  

archivos:JPG, BMP, TIF, 

PNG, GIF  

 4.08, 6.02 

Disenos para 

comprar: 

4.07 

MTC Galeria: 

4.02 

Archivos de 

fuentes:  

4.06, 5.02, 5.11 

PDF, AI, EPS, PS 

Archivos: 4.04 

Formas Basicas: 

3.08 

SVG, SVGZ  

Archivos: 4.03 

WPC Archivos :  

4.05 

GSD Archivos:  

4.05 
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4.02 Importación de la Galería de MTC en línea 

video 

 La Galería MTC (MTC Gallery) se puede acceder mediante los tres métodos que se muestran arriba o por ir a 

Ayuda (Help)> SVG gratis y MTC  (Free SVGS and MTC).  Cuando se selecciona, la siguiente ventana se abre 

y puede elegir entre miles de archivos compartidos de otros propietarios de MTC: 

 
  

 

 

 

 

 

 

 Al hacer clic en Buscar (Search), aparecerán imágenes en miniatura de las imágenes identificadas en la 

búsqueda:  

                              
 

 Haga clic en la imagen en miniatura y una ventana de vista previa más grande se abrirá. Haga clic en Descargar 

(Downland) y el archivo inmediatamente importar en la ubicación actual del cursor. A continuación, puede 

cambiar el tamaño, cortar, editar, guardar, etc., según sea necesario. 

Opcional: Ingrese el termino a 

buscar en ingles, debe usar el 

nombre del archive o  descripcion. 

Seleccione una  Categoria 

fde la lista despegable 

Seleccionar un particular User 

ID 

Seleccione el tipo de archive SVG, 

MTC o los dos 

Seleccione por Fecha, titulo, 

descripcion, o ID y escoja entre  

ascendente o descendente 

Seleccione el  # de items para ver por 

pagina 

Despues de ingresar la opciones de 

busqueda haga  click en el boton Search 

Los  archivos MTC aparecen 

con el mat virtual en el 

fondo 

Los archivos SVG aparecen  

sin el mat virtual de fondo 

Cada miniature 

indica el nombre de 

archive, categoria, 

descripcion, usuario 

id y fecha de ingreso 
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4.03 Importación de SVG, SVGZ desde el ordenador 

 Si el formato de archivo seleccionado es SVG o SVGZ, a continuación, importar el gráfico traerá la forma en 

MTC redimensionada, editado, corte, etc.  Al igual que en la apertura de los archivos, se abrirá una ventana 

abierta, lo que le permite navegar por su ordenador para localizar una subcarpeta y seleccionar el archivo que 

desea importar. Con SVG puede hacer clic en grande 

 Vista previa para abrir una ventana que muestra una visión mucho más grande que la vista previa en 

miniatura:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Los diferentes programas utilizan diferentes DPI al exportar como SVG. Mientras MTC importará el SVG en la 

DPI más comúnmente utilizado, es posible que un tamaño importado será diferente de la original (tal como 

sucede con SVG de creada en KNK Studio). Por lo tanto, compruebe siempre el tamaño para ver si es apropiado 

o necesita antes de cortar. 

 Si importa un SVG que es un archivo de impresión y de corte y las líneas de corte no aparecen, aplique la 

Funcion (Join), seguido por la función de capa (Layer) (consulte la Sección 7.01). Una nueva capa se creará 

con las líneas de corte alrededor de la trama. La capa original se puede eliminar. 

 También puede importar archivos SVG mediante arrastrar y soltar en una instancia en ejecución de MTC. 

 

4.04 Importación de AI, EPS, PS, PDF 

 Si el formato de archivo seleccionado es uno de los siguientes formatos vectoriales: AI, EPS, PS, PDF (vector 

solamente), a continuación, importar el gráfico funciona igual que la apertura de los archivos de MTC o 

importar archivos SVG. Hay unas pocas opciones  diferentes  de importación:  

 

 

   

 

 

 

 

 

 

 

El buscador localiza 

el folder que 

contiene el archivo 

Haga Click  en el 

archive y 

aparecera  debajo 

del nombre de 

archivo 

Vista previa del archive 

importado 

Haga Click aqui para abrir la 

ventana para ver su forma. 

Haga Click aqui para abrir la 

ventana  que muestra la 

forma  

Haga  Click en  Open  y abrira  

el  nuevo proyecto. 

Seleccione el numero  de pagina si 

hay  varias paginas 

El buscador localiza 

el folder que 

contiene el archivo. 

Haga Click  en el 

archive y 

aparecera debajo 

de  File name: 

Vista previa del archivo  a 

importar 

Opcion  de importacion para trazos: 

Strokes Only, Rellenos: Fills Only o  

rellenos y trazos Strokes and Fills.  
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 Tenga en cuenta que cuando el archivo tiene varias páginas (como algunos archivos PDF vectoriales), el 

usuario debe elegir qué página para importar. Haga click en la Gran Vista (Large Page) previa para ver mejor 

las formas individuales o utilizar Adobe Reader para ver las páginas de la misma manera que lo haría ver 

cualquier archivo PDF. 

 Para los  archivos MTC la   forma  de importación  se permite desde  la versión 9 o posterior. Por lo tanto, si  

no importa, puede que este sea el problema. A partir de algunos programas, como Funtime, será necesario 

guardar en un formato diferente, como PDF o EPS. 

 Un PDF creado a partir de una imagen de trama no importará en MTC. En la ventana de vista previa leera  un 

mensaje diciendo “No hay nada en la  vista previa ( Nothing to Preview)” y un mensaje de tipo azul 

aparecerá en la parte inferior de la ventana. Este mensaje le dará la opción de acceder a la ventana de 

seguimiento de píxeles (Pixel Trace) para que esa imagen puede ser vectorizada en primer lugar. Consulte el 

Capítulo 6.  

 

 

 

 

 

 

 

 

 

 

 

 

 También hay un menú para   importar trazos  and    y rellenos con tres opciones para importar Strokes 

solamente, Importar Fills Sólo o Importar Trazos y rellenos. Seleccionar este último y luego observar si tiene 

líneas no deseadas en su imagen.Si es así, pruebe una de las otras opciones, como la importación Strokes 

Only. 

4.05 Importación SCUT, SCUT2, WPC, GSD 

 Los archivos creados en Sure Cuts a Lot (SCAL) se guardan en la SCUT formato o SCUT2, dependiendo de la 

versión 

de SCAL utilizado. Los archivos con la extensión de archivo WPC se crean en programas desarrollados por 

sesión Max, que incluye  WinPC Señal, Funtime, Puzzles Inspiración, y Gazelle. Archivos GSD se crean en 

RoboMaster, RoboMaster Pro y Wishblade Advance. Estos formatos son todos importados utilizando los 

mismos métodos que fue descrito para SVG. No hay ajustes especiales. Simplemente busque el archivo en su 

ordenador, selecciónelo y haga clic en  Abrir. 

 El formato GSD no tiene una vista previa disponible. Además, la opción de Fuse N Weld está disponible, en la 

ventana de importar, para conectar los diversos segmentos que componen los  archivos y se recomienda que 

la caja permanece activada. La barra de desplazamiento junto a esta opción le permite establecer la distancia 

mínima entre dos nodos a fin de que se conecte a la importación. 

Nada aparecera si  el archive 

de PDF xontiene imagenes de 

trama. 

Si  aparece este  link  azul  

abrira el trazo de pixel 

Chapter 6. 
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 Se recomienda que este en  automático la función  (Auto fuse n ‘Weld and  Render Metafiles Para 300 DPI) 

y dejarse encendido. Se necesita la opción de Fuse N Weld para conectar los diversos segmentos que 

componen los caminos en los archivos GSD. La función Render Metafiles  se utilizan para identificar los 

archivos WMF y EMF incrustados utilizados para la impresión y corte  y convertir aquellos a texturas. 

 Antes de guardar un archivo GSD importados, ejecute el Camino Auto Simplifique  (Auto Simpliy Path) para 

reducir nodos. Consulte la Sección 7.02.2. 

 

4.06 Importación  TTF, OTF Fuentes Archivos 

 Si el formato de archivo importado es TTF, OTF o OPF luego se agregará el archivo de fuente a la lista de 

fuentes instaladas y estar disponible para la creación de formas de texto. La fuente no necesita ser instalada 

primero en Windows, ni lo hace necesitan ser reabierto en MTC después de guardar el archivo y se abre de 

nuevo en el ordenador del usuario actual o cualquier otro equipo. Más detalles sobre la importación de 

ficheros se tratan en la Sección 5.02. 

 

4.07 Importar desde Lettering Delights 

 Si se elige la opción Lettering Delights, a continuación, la ventana  se abrirá en el lado izquierdo de la pantalla. 

 Usted puede iniciar sesión en el siguiente sitio web: http://www.letteringdelights.com/ y comprar nuevos 

archivos de corte o cargar archivos de corte existentes de su cuenta  

 

 

 

 

 

 

 

 

 

 

 

 

Auto Fuse n’ Weld  es una 

opción que conecta los 

segmentos individuales: 

Altamente recomendado 
Aumentar la tolerancia , si se  

rompe no se esta cerrando, y 

establecer menor nodos 

conectados que no deberian 

estar. 

Convierte archivos 

incrustados a  textura 
Indica como se  encuentran muchos patrones . Nota: Con  Auto 

Fuse n’ Weld , importa  graficas , como por ejemplo, graficas, en 

este ejemplo, 7 patrones de  143. 

Imagen 

seleccionada 

Log in o  Registrarse 

Haga click en solo ls productos 

que compra 

Haga Click en la fecha de 

arriba hacia abajo para 

otros productos. Nota: Si 

hace click en la Estrella  

solo mostrara los  

productos que usted ha 

comprado 

http://www.letteringdelights.com/
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 Los archivos de corte de Lettering Delights de su propiedad se mostrarán en orden alfabético por Nombre de 

la colección(Collection Name). Si desea cambiar el orden de clasificación de Ordenar, vaya a Ayuda(Help)> 

avanzadas (Advanced) > Configuración avanzada (Advantanced Settings), y seleccione la otra opción bajo 

Ordenar Lettering Delights (Sort Lettering Delights) :  

 

 

 

 

 Cuando se trabaja con Ordenar por Nombre de la colección (Sort by Collection Name), si se conoce el nombre 

de un producto LD particular, puede escriba la primera letra y se le llevará a los productos que comienzan con 

esa letra. Esto le permite a más desplazarse rápidamente a través de los productos. 

 Una vez que haya seleccionado un producto Lettering Delights, haga doble clic en cualquier imagen y se abrirá 

una ventana donde se puede elegir para ir al sitio web de Lettering Delights para comprar este producto en 

particular. Las formas en que paquete de productos estarán disponibles para descargar directamente en el 

MTC en el futuro, cuando se Accede a tu cuenta. 

 El siguiente ejemplo muestra una colección de imágenes prediseñadas (Clipart) llamado “Arizona Grand 

Canyon State” que ha sido encontrado en el sitio Lettering Deligths, pero aún no se ha comprado. Usted puede 

ver las imágenes contenidas en esta colección y, al hacer doble clic cualquiera de las imágenes, se abrirá una 

ventana:  

 

  

 

 

 

 

 Si su respuesta es Sí (Yes), su navegador de Internet se abrirá y usted será llevado a este enlace: 

http://www.letteringdelights.com/clipart:arizona_grand_canyon_state-10057.html  donde se puede ver de 

Ordena los productos del 

menu del programa Lettering 

Delights  

http://www.letteringdelights.com/clipart:arizona_grand_canyon_state-10057.html
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nuevo las imágenes de esta colección, navegar por los proyectos realizados con esta colección, enlaza con 

colecciones relacionadas, y, Por supuesto, la compra de esta colección. 

 

4.08 Importación Raster archivos (JPG, BMP, PNG, etc.) 

 Si el formato de archivo seleccionado es un raster (por ejemplo, JPG, BMP, TIF, PNG o GIF), a continuación, se 

utiliza la opción de seguimiento de píxeles para importar el gráfico y vectorizar partes seleccionadas o toda 

de la forma. Consulte el Capítulo 6 de Búsquedas. 

 Las imágenes de trama también se pueden copiar y pegar en la ventana Seguimiento de píxeles (Pixel Trace) 

directamente desde el Explorador de Windows. 

 Si el archivo raster solamente va a ser utilizado para llenar una forma con la imagen (también referido como 

la adición de una textura), a continuación, consulte la Sección 3.14. 

4.09 Acceso a las Opciones de exportación 

 Uno puede exportar una forma o grupo seleccionado de formas en cualquiera de las siguientes maneras: 

 Vaya a Archivo (File)> Exportar (Export) y seleccione una de las opciones de exportación disponibles 

 Haga clic derecho en la pantalla y seleccione Exportación (Export) 

 Haga clic derecho sobre la pestaña proyecto sobre la barra de pestañas (Tab Bar) y seleccione 

Exportar (Export) en el menú. Este es el mismo como ir a Archivo (File) > Exportar (Export). 

 Utilice cualquiera de las tres teclas de acceso directo para abrir las opciones de exportación (Export) 

disponibles. Consulte la siguiente captura de pantalla.  

 
 

 

 

 

 

4.10 Exportación de Formas básicas 

VIDEO 

 Al exportar un archivo a la biblioteca de formas básicas (Basic shapes), una ventana emergente aparecerá 

pidiendo el archivo sea nombrado. Introduzca un nombre descriptivo para la forma y luego haga clic en 

Agregar (add). Esa forma se añadirá a la categoría - “Sus formas (Your shapes)”.   

 

 
 

 

 A medida que construye “Sus formas” de la biblioteca, es posible que desee una copia de seguridad en el caso 

de que tenga una rotura del disco duro o si usted desea cargar “Sus formas” a otros equipos de su propiedad. 

Para acceder a esta función, vaya a Ayuda (Help)> avanzadas (Advanced)> Configuración avanzada (Advance 

Exporta las formas seleccionadas 

en sus formas/ “Your Shapes” 

bajo categoria  Basic Shapes. 

 

Utilice si desea bajar una forma 

seleccionada  online en MTC Gallery 

Exporta forma con imagenes de 

trama 

Exporta en un vector 

comun las formas   

standard 
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settings). Bajo Backup / Restore shapes, usted encontrará las opciones para cualquiera Copia de seguridad o 

Restaurar.  

 

 

 Al hacer clic en Copia de seguridad Se abrirá una ventana Guardar como (Save As), donde se puede navegar 

por el equipo para encontrar una localización para el almacenamiento, como en una unidad flash. Al hacer clic 

en Restaurar (Restore) Se abrirá una ventana abierta donde se puede a continuación, localizar el archivo de 

copia de seguridad que ha creado. 

4.11 Exportación a MTC Galería 

 Al exportar a la Galería de MTC, usted tiene que elegir entre exportar como SVG o como un MTC. Al exportar 

simplemente una forma seleccionada del MTC a la Galería, seleccione el archivo y luego elija el Sel. como SVG 

Opción MTC Galería. La siguiente ventana se abrirá donde podrás introducir información y seleccione una 

categoría: 

                            

 

 

 

 

 Cuando otro propietario MTC importa el archivo, se importará automáticamente a la altura y la ubicación del 

Caret o cursor, Si es necesario, el tamaño diseñado podría ser mencionado en la descripción. Para un archivo 

como este aguacate, es no es necesario. Pero para algo así como una envoltura de la magdalena, podría ser 

importante para el usuario saber la dimensiones  de diseño originales. 

 Otra alternativa, que conserva las dimensiones originales de todas formas en el archivo, está disponible. Desde 

las Opciones de exportación  (Export), elija Sel. como Proyecto de MTC Galería (Sel. as Project to MTC Gallery). 

Aparece una ventana idéntica,  incluir  todo en el expediente, incluyendo los mismos ajustes Mat virtuales, 

Notas, capas, etc. 

 Si sube un archivo y luego desea borrarlo, localice el archivo y haga clic en el enlace Eliminar elemento  (Delete 

Item) en la parte inferior de la ventana de la imagen: 

 

Ingrese el nombre de  su archivo 

Adherir la descrpcion y notas para  

la persona que desee descargarlo. 

La imagen aparece  

autoaticamente. 

Seleccione la categoria del menu  

que se desplazara. 
Haga check despues de 

leer este cuadro 

Lea terminos y condiciones 

Haga Click en Go para 

descargar. El archivo 

aparecerá cuando sea 

aprovado 
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Puede remover su archive de la galleria MTC  con un click aqui 

4.12 Exportar como SVG 

 Para exportar como un archivo SVG, seleccione la forma o formas y luego o bien ir a Archivo (File)> Exportar 

(Export)> Sel. a SVG Archivo(Sel. to SVG File) o haga clic derecho sobre la forma (s) seleccionado y elija 

Exportar (Export)> Sel. a SVG Archivo (Sel. to SVG File). 

 Elija una ubicación y un nombre para el archivo. Usted también tendrá la opción de establecer un color de 

trazo(Stroke color) y / o Ancho (Stroke Widt). Tenga en cuenta que no aparecerá  si vuelve a importar el 

archivo en MTC. Sin embargo, usted será capaz de ver esto en otros programas vectoriales, tales como 

Inkscape. 

 

 

 

 

 

 

 

 

 

 

4.13 Exportar como EPS / AI o PDF 

 Para cualquiera de estos formatos, primero seleccione la forma o formas y luego o bien ir a Archivo (File)> 

Exportar (Export) o seleccione la Opción Exportar en el menú desplegable (clic derecho en la imagen 

seleccionada para la opción de exportación). A continuación, seleccione ya sea Sel. AI / EPS Archivo o Sel. 

Vector de archivo PDF. Se abrirá una ventana: 

 

 

 

  

  

  

 

Seleccione el lugar 

para salvar el 

archivo Seleccione 

la imagen 

para  

exportar 

Nombre de archivo 

Haga Click en Save 

cuando el archive 

este exportado 

Optiones deStroke Color y  

Stroke Width 

Seleccione el lugar 

para salvar el 

archivo 
Seleccione 

la imagen 

para  

exportar 
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La imagen 

exportada  

con opcion de  

drop shadow 

adherida 

Opcion marca de 

agua/ watermark 

adherida 
Watermark /Marca de 

agua Ajustes 

Drop Shadow/Linea de 

sombra Ajustes 

La opcion para guarder 

selecciona las propiedades 

que puede volver a usar en 

una future exportación de 

trazo de imagen 

Especificaciones 

para la imagen 

Imagen de trama podria 

ser copiada y pegada 

para otros programas Imagen de trama puede ser 

impresa y/o guardada 

 

 

 

 

 

 

 

4.14 Exportar como archivo de la trama 

 Hay muchas razones por las que es posible que desee exportar el archivo como un mapa de bits. Por ejemplo: 

(1) La imagen podría ser publicada en un sitio web o blog, (2) La imagen podría ser compartida con un amigo 

o un cliente, (3) La imagen podría ser utilizado en un programa de álbum de recortes digital. 

 • Seleccione la imagen y haga clic derecho para abrir el menú para seleccionar la Exportar (Exort) y 

luego seleccione la última opción, Sel. a Raster File. Esta ventana se abrirá: 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 Tenga en cuenta que hay  muchos ajustes disponibles para la exportación de la trama. Si la imagen se va a 

importar en una estratificación  de programa (como Photoshop o un programa de scrapbooking digital), a 

continuación, PNG será el formato preferido. Para aplicaciones comerciales, es posible que desee agregar una 

marca de agua para proteger su imagen de la copia. Una sombra se puede agregar a darle a su dimensión de 

la imagen. Experimente con estos ajustes y si encuentra  los que usted desea utilizar en varias ocasiones, haga 

clic en la opción en la parte superior para guardar los ajustes y se abrirá una ventana donde los ajustes se 

pueden guardar con un nombre que usted proporciona:  

Nombre de archivo 

Haga Click en Save 

cuando el archive 

este exportado 

Seleccione  archivos EP S/AI  
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4.15 Uso de Windows Copiar / Pegar 

 

Ilustrador Adobe 

 En Adobe Illustrator, seleccione la forma o formas y utilice Editar (Edit)> Copiar (Copy) o Ctrl + C  para copiar 

las imágenes al Portapapeles de Windows. En MTC, utilice Pegar (Paste in Place) (Ctrl + Shift + V o en el icono 

en la barra de herramientas Archivo (File toolbar)        para importar las formas en el tamaño original. Nota El 

relleno y trazo colores asignados en Illustrator no serán llevados en MTC. 

 En algunas formas, duplicados pueden dar durante la conversión de AI a MTC. La forma más rápida para 

eliminar 

esos duplicados es aplicar la función Fuse n ‘Weld. No es necesario saber qué formas podrían ser duplicadas.  

Sólo tienes que seleccionar todas las formas importadas y haga clic en el icono Avanzado (Advanced Icon 

) en la Forma Barra de herramientas de la Magia ( Shape Magic Toolbar), y seleccione Fuse n ‘Weld. Una 

pequeña ventana se abrirá. No es necesario ajustar  en este caso. En su lugar, haga clic en el botón óptima. 

La ventana se cerrará y las formas duplicadas será fundido en una sola versión: 

Click en Optimal 

 Si usted tiene algún problema utilizando el método de Windows Copiar / Pegar, tratar de importar archivos 

AI guardados en MTC. Consulte la Sección 4.04. 

 

Inkscape 

 En Inkscape, seleccione la forma o formas y utilice Editar (Edit)> Copiar (Copy)  o Ctrl + C  para copiar las 

imágenes al portapapeles de Windows. En MTC, utilice Pegar en su sitio (Paste in place) (Ctrl + Shift + V o en 

el icono en la barra de herramientas de archivos (File Toolbar)  ) para importar las formas en el tamaño 

original. Nota El relleno y trazo colores asignados en Inkscape no serán puestas en MTC. 

 Al igual que en los archivos AI, duplicados pueden ocurrir con algunas formas durante el proceso de copiar / 

pegar. Aplique el fuse n ‘  Weld  para reducir los duplicados en las ocurrencias individuales. 

 • Si usted tiene algún problema utilizando el método de Windows Copiar(Copy) / Pegar(Paste), 

intente importar sus archivos SVG guardados en MTC. Consulte la Sección 4.03. 

 

 

KNK estudio / ACS Estudio 

VIDEO  VIDEO 

 En KNK o ACS Studio, seleccione la forma o formas y utilizar las teclas Ctrl + C o Editar (Edit)> Copiar(Copy) 

para copiar las imágenes al Portapapeles de Windows. En MTC, utilice Pegar en su lugar (Paste in Place)  

(Ctrl + Shift + V o en el icono en la barra de herramientas Archivo (File toolbar) ) para importar las 

formas KNK en el tamaño original. También se mantiene el color de relleno en KNK Studio. 

 Si tiene que cortar por el color, entonces puede ser más fácil seleccionar un color a la vez en KNK Studio, 

para copiar / pegar a MTC. Una nueva capa se creará en la barra de capa y esas formas asignados a esa 
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nueva capa. Esto puede ser más rápido y más fácil que copiar y pegar todo para MTC y luego tratar de 

reasignar formas del mismo color a sus propias capas. 

 Si las dimensiones de las formas importados son más grandes que las mismas dimensiones que se muestran 

en KNK studio (que va a pasar con los patrones de diamantes de imitación, por ejemplo), aplique el 

comando ( Flatten Paths) Aplanar Caminos y las dimensiones entonces deben coincidir. Las formas no han 

cambiado tamaños durante la conversión de KNK Studio para MTC; esto es simplemente una corrección 

para eliminar los puntos de control de Bézier. Consulte Acoplar Caminos bajo la Sección 7.04. 

 • La función Notas (Notes) en KNK / ACS estudio también permitirá texto a ser copiado y pegado a la 

ventana de Notas (Notes Windows) en MTC. 

 Si alguna de las fuentes  VEF y  WFN específicas para KNK / ACS estudio se han utilizado para crear texto, 

ese texto puede también puede copiar y pegar desde KNK / ACS Studio para MTC aunque esas fuentes 

particulares no pueden ser abiertas en  MTC. 

 Si usted tiene algún problema utilizando el método de Windows Copiar / Pegar, exportar sus archivos desde 

KNK studio en formato EPS o PDF para importar en MTC. Consulte la Sección 4.04. 

 Exportar desde MTC KNK / ACS Studio, seleccione la forma (s) y el uso de cualquiera de las EPS o de exportar 

a PDF  descritas en el apartado 4.1. Los archivos importados en KNK / ACS studio necesitarán tener los  colores 

asignados 

y Grueso  de Línea atributo ( Thick Line Attribute) establecido en (No Line) o (Hair Line). Consulte los 

Manuales KNK Studio. 

 

 

 

 

5. Trabajo con texto 

5.01 El texto y fuentes Tab 

 En la barra principal (Main Bar) en el MTC, se encuentra una pestaña llamada texto y fuentes (Text And Fonts):  

 

 El texto y la ficha Fuentes (Text and Fonts)se utiliza para:                                                                                                             

 Navege y seleccione qué tipo de letra va  a utilizar para la creación de una forma de texto. Tenga en 

cuenta que marcar la opción (Show Face) mostrará los nombres de fuente en su tipo de fuente. 

 Navegar todos los caracteres (pictogramas) disponibles en cualquier fuente dada 

 Apertura (Opening) / importadores nuevas fuentes (importing new fonts) 

 Acceso a la ventana para escribir texto 

 La elección de hacer el texto en negrita o cursiva.   

 

 

 

 

 

 

Haga click para accede a  

texto y fuentes/ Text and 

Fonts 
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 Las Fuentes aparecen en negro en el menú desplegable  que están instalados en Windows. Fuentes 

que aparecen en azul han sido abiertas  en MTC durante la sesión actual. Fuentes que aparecen en 

verde se han abierto durante esta sesión o previamente se  abrió, con la opción marcada para instalar 

de forma permanente en el MTC. (Consulte la Sección 5.02.) 

 Usted puede hacer clic en cualquier tipo de letra en el menú desplegable y luego usar el botón de 

desplazamiento del ratón para desplazarse por todo de las fuentes en el menú. Asegúrese de que la 

opción Show Face está marcada si desea que los nombres de las fuentes que aparecen en la fuente 

real. 

 Si usted está buscando una fuente en particular, escriba la primera letra del nombre de la fuente y se 

le llevará a las fuentes que comienzan con esa letra. 

 Algunas fuentes se cambian de manera significativa si se selecciona la opción Negrita, para estar al 

tanto de esa posibilidad. Lo mismo es el caso de la opción de Itálica. Asegúrese de que no tiene sangría 

/ de color azul. 

 

 

5.02 Apertura de archivos de fuentes 

VIDEO 

 Es cierto tipo (.TTF) y de tipo abierto (.OTF) fuentes que ya están instalados en el equipo están listos 

para ser utilizado en MTC. Sin embargo, a diferencia de la mayoría de las otras aplicaciones de 

Windows, las fuentes no instaladas no necesitan ser preinstaladas en Windows con el fin de ser 

utilizado. Se pueden abrir directamente en MTC, tan fácilmente como la importación de otros archivos 

vectoriales. 

 Una fuente se puede abrir en MTC utilizando cualquiera de las siguientes maneras: 

Menu despegable para 

seleccionar la fuente 

Optciones para crear 

texto en  Bold y/o  

Italic 

Al marcar aqui muestra los posibles 

caractres  (glyphs) disponibles en cada 

tipo de letra. 

Al marcar aqui muestra el nombre 

de la Fuente en el menu despegable  

Scroll to increase/decrease 

size of text characters 

displayed. 

Actualiza la  lista de fuentes 

disponibles 

Abre  una Fuente no instalada  en 

windows ( Section 5.02). 

Haga click para abrir donde desea 

que el texo vaya en su Proyecto, se 

abrira una ventana ( Section 5.03). 
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 Haga clic en el icono Import TTF/ OTF  en la barra de herramientas de importación (Import 

Toolbar):  

 Haga clic en el icono Añadir fuente de TTF (Add Font from TTF File) archivo de la fuente (Font 

and Text) y ficha Texto de la barra principal (Main Bar):  

 Presione Ctrl + Mayús + H 

 Vaya a Archivo (File) > Importar (Import)> (True) / (Open Type Font File) Tipo de fuente de 

archivos. 

 Después de invocar uno de los métodos para abrir un archivo de tipo de letra, la siguiente ventana se 

abrirá:  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 Cuando MTC está cerrado, los nuevos tipos de letra que se abrieron durante ese período de sesiones (pero no 

instalados de forma permanente en MTC) serán automáticamente desinstaladas del MTC. No es para 

preocuparse! Una vez que una fuente en particular se utiliza para crear texto y se guarda el archivo, entonces 

esa misma fuente no necesita ser reabierto al abrir el mismo archivo. 

 Si desea abrir más de una fuente a la vez, mantenga pulsada la tecla Mayús o Ctrl, tal como lo haría cuando 

seleccionar varios archivos en otras aplicaciones de Windows. 

 Si desea seguir utilizando esa misma fuente o fuentes en MTC para otros proyectos, a continuación, compruebe 

la Instalación permanentemente (Install permanently inside make the cut) en la parte inferior de la ventana 

Abrir archivo de fuente (Open Font File ) 

 Para eliminar una fuente instalada permanentemente en MTC, selecciónelo y pulse la tecla Suprimir (Delete)del 

teclado o la derecha haga clic en el tipo de letra. Tenga en cuenta que esto sólo funciona con las fuentes que ha 

instalado desde el interior de la MTC, no fuentes instaladas en  Windows. 

 

 

5.03 Agregar Grupo Texto 

video 

 Hay dos formas de abrir la ventana Agregar Grupo texto (Add Text Group) para crear texto para su proyecto: 

Buscador para 

localizar el folder. 

Haga Click  en el 

nombre de la Fuente 

que  aparecera 
Click  en  

Open/Abrir 

Marque aqui para  

instalar  la  Fuente en 

MTC 
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 Haga clic en el Agregar un grupo de personajes (Add agroup of characters) en el texto y la ficha 

Fuentes (Text and Fonts)  

 Presiona  Ctrl+I   

 

 

 

 

 

 

 

 

 

 

 

 A medida que escribe el texto, sino que también aparecerá en la pantalla en la ubicación y la altura del Caret 

(consulte la Sección 4,01). Después de hacer clic en Aceptar (Accept) en la ventana anterior, el Grupo Agregar 

texto (Add text group) se cierra y el texto está listo para cualquier edición adicional deseado: 

 
 

 

 Tenga en cuenta que el texto también se puede importar a esta ventana, desde otras aplicaciones de Windows 

(Word, Outlook, Excel u otros programas de texto), utilizando el método normal copiar y pegar. Video 

 

Rotación de texto 

 Para crear texto vertical, seleccione Girar a la izquierda (Rotate Left) en la ventana Agregar Grupo Texto (Add 

Text Grup):  

 

 
 

 A continuación, seleccione el texto creado y rotar 90 grados (Ctrl + G):  

Alignment/Alinear 

Opcion  

 Ingresar el texto en la 

ventana Presione  Enter e 

iniciar las nuevas lineas. 

 Haga Click en  Reset 

para borrar el texto 

 

Haga Click en Accept/aceptar para 

ingresar  texto en screen 

 

Rotation/Rotacion  

opciones para rotar las 

letras para creación 

vertical. 

 

Vertical Spacing/ 

Espaciado vetical 

 

Opciones para Splitting/division por  

Lines/ineas, por  Glyphs/glifos, por  

Spaces/espacios, o No Splitting/sin 

division. 

 

Sólo una línea se escribe 

de este modo la 

alineación y la 

separación vertical no 

importa 

Seleccione Rotate Left en 

el menu en cada letra 

individual puede ser rotada  

900 hacia la izquierda. 
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La división  (Splitting) del texto 

 Hay cuatro opciones en el menú Splitting desplegable: 

 No División: Texto completo es tratado como una sola forma:   

 
 

 El desglose por líneas  (Split by lines): líneas individuales de texto serán formas distintas: 

 
 

 Dividida por espacios (Split by spaces): Espacios creados usando la barra espaciadora dividirá texto 

en formas distintas:  

 
 

 Dividir por Glifos (Splits by Glyphs): Cada carácter escrito será su propia forma individual: 

 

 
 

 

 Las diferentes opciones son útiles dependiendo de lo que el siguiente paso será planeado con el texto. Por 

ejemplo, si va a solapar los personajes para soldar juntos, entonces usted desea que el texto se dividirá por glifos. 

Despues de 

modificacion de 

texto oprima Accept 

 

Luego del 

texto 

presione Ctrl-

G para rotar 

 

1 Forma 

 

2 forma, cada linea 

de texto 

 

6 formas,una para 

cada palabra 

 

19 formas, una para cada character  

para ser  movido individualmente 

como desee 
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Pero como explorara las  otras funciones de diseño, usted aprenderá cómo las otras opciones serán mejores 

opciones. 

 Si por error selecciona la opción equivocada para el diseño de su intención, no se preocupe! Usted puede utilizar 

la  función de Split (Ctrl + P) en el texto después de cerrar la ventana (Add text Group) a Split por glifos. Entonces, 

si usted quiere Split por líneas o Split por espacios, a continuación, sólo seleccionara las agrupaciones, uno a la 

vez, y aplicara  la función Join (Ctrl + J)  para recrear la división que desea tener. Por ejemplo, marque seleccionar 

en  toda la línea superior del título que se dividió por Glifos y aplicar la herramienta de Ingreso ( Join Tool):  

 

                           

 

 

                                          

 

           

 

 

5.04 Creación de un Título Conectado Carta 

VIDEO 

Uso de las instrucciones de la Sección 5.03, escriba las letras de su título. En este ejemplo, usted deseará elegir Split 

por Glifos modo que las letras individuales se pueden mover a superponerse entre sí, según se desee:  

 

 

 

 Si se olvida de seleccionar Split por glifos, a continuación, seleccione el título y utilizar la función Split, en 

cualquiera de las 

siguiente formas: 

 Haga clic en el icono de Split, en la barra de herramientas de Magia (Magic Toolbar)  

 Presione Ctrl + P 

 Haga clic derecho en la pantalla y seleccione Forma Magia (Shape Magic) > Split desde el menú 

 Vaya a Editar  (Edit)> Forma Magia (Shape Magic) > Split. 

 Con las letras divididas, puede seleccionar uno o más y utilice las teclas de flecha izquierda y derecha para cambiar 

el espaciado entre las letras, la superposición de lo deseas. Es recomendable hacer un zoom sobre el texto para 

Marque-seleccione el top de cada línea de 

caracteres 

Aplique Join (Ctrl+J) 

 

Top  de linea  es ahora   el la forma  

Marque-seleccione el boton de la linea de los 

caracteres 

 

Aplique  Join (Ctrl+J) 

 

 

El boton de la linea ahora esta en la 

figura 
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obtener una visión más precisa del  posicionamiento actual de las letras. También es posible que desee comprobar 

el texto con y sin el relleno encendido (que se puede cambiar en la ficha Mat virtual). 

 También puede solaparse con rapidez cartas seleccionando a todos, manteniendo pulsada la tecla Ctrl, y luego 

arrastrando el medio derecha del área de delimitación hacia la izquierda. Tenga en cuenta que debe estar en 

modo de cambio de tamaño para que esto funcione (consulte Sección 4.13):  

 
 

 

 

 Cuando esté satisfecho con la superposición, seleccione todas las letras y luego aplicar la función de soldadura 

(Weld) utilizando uno de los siguientes: 

 Haga clic en el icono de soldadura (Weld) en la barra de herramientas de Magia (Magic Toolbar)  

 Presione Ctrl + W 

 Haga clic derecho en la pantalla y seleccione Forma Magia (Shape Magic)> Weld en el menú 

 Vaya a Editar (Edit)> Forma Magia (Shape magic)> Weld.  

 

 Para crear un esquema (outline) / sombra para los títulos y otras formas o si usted necesita mas gruesa la  fuente 

que resulta ser demasiado delgada para el corte, consulte la Sección 8.05. 

 

 

 

5.05 Incorporación Dingbat Formas en un Título 

video 

 Una forma rápida para incorporar una forma en un título unido es utilizar cualquiera de miles de fuentes dingbat 

disponibles desde Internet de forma gratuita. En este ejemplo, una fuente libre llamado  1 Bean sprout DNA se 

está utilizando para el título y la fuente dingbat, Wingdings, será utilizado para la forma. 

 Utilización de los pasos en la Sección 5.03, crear el título, con la opción Dividir por Glifos (Split by Glyphs) 

seleccionado:  

 

 Marque seleccionar al lado izquierdo y arrastra lejos de la derecha para crear un espacio para una forma: 

 

 En el texto y la ficha Fuentes (Text and Fonts), seleccione la fuente, Wingdings, en el menú desplegable. 

Desplácese hasta localizar la imagen de  Tijeras. En lugar de entrar en la ventana Agregar Grupo de texto (Add 

Tenga presionada la Tecla  Ctrl y arrastrar 

este icono de la flecha doble medio a la 

izquierda para disminuir el espaciado 

Este seguro  que el 

texto cambia de 

tamano/ Resizing 

mode. 
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text group), puede hacer doble clic en la imagen que quiere usar y será añadido a la ubicación de la Caret (consulte 

la Sección 4.01):  

  

 

      

 

 

 

 

 Cambiar el tamaño y la forma de organizar el dingbat, si lo deseas. También se superponen las letras entre sí, 

según se desee. A continuación, aplicar la herramienta de soldadura (Ctrl + W).  

             

 Tenga en cuenta que las fuentes dingbat no son las únicas formas que pueden soldarse a las cartas. Cualquier 

forma importado o creado dentro de MTC se puede utilizar! 

 

5.06 Títulos de soldadura en imaginativas maneras 

 Algunas fuentes no funcionan bien con la superposición tradicional de las letras a unir en una sola pieza para el 

corte. Por ejemplo, tomemos un caso extremo con la fuente Arial y el nombre, “Billy”. Nota lo que sucede cuando 

se toma el trabajo y luego superponer las letras de esta fuente en particular:  

                                             
 

 

 La mayoría de los diseñadores empieza a buscar un tipo de letra diferente ... una con ligaduras (extensores) que 

conectan fácilmente al cartas a los unos a los otros. Sin embargo, muchas fuentes con ligaduras son fuentes de 

script y no pueden transmitir la deseada. Entonces, ¿hay una solución? Definitivamente! Buscar objetos que 

Seleccione 

fuente 
Doble click  en la imagen que 

desea y sera inseratda en la 

ubicacion del cursor/ Caret. 

Si desea uede 

hacer imagenes 

mas grandes 

aqui 

Algunas fuentes dingbat aparecerán, como imágenes, en la lista 

desplegable de todas las fuentes. Por lo tanto, desactive Mostrar la 

cara, /Show face según sea necesario. 

Tipo de letras  Superpocision de 

letras 

 Resultado no deseado 
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pueden ser utilizados para conectar las letras! Un básico rectángulo delgado es una solución fácil. Sólo alinearlo 

lo largo de la parte inferior de la letras y unir.  

  

 Sin embargo, los objetos a utilizar como base no tienen que ser tan básico! Busque objetos que se unirá a un 
tema! Aquí  algunos ejemplos:  

                  

 

5.07 Texto de montaje en el exterior de una forma 

Cómo ajustar el texto alrededor de un círculo 

 Los objetos Ajustar a la función de Ruta (wrap objects to path) se pueden utilizar para ajustar el texto a la parte 

exterior de una forma. En este ejemplo la las palabras “feliz cumpleaños” serán envueltos alrededor de un círculo 

tres veces. 

 El primer paso es escribir el texto, asegurándose de que está seleccionada la opción Dividir por glifos. Si se olvida, 

a continuación, utilizar la función Split para romper el texto en letras individuales:  

 

 

 El siguiente paso es crear el círculo. Puede importar un círculo de Formas básicas  (Basic Shapes) y cambiar su 

tamaño a lo que parece cerca de encajar las letras si la letra se repite tres veces. No es necesario ser exactos ya 

que tendrá algunos ajustes para retocar esto! En el peor de los casos, usted será capaz de cancelar el proceso y 

cambiar el tamaño del círculo más grande o menor, según sea necesario:  

 

 
 

 En la actualidad existe una sola manera de activar los objetos activando la función (Wrap objects to Path). 

Seleccione lo que quiere  envolver (en este caso, el texto) y mantenga presionada la tecla Ctrl mientras 

arrastra el texto en la forma. Cuando vea  el cambio del cursor  para liberar el botón del ratón y la 

siguiente ventana se abrirá:  
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 Las letras no encaja. Pero no se preocupe! Comience a ajustar la configuración:  

 

 
 

 

 

 

 

 

 Para terminar con un diseño perfectamente arreglado, trabajar con la configuración en este orden: 

 Repeat Count: Si usted quiere un número determinado de repeticiones, entrar en él. 

 • Separación (Spacing) : Esta es la distancia entre cada una de las repeticiones. En nuestro 

ejemplo, es el espacio situado entre el final de “cumpleaños” y el inicio de la próxima “feliz”. Tenga 

en cuenta que esto no puede ser retenido como el ajuste de espacio (space settings) para obtener 

todas las repeticiones visibles. 

 Espacio (Space): Esta es la distancia entre las formas individuales que componen el diseño. En nuestro 

ejemplo, es el espacio entre todas las letras que componen el “feliz cumpleaños”. 

 Vert. Align: Esto indica lo cerca el texto original se coloca en el círculo. Al 100%, el texto solo toca el 

círculo pero el ajuste se puede aumentar para mover el texto hacia el exterior, lejos del centro del 

círculo o disminuido para mover el texto hacia adentro, hacia el centro. 

 Offset: Esto hará girar el texto alrededor del exterior, si se desea, de modo que el texto comienza en 

una ubicación círculo a lo largo de la parte exterior del círculo. 

 En los ajustes que arrastra con el botón del ratón, recuerde utilizar las teclas de la derecha y flecha izquierda 

sobre el  Teclado para los cambios más pequeños en los ajustes. 

 Haga clic en Aceptar (Accept) y luego eliminar el círculo:  

 

 
 

Ajuste del texto A mitad de camino en la parte superior y la parte inferior de un círculo 

 En este ejemplo, el texto necesita ser dividido de manera que las envolturas primera media alrededor de la mitad 

superior de un círculo y el segundo medio envuelve la otra manera alrededor de la parte inferior. 

Nota  Aqui lost res 

Happy Birthday’s  no 

encajan.   

Maeque  Repeat    

Ingrese  2 para el numero de 

repeticiones, en total seran  

3.  

Ingrese el espacio 

deseado Spacing. 

Click en  Accept 

cuando termine. 

Vert.  Align mueve el texto 

hacia adentro, hacia el centro 

de la shap 

e or away.   
Space mueve los 

caracteres individuales 

más cerca o más lejos. 

Offset es utilizado para mover 

la ubicación inicial del texto. 

Ahora los tres están 

uniformes  el círculo. 



106 
 

 Escriba el texto, de nuevo asegurándose de que esté seleccionado Dividir por glifos (Split by glyphs). En este 

ejemplo, una dirección se utilizará:  

 
 Carpa-seleccionar la segunda mitad de la dirección y aplique tanto a las funciones flip Espejo (mirror and flip) y 

Haga clic en Aceptar cuando termine.  

 

 

 

 

          

 Dibuja un círculo y seleccione el primer texto. Mantenga pulsada la tecla Ctrl mientras arrastra el texto en el 

círculo, soltar el botón del ratón primero. Los objetos Abrir la ventana Wrap Objects to Path:  

  

 

                                                
 Esta vez, deje el cuadro Repetir sin marcar. Entonces comenzar a ajustar la compensación (offset) para que el 

texto se desplaza a la mitad superior del círculo. Es una buena idea escribir el Espacio (Space) y Vert. Alinear 

(Vert. Align) configuración para que similares valores se pueden utilizar cuando se hace la segunda mitad del 

texto: 

 

 

 

  

 

 

 

 

 

 

 

 

Luego de aplicar efecto espejo Mirror (Ctrl+M) 

en la  segunda mitad del texto 

Despues de aplicar Vuelta Flip (Ctrl+F) en la 

segunda mitad del texto 

El texto  alineado  con el 

boton Offset  si desea ajustar 

y mover el texto al top 

No seleccione  Repeat  por 

para este  caso 

Texto está separada y se 

coloca a lo largo de media 

superior del círculo. 

Click en Accept 

cuando termine. 

Ajuste las propiedades y 

escribe abajo Vert. Align y 

Space ajustes. 
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 Después de hacer clic en Aceptar (accept), se selecciona la segunda mitad del texto y, una vez más, se traslada 

al centro del círculo mientras mantiene la tecla Ctrl:  

 
 

 Ajuste el Vert. Alinear y la configuración del espacio para que coincida con lo que se utilizó para la mitad superior. 

A continuación, cambie el Offset para alinear segunda mitad del texto a lo largo de la mitad inferior del círculo. 

                                                     
 

 Haga clic en Aceptar cuando haya terminado. Añadir otras formas, si lo deseas. En este caso la compañía se 

añadió a 

el centro 

 

 Los objetos Ajustar a la trayectoria puede ser utilizado para otras aplicaciones de diseño, uno de los cuales se 

muestra en la Sección 8.08. 

 

5.08 Texto de montaje de Caminos 

 

 Una función diferente, el Bézier Warp, también se puede utilizar para ajustar el texto a un círculo o para ajustar 

el texto a un diseño. 

Segunda mitad del 

texto aparece con la 

orientación correcta 

para la mitad inferior 

del círculo. 

Nota los ajustes de  alinecion 

vertical  Vert. Align y   

Espacio /Space son iguales 

para ser usados en la mitad 

del  top half. 

Segunda mitad del texto está 

alineado a lo largo de la parte 

inferior del círculo. 

Click en  Accept. 
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 Al igual que antes, escriba las letras que desea adaptarse a un círculo usando el método descrito en la Sección 

5.03. El texto creado en la Sección 5.04 volverá a ser utilizado. Tenga en cuenta que las letras se puede soldar o 

no. Y si no soldada, 

las letras se pueden dividir por Glifos (Split by glyphs) o no:  

 

 Con el título seleccionado, abra la ventana de Bézier Warp usando una de las siguientes maneras: 

 • Haga clic en el icono de Bézier Warp en la barra de herramientas de Magic toolbar  

 Presione Ctrl + T 

 Haga clic derecho en la pantalla y seleccione Forma Magia (Shape magic)> Bézier Warp desde el 

menú 

 • Vaya a Editar (edit)> Forma Magia (shape magic)> Bézier Warp. 

 

 

Cerrar la trayectoria  en Bézier Warp 

 En el primer ejemplo, el texto está en condiciones de una forma circular y se elige la opción de tamaño 

automático (auto size). Tenga en cuenta que la Opción Tamaño Manual (Manual size) también podría haber sido 

utilizado y se seleccionará en el ejemplo después de éste: 

 

 

 
 

 

 

Abrir la trayectoria en Bézier Warp 

Despláce estos dos 

ajustes a 25 "para 

ajustar el texto a mitad 

de camino alrededor 

del círculo. 

Click en Apply 

despues que 

termine 

Texto inicialmente ser 

envuelto alrededor de 

toda círculo. Pero 

después de ajustar Size 

& Position,el  texto 

aparecera asi. 

Opcion para ajutes  

comunes 

Opcion para  zoom 

imagen previa 
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 Para utilizar un trazado abierto, la opción cerrar  curva (Close curve) no está marcada, por lo que la trayectoria 

es una línea en lugar de un círculo.A continuación, se añaden más puntos y los puntos son arrastradas para crear 

la ruta deseada. Utilice el zoom para establecer si usted no puede ver toda su texto. 

  

 

  

 
 

 En este ejemplo, se seleccionó Manual Tamaño pero también se puede tratar Tamaño Auto nuevo, también! El 

Bézier Warp  está a punto de experimentar y divertirse con él! Si te gusta ciertos ajustes, recuerde que la opción 

para guardar la configuración (Presets) está disponible. 

5.09 Creación de superposiciones Título y soldadura Texto para Marcos 

 • Creación de un marco para la soldadura de una sola letra o imágenes es muy fácil. El uso de los pasos 

en la Sección 5.03, crear un título. La fuente elegida para este ejemplo es Times New Roman. También, Dividir 

Por Glifos se selecciona de manera que letras individuales pueden cambiar de tamaño, si es necesario, para 

el marco: 

 

 Haga clic en el icono de Formas básicas en Importar (Import Basic Shapes) en la barra de herramientas de 

importación (Import Toolbar)  y seleccione Polígonos (Polygons). Desplácese hasta localizar en Forma de 

rectángulo y haga doble clic para agregar a la pantalla: 

Click en Applycuando 

termine. 

Seleccione ajuste  Smooth para  

realizer la curva mas redonda 

Texto cae lo 

largo del 

camino para 

requisitos 

particulares 

El Patron  se 

puede modificar 

arrastrando 

verde, azul y 

rojo. maneja 

puntos 

Aumente los puntos/ 

Points para adherir mas 

curvas 

No hacer clic en  Close Curve para  

crear un patrón abierto 

Chequee  Manual Size. 

Juste  Width/ancho y  Height/alto 

para abrir patron. 

Zoom outsi es necesario 

Cambie  Vert. Align: del Top para 

Middle para igualar la parte superior e 

inferior de las letras 
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 En la pestaña Configuración Mat virtual en la barra principal/ Main Bar (consulte la Sección 4.04), asegúrese 

de que tiene el modo de esquema/outline seleccionado de modo que usted será capaz de ver el rectángulo y 

las letras claramente. Además, cambie a Sin rotura bajo Snap Posición de modo que usted puede cambiar el 

tamaño del rectángulo y las letras con precisión. 

 También será más fácil seleccionar letras individuales si el rectángulo es en su propia capa y por debajo del 

texto. Con 

sólo el rectángulo seleccionado, haga clic en el icono de Selección a Nueva Capa (en la parte inferior de las 

capas ) y a continuación, mover la capa rectángulo de forma que está por debajo de la capa de texto: 

 

                
 

 Cambiar el tamaño del rectángulo para ser ancho y delgado para que las letras se extienden un poco por encima 

y por debajo de ella. A continuación, cambiar el tamaño y re-espaciales letras individuales, según sea necesario, 

para solapar el rectángulo. Recuerde que para hacer un zoom para una mirada más de cerca a la superposición: 

 

       
 

 Si la herramienta habitual de soldadura se aplicaron en este punto, las letras desaparecerían, con la excepción 

de las pequeñas superposiciones en la parte superior y la parte inferior: 

 
 

 Por lo tanto, un tipo alternativo de soldadura debe ser aplicada. El uso es parte de la Boole Únete opciones 

(Consulte la Sección 8.07 para más detalles sobre Boolean Join). Pero antes de que  puede ser utilizado, debe 

reducir el número de formas individuales a sólo dos: las letras (como una sola forma) y el rectángulo. Para 

El rectángulo seleccionado se mueve a 

su propia capa, haga clic en Selección de 

Nuevo icono Capa/ Selection  New 

Layer icon. 

A continuación, la capa con el 

rectángulo se mueve por debajo de la 

capa con el texto haciendo clic en la 

flecha hacia abajo en esa capa 

Ahora las dos formas se encuentran 

en capas separadas con el texto 

encima del rectángulo 

zoom/Acercar para 

verificar la 

superposición y 

ajuste letras 

individuales, según 

sea necesario 
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combinar las letras para ser tratados en una sola forma, haga clic en la vista previa de la capa de texto en la 

barra de capa/ Layer Bar y luego aplicar la función, que se puede acceder en cualquiera de las siguientes formas 

de incorporación: 

o Haga clic en el icono en la barra  Magia/Magic toolbar  

o • Presione Ctrl + J 

o Haga clic derecho en la pantalla y seleccione Forma Magia/Shape magic> Ingreso desde el menú 

o Ir a Editar/Edit> Forma Magia/Shape Magic> Unirse/Join. 

 Ahora carpa-seleccionar tanto el rectángulo y las letras y que aparezca el menú de Boolean Join, utilizando 

cualquiera de los siguientes: 

o Haga clic en el icono de Boolean Join Únete a la barra de herramientas de Magia/Magic Toolbar 

o Presione Ctrl + T 

o Haga clic derecho en la pantalla y seleccione Forma Magia/Shape Magic> Boolean  Join Ingreso 

desde el menú 

o Ir a Editar/Edit> Forma Magia/ Shape Magic> Boolean Join. 

 El siguiente menú aparecerá y al mover el ratón sobre las diferentes opciones, verá su cambio de imagen en 

la pantalla. La opción llamada Diferencia B-A muestra el contorno del rectángulo desapareciendo donde las 

letras se superponen, que es lo que quieres en este caso: 

                  
 

 Ahora bien, esta soldadura resultante funcionaría bien para una superposición en la parte negativa de la 
imagen es lo que usted desea conservar. Para tener un marco real, añadir un rectángulo a la parte exterior y 
luego seleccionar todo, aplicar Stack/ Ctrl + S (que centrar las dos formas) y realice una preforma Join (Ctrl 
+ J). Estos son los dos resultados: 

 
 

 

5.10 Estencil de letras/Stenciling letters 

 

 Al crear una plantilla, que desea mantener el “residuo” o “negativo” de un corte. Al utilizar fuentes regulares, 

como Arial, algunas de las letras, como una “B”, “a” y “e”, no va a funcionar porque no tienen caminos interiores 

llamados niño formas. Esas formas niño no están conectados a la porción de los residuos del material y se 

perderán de la plantilla como se muestra a continuación. Las flechas rojas indican el niño formas dentro de las 

formas de los padres de las letras “B”, “a” y “e”: 

Haga clic en el menú desplegable para 

seleccionar una de las cinco opciones. 

Cuando la imagen se muestra la soldadura 

que desea, haga clic en Apply.  

Superposición 

Título 

Titulo pegado  al marco  

https://vimeo.com/60854970
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 Para evitar esto, un procedimiento llamado estarcir se puede utilizar para conectar la zona exterior de las cartas a 

los niños formas, esencialmente eliminarlos. Si bien hay varias maneras de hacer esto en el MTC, la más sencilla es 

probablemente utilizando la herramienta Borrador. En este método de borrado de una línea recta, con una 

anchura preestablecida, los resultados en la forma interior está conectado al exterior de la carta. 

 La herramienta Borrador/Eraser Tool es el icono octavo  en la barra de herramientas Modo de nodo/ Node 

Mode  y puede activarse abriendo primero la barra de herramientas Nodo Editar/ Node Edit toolbar  (o 

pulsando W) y haciendo clic en el icono o pulsando F8. 

 Zoom en estrecha de las letras de modo que usted será capaz de ver exactamente donde tiene que borrar. 

Cuando se activa la herramienta Borrador, los siguientes ajustes aparecerán en la parte superior de la pantalla: 

                                                                                           
 El tamaño de entrar normalmente se relacionará con la altura y el estilo de las letras está estarcir. En este 

ejemplo, la palabra “Baterías” se escribe a una altura de 1 pulgada. El tamaño del borrador se ha fijado en 1,5 
mm, pero podría ser mayor o menor dependiendo de su preferencia personal. 

 Mantenga pulsada la tecla Ctrl y el botón izquierdo del ratón y arrastre el ratón en una línea recta en la que desea 
borrar. Una línea roja se dibuja: 

 

 

 

 
 
 
 
 

 Suelte la tecla Ctrl y el botón izquierdo del ratón. La “B” tendrá ahora una brecha a través de la letra: 

 

 Repita el proceso con las otras cartas que contienen niño formas. Si en algún momento algo va mal, utilice la 

tecla Deshacer en la parte superior de la pantalla para retroceder un paso. 

 Ahora cuando se corta las letras para crear una plantilla, todas las partes de las letras permanecen 

conectados: 

Sin check 
Introduzca el tamaño/Size (grosor) 

del borrador que desea utilizar. 

Las pequeñas líneas 

horizontales en la parte 

superior e inferior de la 

línea de borrado en rojo 

indican que la línea es 

perfectamente vertical. 

Mantenga tecla Ctrl y arrastre el ratón hacia abajo, por el centro de la "B" 
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 Tenga en cuenta que las líneas borradas no siempre tienen que ser vertical. Por ejemplo, con el tipo de letra 

Cooper Negro, la “O” s están en ángulo, por lo que es posible que desee ángulo de las líneas de borrado de 

la misma manera: 

 

   

 

 

5.11 Open Path Fonts (OPF)/Abrir  Patron de fuentes 

 

 Además de TTF y OTF, un tercer tipo de fuente, el camino abierto Fuente (.opf) se puede abrir en MTC. Esta 

fuente se compone de sólo líneas / curvas individuales: 

 

 Estas fuentes son útiles cuando se utiliza un lápiz o herramienta de grabado en su cortador o para el diseño de 

títulos individuales de diamantes de imitación de línea (Consulte la Sección 8.12 para obtener más información 

sobre la función Rhinestone en MTC.) 

 

 En la actualidad, este tipo de fuente sólo funciona en hacer el corte y no se instala en Windows para su uso en otras 

aplicaciones. Los hay gratuitos para descargar aquí: 

http://www.iloveknk.com/Support/Software/Make-The-Cut/Open-Path-Fonts/ 
 Usted puede comprar Fuentes trazado abierto (también llamados Thin Fuentes) de  www.letteringdelights.com y 

desde  www.onelinefonts.com para utilizar en MTC. Tenga en cuenta que estos también vienen con los 

equivalentes TTF, que no son líneas y curvas individuales reales, pero siguen siendo delgada.  

 

 

 

 

 

 

 

Completo  stencil 

Vertical Stencil Colocación de letreros en ángulo en las cartas en ángulo 

http://www.iloveknk.com/Support/Software/Make-The-Cut/Open-Path-Fonts/
http://www.letteringdelights.com/
http://www.onelinefonts.com/
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6.Seguimiento/Tracing 
 

6.01 Raster versus Vector 
 

 Todos los gráficos son o raster o vector y no hay tercer tipo. Aunque a menudo se puede decir por el formato de 

archivo, incluso eso no es siempre una buena manera de saber a ciencia cierta. Por ejemplo, un archivo PDF se 

puede hacer de cualquiera de las imágenes de mapa de bits o imágenes vectoriales y algunos de PDF contendrán 

ambos tipos. 

 Es posible que no pueda contar, a primera vista, si una imagen es una trama o un vector. Por ejemplo, esta 

captura de pantalla muestra la misma imagen en ambos formatos: 

 

 

                                                                               Raster                     Vector 

 Casi todo el mundo hoy en día tiene una cámara digital y, por lo menos, ha oído el término “mega-píxeles.” 
Un píxel es un cuadrado que es de color negro, blanco o de color. Las fotografías se componen de millones 
de estos píxeles para crear la imagen que ves. Si te acercas lo suficiente sobre cualquier imagen de trama, se 
puede ver estos pequeños píxeles. Pero cuando uno se acerca en estrecha en la misma zona en la versión 
del vector, en su lugar verá líneas y curvas, y no cuadrados / pixels: 

  

 

 Una imagen del vector no está formada por píxeles. En lugar de ello, un vector es como un dot-la-connect 
puzzle en el que pequeños puntos (llamados nodos o puntos) están conectados entre sí con sendas (ya sean 
líneas rectas o curvas). Troqueladoras digitales necesitan esos caminos para que que puedan comunicarse a 
la cortadora en la hoja debe viajar con el fin de hacer los cortes que quieras ... como una especie de hoja de 
ruta. En MTC, los nodos se ven así: 

 

 Como se mencionó anteriormente, a menudo se puede saber si un archivo es una trama o un vector basado 
en el formato de archivo. Aquí hay algunas pautas: 

Raster:  BMP, JPG, TIF, PNG, GIF     Vector:  AI, EPS, WMF, DXF, SVG      Either:  PDF, sometimes EPS & WMF 

Vector Raster 
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 Para convertir una trama en un vector, MTC ofrece dos opciones: Traza Pixel/ Pixel Trace y traza Manual/ 
Manual Trace. Debido a que la función de rastreo de píxeles/ Pixel Trace en la MTC es tan rápido y potente, 
siempre vale la pena probarlo primero. La única situación en la que puede que no sea capaz de proporcionar 
los resultados que necesita son (1) la imagen es muy pequeña o tiene una resolución muy pobre o (2) la 
imagen tiene poco contraste entre una parte y otra. Por ejemplo, imagine un perro marrón miente en la 
alfombra marrón. ¿Cómo sería el software sabe qué parte es el perro y qué parte es la alfombra? Por lo 
tanto es posible que necesite trazar manualmente algunas imágenes, por lo que ambas funciones están 
cubiertos, en detalle, en este capítulo 

 
6.02 Buscando imagenes faciles para trazar/Finding Easy Images to Trace 

 

 ¿Qué califica como una imagen fácil? La respuesta obvia es “una imagen que le da los resultados que usted 
quiere!” Pero los que son nuevos en el proceso de vectorización no siempre se dan cuenta de que las imágenes 
van a ser fácil y cuáles no lo son. Tenga en cuenta que usted no debe ser desalentado de tratar de rastrear 
cualquier cosa. Pero cuando usted está aprendiendo el proceso, trabajando con imágenes fáciles hará que la 
etapa de aprendizaje vaya más suave. Así que aquí están algunas pautas en la selección de las imágenes: 

o Imágenes en blanco y Negro  son más fáciles de vectorizar imágenes coloreadas 

o Imágenes coloreadas con colores planos son más fáciles de identificar que los que tienen colores 
saturados 

o Grandes, imágenes de alta resolución son más fáciles de identificar que diminutas imágenes de baja 
resolución 

o Las imágenes con pequeños detalles serán más difíciles de rastrear que las imágenes más simples 
con menos detalles 

o Las fotografías suelen ser los más difíciles de rastrear, sobre todo cuando algunos de los colores se 
mezclan (como el perro marrón en la alfombra marrón, mencionado anteriormente). 

• Para su uso personal, hay muchas imágenes que se pueden encontrar en Internet. Utilice Google para buscar y 
encontrar las imágenes basándose en palabras clave. Google también tiene filtros en la parte superior de la 
ventana (en Buscadores) para limitar su búsqueda a los dibujos en blanco y negro, así como a clipart o línea. 
Utilice estos filtros! 

 
6.03 Pixel Trace 
 

Intro:  Tracing for a PNC:     Trace and Edit Example:   

 Para comenzar el proceso de seguimiento de píxeles/ Pixel Trace, se recomienda que primero haga doble clic 

cerca de la parte superior izquierda de la Mat virtual. Esto plantar la Caret en ese lugar y, a medida que juega 

con los valores de rastreo, podrás ver los resultados de los ajustes corrientes seleccionado. 

 El siguiente paso es importar una imagen de trama. Se puede acceder a la imagen abierta para la ventana 

Seguimiento en cualquiera de las siguientes maneras: 

• Haga clic en el icono de seguimiento de píxeles/ Pixel Trace en la barra de herramientas de importación/ 

Import Toolbar  

• Presione Ctrl-Shift-T 

https://vimeo.com/41790879
https://vimeo.com/60006133
https://vimeo.com/60872747
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• Vaya a Archivo> Importar> Traza Pixel / File>Import>Pixel Trace 

• Arrastrar y soltar una imagen de trama en una instancia en ejecución de MTC. 

 Cuando se abra la ventana, hay tres opciones para la importación de su imagen de trama: 

 

 

 

 

 
• Opción 1: Importar de un archivo que ya está en su computadora, CD, una unidad flash, 

disco duro externo, etc. 

• Opción 2: Importar una imagen utilizando un escáner conectado a su ordenador 

• Opción 3: Copiar / pegar una imagen desde el Explorador de Windows o desde Internet 

• La imagen se abrirá en la ventana Seguimiento de píxeles/ Pixel Trace. Tenga en cuenta la siguiente información 

en esta ventana: 

  

 

  

 

 

 

 

 

 

 

 

  

 

• Cuando la experimentación con los distintos métodos de rastreo, recuerde lo siguiente: 

Opcion 1: Buscar la 

imagen en el foder.Haga  

Click en la  imagen y 

ennombre de archive/ 

File Name aparecera. 

Haga Click en Open para 

importer la imagen. 

Imagen previa 

Opcion 2: Scan imagen 

en  MTC  

Opcion 3: Pegue de 

Windows Clipboard 

Click en Open  

Las líneas azules indican las líneas de 

trazo. El verde es el relleno que se 

mostrará si se acepta la trazo. 

Información sobre la imagen 

original: tamaño, resolución, etc. 

Visualization Settings/ Ajustes de visualización: ajuste por sólo preferencia personal. 

Estos ajustes no afectan a la traza  resultados  

Información sobre el trazado: # de nodos, 

tamaño, número de caminos, etc. 

Import cuando este listo o Cancel 

si  no desea el proceso 

Despes de cada  

cambio de ajustes, 

haga  click en  Apply 

Changes para mirar su 

Nuevo trazo. 

Opciones de 

seguimiento y 

ajustes (cubierto en 

detalle más 

adelante) 

En la pantalla 

aparecerá Vista 

previa en la 

ubicación actual 

del Caret 
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• Cada vez que se cambia un ajuste, es necesario hacer clic en el botón Aplicar cambios / Apply Changes 

para ver la vista previa actualizada. 

• Antes de comenzar el proceso de seguimiento de píxeles/ Pixel Trace, la posición de su Caret en la parte 

superior izquierda de la pantalla. A continuación, verá también una vista previa del trazado en la pantalla 

principal como probar diferentes ajustes en la ventana de seguimiento de píxeles/ Pixel Trace. Puede que 

tenga que mover la ventana Seguimiento Pixel para ver este trazado. 

• Experimente! Recuerde que usted puede cambiar la configuración y actualizar los resultados sin hacer 

ningún compromiso. Tome notas cuando se descubre algo nuevo acerca de la localización! 

• Una combinación de métodos de rastreo de vez en cuando podría producir los mejores resultados. Cada 

vez que haga clic en Importar, se le dará la oportunidad de colocar la traza actual en la ventana principal, 

pero luego volver y probar diferentes configuraciones o diferentes métodos. Sea aventurero en su 

trazado! Siempre se puede volver atrás y borrar partes de una traza no te gusta o duplicar trazados que 

no son tan perfectos como quizás uno de los otros. Capítulo 7 contiene métodos para la edición de sus 

trazados, también. 

• Para imprimir y cortar aplicaciones, marque el cuadro Ruta Texturizar/ Texturize Path para que el gráfico 

de la trama original también se importará con la traza. También puede marcar el cuadro Ruta/ Blackout 

Path para que se importará sólo la línea de trazo más externa. 

• Si su gráfico importado tiene muchas imágenes y sólo desea trazar una, o si sólo desea trazar una parte 

de una imagen, mantenga pulsada la tecla Ctrl y carpa-seleccionar la parte que desee: 

•  

 
• Si decide cancelar su selección, simplemente mantenga presionada la tecla Ctrl y clic izquierdo una vez en 

cualquier parte de la vista previa. 

 Si usted elige utilizar la función de escala para cambiar el tamaño de la imagen antes de importar, a 

continuación, tenga en cuenta que a medida que se deslizando la barra, aparecerá el nuevo tamaño de la 

imagen: 

 

Sólo se pueden remontar 

estas dos imágenes. 
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6.03.1 Pixel Trace Method 

 

• El seguimiento de píxel/ Pixel Trace es una vectorización monocromática. En la ventana de seguimiento Pixel, 

aparecerán líneas traza azules y verdes rellenos, independientemente de los colores de la imagen original. Estos 

son los valores predeterminados y se pueden cambiar por ir a Ver> colores predeterminados/ View>Default 

Colors. Después de la localización, los trazados en la ventana principal se colorearán según el color Mat virtual 

seleccionado. Se pueden cambiar a otros colores al igual que cualquier otra forma. 

 El ajuste de rangos 1-255 Umbral. Disminuya este valor para agregar más distinción entre colores y aumentar el 

número de trayectorias individuales reconocidos y trazados. Aumentar para disminuir la distinción entre los 

colores y disminuir el número de trayectorias individuales reconocidos y trazadas. En el extremo de 255, usted 

no tendrá nada más que una caja alrededor del exterior de la imagen que se trazó. 

 Las siguientes imágenes muestran la misma imagen con diferentes valores de umbral utilizados y la traza 

resultante cuando se importen en la pantalla: 

Imagen  en Pixel Trace: 

 

 

 

 

Resultado del trazo después de la importación:: 

     

 

 

A medida que el cursor se 

mueve en el entorno de 

escala, la ventana emergente 

muestra nuevas dimensiones 

de la imagen. 

Threshold: 1 

Pierde detalle 

  

  

Threshold: 75 

Detalle perdido en ala 

Threshold: 127 

Pierde  Alas 

  

Threshold: 250 

Detalle perdido en garras 

 

Threshold: 255 

Solo trazo del borde 

http://vimeo.com/user8812763/review/31968655/ada7899b50
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• Como se muestra en el ejemplo anterior, la mayoría de los detalles se obtuvo con el umbral más bajo/ Threshold. 

Por lo general, esto no es necesariamente lo que usted desea en su trazado. El punto es experimentar libremente 

en toda la gama de ajustes de umbral/ Threshold, para ver los efectos de cambiar este ajuste importante. Al 

mismo tiempo, probar las otras opciones disponibles. 

 Elegir Por luminancia/ By Luminance frente Por Average puede dar resultados diferentes. Comience con Por 

luminancia/ By Luminance y cambiar si usted está teniendo problemas para conseguir un buen rastro. Consulte 

el Apéndice B Terminología para las definiciones de estos dos términos. 

 El ajuste Despeck filtrará pequeños senderos que usted puede no querer ser rastreado. Aumentar para eliminar 

estos pequeños caminos de su trazado. Sin embargo, si usted ve las piezas que desaparecen lo que necesitas, y 

luego disminuir. También puede aplicar una pausa a su trazado/ Break y luego eliminar manualmente las partes 

que no desee. 

 

 

 

 

 
 

• El ajuste Remuestrear/ Resample Image la imagen se puede utilizar para aumentar o disminuir la fuerza se traza 

una imagen. Bajarla a disminuir el número de nodos y “aflojar” el ajuste del rastreo. Aumentar para aumentar los 

nodos y crear un ajuste más preciso. Esto también se puede utilizar para suavizar los trazos angulares, como se 

muestra en esta traza de un gato: 

 

 

 

 
 

 

 

 

 
 

• El ajuste de color de fondo/ Background Color  se vuelve útil cuando hay un canal transparente o alfa en la 

imagen que está trazando (tal como se encuentra en algunos archivos PNG y GIF). El color de fondo será definir 

los píxeles semitransparentes mezclándolos con el color de fondo que usted seleccione. Aquí está una foto de un 

coche blanco que ilustra esta característica: 

 

 

 

Despeck set to 0: 

Motas diminutas en las garras del 

búho 

Despeck set to 15: 

Motas diminutas eliminan 

Muy 

angular 
Sigue 

angular 

Mas suave 

Suave 

Resample Image: x1.0 

Imagen del gato muy angular 

Resample Image: x0.75 

Mejora el gato, pero la 

cabeza es muy angular 

Resample Image: x0.5 

Todas las parte son mas 

suaves ahora 
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 Cuando importados en la ventana Seguimiento de píxeles, con la configuración predeterminada en su lugar, 

tenga en cuenta las partes de la imagen que se trazó con el fondo blanco por defecto seleccionado: 

 
 

• A continuación, haga clic en el cuadro Color de fondo/ Background Color y se abrirá una ventana. Seleccionar un 

color diferente, por ejemplo, rojo: 

 

 

• Las partes de la imagen que se remonta cambios: 

 

 

• Esto se puede utilizar para identificar y rastrear diferentes partes de una imagen. Sin embargo, con el nuevo Alfa, 
Paleta, y las opciones de color disponibles, esta función puede no siempre ser algo que usted necesita. 

 

Valores por defecto 

Background Color por 

defecto es blanco 

Haga click en cualquier 

color de la paleta 

Click en OK 

Cambiando el fondo de 

color/ Background Color a 

rojo, es el unico cambio 

hecho 
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6.03.2 Alpha Trace Method  

   

• Utilice el Alfa traza para archivos PNG con fondo transparente (canales alfa). Para cambiar al método de Alfa 

Trace, haga clic en la pestaña denominada Alfa y aparecerá lo siguiente: 

                                                       
• Utilice el Umbral alfa de la misma manera que el umbral se aplicó el método de seguimiento de píxeles. Lo más 

probable es descubrir que se requiere menos ajuste. Ambos ajustes de la imagen Despeck y Resample Image 

también se aplican de la misma manera. 

• En este ejemplo, estamos importando una imagen PNG de un leopardo/ PNG image of a leopard. Antes de 

importar, haga los siguientes cambios en la ficha Mat Virtual de la barra principal/ Main Bar. Estos dos cambios 

permitirán a la imagen que traza a aparecer a todo color, en la pantalla principal, después de rastreo: 

 

• Antes de utilizar la función de seguimiento Alfa/ Alpha Trace, tenga en cuenta cómo aparece el leopardo cuando 

se aplican los ajustes predeterminados de la ficha de píxeles. También tenga en cuenta que si usted primero haga 

doble clic en la parte superior izquierda de la pantalla, puede “plantar” la Caret en un lugar donde se puede ver 

una vista previa más clara de la forma que se produce con los ajustes: 

 

 

 

• Como se indica en la pantalla, el trazado podría ser utilizado para el corte de vinilo, ya que se aplica de vinilo con 

cinta de transferencia. Sin embargo, vamos a decir que esto va a ser una aplicación de impresión y corte en la que 

el leopardo será impreso en papel y luego el borde exterior recortado. Lo que se necesita es una sola línea de 

Remuestrear la imagen y 

Despeck se utilizará tal y 

como estaban en el 

seguimiento de píxeles. 
Alpha Threshold se 

utilizará como lo fue en el 

seguimiento de píxeles, 

pero probablemente no 

será necesario tanto 

cambio 

Click en  Alpha  

Esto podría ser exactamente lo 

que quieres para un corte de 

vinilo! 

Configuración  

de píxel Tracel  

por defecto 

cuando la 

imagen se 

importa 

primero. 

Caret colocado 

aquí antes de ir 

a Pixel trace lo 

que un 

verdadero 

avance de la 

forma se 

puede ver. 

http://vimeo.com/user8812763/review/31974725/d4915ab0af
https://vimeo.com/70912578
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contorno alrededor del leopardo. Al experimentar con el umbral, se comprueba que se necesita un ajuste de 240 

para obtener un contorno liso alrededor de la imagen. Además, ya sea un Despeck de 18 o marcado Blackout Path 

era necesaria para eliminar caminos diminutos trazadas dentro del animal: 

      

 

• Sin embargo, si cambia a la pestaña Alfa Trace, el valor por defecto de 127 de inmediato le da, en este caso, el 

esquema que desee: 

       

 

• Marque el cuadro Texture Path, haga clic en Aplicar cambios/ Apply Changes, y la imagen aparece en la pantalla, 

listo para el proceso de impresión y corte (consulte el Capítulo 9): 

Threshold se 

incrementa hasta 

240 

Blackout Path está 

marcado para 

eliminar pequeños 

caminos interiores. 

Alpha Threshold valor 

por defecto de 127 da 

suave contorno de la 

forma 
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6.03.3 Palette Trace/ Trazo con Paleta  

 

• La paleta de seguimiento/ Palette Trace ofrece rastreo de color que es especialmente útil en el diseño de 

patrones de empalme de papel. En este ejemplo, la imagen de la flor siguiente fue importado y será 

vectorizado: 

 

• Con Palette Trace, los más prevalentes 16 colores de la imagen son identificados y se muestran. Para cambiar al 

método de Paleta Trace, haga clic en la pestaña llamada Paleta y aparecerá la siguiente: 

 

• Luego, puede seleccionar qué colores para combinar juntos, en un solo color, para ser rastreado. Tenga en cuenta 

que la selección de Corte intermedio/ Median Cut, en lugar de Árbol de octantes/ Octree, utilizará un algoritmo 

diferente y producir un conjunto diferente de 16 colores: 

 

Resample Image y 

Despeck se utilizará tal y 

como estaban en Pixel. Click en Palette tab 

Aparecerán hasta 

16 colores 

Median Cut o Octree puede ser utilizado 

para generar los colores. 

http://vimeo.com/user8812763/review/31981536/573cff97d6
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• Para este ejemplo, vamos a volver a la opción de usar Corte intermedio/ Median Cut. En primer lugar, apague 

todos los colores haciendo clic derecho sobre las cajas. Un menú emergente aparecerá que ofrece algunas 

opciones para que los colores que se han seleccionado, así como la forma de ordenarlos. Comience eligiendo 

Seleccione Ninguno/ Select None. 

 

 

• Sin colores seleccionados, a continuación, puede hacer clic en los colores que son similares y se fusionaran juntos 

para simplificar la traza. Por ejemplo, para la flor en este ejemplo, comience haciendo clic en la totalidad de la 

sombra de color rosa: 

 

 

• Uso Despeck para eliminar caminos no deseados diminutas y Volver a muestrear la imagen para afinar detalle/ 

Resample Image to  o proporcionar más curvas a la imagen. También, haga clic en Aplicar cambios a medida que 

cambia la configuración para que pueda ver el efecto de cada cambio. Ahora, las piezas seleccionadas para ser 

rastreado se indica en azul y lleno de verde, tal y como vimos con el método de píxeles: 

 

Se genera un conjunto 

diferente de colores. 

Median Cut se utiliza 

para generar los colores. 

Click  en Select None Seleccione opciones 

opciones Ordenar 

Haga clic una vez en cada caja de color 

rosa para marcarlo. Si por error hace 

clic en un cuadro de color que no desea 

incluir, haga clic de nuevo para anular 

la selección. 

En la pantalla principal 

podrás ver la forma del 

trazado en la ubicación 

del cursor. 

Todas las rosas se han 

marcado 

Un esquema de color azul y 

verde relleno marcan aquellas 

partes que son de color lo 

mismo que las rosas 

seleccionados. 

Volver a 

muestrear, 

  según sea 

necesario 

Uso Despeck, si 

es necesario 
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• Tenga en cuenta que Despeck y Resample Image la imagen se puede utilizar, respectivamente, para eliminar 

pequeñas manchas trazadas no deseados y más nítida o suavizar el trazado (tal y como se utilizan en el método 

de seguimiento de píxeles). En este caso particular, solamente Despeck se aplicó. 

• Ahora, antes de aceptar esta parte de la imagen, puede agregar más colores si lo desea. Por ejemplo, el centro de 

la flor es más de un púrpura, pero si usted va a cortar esto como un patrón de empalme de papel o como un 

diseño de vinilo, tal vez usted quiere usar el mismo color para los pétalos y el centro. Por lo tanto, al hacer clic en 

ese color, seguido por clic en Aplicar cambios/ Apply Changes,, se traduce en que el color se añaden a las partes 

que están trazadas: 

 

 

 

 

 

• Haga clic en Importar/ Import y el programa le preguntará si desea continuar Tracing/ Continue Tracing o 

Finalizar rastreo/ Finish Tracing. Respuesta Continuar Tracing/ Continue Tracing. Ahora haga clic en las casillas de 

color rosa y rojo nuevamente para apagarlos o haga clic derecho sobre los colores y elija Seleccionar Ninguno en 

el menú/ Select None. Luego haga clic en los cuadros de color verde y haga clic en Aplicar cambios/ Apply 

Changes: 

 

 

 

 

 

 

 

Marque el color 

púrpura oscuro y 

luego haga clic en 

Apply Changes. 

El centro de la flor 

ahora se añade a la 

localización 
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• Haga clic en Importar/ Import. Luego, decida si desea rastrear también la sombra negro alrededor de la imagen o 

crear uno usando la característica capa de sombra/ Shadow Layer en el MTC (consulte la Sección 8.05). Si decide 

rastrear la capa de negro, a continuación, responda Sí/Yes. Repita el paso anterior, pero sólo tiene el cuadro de 

color negro seleccionado. 

• Ahora, antes de hacer clic en Aplicar cambios/ Apply Changes, parar y pensar en lo que desea crear. Usted no 

quiere que las partes negras individuales para crearse como formas separadas. En su lugar, desea que el gran 

contorno negro sobre el que va a adherir el pétalos de rosa y hojas verdes individual. Así, marque la opción Ruta 

Blackout/ Blackout Path con el fin de eliminar las partes interiores. Luego haga clic en Aplicar cambios para ver los 

resultados/ Apply Changes: 

•  

 
Hay un pequeño punto en el que el negro no es un camino continuo 

• Pero hay un problema! En lugar de ver una grande contorno negro de la flor, todavía hay una muestra pétalo. 

Esto es porque el negro no se reconoció como que se extiende alrededor del borde exterior de dicho pétalo. Pero 

no se preocupe ... aumentando el valor Remuestrear la imagen/ Resample Image para X2.0 Tiempos proporciona 

un rastro más cerca y que luego se cubre esa sección delgada alrededor de ese particular, pétalo:  

La imagen en pantalla muestra ahora 

tanto la formas verdes y rosa. 

Marque las dos cajas 

verdes después de 

anular la selección de 

todos los rosados. Haga 

clic en Apply Changes. 

Uno de los 

pétalos todavía 

aparece! 

Mrque en opcion  

Blackout Path y 

despues haga click en 

Apply Changes. 
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• Haga clic en Importar/ Import  y responder Finalizar rastreo/ Finish Tracing. En las capas Bar/ Layers Bar, 

podrás ver las diferentes capas de la imagen. Sin embargo, no hay un icono de capa Mostrar / Ocultar en las 

capas individuales. Por lo tanto es necesario hacer clic en el menú Opciones de capa/ Options Menu  y 

seleccione Para cada una su propia/ To Each Its Own: 

 

• Ahora cada uno de los cuatro colores se ha mudado a su propia capa de nivel superior donde ahora podrán activar 
y desactivar capas individuales para cortar. Además, puede mover las capas de arriba a abajo de manera que la 
capa de negro se encuentra en la parte inferior donde sirve como un resumen: 

Outline now looks 

complete! 

Increase Resample 

Image.  Then click on 

Apply Changes. 

Mientras que las capas 

individuales se pueden 

seleccionar, no se puede 

convertir de forma individual 

las capas de forma 

intermitente durante el corte 

por colores. Por lo tanto, haga 

clicK en Layer Options Menu y 

seleccione To Each Its Own. 
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• ¿Es la perfecta flor? No. Las flechas azules indican que la imagen necesita algunos ajustes: 

 

                                                                            

• Existen herramientas de edición fáciles de usar de ajustar los pétalos en esta imagen. Estas herramientas se 
presentarán en la Sección 7.11. 

 

 

6.03.4 Color Trace / Trazo por color 

 

• El color de Trace / Color Trace  es similar a la paleta de seguimiento/ Palette Trace, pero se puede de forma 
individual, haga clic en un color, de su trama importada original, para rastrear y luego especificar un nivel de 
tolerancia/ Tolerance  que se sumará o restará colores similares a incluir en esa selección. Esta es la imagen que se 
utilizará en este ejemplo y se ha importado: 

 

 

 

Las flechas se usan 

para cambiar el orden 

de las capas de modo 

que la capa de negro 

ahora está en la parte 

inferior 

http://vimeo.com/user8812763/review/31982767/012eb67dec
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• Para cambiar al método de color Trace/ Color Trace, haga clic en la pestaña denominada Color y aparecerá la 
siguiente: 

 

                                                                                  

 

 

• El primer paso es hacer clic en la pequeña caja blanca en la ficha Color Trace. Se abrirá una ventana que muestra la 
imagen importada y se puede seleccionar el primer color que se trazó. Vamos a empezar con el interior de la olla de 
la flor. Un cursor cuentagotas aparecerá y se puede mover por la pantalla para recoger el color de cualquier parte 
de la imagen. Para seleccionar el color de la maceta, simplemente coloque el cuentagotas en cualquier parte sobre 
la olla de flores 

                                                           

 

• Cuando se selecciona el color deseado, haga clic izquierdo una vez para seleccionarlo, haga clic en Aplicar 
cambio/Apply Changes, y la traza será inmediatamente hecho usando la configuración actual. Al igual que con los 
otros métodos de seguimiento, otros ajustes en esta ventana se puede ajustar. En este caso particular, será 
necesario el ajuste Despeck para ser utilizado para eliminar caminos diminutos que se añade a la localización. 

Click en  Color 

Haga clic en el cuadro blanco 

para abrir una ventana para 

seleccionar el color para el trazo 

Como se trata de un archivo PNG, 

Background Color se puede modificar, si 

es necesario. 

Incrementar o disminuir 

tolernacia/Tolerance Para sumar o 

restar porciones de la imagen que se 

incluirán en la traza. 

Resample Image y  Despeck se 

utilizará tal y como estaban en Pixel. 

Un icono del cuentagotas se 

mueve alrededor de la 

imagen 

Este cuadro indica el color 

del píxel actual bajo el 

cuentagotas/eyedropper 
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• Supongamos que desea toda la maceta de flores trazado en lugar de sólo el interior. Aumente el ajuste de ampliar 
la gama de colores que está cerca del color original Tolerancia. En este ejemplo, la tolerancia se aumenta a 14 y la 
maceta de flores se ve muy bien! La totalidad está trazada. Desafortunadamente, la parte exterior de la flor rosa 
también cayó en esta gama de color y se está incluido. ¡Pero eso está bien! Esa parte se puede eliminar más tarde 
después de que se complete el trazado: 

 

           

 

 

 Haga clic en Importar/ Import y el programa le preguntará si desea continuar Tracing/ Continue Tracing o 
Finalizar rastreo/ Finish Tracing. Respuesta Continuar Tracing/ Continue Tracing. Haga clic en el cuadro 
Color de nuevo y luego elige otro color. Esta vez elija las hojas verdes: 

Las líneas azules y 

relleno verde indican 

la parte de la imagen 

de trazado. 

Vista previa en 

pantalla 

La caja de  Color cambios 

en el color seleccionado 

con el 

cuentagotas./eyedropper 

Click en  Apply Changes 

cada vez que se realiza 

un cambio para 

actualizar la vista 

previa. 

Despeck 

planteado para 

eliminar caminos 

diminutos. 

Toda la maceta de flores está 

trazado como una forma. 

Outline/ Esquema de la flor 

también se trazó. 

Tolerance 

aumenta a  14   
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• Si desea que las hojas y el tallo de ser rastreado como diferentes formas, a continuación, reducir la tolerancia. Fue 
obligado a reducir la tolerancia hasta el fondo a 2 con el fin de obtener sólo las hojas remontar: 

                        

 

• Haga clic en Importar/ Import, responda Continuar rastreo/ Continue Tracing para rastrear más capas, y luego 
seleccionar el color del tallo. Una vez más, la tolerancia debe mantenerse baja con el fin de rastrear el tallo y no 
incluir las hojas en la selección: 

Tolerance 
Todavía está 

ajustado a 

14.   

Las hojas y el tallo son 

ambos trazados. 

Sólo las hojas se trazan. 

Tolerance es 

reducida a 2.   
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• Haga clic en Importar y ahora repetir el mismo proceso para las flores azules y rosas. 

• Esto deja a los centros amarillos de las flores. Haga clic en el cuadro Color para que aparezca la trama original para 
la selección de color. Los centros no son de un color sólido, sino que irradian de un color casi blanco en el centro a 
un amarillo (casi marrón) sombra muy oscura en el exterior. En casos como el presente, elegir una sombra en algún 
lugar en el medio de la gama de colores (un tono más oscuro de color amarillo, pero no el más oscuro): 

 

                                                             

 

• Izquierda haga clic en el amarillo. La ventana Elegir color se cerrará. El cuadro Color mostrará este color amarillo 
seleccionado. Haga clic en Aplicar cambios/ Apply Changes. Aumentar la Tolerancia y el exterior completa de las 
regiones amarillas están incluidos en la traza: 

Tolerance se 

mantiene baja  

Los tallos son ahora 

trazada.    

Mira este cuadro para 

un tono medio de 

amarillo a aparecer:    

Recoger en algún lugar entre 

las sombras más claras y más 

oscuras de color amarillo.    
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• Los círculos internos donde el color es un amarillo muy pálido no están incluidos. El aumento de la tolerancia se 
reduce gradualmente el tamaño de los círculos internos: 

•  

                 

 

 

 

 

 

 

 

 

 

 

Incremento de 

Tolerance  5. 

    

Incrementa la 

Tolerance  de 

40. 

    

Centros amarillos 

se expanden con 

mayor Tolerance 
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Sin embargo, hay una manera más fácil de manejar esos! Simplemente marque el cuadro Ruta/ Blackout Path  y que 
se eliminan al instante de la traza: 

                   

• Haga clic en Importar/ Import y, esta vez, responder Finalizar rastreo/ Finish Tracing.. La parte rastreo es 
completa: 

 

• Ahora, para la edición. Para seleccionar el trazado, haga clic en el icono Opciones de capa de menú/ Layer Options 
Menu y seleccione el uno por sí mismo. Ahora la imagen se puede editar, según sea necesario y los colores enciende 
o se apaga para cortar. 

                                                          

 

Haga Click 

en Blackout 

Path 

    

Centros amarillas 

llene 

completamente 

con Blackout 

Path marcado 

    

Opciones de Layer Menu    

Despues de seleccionar To 

Each Its Own de the Layer 

Options Menu, cada color 

que se trazó, tendrá esas 

formas en su propia capa. 
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• Busque el camino que tenía el extra frontera de la flor fuera de trazado/ Blackout Path y seleccione esa capa: 

                                                                           

 

• Aplique un Ctrl + B (Pausa)/ (Break) para que la rosa frontera de la flor que se remonta a la olla de la flor ahora se 
puede seleccionar y borrar. A continuación, la flor está lista para cortar de colores individuales de papel, 
cartulina, vinilo, etc .: 

 

 

6.03.5 Color Scans Trace / Escanear trazo con color 

 

• Versión 4.3.3 de MTC introdujo una quinta herramienta de rastreo de llamada color exploraciones/ Color Scans . 

Esta característica se traza por el color (similar a las formas en que la paleta de color y fichas de trabajo), pero 

que va a hacer todos los colores en un solo paso. Se especifica la cantidad de colores que desea identificado. Esta 

es la imagen para ser utilizado en este ejemplo: 

 

• Para cambiar al método de color Escanea Trace/ Color Scans Trace, haga clic en la pestaña denominada Color 

Escanea/ Color Scans  y aparecerá la siguiente: 

                                                                  

 

Haga click en la 

vista previa de 

la capa 

Resample Image y 

Despeck se utilizará tal y 

como estaban en Pixel. Click en  Color Scans 

Para  archivos  PNG,  el fondo de 

color/Background Color se puede 

modificar, si lo desea 

Seleccione el número de 

colores para identificar 

Opción para eliminar caminos internos 

de la capa de contorno de la imagen 

Opción para cambiar cómo 

se construyen las capas 

Opción para convertir 

a tonos de gris única 

https://vimeo.com/56727192
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• El primer paso es seleccionar el número de colores que desee escanear. Incluya siempre blanco en el conteo. Para 
ver la imagen importada original, mantenga pulsado el botón derecho del ratón sobre la previsualización: 

•  

                                                           

• En muchos casos, es posible que desee seguir adelante y comprobar los resultados de rastreo si se utiliza el conde 
por defecto de 8. Antes de decidir cualquier Conde particular parece bien, asegúrate de revisar el número de 
formas. En este caso se muestra 113: 

               
 

 

 Algunos de los ajustes ahora se ajustarán: 

o Basado en cómo perder el trazado parece ser, el Volver a muestrear/ Resample se incrementará. 

o Basado en el excesivo número de formas, el ajuste Despeck se elevará a aproximadamente 20. Esto 
eliminará cualquier forma diminutas que no se querían. Por supuesto, es importante también 
asegurarse de que no pierda ningún detalle fino que usted necesita. 

Mantenga pulsado el 

botón derecho del 

ratón para ver la 

imagen original y 

contar colores 
Cambie el número de colores o 

aceptar por defecto de 8 para ver 

lo que se trazó 

Click en  Apply Changes  
para ver los resultados de los 

ajustes actuales  

Numero de formas/Shapes 

Rastreo alrededor de 

las llamas tiene que 

ser más estricto 

Vista previa de la 

imagen trazada en 

Virtual Mat 
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• Después de hacer clic en Aplicar cambios/ Apply Changes: 

  

 

 

 

 El número de formas/ Shapes se redujo de 113 a 23. Esto todavía parece alto. Sin embargo, recuerde que cada 
forma individual que usted ve tiene un contorno negro de la sombra. En la mayoría de los proyectos de empalme 
de papel, es probable que prefiera el contorno negro para ser una sola forma de fondo. Aquí es donde se puede 
aplicar la opción Blackout contornos. 

• También tenga en cuenta que el color amarillo más claro en la llama no es una forma de la imagen. Si se desea 
que los detalles, a continuación, aumentar el Count y, posiblemente, disminuir Despeck, hasta que aparezcan los 
centros amarillos de la llama. En este caso, se requiere un recuento de 17, pero el Despeck se dejó a 20: 

 

   

 

menos formas 

Aumento Remuestrear a la 

imagen/ Resample Image y 

Despeck/ Despeck 

Traza se mejora: los puntos más 

agudos en las llamas y capas 

"encajan" mejor unos a otros 

Centros amarillas de las 

llamas muestran ahora 

Increamentar 

Count a 17 

Marque 

lamopcion 

Blackout 

Outlines 

Aún menos formas 
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• Al hacer clic en Importar/ Import, se le preguntará si desea continuar Tracing/ Continue Tracing o Finalizar 
rastreo/ Finish Tracing. Seleccione Finalizar rastreo. Haga clic en Finalizar rastreo/ Finish Tracing 

 

• A continuación, vamos a echar un vistazo a las Bar de  capas/ Layers Bar . Apertura de la capa de seguimiento 
muestra que cada uno de los 9 colores no sólo tiene esas formas unido, sino que también han sido nombrados con 
el color correspondiente: 

       

• Si la opción Blackout contornos/ Blackout Outlines no había ser marcada, entonces la capa de negro no estaría 
completa: 

 

     

 

 

• Se dará cuenta de que hay también una capa blanca que siempre se creará a menos que el fondo de la imagen es 
un color que no sea blanco. Esta capa blanca se puede eliminar, salvo en situaciones en las que hay formas blancas 
que componen la imagen. Por ejemplo, aquí está una imagen que ha sido rastreada y contiene blanco: 

A pesar de que el count se establece 

en 15, se trazaron sólo 7 capas / 

colores. Tenga en cuenta las capas se 

nombran en función del color. 

Blackout Outlines sin seleccionar Blackout Outlines seleccionadas 
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• También contiene una capa llamada Cáliz de plata y otro llamado oro de Brown. Antes de la separación de las 
distintas capas, también puede simplemente tratar de eliminar los que usted siente que no necesita. Si usted no 
pierde nada visualmente, entonces usted sabe que no es necesario que la capa. Sólo ver con cuidado en caso de 
que pasa a ser algo pequeño. 

 

 

  

Siete capas/ layers 

Imagen con Trazo Imagen trazada después de eliminar cáliz de plata y 

oro de Brown capas - ninguna diferencia! 
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• Ahora, mueva la capa blanca a un lado para que pueda editar todo menos las alas de la abeja. Utilice la rotura por 
lo que las rutas individuales se pueden seleccionar: 

 

           

  

 

• Después de romper y eliminar, esos cinco partes blancas pueden reunieron y se añaden a la imagen: 

 

 

Stack Scans/Amontonar  scan 
• La función de apilado Escanea/ Stacked Scans afecta a qué partes de la imagen se trazan y se asignan a cada capa. 

En ciertas aplicaciones de impresión, sería aconsejable disponer de esta función verifica cuando se hace un rastreo 

de píxeles con el fin de obtener un resultado de mayor calidad para la impresión. Por otro lado, para la mayoría de 

aplicaciones de empalme de papel, usted no desea utilizar este, ya que podría perder la oportunidad de partes 

específicas que desea cortar. La forma más fácil de entender cómo esta característica afecta el trazado es basta con 

ver lo que sucede. En el ejemplo siguiente, en el que se trazó un logotipo bien conocido, muestra el efecto de la pila 

Scans/ Stack Scans: 

Capa en blanco 

Las únicas partes de mantener son 

las cuatro secciones de las alas de 

la abeja y un pequeño tramo entre 

el vapor y la hoja de la flor. 
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• Después de trazar las capas se separan. Tenga en cuenta las diferencias en lo que se crea: 

 

                 
 

 

 
 

• Mientras la función Pila Escanea/ Stack Scans fue desarrollado para ciertas aplicaciones de impresión, los 

artesanos de papel puede resultar útil para algunos proyectos de empalme de papel. Por ejemplo, utilizando 

apiladas Escanea trazar una simple imagen de un baloncesto que eliminará la necesidad de adherirse 

individualmente todas las secciones de la pelota de baloncesto sobre un fondo negro. En lugar de ello, un 

solo recubrimiento negro se puede cortar y puso en la parte superior de una sola pieza de color naranja: 

 

 

                

 

          

 

  

Stack Scans sin 

seleccionar 

Stack Scans 

Seleccionado   

Imagen trazada 

Blackout seleccionado: Tendrían que ser 

pegado en el fondo de nuevo ocho 

pedazos  de naranja. 

Stack Scans seleccionado: Una 

superposición negro tendría que ser el 

pegamento en una sola fondo naranja. 
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Grayscale Option/Opcion en escalas de grises. 
• La opción Escala de grises introducido con imágenes de mapa de bits de la versión 4.6 conversos importados en el 

más cercano de 256 posiblemente tonos de gris, con base en el número de colores seleccionados. Es muy adecuado 

para fotos o pinturas. 

• • Al seleccionar una foto para la aplicación de escala de grises, busque un fondo de 

color sólido y la iluminación brillante sobre el tema que desea rastrear. Estos son ejemplos de una buena elección y 

una mala elección: 

 

    

 

 

• Importar la foto y seleccione la opción Color exploraciones. Debido a que es muy probable que se le estratificación 

sus cortes, marque la opción apiladas exploraciones/ Stacked Scans. A continuación, iniciar con un recuento de 2 

y trabajar hacia arriba, comparando cada traza para determinar lo que es deseable. Recuerde que con el aumento 

en el recuento, se requerirá una nueva capa de corte: 

 

 

 

Trabajará así: sólida, buena 

iluminación 

No funciona así: Fondo ocupados, objeto 

delante de la cara, mala iluminación 

Count: 2   

Count: 3   
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• Los últimos dos capturas de pantalla tienen el detalle, pero hasta que se aplique el ajuste Despeck, no está claro 

cuál podría ser mejor. Recuerde que cualquier trazado se puede editar, por lo que grandes caminos no deseados, 

como el fondo en la parte inferior izquierda de la última exploración, se puede quitar fácilmente después de la 

finalización del proceso de trazado. Asegúrese de leer las secciones pertinentes del capítulo 7 

• En los próximos dos capturas de pantalla, Despeck se ha establecido en 20: 

                   

                 
• Se decidió que la simplicidad de la que tiene un conde de 4 se ve mejor. Pero hay algunos retoques necesarios: 

 

Count: 4   

Count: 5   

Count: 4   

Count: 5   
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• Después de la edición, tenemos la huella en escala de grises definitiva de Leonardo DiCaprio: 

                                 

 

6.04 Manual Tracing/Trazo Manual 

• Hay dos maneras de trazar una imagen importada manualmente en MTC: 

• El uso de la herramienta Dibujar a mano alzada/ Draw Freehand Lines (herramienta Lápiz/ Pencil Tool) (consulte la 

Sección 7.10): Si usted es dueño de una tableta gráfica y disfrutar de dibujo a mano alzada, puede encontrar este 

método viable para el seguimiento manual. No está cubierto en este tutorial porque es bastante simple de líneas 

de dibujar a mano alzada y curvas como se presenta en la Sección 7.10. Pero a menos que tenga una mano muy 

firme, su trazado probablemente requerirá edición de nodos considerable si quieres curvas suaves en el diseño final. 

• Utilizando el Bézier Las curvas y líneas rectas herramienta de dibujo/ Draw Bézier Curves and Straight Lines (Bézier 

o Pen Tool) (consulte la Sección 7.12): Revise esta sección y practicar el uso de la herramienta para dibujar dos líneas 

rectas y curvas antes de intentar repetir los pasos que se muestran en el siguiente tutorial. 

Importación de una imagen de rastreo manual 

• Las imágenes de trama pueden ser importados utilizando Pixel Trace (consulte la Sección 6.03) o como textura 

llenar una forma (consulte la Sección 3.14). El primer método se presenta aquí 

• Haga clic en el icono de rastreo Pixel/ Pen Tool  y navegar para localizar la imagen que desea rastrear. También 

puede escanear una imagen o pegar una imagen que se ha copiado en el Portapapeles de Windows. En este 

tutorial, la imagen del vestido de este sitio web se utilizará: 

http://houseofstirfry.com/chia/templates/dress01.html 

Se eliminarán los 

parches blancos. 

El fondo a la derecha no 

coincide con el fondo a la 

izquierda. 

 Pequeños garabatos  

deben ser eliminados. 

http://houseofstirfry.com/chia/templates/dress01.html
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• Tenga en cuenta que este vestido puede ser fácilmente rastreada píxeles sino porque ofrece un gran ejemplo de 

cómo las curvas de Bezier se pueden extraer para adaptarse a una forma como ésta, que será utilizado para el 

ejemplo el rastreo manual. En lugar de hacer cambios en la configuración con el fin de rastrear automáticamente 

la imagen, ajustar el umbra/ Threshold l a 255 en la ficha Pixel y marque el cuadro Ruta de la textura/ Texture 

Path. Haga clic en Aplicar cambios/ Apply Changes y toda la ventana se llenará de color verde que indica un 

rectángulo alrededor de la imagen se formará la línea de trazo: 

                        

• Haga clic en Importar/ Import . Respuesta No cuando se le pregunte si desea rastrear más capas. La imagen 
aparecerá en la pantalla. Asegúrese de cambiar su color tapete de contraste/ Contrast en la ficha Mat virtual 
(consulte la Sección 3.04) y también seleccionar Rellenar o Relleno / Esquema de manera que se puede ver 
claramente la imagen: 

 

• Un pequeño consejo adicional: al trazado manual y la edición, que a menudo puede ser un problema si 
inadvertidamente clic en y seleccione la imagen importada. Una manera de evitar este problema es tener la 
importación de imágenes en una página y realizar el rastreo en otra página. Pero primero, usted quiere hacer la 
imagen importada visible en otras páginas. Para ello, haga clic derecho en la página actual que contiene la imagen 
importada y seleccione Visible: 

 

Click on Apply Changes.    

Set Threshold to the 

maximum of 255.    

Mark Texturize Path box    

Click on Import    
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• Ahora haga clic en el icono para agregar una nueva página y verá la imagen importada claramente en la pantalla, 
pero no será capaz de seleccionar inadvertidamente que: 

 

• La imagen ahora será ligeramente atenuado, pero aún lo suficientemente clara para el rastreo.  

 

Manual Tracing Using the Bézier Curves and Straight Line (Pen Tool)/ Rastreo Manual de Uso de las 

curvas de Bézier y Línea Recta (Pen Tool) 

Simple:  Intermediate:  

• Como se mencionó al comienzo de esta sección, usted querrá leer la Sección 7.12 para aprender a cómodamente 
y con éxito utilizar la herramienta Pluma/ Pen Tool. 

• Ahora, el mejor método para trazar una imagen simétrica es sólo para trazar la mitad. A continuación, puede hacer 
una copia de la imagen espejo y soldadura al origen para crear una forma perfectamente simétrica. Esto es lo que 
se hará en este caso porque el vestido es simétrica 

• Antes de iniciar la traza, tome nota de cómo existen muchos cambios en las curvas y líneas rectas. Esto le ayudará 
a entender donde se le está comenzando y terminando caminos como se traza: 

 

 

 

 

 

Right click on current pa    

ge to open menu.    

Click on Visible.    

https://vimeo.com/47177660
https://vimeo.com/55406509
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• Las directrices del proceso son los siguientes: 

o Izquierda haga clic una vez para plantar un nodo. Haga clic derecho para poner fin a un segmento y 
plantar el nodo final. 

o Una serie de segmentos de línea recta se puede hacer, una tras otra, sin necesidad de clic derecho. 

o Segmentos de curvas también se pueden crear, una tras otra, aunque puede ser difícil obtener las 
curvas que mirar exactamente de la manera que quieras. Por esta razón, a menudo es más fácil de 
terminar cada nueva curva haciendo clic derecho antes de comenzar el siguiente segmento. 

o Después de terminar un segmento, puede hacer clic izquierdo en el mismo lugar donde el último 
terminó al comenzar el siguiente segmento. El nuevo segmento se conectará automáticamente a la 
última estación. 

o No es necesario para poner fin a un segmento de línea recta antes de la adición de un segmento de 
la curva. Después de hacer clic izquierdo para plantar el último nodo para el segmento de línea recta, 
haga clic y mantenga pulsado el botón izquierdo del ratón en el punto en que el próximo segmento 
de la curva debe terminar y arrastrar el ratón, según sea necesario, para formar la curva que se ajusta 
a la imagen. Con el botón izquierdo del ratón todavía pulsado/ still held down haga clic derecho a 
poner fin a esa curva. 

o Cuando se llega al punto de partida original y haga clic derecho sobre el mismo, la forma se llenará 
de color y usted tendrá un trazado cerrado, a pesar de arranque y parada en el camino. 

Ahora, para demostrar este proceso con más detalle: 

• Trace la parte recta como se muestra: 

o Trace la parte recta como se muestra: 

 

Traza comenzará y terminará aquí se mueve hacia 

la izquierda alrededor del vestido.  

Las flechas rojas indican que un 

cambio en la dirección o la 

curvatura se produce y dónde 

comienza un nuevo camino. 
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• Ahora, para hacer la primera curva, ir al punto en el que termina la curva, mantenga pulsado el botón izquierdo 
del ratón y arrastrar el ratón para que la curva coincide con el vestido. Luego, mientras mantiene pulsado el botón 
izquierdo del ratón, haga clic derecho para terminar el segmento: 

                                                                                          

• A continuación, haga clic izquierdo en la última curva terminó, vaya a donde la curva va a terminar, mantenga 
pulsado el botón izquierdo del ratón y arrastre para formar curva. Inmediatamente click derecho para poner fin a 
ese segmento: 

                               

 

 

• Ahora hay dos segmentos de línea recta, por lo que sólo la izquierda clic en cada una. Entonces, una vez más, 

pasar a la final de la siguiente curva, mantenga pulsado el botón izquierdo del ratón y arrastre para ajustar la 

curva y luego haga clic derecho a la final: 

                                                     

 

1. Izquierda haga clic una 

vez para comenzar la traza 

aquí. 

2. Izquierda haga clic 

una vez 

3. Izquierda haga 

clic una vez 

4. Mantenga pulsado el botón izquierdo del ratón 

aquí y comenzar a arrastrar el ratón para ajustar 

la curva. 

5. Cuando la curva es perfecto, NO suelte 

el botón izquierdo del ratón hasta que 

haga clic derecho para terminar el 

segmento. 

6. Haz clic en la parte 

superior de donde terminó 

el último segmento de la 

izquierda. 

7. Mantenga pulsado el botón 

derecho del ratón en la final del 

próximo segmento. 

8. Arrastre el ratón para ajustar la 

curva y luego haga clic derecho 

antes de soltar el botón izquierdo 

del ratón. 

7. Haz clic izquierdo en la parte 

superior de la última final del 

segmento y luego haga clic en 

la izquierda en la parte superior 

de la manga interior. 

8. Haz click izquierdo en la 

parte inferior del vestido. 

9. Mantén pulsado el botón 

izquierdo del ratón y 

arrastre para ajustar la 

curva de vestir. 

  10. Haga clic derecho, mientras 

que mantiene el botón izquierdo 

del ratón para terminar el 

segmento. 
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 Por último, mantenga pulsado el botón izquierdo del ratón en la parte superior, donde comenzó traza inicial. 

Arrastre el ratón para crear la curva escote. Mientras izquierdo del ratón todavía se mantiene pulsado y se 

extendió a cabo para formar la curva, haga clic derecho para terminar el segmento y luego suelte el botón del 

ratón. La final del botón derecho se cerrará la forma y el vestido se llenará de colores: 

        
 

 

 

 

Flip/Mirror and Weld to Complete Symmetrical Shapes/ Voltear / Espejo y  Soldar para cumplementar Formas 

simétricas. 

 El paso final para completar el vestido consiste en hacer una copia de la imagen del espejo y luego soldar la misma. 

Seleccione el vestido y hacer un copiar / pegar en su lugar/ Copy/Paste in Place. Luego, haga clic inmediatamente 

en la herramienta espejo/Mirror. (Si la línea de simetría era horizontal, entonces usted hace clic en la herramienta 

del tirón/Flip). A continuación, utilice las teclas de flecha para mover la copia simétrica a superponen como se 

desee y realizar la soldadura básica/ Basic Weld: 

 
 

                                           

 

 

 

 

 

 

 

 

15. Mover arriba y 

mantenga pulsado el botón 

izquierdo del ratón sobre el 

punto de partida original. 

16. Arrastre el ratón hasta 

encajar curva del vestido de 

escote. 

17. Mientras mantiene el botón 

izquierdo del ratón, haga clic 

derecho a poner fin a la traza. 

Vestido llena de color. 

Copiar/Copy  trazo de 

vestido y pegar en el 

lugar/Paste in Place  

Aplicar espejo/Mirror  
Mueva copia para 

superponerse al trazo del  

vestido 

Aplique herramienta 

de  soldar Weld 
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7. Editing/ Edición 

 

7.01 Separación y combinación de formas 

Split/Division 

 La función Split se utiliza para romper las formas combinadas en formas individuales, pero mantener unidos a sus 

respectivos caminos exteriores. A veces los caminos exteriores se llaman formas de patrones y los caminos 

interiores se llaman subpatrones de formas. 

 Después de seleccionar una forma combinada, la función Split puede acceder en cualquiera de las siguientes 

maneras: 

o Haga clic en el icono de Split, en la barra de herramientas de Magia/ Magic Toolbar  

o Presione Ctrl + P 

o Haga clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic > Split desde el menú 

o Vaya a Editar/ Edit> Forma Magia/ Shape Magic > Split. 

• Como se muestra en la Sección 5.04, si se aplica Split a una palabra como “Bob”, el niño formas dentro de las 

letras “B”, “o”, y “b” son todavía una parte de las formas de los patrones: 

 

                                                             
 

 

 Hay tres cosas que le hará saber que los patrones y subpatrones de formas todavía están unidos entre sí: 

  No hay cuadros delimitadores individuales en torno a los subpatrones de formas, 

solamente alrededor de las formas individuales de patrones. 

 Se puede ver las líneas de la cuadrícula de la Mat virtual dentro de las formas de 

subpatrones, indicando esos son espacios vacíos: 

 Si se mueve una de las letras, la forma ndel subpatron  se mueve con la forma del patron. 

• Lo mismo ocurre cuando se abre un archivo y descubrir que todas las partes se combinan como una forma. 

Primero aplique la función Split para ver si el archivo entonces se dividirá en las formas combinadas que tienen más 

sentido. Por ejemplo, el archivo SVG siguiente ((Cupcake Seashells by Judy Keating) se importa en MTC: 

 

La rejilla es visible a través 

de los caminos interiores 

"vacías".  

No hay cuadros 

delimitadores alrededor 

de los caminos interiores. 

Un solo cuadro 

delimitador    

http://teamknk.com/?p=299
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 Las importaciones de archivos como una sola forma. Pero una vez que se aplica Split, hay 8 formas individuales que 
luego se pueden mover individualmente, cambiar de tamaño, re-coloreado, asignados a capas separadas, etc .: 

                                       

 

Break/Romper 

 La función romper/ Break se utiliza para separar cada camino, cada curva y cada línea en su propia forma individual. 

 Después de seleccionar una forma combinada, la función Pausa/ Break se puede acceder en cualquiera de las 

siguientes maneras: 

 Haga clic en el icono de la rotura/ Break de la barra de herramientas de Magia/ Magic Toolbar   

 Presione Ctrl + B 

 Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Pausa/ Break en el menú 

 Vaya a Editar> Forma Magia> Break/ Edit>Shape Magic>Break. 

 Si la función Pausa/ Break se aplica al ejemplo de “Bob” utilizado en la sección anterior sobre Split, los niños formas 

continuación tienen cuadros delimitadores individuales y se llenan colorearán. Esto indica que los niños las formas 

ya no se unió a sus formas de patrones: 

 

 

 Una vez que usted solicita Break, usted tiene el control total sobre la edición de cada forma individual dentro de 

un diseño. ¡Pero ten cuidado! También es fácil de mover inadvertidamente una forma particular (especialmente 

los más pequeños) y se puede correr el riesgo de estropear el diseño. Así, sólo utilice Romper cuando sea necesario 

y, a continuación, lo más importante, saber cómo reunirse con sus formas, que se tratarán en la siguiente sección. 

Join/Unir 

 La función Join se utiliza para combinar trayectos individuales, curvas y líneas en una sola forma. Esta es 

básicamente la función opuesta de romper/ Break. 

 Después de seleccionar dos o más formas, la función Join se puede acceder en cualquiera de las siguientes maneras: 

o Haga clic en el icono en la barra Únete Magia/ Magic Toolbar  

o Presione Ctrl + J 

Cuadros delimitadores 

ahora indican un total de 

8 formas diferentes.   

Ahora hay que limitan las cajas 

alrededor de cada camino interior. 
Los caminos interiores 

están llenos de color. 
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o Haga clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic > Ingreso desde el menú/Join 

o Ir a Editar> Forma Magia> Unirse./ Edit>Shape Magic>Join 

 Si la función Join se aplica a la “Bob” ejemplo de la sección anterior sobre Break, la palabra ahora convertido en 

todo lo que se forma e incluso las letras individuales ya no pueden ser seleccionados: 

 

                                                            
 

 Otra razón para aplicar Únete antes del corte es para controlar el orden de la corte. Una forma de niño, que está 

unido a una forma matriz, siempre será cortado antes de la matriz. Esto proporciona estabilidad a la de corte. Si 

se va a cortar a la inversa, en donde la forma exterior de los patroness se corta primero, esta forma sería más 

probable que se suelte de la estera cuando es seguida por una forma de subpatrones que está siendo cortado. 

Layer/Capa     

 

 La función de la capa está en-entre Split y Break en términos de lo que hace. Pero también puede realizar una 

función Join al mismo tiempo! Siga los ejemplos cuidadosamente. 

 Después de seleccionar una forma combinada, la función de la capa/layer se puede acceder en cualquiera de las 

siguientes maneras: 

 Haga clic en el icono de la capa/layer en la barra de herramientas de Magia/ Magic Toolbar   

 Presione Ctrl + L 

 Haga clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic > capa/ Layer en el menú. 

 Vaya a Editar> Forma Magia> Capa/ Edit>Shape Magic>Layer. 

 Por ejemplo, vamos a utilizar el ejemplo de “Bob” por encima, después se aplicó Join, que se tradujo en una sola 

forma. La aplicación de la función de capa/layer  aparecerá inicialmente haber realizado la misma función que la 

rotura/Break: 

 

                                              
 

 Sin embargo, la gran diferencia es la siguiente: Si se aplica la rotura/Break a “Bob”, se termina con siete formas 

individuales (uno para cada forma exterior de los padres más uno para cada forma niño interior). Si se aplica la 

capa a “Bob”, se termina con sólo dos formas (las tres rutas de acceso primarias exteriores se unieron como una 

forma y las cuatro formas niño interior se unen como una segunda forma). En este ejemplo, una forma se aleja de 

la otra para mostrar lo que constituye cada una de estas nuevas formas distintas: 

 

La rejilla es visible de nuevo en 

el interior de las partes internas 

de las letras 

Un cuadro delimitador sola 

alrededor de toda la 

palabra 

Subpatrones  se llenan de 

color después de la 

aplicación  Layer 

https://vimeo.com/45407647


153 
 

                                                    

 

 Un resultado diferente ocurre si nos remontamos a la “Bob” ejemplo en el que la palabra se ha dividido/split 

primero y luego aplicar capa/layer. Una vez más, parece similar a los resultados de una pausa/break: 

 

 Esta vez, en lugar de obtener dos formas individuales, terminamos con seis (uno por cada ruta padre más uno para 

cada conjunto interno de caminos secundarios). La diferencia es que que los dos caminos de subpatron  interior 

dentro de la letra “B”, permanecen unieron como una forma: 

 

                                                                              

 

Blackout/Fondo 

 La función Blackout elimina todos los caminos secundarios de sus rutas paternas. 

 Después de seleccionar una forma que contiene una o más rutas de niño, la función Blackout se puede acceder en 

cualquiera de las siguientes maneras. 

o Haga clic en el icono de Blackout en la Barra de Magia/ Magic Toolbar  

o Presione Ctrl + R 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic >  Blackout en el menú 

o Vaya a Editar> Forma Magia> Blackout/ Edit>Shape Magic>Blackout. 

 En el “Bob” ejemplo anterior, no importa si usted ha Dividir el texto en letras individuales o el texto sigue siendo 

una forma, el mismo resultado se produce utilizando Blackout. Se suprimen los caminos internos del patron: 

 
 

                                                        

Subpatrones de "Bob" 

se han unido en una 

sola forma. 

Subpatrones  de "Bob" se 

han unido como una 

segunda forma. 

Las tres rutasde patrones son 

tres formas 

Los dos caminos secundarios de la 

letra "B" son ahora una sola forma 

Los dos caminos secundarios  

de "o" y "b" son las dos últimas 

formas. 

Antes de aplicar 

Blackout 

Despues de aplicar 

Blackout 

Todos los subpatrones 

son borrados 
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 ¿Qué pasa si no se anidan  las trayectorias de subpatrones? 

Antes de aplicar Blackout: 

 

 

 

Despues de aplicar Blackout: 

                                                            

 
 

 

7.02 Forma Magica Avanzada  Parte 1: Las funciones para Simplificar/ Shape Magic Advance Part 1: The Simplify 

Functions 

7.02.1 Auto Simplificar Caminos/ Auto Simplify Paths 

 La función Simplificar Caminos Auto/ Auto Simplify Paths es  un encendido / apagado automático que debe ser 

activada cuando se instala MTC. Su propósito es reducir continuamente el número de nodos después se aplican 

otras funciones, por lo que un diseño se corte suave y rápidamente a un cortador. 

 Simplificar Caminos Auto/ Auto Simplify Paths  se puede acceder de las siguientes maneras: 

 Haga clic en el icono de Avance/ Advance en la barra de herramientas de la magia / Magic Toolbar   

y seleccione Auto Simplificar Caminos/ Auto Simplify Paths   

 Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Auto 

Simplificar Caminos/ Auto Simplify Paths desde el menú 

 Vaya a Editar> Forma Magia> Avanzado> Auto Simplificar Caminos./ Edit>Shape Magic> 

Advanced>Auto Simplify Paths. 

 La mayoría de las veces, esta función se puede dejar en. Sin embargo, si está editando ampliamente una imagen, 

como el uso de la función Borrador /Eraser una y otra vez en la misma forma seleccionada, entonces puede ser 

necesario desactivar esta función. Las aplicaciones repetidas de los Simplificar Caminos Auto comenzará a 

distorsionar las formas. Así que, como se recomienda en las secciones posteriores de este capítulo, apagarlo, y 

luego la siguiente ruta Auto Simplificar se puede aplicar una vez que se haya completado la edición. 

7.02.2 Auto Simplify Path/Autosimplificar Patron 
 

 La función Auto Ruta Simplificar/ Auto Simplify Path se puede aplicar cuando se han apagado Auto Simplificar 

Caminos. Seleccione la forma (s) y luego aplicar Auto Simplificar Camino/ Auto Simplify Path en cualquiera de las 

siguientes maneras: 

 Haga clic en el icono de Avance/ Advance en la barra de herramientas de Magia/ Magic Toolbar   

y seleccione Auto Simplify Path. 

Anillos se han unido 

para crear un solo 

forma. 

2 formas (un anillo 

interior y un anillo 

exterior) 

4 círculos individuales 

apiladas 

Nada sucede porque estos 

círculos individuales no 

tienen subpatrones 

Todos los caminos 

secundarios se eliminan 

Cada anillo pierde su 

ruta 



155 
 

 Presione Ctrl + Shift + Z 

 Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Auto 

Simplificar trazado/ Auto Simplify Path en el menú. 

 Vaya a Editar> Forma Magia> Avanzado> Auto Simplificar Sendero Edit>Shape 

Magic>Advanced>Auto Simplify Path. 

 La función se aplicará de forma automática y se abrirá una ventana que indica los resultados de la simplificación. 

Aquí hay una ventana de muestra: 

                                                                                           

 

 Si se eliminan suficientes nodos, a continuación, pruebe a reducir temporalmente el tamaño de la forma. Utilice 
el método de escala se muestra en la Sección 3.13 para reducir el tamaño de la forma de, por ejemplo, 25%. 
Aplique la función Auto Ruta Simplificar. A continuación, cambiar el tamaño usando el recíproco, 25% r, para 
volver a su tamaño original. 

 
 

7.02.3 Smooth & Simplify/ Suave y Simplificar 

 La función suave y Simplifique/ Smooth and Simplify  es una versión manual de la función Path Auto Simplifique/ 
Auto Simplify Path  en el que se puede elegir la cantidad de simplificación se aplicará. Seleccione la forma y luego 
abrir la ventana suave y Simplificar/ Smooth and Simplify  en cualquiera de las siguientes maneras: 

o Haga clic en el icono de Avance/ Advance en la barra de herramientas de la magia/ Magic Toolbar 

 y seleccione Suave y Simplificar/ Smooth & Simplify 

o Presione Ctrl + Shift + J 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > 
Smooth y Simplificar/ Smooth & Simplify  el menú 

o Vaya a Editar> Forma Magia> Avanzado> Smooth y Simplificar./ Edit>Shape 
Magic>Advanced>Smooth & Simplify. 

• En la siguiente ventana se abre con los ajustes que se pueden ajustar si lo deseas. Los ajustes se reflejarán en la 
vista previa para que las distorsiones de la imagen se pueden evitar: 

Number of nodes in the 

selection before and after 

Auto Simplify is applied 

Percent reduction in the 

number of nodes 

Click on OK to close the 

window 
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 La opción Ignorar Longitud/ Ignore Length se puede utilizar para controlar la cantidad de suavizado aplicado a 
una imagen. Por ejemplo, en la siguiente imagen de una manzana muy angular, mayor es el ajuste para Ignorar 
Longitud/ Ignore Length, mientras mantiene Nodos suaves/ Smooth Nodes en un valor constante, más redondeo 
de la forma: 

             

 

 

 En general, la función  lisa y simplificar/ Smooth and Simplify no se utiliza debido a las dos funciones más fáciles 
(Auto Simplificar patrones/ Auto Simplify Paths y Auto Simplificar Patron/ Auto Simplify Path), que fueron 
ambos añadidos a MTC después de la introducción de esta función. 

 Si Simplificar Nodos / Simplify Nodes no reduce los nodos de manera significativa, a continuación, tratar de 
reducir el tamaño de la imagen, como se describe al final de la sección Ruta Auto Simplificar/ Auto Simplify Path. 

 
7.03 Shape Magic Advance Part 2: Details/ Forma Magia Avance Parte 2: Detalles 

View Path Detail/Ver detalles Path 

 La función de Vista Detalle Path/ View Path Detail se utiliza para proporcionar información sobre la forma o 
formas seleccionadas, así como indica el orden en el que da forma serán cortados. Se puede acceder de las 
siguientes maneras: 

 Haga clic en el icono de Avance/ Advance en la barra de herramientas de la magia/ Magic Toolbar  

y seleccione Ver Detalle Path/ View Path Detail 

 Presione Ctrl + Shift + X 

 Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > 
Detallado trazado/ View Path Detail en el menú 

Vista previa de 

cómo se 

cambiará la 

imagen 

Opción para mostrar los nodos 

Ajuste estos valores y tenga en 

cuenta los cambios en las 

formas 

Reducción de nodos basado 

en valores actuales 

seleccionados 
Click en Accept 

cuando termine 

Forma original Ignorar Largo/Lenght: 

0.15 

Ignorar Largo/ 

Length: 0.36 

Ignorar largo/ Length: 

0.43 

Ignorar largo/ Length: 

0.71 
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 Vaya a Editar> Forma Magia> Avanzado> Detallado Sendero/ Edit>Shape Magic>Advanced>View 
Path Detail 

 

 

• Una vez seleccionado, la siguiente ventana se abrirá: 

                                               

 

Nodes on Mat/Nudos en Mat 

 Los nodos en función Mat/ Nodes on Mat es un on /off  automático en el que se apaga cuando MTC se instala 
por primera vez. Cuando se activa, los nodos en todas las formas se le aparecen en la pantalla: 

    

 

 

 Los nodos en el mat de corte/ Nodes On  Mat se puede acceder de las siguientes maneras: 

o Haga clic en el icono de Avance/ Advance en la barra de herramientas de Magia/ Magic Toolbar  y 
seleccionar nodos en la estera/ Nodes On Mat 

o Presione Ctrl + Shift + I 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Nodos 
en el mat/ Nodes On Mat desde el menú. 

o Vaya a Editar> Forma Magia> Avanzado> Nodos En Mat./ Shape Magic>Advanced>Nodes On Mat. 

 Para ver el orden en el que se cortan las formas, haga clic en la línea superior en el lado derecho para resaltarlo. 
La ubicación de ese corte a partir aparecerá en la forma en el lado izquierdo. A continuación, mantenga pulsada 
la tecla de flecha abajo en el teclado. No hay manera de controlar realmente el orden en el que formas cortadas. 
A partir de la versión 4.3, formas cortarán automáticamente en orden de derecha a izquierda. 

 

Imagen 

previa 

Numero de formas/Shapes, 

segmentos/Segments,Puntos/ 

Points, y nudos/ Nodes  
Esta es una lista paso a paso 

de los caminos que 

conforman las formas 

seleccionadas. Se forma una 

hoja de ruta de cómo la hoja 

viajará al cortar. 

Nodes On Ma Apagados Nodes On Mat Encendidos  



158 
 

7.04 Shape Magic Advance Part 3: The Path Functions/Forma Magia Avance Parte 3:  
 

Flatten Paths/Las funciones de trayectoria. 

 La función Aplanar Caminos/ Flatten Paths elimina todas las curvas de Bézier de una forma. Es muy rara vez se usa 
porque otras funciones realizan automáticamente según sea necesario. La única vez que debe de estar es al 
cambiar el tamaño de un cuadro de límite que se extiende más allá de los límites de una forma. La función Aplanar 
Caminos/ Flatten Paths será redimensionar un cuadro delimitador para alinearse con la verdadera anchura y altura 
de la imagen. 

• Por ejemplo, importar la forma del corazón 1 de la carpeta genérica en formas básicas/Basic shapes: 

 

             

 Estas brechas no plantean un problema, excepto en algunas circunstancias, como por ejemplo: 

 Si usted está tratando de alinear la parte superior, izquierda o lado derecho de este corazón con otra 
forma o formas. Debido a las lagunas, no sería capaz de utilizar las funciones de alineación de la 
Sección 3.15, con la excepción de la alineación final. 

 Si necesitabas el corazón para ser un tamaño específico, por ejemplo, exactamente 1 “de altura. El 
cuadro delimitador para este corazón es de 1 “de altura, pero es evidente que el corazón es 
significativamente más corto que eso. 

 Para volver a colocar un cuadro delimitador, seleccione la forma y la función Aplanar Caminos/ Flatten Paths se 
puede aplicar en cualquiera de las siguientes maneras: 

 Haga clic en el icono de Avance/ Advance  en la barra de herramientas de la magia / Magic Toolbar  

y  seleccione Aplanar Caminos/ Flatten Paths 

  Presione Ctrl + Shift + F 

 Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Acoplar 
Caminos/ Flatten Paths  desde el menú 

 Vaya a Editar> Forma Magia> Avanzado> Acoplar Caminos/ Edit>Shape Magic> Advanced>Flatten 
Paths. 

• El corazón ahora aparece con el cuadro delimitador alineado: 

 

                                                                                           

Tenga en cuenta las brechas 

entre los bordes del cuadro 

delimitador y el propio 

corazón 

Los huecos se deben a 

los puntos de control en 

las curvas de Bézier 

Sin 

interrupciones! 
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 Debido a que el comando de Sendero Aplanar/ Flatten Path  añade un importante número de nodos, es 
recomendable hacer un seguimiento de esta función con la función Auto Ruta Simplificar/ Auto Simplify Path 
presentado en la Sección 7.02.2. 

 

Thin Paths/Caminos Delgados 

  

 La función de  Caminos delgados  / Thin Paths se utiliza para convertir una forma en una sola línea o curva. Esto 
es útil en el diseño rhinestone para convertir fuentes finas en las fuentes de una sola línea. También se puede 
utilizar después de una imagen de líneas en blanco y negro de rastreo (también conocido como colorear la imagen 
del libro), como esta imagen Lobo: 

 
 

 

 

 

 Después de seleccionar la forma, delgados Caminos/ Thin Paths  se puede aplicar en cualquiera de las siguientes 

maneras: 

o Haga clic en el icono de Avance/ Advance  en la barra de herramientas de la magia/ Magic Toolbar 

 y seleccione Caminos delgados/ Thin Paths 

o Presione Ctrl + Shift + K 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/Advanced> 

Delgados Caminos/ Thin Paths desde el menú 

o Vaya a Editar> Forma Magia> Avanzado> Caminos delgados./ Edit>Shape Magic> Advanced>Thin 

Paths 

Fusible n ‘Weld 

 El Fuse n’ Weld función de soldadura fusible se utiliza para eliminar las formas duplicadas en el mismo camino y 

también unir nodos juntos que están en la parte superior de uno al otro. Esto es en su mayoría de uso común 

para la importación de determinados formatos de archivo en el que no puede haber cientos de pequeños 

caminos de desconexión que componen la forma. 

 A modo de ejemplo, digamos que tenemos varias líneas de caminos rectos de desconexión: 

 

Original imagen  Despues de 

Pixel Trace  

Despues de 

Thin Paths  

http://vimeo.com/user8812763/review/31912018/845ed9d0e6
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 Para conectar estos, tenemos que primero asegurarse de que las diferencias son muy pequeñas. Para eso, 

vamos a seleccionar los segmentos de línea y cambiar el tamaño de decir 10% utilizando el método que se 

muestra en la Sección 3.13. En otras palabras, asegúrese de que la relación de aspecto está bloqueado y el tipo 

en el 10% en el W: cuadro de ajuste: 

 

 

 

 

 Una vez que la línea se cambia el tamaño, haga clic en el icono de Join   en la barra de herramientas de forma 

mágica/ Shape Magic  para unirse a los segmentos y luego la función Fuse n ‘Weld se puede aplicar en cualquiera 

de las siguientes maneras: 

o Haga clic en el icono de Avance/ Advance en la barra de herramientas de la magia/ Magic Toolbar 

 y seleccione Fusible n ‘Weld 

o Presione Ctrl + Shift + M 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Fuse n’ 

Weld en el menú 

o Vaya a Editar> Forma Magia> Avanzado> Fusible n ‘Weld./ Edit>Shape Magic> Advanced>Fuse n’ 

Weld. 

 

 

                                                                            
 

 Para cerrar las brechas apretados, como en este caso, deslice la Tolerancia/Tolerance al máximo y haga clic en 

Aplicar 

 Para cambiar el tamaño de la selección, el tipo en el 10% r en el W: ajuste, por lo que se aplicará la reciprocidad y 

la línea será redimensionada a su ancho original. 

 

Reverse Paths/Caminos inversos 

 La función de Caminos inversos/ Reverse Paths se utiliza para cambiar la dirección de un corte. Esta no es una 

función de uso común, pero a veces puede fijar corte problemas con algunos archivos. 

 Para ver la dirección de un corte, presione F10 para abrir la herramienta Medir en la barra/ Measure Tool  Modo 

Nodo/ Node Mode. Mueva su ratón sobre una forma y se llenará con las rayas. Una flecha verde apuntará en la 

dirección del corte. En el siguiente ejemplo, el corte procederá en sentido antihorario alrededor de la forma: 

Introduzca 10% al cambiar el tamaño de las 

líneas y hacer los huecos más pequeños (nodos 

más juntos) 

Maxima Tolerancia/ 

Tolerance y  click en Apply. 
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 Rutas inversa/ Reverse Paths  se puede acceder en cualquiera de las siguientes maneras: 

o Haga clic en el icono de Avance/ Advance en la barra de herramientas de la magia/ Magic Toolbar 

 y seleccione Caminos Inversos/ Reverse Paths 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > Invertir 
Caminos / Reverse Paths desde el menú 

o Vaya a Editar> Forma Magia> Avanzado> Trazados inversa./ Edit>Shape Magic> Advanced>Reverse 
Paths 

 La aplicación de Caminos inversos / Reverse Paths al ejemplo anterior causará la flecha ahora a apuntar hacia abajo 
y el corte procederá agujas del reloj alrededor de la forma: 

 

      

 Consulte la Sección 7.08 para usos adicionales de la herramienta Medir. /Measure Tool. 

 
7.05 Shape Magic Advance Part 4: Tile/7.05 Forma Magia Avance Parte 4: Solador 

 

 La función de solador/ Tiler se utiliza para dividir una forma o selección de formas en secciones más pequeñas 
para el corte. 

 En el siguiente ejemplo, se supone que desea cortar un 58 “de diseño ancho (como la de abajo), pero su cortador 
sólo tiene un máximo de 14” de ancho de corte (como el KNK Zing). 

Close-up 

Acercamiento 

Sitúe el cursor sobre la línea 

exterior de la forma para 

resaltarlo. 

La flecha verde indica la 

dirección de corte 

Forma igual despues 

de aplicar Reverse 

Paths   

Flecha verde está indicando que 

corte procederá a la izquierda 

alrededor de la forma. 

Close-up 

http://vimeo.com/78737584
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 Después de seleccionar la forma, la función Solador/ Tiler puede acceder de las siguientes maneras: 

o Haga clic en el icono de Avance/Advance en la barra de herramientas de la magia/ Magic Toolbar 

y seleccione Solador/ Tiler 

o Presione Ctrl + Shift + N 

o Haz clic derecho en la pantalla y elegir Forma Magia/ Shape Magic > Avanzado/ Advanced > 

Solador/ Tiler en el menú 

o Vaya a Editar> Forma Magia> Avanzado> solador/ Edit>Shape Magic> Advanced>Tiler. 

 La siguiente ventana se abrirá con un conjunto de ajustes predeterminados: 

 

 
 

 Sólo el ancho de la teja/ Tile Width debe ajustarse a algo menos de 15 “, ya que el cortador puede manejar 14” 

de ancho de corte. Para este ejemplo, la anchura del azulejo/ Tile Width se ajustará a 13.5 “. Nótese que es 

asumir que el cortador puede cortar secciones largas de vinilo a la vez, por lo que el azulejo/ Tile Width será 

fijada ligeramente mayor que la altura de la forma. Además, no hay necesidad de tener todavía un 

desplazamiento, por lo que se establece en 0: 

 

Vista previa de 

forma dividida en 

azulejos para cortar 

W y  H de figura en el screen 

Opciones para ajustar W y  H  

W y H de cada baldosa 

Distancia al desplazamiento 

horizontal de azulejos verticales 

Click  en Preview aplicar los 

nuevos ajustes 
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La Quinta  baldosa  tiene solamente 

una pequeña parte de una hoja! 

                                                            

 

  

 

 Todo se ve bien, excepto por la última ficha en la que sólo hay una fracción de una hoja. Esto no sería un uso 

económico del vinilo. Por lo tanto, los ajustes podrían ser ajustados sólo una ligera cantidad de manera que sólo 

cuatro azulejos serán cortados en vez de cinco. Hay varias opciones: 1. El ancho real/ Actual Width de la imagen 

podría hacerse ligeramente más pequeño, 2. La anchura del azulejo/ Tile Width podría hacerse ligeramente más 

grande, o 3. Una combinación de ambos: 

 

                                              
 

 

 

 

 

• Los azulejos individuales se colocan en nuevas páginas/ Pages en la barra de Página/ Page Bar:: 

 

 

                           

 

 

vista preliminar 

revisado Tile Width cambia a 13.5”   

Tile Height cambia a 66”   

Offset Y cambia a 0”   

Vista previa 

revisada  

Solo 4 baldosas 

Tile Width: 
aumentar 

ligeramente 

New Width: disminuir 

ligeramente 

Click en  Accept   
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7.05 Node Mode Toolbar /Modo Nudo Toolbar 

 

 El modo de barra de herramientas Nodo/ Node Mode Toolbar ofrece herramientas a utilizar para la edición de 

formas, dibujar líneas y curvas, la importación de la biblioteca de formas básicas/ Basic Shapes, y una serie de 

otras funciones. Esta barra de herramientas se puede activar en cualquiera de las siguientes maneras: 

o Haga clic en el icono   en la zona superior izquierda de la pantalla, como se muestra en la Sección 

4.01. 

o Presione F1 o W 

o Ir a Ver> Modo de nodo/  View>Node Mode. 

 El modo de barra de herramientas de nodo/ Node Mode Toolbar aparece en la parte izquierda de la pantalla. La 

siguiente captura de pantalla muestra la función de cada herramienta y la sección número detallando esta 

herramienta. Tenga en cuenta que tres de las funciones se presentan en el capítulo 8, ya que están relacionados 

con el diseño, en lugar de la edición: 

 

                                                                                                      
 

7.07 Edit this Project Normally (Select Tool) /  Editar este Normalmente Proyecto (Herramienta de 
selección) 

 

 El Editar esta función Proyecto Normalmente (Select Tool) es el primer icono  en el modo de barra de 

herramientas Nodo/ Node Mode Toolbar y puede activarse haciendo clic en el icono o pulsando F1. Tiene una 

función principal que es que lo lleve a cabo cualquier otra función en esta barra de herramientas, lo que le 

permite utilizar las otras barras de herramientas o funciones en el MTC. 

Forma original todavía 

estará en la página 

original 

Cuatro nuevas páginas se crean para albergar a las cuatro fichas 

Editar este proyecto normalmente (herramienta de 

selección): 7.07 

Añadir formas básicas (Herramienta Formas 

básicas): 8.02 

Dibujar curvas de Bézier y líneas 

rectas (Pen Tool): 7.12 

Slice formas y líneas (Herramienta Cuchillo): 

7.09 

Editar trazados a nivel de nodo (Herramienta Editar Nodo): 7.13 

Dibujar líneas a mano alzada (Herramienta 

Lápiz): 7.11 

Borrar secciones de caminos (Herramienta 

Borrador): 7.10 

Medida da forma a longitudes y ángulos 

(Mida Tool): 7.08 

Crear espirales (Herramienta Espiral): 8.03 

Crear estrellas y polígonos (Estrellas y Polígono 

de herramientas): 8.04 
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7.08 Measure Shape Lengths and Angles (Measure Tool) / Medir longitudes forma y Angulos 
(Herramienta de medida) 

 

 Las longitudes de la forma y de  ángulos/ Measure Shape Lengths and Angles (Measure Tool) es el último icono 

 en la barra de herramientas Modo de nodo / Node Mode Toolbar y puede ser activado haciendo clic en el 

icono o pulsando F10. Se utiliza para obtener las propiedades y los detalles acerca de cualquier forma, 

incluyendo caminos internos dentro de esa forma. 

 En este ejemplo, la herramienta de Medida/ Measure Tool  se utiliza para señalar las diferencias entre estas dos 

estrellas: 

 

 Haga clic en el icono de la Medida/ Measure Tool  y el cursor del ratón se convierte en una regla. Desplace el 

cursor a lo largo del lado de una de las formas. La forma llenará con rayas y la parte superior de la pantalla 

mostrará las propiedades de esa forma, que incluyen Perímetro/ Perimeter (hoja distancia viajará), Zona de 

Camino,/ Cut Direction,  Dirección Cut, el número de nodos, y las dimensiones del cuadro delimitador de la forma 

(W y H, que debe coincidir con los que ves en la Sel. Barra Propiedades/ Properties Bar cuando ya no está en el 

modo de nodo/ Node Mode). 

                                                                  

                                                      
 Del mismo modo, cuando se pasa el cursor sobre un lado exterior de la otra estrella, el área sólida de la estrella 

se llenará de rayas y se mostrará las propiedades de la estrella exterior. Si pasa el cursor sobre la estrella interior, 

a continuación, las propiedades de esa estrella se mostrarán en su lugar: 

  

         

 Tenga en cuenta que el área de trazado de la estrella exterior incluye el área de la estrella interior. No restar esa 

parte de la forma. Esto tiene sentido en relación con el corte desde sería necesaria la misma cantidad de 

material a cortar la estrella exterior, independientemente de si o no la estrella interna se cortaron. Si, por 

Mueve el cursor sobre la línea 

exterior de la forma de criar a 

propiedades 

Propiedades de la 

parte resaltada de la 

forma 

Flecha verde Pequeño indica 

la dirección de corte 
Opción para 

mostrar el 

tamaño en 

pulgadas, cm o 

mm 

Propiedades 

de las estrellas 

exterior 

Propiedades 

de las estrellas 

interno 

https://vimeo.com/58134563


166 
 

cualquier razón, usted necesita el área real de la estrella más grande, entonces usted podría restar el área de 

trazado de la estrella interior de la de la estrella exterior. 

 Para medir un ángulo, coloque el cursor en el punto donde los dos lados de la reunión de estrellas y arrastrar 

hacia el exterior a lo largo de uno de los lados. Se muestran la longitud y el ángulo de este lado del horizonte. 

Luego mantenga presionada la tecla Ctrl y llevar el cursor del ratón hasta la punta exterior del otro lado. La 

longitud de este lado y el ángulo con relación al otro lado se muestran ahora: 

                        

        

 Del mismo modo, el ángulo de la otra estrella se puede medir y luego la lista completa de propiedades de 

comparación entre las dos estrellas: 

     

                         
 

7.09 Slice Shapes and Lines (Knife Tool)/ Parte de las  formas y líneas (Herramienta de cuchillos) 
 

 La función Slice formas y líneas/ Slice Shapes and (Herramienta de cuchillos/ Knife Tool) es el icono  noveno 

en el modo de barra de herramientas Nodo y puede activarse haciendo clic en el icono o presionando F9. Se 

utiliza para cortar una forma o formas existentes a lo largo de líneas rectas o caminos libremente dibujados. 

 Por ejemplo, vamos a usar la forma Secret Agent Man de la biblioteca de formas básicas. Digamos que usted 

desea quitar la parte inferior de la forma de modo que cuando se corta, la forma sería que permanece unido al 

material y puede ser plegado: 

                                                                                      
 

 Para cortar sólo la parte inferior de la forma, seleccione la herramienta Cuchillo y mantenga pulsado el botón del 

ratón fuera de la forma, por un lado, apenas por encima de la parte inferior de la forma y luego arrastrar el 

ratón hacia el otro lado, dejar ir una vez que el cursor se encuentra fuera de la forma: 

 
 

Length del lado que se 

muestra, junto con el 

Angle de este lado del 

horizonte. 

Oprima Ctrl y mover el cursor 

hasta el final de la otra parte. 

Propiedades que se muestran son 

la longitud del lado y el ángulo 

entre las dos partes. 

 Knife Tool se utiliza para eliminar la 

línea inferior de esta forma. 
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 A continuación, haga clic en la herramienta de selección/ Select Tool (Edit this project normally  (Editar 

este proyecto normalmente) en la parte superior de la barra de herramientas de modo Nodo. Ahora usted puede 

seleccionar y mover la línea de corte de la parte inferior de la forma y eliminar. La forma ya no tiene una línea de 

conexión a lo largo de la parte inferior: 

 

             

 
 

7.10 Erase Sections of Paths (Eraser Tool) /  Borrar Secciones de Caminos (herramienta Borrador) 

 

Erasing/Borrando 

 Las Secciones Borrado de la función Path / Erase Sections of Path  (Herramienta Borrador) es el icono de la 

octava  en la barra de herramientas Modo de nodo/ Node Mode  y se pueden activar haciendo clic en el 

icono o pulsando F8. 

 Use esta herramienta para borrar partes de una forma, así como la adición de una forma. Para borrar, arrastre el 

botón izquierdo del ratón y se eliminarán las formas por debajo de ese camino dibujado. Para una línea recta de 

borrado, pulse la tecla Ctrl mientras arrastra el puntero del ratón. 

 Importante! Antes de utilizar la herramienta Borrador para grandes cambios a una imagen, apague Auto 

Simplificar Caminos/ Auto Simplify Paths.  De lo contrario, la forma comenzará a perder su forma como 

simplificar el proceso se aplica repetidamente. Para ello, haga clic derecho en la pantalla y elija Forma Magia/ 

Shape Magic > avanzadas/ Advanced > Auto Simplificar Caminos/ Auto Simplify Paths en el menú (o consulte la 

Sección 7.02.1 para los otros métodos). Luego, una vez que haya terminado de usar la herramienta Borrador, 

aplicar la Ruta Auto Simplificar/ Auto Simplify Paths  o funciones lisas y simplificar para reducir el número de 

nodos para el corte más suave/ Smooth and Simplify. Consulte las secciones 7.02.2 y 7.02.3. 

 La flor que se trazó en la Sección 6.03 se utilizará para ilustrar la herramienta Borrador/ Eraser Tool . La flor se 

volverá de color azul para que las líneas rojas de goma de borrar, en las capturas de pantalla, será más fácil de ver 

en este manual del usuario. Las flechas indican las áreas que necesitan tener algo de la capa azul borrado: 

     

Comience cortando justo 

por fuera y por encima 

de la parte inferior de la 

forma. 

Arrastre el ratón para el otro lado 

y dejar ir cuando el cursor está 

más allá de la frontera de forma. 

Arrastre línea 

inferior de 

distancia y 

eliminar. 

Forma está abierto 

en la parte inferior. 

Re-color de la 

flor 

https://vimeo.com/54814720
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 Cuando utilice la herramienta Borrador/ Eraser Tool , todas las capas se borrarán en el lugar donde se aplica la 

goma de borrar. Así que, para evitar el borrado de la capa de negro al borrar el azul, la capa de negro tiene que 

ser ocultado. Seleccione la capa y pulse la Selección de propio/ Selection to Own Layer  icono de capa en la 

parte inferior de la barra de capa. Luego ocultar la capa negro pulsando el icono Ocultar Capa/ Hide Layer   

 

 

 

 
 

 Zoom en estrecha de modo que usted será capaz de ver exactamente donde tiene que borrar. Cuando se activa la 

herramienta Borrador, los siguientes ajustes aparecerán en la parte superior de la pantalla: 

 

                                                                                        
 

 Mantenga pulsado el botón izquierdo del ratón y arrastrar el ratón en una pequeña línea en la que desea borrar. 

Una línea roja se elaborará y, al soltar el botón del ratón, se borrará la parte de la forma debajo de esa línea roja: 

 

                                                   

 

 
 

 Si la línea era demasiado gruesas y que borró más de lo que quería, a continuación, utilice el botón Deshacer/ 

Undo (o Ctrl + Z) para retroceder un paso. A continuación, introduzca un borrado menor tamaño. Si no es 

suficiente fue borrado, y luego aumentar el Borrador Tamaño y repasar su trayectoria de nuevo con la goma de 

borrar más grueso. 

 Aplicar la herramienta Borrador para las otras dos áreas de los pétalos de color amarillo. En el siguiente ejemplo, 

uno de los pétalos tiene que ser separado del centro de la flor: 

 

Capa de Negro está 

en su propia capa 

nueva 

Después de ocultar la capa, el icono 

cambiará a un ojo cerrado. 

Deja sin marcar 

Introduzca el tamaño (grosor) del 

borrador que desea utilizar. 

Ratón arrastrar a lo largo de ruta 

que desea borrar. Una línea roja 

aparecerá mientras arrastra. 

Ratón de lanzamiento y la ruta 

bajo la línea roja se borran. 

Forma debe ser borrado para 

que este pétalo coincide con 

los demás 
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 En este último ejemplo, uno de los pétalos sobresale un poco demasiado lejos y se recortará espalda. En la 

segunda el borrado, la tecla Ctrl se mantiene presionado para que la línea roja será perfectamente recto: 

 

                      

 
 

 

 

 Una vez que haya terminado de borrar toda la parte de los pétalos, haga clic en la herramienta de selección para 

que tenga acceso a las funciones regulares MTC. Seleccione los pétalos y aplicar el Camino Auto Simplificar 

(Sección 7.02.2) para suavizar los bordes donde se borran y reducir los nodos. En este punto, si usted termine de 

usar la herramienta Borrador, ahora se puede reactivar Auto Simplificar Caminos. Consulte la Sección 7.02 

 

Inverse Erasing (Adding to an Image)/ Borrado Inverso (Adición de una imagen) 

    

 La otra opción en la configuración de la herramienta Borrador es el Borrador inverso/ the Inverse Eraser que le 

permite añadir o rellenar áreas vacías de una forma. Marque esta opción y otra vez, establecer un tamaño para el 

uso de la herramienta Borrador como una herramienta de dibujo: 

                                                                                         
 

 Volver a nuestro ejemplo anterior, el camino gris alrededor de ese último pétalo amarillo representa la capa de 

sombra negro que estaba oculto durante el proceso de borrado. Observe cómo se hace muy delgada en esa área 

donde se alisó el último pétalo: 

Pétalo está ahora separada de 

centro de la flor. 

Pétalo está conectado 

al centro de la flor. 

Eraser Tool se utiliza 

para desconectar. 

Eraser Tool se utiliza de nuevo 

para suavizar el borde del 

pétalo y alrededor de centro 

de la flor. 

Pétalo es más suave Pétalo extiende 

demasiado en el 

exterior 

Eraser Tool se utiliza para 

borrar esa parte. 

Eraser Tool se utiliza de 

nuevo, esta vez manteniendo 

pulsada la tecla Ctrl para 

conseguir un camino recto. 

Seleccionar Inverse Eraser  
Introduzca el tamaño (grosor) de la 

línea de dibujo. 

https://vimeo.com/36523440
https://vimeo.com/72203701
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 Esta es una aplicación perfecta para el Inversa Borrador/ Inverse Eraser. Si había muchas áreas alrededor de la 

imagen en la que la capa de sombra necesaria corrección, probablemente sería más rápido para eliminar la capa 

de sombra que se píxel remontar desde el original, y luego usar la función de capa Sombra/ Shadow Layer  en 

MTC para crear una nueva (consulte la Sección 8,05). Pero en este caso, sólo que un punto parece demasiado 

delgada. 

 Hay varias cosas que se deben hacer antes de utilizar la herramienta. Si va a utilizar para una serie de puntos 

alrededor de la forma, de nuevo apague Auto Simplificar Caminos/ Auto Simplify Paths (consulte la Sección 

7.02.1). Tenga en cuenta que si usted todavía está en la función de herramienta Borrador, tendrás que hacer clic 

en la herramienta de selección/ Select Tool para volver al modo normal de MTC. 

 A continuación, mostrar la capa de negro y mover hacia abajo en la barra de capa/ Layer Bar para que sea ahora 

detrás de los pétalos. 

                                    
 Activar la herramienta Borrador/ Eraser Tool, una vez más confirma que el cuadro inverso Borrador/ Inverse 

Eraser está marcado. Luego hacer un zoom sobre la zona donde la sombra negro estaba muy cerca de los 

pétalos. Arrastre el botón izquierdo del ratón para ampliar la frontera alrededor de la flor: 

                           

 

                                

       
 

 

Capa de sombra es muy 

fina en este punto. 

Capa de negro se 

trasladó a la parte 

inferior. 

Capa de Negro se 

trasladó a la parte 

inferior de modo 

que está ahora 

detrás de los 

pétalos azules y 

hojas verdes. 

Borde negro es 

demasiado delgada. 

Se añade primer camino, la 

superposición con zona de 

espesor. 

Se añade otro camino, la 

superposición con la 

primera. 

Más se añade, de nuevo se 

superponen con el primer paso. Resultado de caminos 

añadido. 
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 Al igual que con el proceso de borrado, aplicar la función Auto Ruta Simplificar/ Auto Simplify Path (consulte la 

Sección 7.02.2), si ha desactivado las Simplificar Caminos Auto/ Auto Simplify Path antes de utilizar esta 

herramienta. A continuación, encienda Auto Simplificar Caminos/ Auto Simplify Path. Consulte la Sección 7.02.1. 

 PRECAUCIÓN! Si se utiliza el inverso Borrador y cruzar de una forma a otra persona, esta adición no 

automáticamente soldar y, cuando envió a la corte, usted puede terminar con líneas de corte no deseados. Por 

ejemplo, digamos que usted tiene una flor y hay dos hojas que no están conectados a la madre. Usted decide 

utilizar el inverso Borrador/ Inverse Eraser para unirse a esas hojas a la raíz: 

 

 Todo parece que funcionó, lo que quisieras, pero, se corta el tallo de la flor / hojas, la nueva hoja de tallos se cortan 

en el tallo más grande. Sin embargo, parece ser lo que quería, ya que han de llenado activado. Si cambia a modo 

de esquema/ Outline y hacer zoom in en las hojas, verás esto: 

                                                            

 Si te das cuenta de que esto ha sucedido, sólo tiene que aplicar la herramienta de soldadura/ Weld tool  
para eliminar las partes superpuestas: 

 

 

 Para evitar esto, primero seleccione las formas (en el caso, el tallo y dos hojas) y aplicar la herramienta Unir/ Join 

tool  A continuación, puede utilizar la inversa Borrador y las partes añadidas será soldada automáticamente. 

 

 

 

Las hojas no están soldados 

al tallo 
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Eraser or Knife?/Borrador o cuchillo? 

 En la Sección 7.09, se demostró cómo la herramienta cuchillo / Knife Tool  se puede utilizar para cortar formas en 

partes. La herramienta Borrador también se puede utilizar para este mismo propósito, cuando el tamaño se 

establece en un valor muy pequeño, como 0,03 mm (el tamaño mínimo permitido). Las diferencias entre las dos 

herramientas son: 

o La herramienta Borrador se cierra automáticamente las trayectorias de ambos lados de las partes 

borradas: 

                                                                     
o La herramienta Borrador/ Eraser Tool no se rompe la forma en formas individuales mientras que la 

herramienta Cuchillo/ Knife Tool hace: 

 

   
 

o La herramienta Borrador no se limita a los cortes de línea recta: 

                                  

 
 

 

 Si va a crear una tarjeta de ventanas emergentes, donde las partes superiores e inferiores de las formas tiene que 

ser eliminado, entonces la herramienta del cuchillo/ Knife Tool es la mejor opción: 

                                             
 

 Si está rompiendo una imagen para crear un proyecto de juntar las piezas de papel, la herramienta Borrador es la 

mejor opción: 

     

 

 

Knife Tool results in 

open paths 

Eraser Tool results in 

closed paths 

Knife Tool resultados 

en formas separadas 

Eraser Tool resultados en una 

sola forma hasta que se aplican 

Break 

Knife Tool sólo puede cortar líneas rectas Eraser Tool puede cortar caminos 

personalizados 
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7.11 Draw Freehand Lines/dibujar líneas a mano alzada  
 

 La función Draw Freehand Lines (herramienta Lápiz) es el icono  de tercero en el modo de barra de 

herramientas Nodo/ Node Mode Toolbar y puede activarse haciendo clic en el icono o pulsando F3. Esta 

herramienta se utiliza para dibujar libremente líneas delgadas o gruesas con el ratón o tableta, o incluso dibujar 

líneas de puntos o un camino de círculos! Sus formas se pueden editar con las otras herramientas en la barra de 

herramientas Modo de nodo/ Node Mode Toolbar, así como personalizar utilizando otras funciones en el MTC. 

Drawing Thin Lines/ Dibujo Líneas finas 

 Hay una serie de ajustes que afectarán el resultado de su dibujo. Smoothing se utiliza para controlar si el dibujo es 

más angular (compuesto por caminos líneas rectas) o más redondo (formado por curvas). Precision se usa para 

controlar el número de nodos utilizados como se dibuja la imagen. La opción Forzar cerrado/ Force Closed, cuando 

marcó, se cerrará automáticamente el principio y el final de la ruta mientras dibuja: 

                                                                                 

 

 Por ejemplo, si usted es dibujo a mano alzada la letra “A”, que le quiere disminuir Smoothing y precisión para que 

las líneas rectas se dibujan. Pero si se utilizaran los mismos ajustes bajos para dibujar una “S”, la carta terminaría 

angular y no bien formada: 

 

 Para una curva, como una “S”, que se quiere aumentar suavizado/ Smoothing de manera que no se forman líneas 

rectas. Para el resultado más suave, seleccione la opción de Super Smooth: 

                                                                  

 

 El ajuste de precisión, como se mencionó antes, permite una “S” más preciso que se elaborará, pero muchos más 

nodos resultará. A continuación se muestra la diferencia cuando la precisión se deja a 0 frente al 100% frente al 

50%: 

                                                       
 

 

 Si tiene que dibujar una línea perfectamente recta, mantenga presionada la tecla Ctrl mientras dibuja: 

Aumentar Smoothing para curvas 
Aumentar Precision para mas detalle 

Marque Force Closed para cerrar el 

trazado 

Seleccione Super Smooth para maxima 

suavidad 

Suavizar: 100% Súper suave: On 

Precision: 0% Precision: 100% Precision: 50% 
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 La opción Ruta Fuerza cerrado/ Force Closed Path se puede marcar de manera que, a medida que dibuja una 

imagen, se conectarán siempre el principio y el final. Por ejemplo, en este dibujo a mano alzada de un rayo, el 

final de la línea siempre se conecta de nuevo al principio. Una vez que el cursor vuelve al punto de partida, la 

forma se cerrará y se llenan de colores (suponiendo Llena está activada): 

 

                     

 

Drawing Thick Lines / Dibujo gruesas líneas 

 Para dibujar una línea que se establece para un grosor determinado, marque el cuadro Ruta de grasa/ Fat Path y 

entrar en la configuración de grosor y estilo de línea / Line Cap  

 

 

 

 

 

 Al dibujar libremente con la trayectoria  seleccionada/ Fat Path, la línea será el espesor seleccionado. Tenga en 
cuenta que cuando se cruza el camino, la superposición se eliminará automáticamente. También tenga en cuenta 
las diferencias en las tres opciones Line Cap: 

 

 

 

 

 

 Tenga en cuenta que si una ruta/ Fat Path se cruza, se eliminará el solapamiento: 

                                                                    

 
 

 

Seleccione  Fat Path. 
Ingrese  Width (grosor 

de la línea) 

 

Elija entre siete 

estilos de capas 

Plano Redonda Triangulo Linea  es 

ahora 5 mm 

de espesor 

Ancla flecha Ancla cuadrada Ancla redonda Ancla diamante 

Solapamientos eliminado 

automáticamente 
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Drawing with Other Line Styles/Dibujo con Otros Estilos de línea 

 La herramienta de dibujo a mano alzada/ Freehand Drawing Tool ofrece otros estilos de línea, además de líneas 

continuas, incluyendo guiones, círculos y combinaciones de los dos: 

 

 

 

 Hay cinco opciones de estilo Dash/ Dash Style para producir aún más la capacidad de diseño, sobre todo, cuando el 
entonces combinado con los siete diferentes opciones de inicio y la tapa. Aquí están algunos ejemplos: 

 
 

7.12 raw Bézier Curves and Straight Lines (Pen Tool) / Dibujar curvas Bézier y líneas rectas (Pen 
Tool) 

 La función de curvas y líneas rectas  Draw/ Draw Bézier Curves and Straight Lines (Pen Tool) es el icono de cuarto 

en el modo de barra de herramientas Nodo/ Node Mode Toolbar   y puede activarse haciendo clic en el icono o 
pulsando F4. Utilice esta herramienta para dibujar nuevos caminos. Puede ser un poco difícil de dominar, pero al 
igual que con muchas buenas prácticas cosas- hace al maestro! 

Drawing Straight Lines / Dibujando líneas rectas 

Para dibujar una sola línea recta, utilizar el ratón a izquierda haga clic una vez en la que desea iniciar la línea y haga 
clic derecho en el que desea terminar la línea. Cada clic genera un nodo: 

                     

 

 

Si desea seguir dibujando una trayectoria recta que une, entonces en vez de hacer clic derecho hasta el final, seguir 
haciendo clic izquierdo. En cualquier momento puede hacer clic derecho de agregar el último nodo y terminar el dibujo 
de líneas rectas: 

     

 

Escoja  Solid, Dash, Dot, Dash Dot, or 

Dash Dot Dot 

Izquierda haga 

clic una vez para 

comenzar. 

Mover el cursor a donde desea 

terminar la línea. 

Haga clic derecho para terminar el dibujo de 

la línea. 

Pulse para iniciar y haga clic 

izquierdo en el segundo lugar 

Izquierda 

Mover a la tercera ubicación y 

click izquierdo de nuevo. 

Mover a la cuarta ubicación y click 

izquierdo de nuevo. 
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 Por otro lado, si va a crear un trazado cerrado, a continuación, al igual que el cursor del ratón se acerca al nodo de 
partida, la forma se llenará de color y puede hacer clic una vez más para finalizar el proceso. Usted no tiene que 
hacer clic derecho para terminar el dibujo si la forma se cierra: 

                        

 

 

 Una vez más, si la forma se está cerrando, puede hacer clic izquierdo o derecho, haga clic para terminar el dibujo 
de esa forma Si la forma no se cierra, entonces usted debe utilizar un clic derecho para detener el dibujo de esa 
forma. 

 

Drawing Curves/Dibujando curvas 

 Las curvas de dibujo es un poco más difícil. La clave es dar un paso a la vez, practicar la técnica mucho, y recordar 
que más tarde puede corregir sus curvas utilizando la herramienta de edición de nodos (consulte la Sección 7.13). 

 • Para dibujar una curva, utilizar el ratón a izquierda haga clic una vez en la que desea el inicio de la curva. 
Entonces, en lugar de clic izquierdo, mantenga pulsado el botón izquierdo del ratón y empiece a arrastrar el ratón 
hacia el exterior. Continuar manteniendo pulsado el botón izquierdo y observe una línea de puntos aparece con 
dos puntos en cada extremo. Estos se llaman puntos de control: 

 

                                                                       

 Al arrastrar el ratón, podrás ver que usted tiene control total sobre cuánto tiempo será este línea de puntos, así 
como donde está posicionado los puntos de control. Experimento con las líneas de control largas y más cortas, así 
como la rotación de la línea para doblar la curva en una gama de diferentes maneras: 

 

Mover a la quinta ubicación y click 

izquierdo de nuevo. 

Si ha terminado de dibujo, haga clic derecho para 

terminar. 

Pulse para iniciar y 

luego clic izquierdo en 

el segundo lugar 

Izquierda 

Tan pronto como la forma 

llena de color, la izquierda 

haga clic para terminar. 

Al acercarse el comienzo, 

para ver la forma para 

llenar. 

Mover a la tercera 

ubicación y click izquierdo 

de nuevo. 

Puntos de control 



177 
 

   

   
 

 
 

Combining Straight Lines and Curves / La combinación de líneas y curvas rectas 

 Existen diferentes métodos para crear una cadena continua de líneas rectas y curvas. Las líneas rectas son fáciles, 
ya que, como lo dejó clic para plantar los nodos, las líneas rectas permanecen rectos y no cambian a medida que 
crea la siguiente línea recta conectada. Sin embargo, una vez que comience la creación de curvas de Bézier, no se 
puede volver a las líneas rectas, sin botón derecho del ratón para poner fin a las curvas y luego comenzar la 
siguiente línea recta desde ese punto: 

    

 

 

 

 ¡No es para preocuparse! Una vez que la curva es completa, puede hacer clic derecho para terminar con esa curva 
y luego a la izquierda, haga clic en el mismo punto de comenzar una nueva línea recta o otra curva sin molestar a 
la que acabamos de crear: 

 

 

 Al final, todos esos puntos / nodos se conectarán. Este es un método que se puede utilizar para hacer el rastreo 
manual, tal como se presenta en la Sección 6.04 

 

Fat Path and Super Smooth/ Camino de grasa y Super Smooth 

 El Bézier Las curvas y líneas rectas función Draw/ Draw Bézier Curves and Straight Lines, al igual que la función 
Draw Freehand Lines, tiene la opción de ruta de grasa/ Fat Path y Super Smooth/ Super Smooth. Hay los mismos 
cinco tipos Style Dash y los mismos siete opciones para la línea de mayúsculas al inicio y al final de las curvas de 
Bézier / líneas. Consulte la Sección 7.11 de ejemplos. 

 

 

2 líneas rectas se dibujan y luego 

se crea una curva 
Pero luego, al intentar volver a una línea recta, la curva se 

distorsiona 
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7.13 Edit Paths at Node Level (Node Edit Tool) / Editar Caminos en el nodo de nivel (Herramienta 
Editar Nodo) 

 

Nota especial: A partir de la versión 4.6, los nodos finales sobre un trazado seleccionado se muestran como cuadrados 
en lugar de pequeños círculos. Las capturas de pantalla de las secciones siguientes reflejan la forma en nodos se 
muestran antes de este cambio. 

 Las rutas de acceso a la función Editar Nodo Nivel/ Edit Paths at Node (Herramienta Editar Nodo) es el icono de 

segundo en el modo de barra de herramientas de nodo/ Node Mode Toolbar y puede activarse haciendo clic 
en el icono o pulsando F2. Utilice esta herramienta para editar ambas rutas y nodos en cualquier forma. 

 Antes de editar rutas y nodos, se recomienda que se realicen los siguientes ajustes: 

o Los nodos en la estera/ Nodes On Mat deben hacerse visibles pulsando Ctrl + Shift + I (o cualquiera 
de las otras formas que se muestran en la Sección 7.03) 

o Set Snap Posición, en el Mat virtual, en No de rotura/ No Snapping, por lo que los segmentos y nodos 
se pueden arrastrar libremente 

o Ajuste la pantalla en el Mat virtual, para llenar / Outline o  Outline para que los nodos serán visibles. 

 

Segment Editing/Segmento Edición 

En esta sección, se utilizará la forma Herramientas de formas básicas/ Basic Shapes. Seleccione la cabeza del martillo 
y luego activar el nodo Editar Herramienta/ Node Edit Tool. Usted se dará cuenta que a medida que se mueve el 
puntero del ratón sobre la forma, el que sea individuo segmento es debajo del cursor del ratón cambiará a rojo. Esto 
es similar a la forma en formas individuales se volverá de color rojo cuando está en el modo de regular en MTC. Si 
hace click en un segmento que se pondrá verde, a menos que le sucede que tiene el color alfombra verde seleccionada 
en cuyo caso el segmento se vuelve azul. Tenga en cuenta que las siguientes imágenes fueron hechas de una versión 
anterior del MTC. Desde la versión 4.6, los nodos finales en un segmento seleccionado aparecen como cuadrados 
azules, y un nodo final seleccionado se pondrá amarillo. Por ahora, estas imágenes muestran los nodos como sólo 
pequeños círculos negros: 

 

Escojer entre Solid, Dash, Dot, Dash 

Dot, o Dash Dot Dot 

Escoger entre  Flat, Round, Triangle, Arrow 

Anchor, Square Anchor, Round Anchor, y 

Diamond Anchor 

https://vimeo.com/54815524
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 Un segmento seleccionado puede ahora ser “arrastrado” en las siguientes maneras: 

o Arrastre en el segmento con el ratón para cambiar la curvatura de diferentes maneras: 

 

                             

 

 

 Arrastre los puntos de control de Bézier (también llamados asas) para modificar también la forma del segmento: 

                                                                              

 

 

 

 Un segmento seleccionado se puede mover con las teclas de flecha del teclado. Alternativamente, también puede 
mover el segmento manteniendo pulsada la tecla Ctrl y arrastre el segmento con el ratón: 

             

 

 If you right click on a selected path, the following menu will open.  Explanations for each options are described 
below: 

 

Al pasar por encima de 

un segmento convierte 

roja 

Selección de un segmento 

de la convierte verde 

Selección de un segmento con un 

tapete verde, convierte el azul 

segmento 

Arrastre un segmento en cualquier dirección para 

transformarse en diferentes formas. 

Al soltar el botón del ratón, se 

modificará la forma. 

Seleccione el segmento y luego 

colocar el cursor sobre el punto 

de control 

Punto de arrastrar y 

forma cambiarán 

Arrastre otro punto y forma va 

a cambiar de manera diferente 

Seleccionar segmento Utilice las teclas de flecha del 

teclado para mover segmento. 

Forma se extiende hacia el 

exterior. 
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o Insertar Nodo/ Insert Node: un nodo se insertará donde el cursor del ratón se sitúa actualmente en 
el segmento y el segmento está dividido en dos segmentos. 

 

     

 

 

o Insertar punto medio de nodos/ Insert Mid-Point Node: un nodo se insertará exactamente a medio 
camino a lo largo del segmento seleccionado y el segmento está dividido en dos segmentos de igual 
longitud. 

     

 

 

 

o Segmento neutral / Neutralize SegmentEl segmento se convertirá perfectamente recta, pero seguirá siendo 
una curva Bézier con puntos de control Bézier para maniobrar. Esto es algo así como un botón de pánico para 
usar cada vez que un segmento se vuelve extremadamente distorsionada. 

                                   

o Convert To Line /Convertir en línea: el segmento se convertirá en una línea recta y ya no será una 
curva de Bézier. Sin embargo, arrastrando la línea para formar una curva será inmediatamente 
transformarla de nuevo en una curva Bézier. 

    

 

 Delete Segment /Eliminar segmento: el segmento se borrará y dejará nodos no conectados en los extremos de los 
dos caminos que estaban conectados a este segmento. Tenga en cuenta que si la forma anteriormente era una 
forma cerrada (y Llena se enciende), ahora será una forma abierta, sin relleno. 

Nota teclas de 

acceso directo para 

varias de las 

opciones 

desplegables 

Coloque el cursor donde 

desea nodo añadido 

Segmento se divide en dos segmentos 

en la ubicación del nuevo nodo. 

Coloque el cursor en 

cualquier lugar a lo largo 

del segmento 

Segmento se divide en dos 

segmentos en el punto medio. 

Segmento neutralizada sigue una 

curva de Bézier con puntos de control 

El segmento de línea ya no es una 

curva de Bézier: no tiene puntos de 

control 
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o Auto-Smoothing: all changes to a segment will result in smoothing (curving) of this segment as well as 
adjacent segments. This should be turned off when segments have sharp junctures or cusps with other Bézier 
curves.  A heart will be used to illustrate this: 

o  

 

 

                   
 

Node Editing/ nodo Edición 

 Si pasas el ratón sobre uno de los nodos finales sobre un trazado seleccionado, verá que se convierta en 

cercado con una ruta roja punteada. Eso significa que el nodo de ahora se puede editar. Por ejemplo, 

puede arrastrar el nodo a una nueva ubicación y el segmento (s) de conexión se moverá también. 

     

 
 

 

 

 Si hace clic derecho en un nodo resaltado, el siguiente menú se abrirá. Las explicaciones de cada opción se 

describen a continuación: 

 

 En aras de ilustrar la edición de nodos, la garra martillo se ha modificado de manera que hay un “golpe” o urdimbre 

en la intersección de dos segmentos. Tenga en cuenta la longitud y la dirección de los dos puntos de control: 

 

Segmento eliminados se borra y la 

forma ya no se llena de color. 

O… 

Auto-suavizado está apagado: se 

retiene cúspide agudo. 

Auto-alisado se enciende: 

cúspide fuerte se convierte en 

una curva. 

Los dos primeros segmentos 

serán arrastrados hacia arriba 

Círculo rojo discontinuo 

aparece alrededor de un nodo 

como el cursor del ratón se 

mantiene sobre ella 

Arrastre el nodo a una 

nueva ubicación 

Los segmentos a cada lado del 

nodo se modifican. 
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o Smooth Node /Nodo Smooth: Las líneas de los puntos de control de Bézier a cada lado de dicho 
nodo seleccionado se alinearán en una línea recta, dando lugar a una transición más suave: 

 

 

o Symmetric Node/  Node Simetrico: Las líneas de los puntos de control de Bézier a ambos lados del nodo 
seleccionado se convertirá en la misma longitud, lo que resulta en una transición más suave: 

 

                                                                            

 

 

o Delete Node/ Eliminar nodo: El nodo se eliminará y los dos segmentos se convertirá en un solo segmento. Los 
puntos de control de Bézier del nuevo segmento se ajustarán automáticamente para tratar de recrear la 
trayectoria anterior de los dos segmentos 

                                                                           

o Break Node /Romper Nodo: Rompe el nodo en dos nodos para que los segmentos ya no están conectados. La 
forma ya no es un camino cerrado, por lo que no estará lleno de color. Los nuevos nodos rotos se pueden mover 
a diferentes lugares, si se desea y vuelto a conectar utilizando la herramienta de pluma/ Pen Tool: 

Punto de control para el 

segmento en el lado izquierdo 

Punto de control para el 

segmento en el lado derecho 

“Bump” 

Dos líneas de puntos de control se 

encuentran ahora en una línea recta 

entre sí 

Dos líneas de puntos de control son 

ahora la misma longitud 
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Tenga en cuenta que también puede utilizar el nodo romper para definir el punto de inicio de corte de un camino, ya 
que, en un camino roto, la cuchilla siempre se iniciará el corte, donde un nodo no está conectado a ningún otro 
nodo. 

o Auto-Smoothing /Auto-Smoothing: La misma función que Auto-Smoothing bajo Editar segmento. Se enumera 
de nuevo, bajo la edición de nodo para un acceso rápido. De nuevo, si una transición brusca debe mantenerse 
entre los segmentos implicados, deje sin marcar. De lo contrario, seleccione esta opción para curvas 
automáticamente lisas. 

 

 

 

Applications for Node Edit/Las solicitudes de Nodo Editar 

 No es siempre obvio cuando la herramienta Editar Nodos/ Node Edit Tool  (por uno o ambos segmentos y edición de nodos) 
podría ser necesaria. Aquí hay algunos ejemplos a tener en cuenta: 

 La edición de píxeles imágenes trazadas: A veces un rastro pixel aparecerá ser perfecto hasta que, por ejemplo, lo utiliza 
para una impresión y corte y descubre que algunos de los caminos son un poco fuera de las zonas impresas de la imagen 
original: 

                            

 Trazado manual: Una de las maneras más rápidas para rastrear manualmente una imagen de trama es 
simplemente haga clic / haga clic / haga clic alrededor de la imagen y luego usar nodo y edición de 
segmentos para mover rutas y nodos para alinear más estrechamente con la imagen original y ajustar los 
segmentos para el corte más suave. 

 La mejora de un corte: Si tiene problemas con una localización particular en una forma de corte, examinar 
los nodos en ese lugar. Usted puede encontrar un conjunto de nodos o una cúspide agudo. Edite el 
segmento y luego vuelva a probar el corte. 

 La modificación de archivos mal diseñados: A veces usted tomará archivos libres que resultan no del todo 
trabajar en la forma esperada. Ejemplos son a menudo las plantillas plegables hasta donde esquinas y 
plegar líneas no muy se encuentran. Tener la capacidad de mover los segmentos y nodos pueden 
perfeccionar este tipo de diseños y ofrecer productos finales más limpias y profesionales. 

Nodo se rompe y forma pierde el 

color de relleno 

Nodos rotos se pueden 

arrastrar a nuevas ubicaciones 

Nodos rotos pueden volver a 

conectarse utilizando varios 

métodos: consulte la Sección 7.14. 

Línea de rastreo no 

sigue la forma aquí. 
Un nodo se agrega a 

romper segmento y 

segmentos son 

arrastrados hacia el 

interior. 
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7.14 Reconnecting Broken Segments/Reconexión Segmentos rotos. 

 

 

 Una forma que aparece cerrado, pero no se llene de color tiene una o más segmentos rotos. En muchos casos, no es necesario 
cerrar el camino porque a menudo los nodos desconectados son tan cerca uno del otro que todavía se obtendrá un corte 
cerrado. Sin embargo, es posible que aún desea que sus formas se llenan de modo que será mejor que puede ver lo que será 
el diseño final. 

 Si no puede ver fácilmente en el segmento está roto, seleccione la herramienta Medir/ Measure Tool  desde el modo de 
barra de herramientas Nodo/ Node Mode Toolbar y luego se ciernen sobre la forma. Debido a un corte siempre se iniciará en 
un nodo desconectada en una forma abierta, la dirección de la flecha verde mostrará donde comienza el corte, lo cual indica 
que el segmento está roto. 

                                                                            

 

 Hay varias maneras de conectar segmentos abiertos. El primero de ellos se enumeran a continuación se limita en su aplicación. 
Cualquiera de los otros pueden ser utilizados para cerrar un segmento rota a la vez. 

 

Using Fuse n’ Weld / Usando Fuse n’ Weld 

 Si la forma tiene muchas lagunas pequeñas, donde los nodos a conectar están muy cerca, luego vuelva al Fusible n ‘porción de 
soldadura de la Sección 7.04. 

 

 Join Node to Closest Node/ Únete nodo a nodo más cercano: si se selecciona esta opción, se formará un segmento entre el 
nodo y el nodo más cercano y aparecerá perfectamente recta, pero seguirá siendo una curva Bézier con puntos de control 
Bézier para maniobrar. 

                

 

 

 

 Join Node to Closest Node with Line /Únete nodo a nodo más cercano con la línea : si se selecciona esta opción, se formará un 
segmento de línea recta entre el nodo y el nodo más cercano, pero no será una curva de Bézier. Sin embargo, arrastrando la 
línea para formar una curva será inmediatamente transformarla de nuevo en una curva Bézier. 

                     

La flecha verde 

indica el lugar 

donde se rompe la 

trayectoria 

Haga clic derecho en el nodo 

final y seleccione Join Node 

para  Closest Node. 

 

Extremos están conectados y la 

forma ha concluido. 

Puntos de control Bézier se 

mueven para crear la curva 

deseada. 

https://vimeo.com/44548707
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Using the Drag Freehand Lines (Pencil Tool) / Usando el Arrastre Freehand  (herramienta Lápiz) 

 En primer lugar, mantenga pulsada la tecla Ctrl. A continuación, arrastre el puntero del ratón de un nodo 

extremo a otro y la liberación. El camino se cerrará con una línea recta. Regreso a Editar Caminos en el nodo 

de nivel, si es necesario, para arrastrar la línea para formar una curva deseada. 

                            

 

 

 

 

 

 

 

Using the Draw Bézier Curves and Straight Lines (Pen Tool)/Utilizando el sorteo curvas de Bézier y líneas 

rectas (Pen Tool) 

 Mueva su ratón sobre uno de los nodos finales hasta que aparezca un pequeño círculo alrededor de él. A 

continuación, arrastre el ratón para el otro nodo. Cuando ves a un pequeño círculo aparecer alrededor de ese 

nodo, haga clic derecho para liberar y una línea recta que conecta los dos nodos, se creará. Regreso a Editar 

Caminos en el nodo de nivel/ Edit Paths at Node Level si es necesario, para arrastrar la línea para formar una 

curva deseada. 

                   
 

 

 

 

8. Designing / Disenando   
 

8.01 Where Do I Start with Learning to Design? /  ¿Por dónde empiezo con Aprender a diseñar? 
 

 MTC ofrece un excelente y fácil de usar diseño de herramientas para ayudarle en la creación de lo que puedas 

imaginar! La mejor manera de aprender estas herramientas es centrarse en sólo uno a la vez, ver el video 

relacionado, y pausar el video después de cada paso, repetir lo que está viendo. Es posible que desee anotar 

Haga clic derecho en el nodo 

final y seleccione Join Node to 

Closest Node with Line. 

 

Extremos se conectan con una línea 

recta y la forma ha concluido. 

Seleccione y arrastre la curva. 

Puntos de control Bézier 

aparecen y se pueden mover 

para crear la curva deseada. 

Mantenga tecla Ctrl y 

coloque el cursor sobre 

uno de los nodos. 

Utilice el botón izquierdo del 

ratón para arrastrar el cursor 

hacia otro nodo final. 

 

Cuando el cursor llega a otro 

nodo, suelte tecla Ctrl y el 

botón izquierdo del ratón. 

Select Node Edit Tool 

Herramienta para crear curva 

deseada. 

Mantenga el cursor sobre 

uno de los nodos finales 

hasta que aparezca el 

círculo. 

Utilice el botón izquierdo 

del ratón para arrastrar el 

cursor hacia otro nodo 

final. 

 

Cuando círculo aparece 

sobre otro nodo final, haga 

clic derecho con el ratón. 

Forma llena de color y curva 

puede ser creado usando 

Node Edit Tool. 
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también algunas notas acerca de los entornos particulares o consejos presentados en el video. Trate de imaginar 

cómo las mismas herramientas pueden ser utilizadas para otros tipos de diseños y anote sus ideas. 

8.02 Add Basic Shapes (Basic Shapes Tool)/ Añadir Formas básicas (herramienta Formas básicas) 

 La función Añadir Formas básicas (Formas básicas Tool) es el icono quinto en el modo  de barra de 

herramientas Nodo  / Node Mode Toolbar y se puede activar abriendo primero la barra de herramientas Nodo 

Editar/ Node Edit toolbar  (o pulsando W) y, a continuación, haga clic en el icono de formas básicas de 

herramientas o presionando F5. 

 Esta herramienta acceder a la misma biblioteca de formas que aparecen en la barra de herramientas de 

importación, con la excepción de la categoría “Sus formas”. Sin embargo, en vez de hacer doble clic en una forma 

para colocar automáticamente que la forma en la pantalla, esta función le permite mantener pulsado el botón 

izquierdo del ratón y libremente arrastra el ratón para crear el tamaño que usted desea. En este ejemplo, la 

forma de la cometa de la categoría de polígonos se ha seleccionado: 

                                                                                      
 

 

 Manteniendo pulsada la tecla Ctrl mientras arrastra para crear la forma dará a conocer la relación de aspecto, 

que le permite hacer más delgada forma o amplia. Puede que tenga que establecer Snap Posición en No rotura 

en la ficha Mat virtual: 

      
 

 Arrastrar desde abajo hacia arriba (y no de arriba hacia abajo) automáticamente le dará la vuelta verticalmente la 

forma básica en la pantalla. 

 

                                                                                                 
 

 Al soltar el botón izquierdo del ratón, usted puede comenzar de inmediato dibujo otro de la misma forma. 

 Esta función también realiza un seguimiento de sus formas utilizados más recientemente y ofrece una lista de 

ellos en el menú: 

Comience arrastrando el ratón 

desde la parte superior a la 

izquierda hacia abajo a la 

derecha. Tenga en cuenta que el 

icono del cursor se parece a la 

forma elegida. 

Cursor saltará a la parte 

inferior izquierda y la 

forma se dibujará. 

Con tecla Ctrl celebró, 

la forma se puede 

sacar más corto y más 

ancho ... 

... O forma se puede 

dibujar más alto y delgado 

Forma se dibuja 

volteado vertical Comience arrastrando el ratón 

desde la parte inferior a la 

derecha hacia arriba a la 

izquierda. 
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8.03 Create Spirals (Spiral Tool)/ 8.03 Crear Espirales (Herramienta Espiral) 

 

 La función Crear Espirales/ Create Spirals (Herramienta Espirales/ Spirals Tool) es el icono de sexto  en el 

modo de barra de herramientas Nodo/ Node Mode Toolbar  y se puede activar abriendo primero la barra de 

herramientas Nodo Editar (o pulsando W) y luego hacer clic en el icono de la herramienta Espiral o pulsando F6. 

Esta herramienta le permite crear espirales con tantas vueltas como desee, junto con varios otros ajustes. 

 Una vez que esté en esta función, se crea una espiral manteniendo pulsado el botón izquierdo del ratón y 

arrastrando libremente el ratón para crear una espiral con el tamaño que usted desea. Está utilizando el mismo 

método que se describe en la Sección 8.02: 

 

                                                                                          
 Al arrastrar las asas derecha oa la izquierda va a cambiar la ubicación del punto de inicio y el punto final de la 

espiral: 

 

                                        
 Si mantiene pulsada la tecla Mayús mientras arrastra el tirador de punto final, puede cambiar la escala (tamaño 

total) de la espiral. 

 Si por error dibuja una nueva espiral al intentar ajustar la actual espiral, pulse la tecla Supr para eliminarlo. Si 

tiene que mover la espiral, mantenga pulsado el botón izquierdo del ratón en cualquier lugar de la espiral 

(excepto en la parte superior de un mango) y arrastra a otra ubicación. 

 Los ajustes del lado izquierdo de la herramienta Espiral permiten cambiar los turnos (igual que arrastra el tirador 

de punto final), cambiar el radio interior (igual que arrastra el tirador de punto de partida), y cambiar la 

divergencia (la distancia entre las vueltas) . También hay un botón de Reset para traer de vuelta a los valores por 

defecto: 

 

Sus Formas básicas utilizadas más 

recientemente son de fácil acceso Recently Used/ formas 

usadas recientemente  

aparecen en la parte 

superior de todas las 

categorías en lugar de  tus 

formas/Your Shapes 

A medida que arrastra el 

puntero del ratón, se añade 

una espiral a la pantalla. Dos asas azules aparecen: al 

comienzo y al final de la espiral. 

Arrastre este mango 

para cambiar el punto 

de inicio de la espiral. 
Arrastre este 

mango para 

cambiar el punto 

final de la espiral. 

Divergence/ Divergencia cambia la distancia entre 

las espiras de la espiral como progresa (ver más 

abajo) 

http://www.screenr.com/c4l7
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 Con una divergencia de 1,0 (por defecto) la distancia entre las vueltas es el mismo. Si la divergencia es inferior a 

1,0, la distancia disminuye a medida que el número de vueltas aumenta. Con una divergencia mayor que 1,0, la 

distancia aumenta: 

                                   

 

 

 

 Los ajustes del lado derecho de la herramienta Espiral/ Spiral Tool permitirá tener una ruta de grasa/ Fat Path, 

controlar el espesor de la Ruta de grasa/ Fat Path, así como el estilo de la ruta de acceso y las tapas de los 

extremos: 

 

             

                                          

 Los cinco estilos Dash disponibles son: 

 

                                           

 
 

 

 Los estilos de inicio y el punto final de la espiral se pueden cambiar a cualquiera de los siete tapas de líneas 

diferentes: 

 

 

                              

Inner Radius cambia el punto 

de inicio de la espiral 

Turns / Resulta cambios 

el punto final de la espiral 
Haga clic aquí para 

restablecer los valores 

predeterminados 

Divergence: 1.0 

Distancia entre todas las vueltas 

es el mismo 

Divergence: 0.5 

Distancia disminuye con el 

número de vueltas 

Divergence: 3.0 

Aumenta la distancia con el 

número de vueltas. 

Ingrese  Ancho (grosor 

de la línea) Seleccione Fat Path 

box. 

Elija entre un menú de cinco 

diferentes Dash Styles 

Solid 

Solido 

 

Dash 

Raya 

 

Dot 

Puntos 

 

 

Dash Dot 

Punto-raya 

 

Dash Dot Dot 

Raya punto 

punto  

 

Elija entre una lista de siete 

estilos de línea Cap diferentes 
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 La línea Caps disponibles son: 

 

 
 

 Una vez que se crea una espiral y hace clic a otra función, no puede ser modificada más. Sin embargo, los ajustes 

utilizados más recientemente se conservarán cuando vuelva a la Herramienta Espiral/ Spiral Tool. 

8.04 Create Stars and Polygons (Star & Polygon Tool)/ Crear Estrellas y Polígonos (Star & Herramienta Polígono) 

  

 El Crear Estrellas y Polígonos función (Herramienta Estrella y Polígono)/ Star & Polygon Tool es el icono 

séptimo  en el modo de barra de herramientas Nodo y se puede activar abriendo primero la barra de 

herramientas Nodo Editar/ Node Edit toolbar  (o pulsando W) y luego haciendo clic en el icono de las 

estrellas y de Polígono Herramienta o F7 apremiante. Esta función le permite crear estrellas personalizadas y 

polígonos. 

 

Star/estrella 

 Una vez que esté en esta función, se crea una estrella manteniendo pulsado el botón izquierdo del ratón y 

libremente arrastrando el ratón para crear una estrella con el tamaño que usted desea. Está utilizando el mismo 

método que se describe en la Sección 8.02: 

      

 Si tiene que mover la estrella, mantenga pulsado el botón izquierdo del ratón en cualquier lugar de la forma 

(excepto en la parte superior de un mango) y arrastra a otra ubicación. Si por error dibujar una nueva estrella al 

intentar ajustar la estrella actual, pulse la tecla Supr para eliminarlo. 

 Hay varios ajustes utilizados para controlar la aparición de la estrella, así como un botón de reinicio. Ejemplos de 

cómo estos valores cambian una estrella se presentan en detalle a continuación. Tenga en cuenta, sin embargo, 

que hay miles de posibilidades basadas en combinaciones de estas opciones: 

 

 

 

Flat/Plano Round 

Redonda 

Triangle 

Triangulo 

Arrow Anchor 

Flecha Ancla 

Square Anchor 

Flecha cuadrada 

Round Anchor 

Flecha redonda 

Diamond Anchor 

Flecha diamante 

A medida que arrastra el 

puntero del ratón, se 

formará una estrella. 

Dos asas azules aparecen: en 

una esquina interna y en un 

punto exterior. 

Alternar entre Estrella 

y Polígono 

Establecer el número de Esquinas 

(puntos de una estrella; lados de 

un polígono) 

Establecer Relación Spoke: 

hace un diluyente de la 

estrella o más grueso 

Conjunto Redondeado: Rondas los 

puntos y las curvas de los lados 

Convertir a una versión del 

esquema de diseño actual 

Restablecer valores 

predeterminados 

http://www.screenr.com/z4l7
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 Corners /Esquinas: El valor predeterminado es cinco. Sin embargo, el rango es de 3 a muchos. Aquí están 

algunos ejemplos: 

   

 

 Spoke Ratio: El rango para este ajuste es de 0 a 1,0. También puede cambiar esta configuración arrastrando el 

tirador de punto exterior hacia adentro o hacia afuera. Verá que cambia tanto el grosor y el tamaño de la estrella. 

También puede girar la estrella usando esta manija: 

                                    

 

 

 

 

 Dragging the inner corner /arrastrar la esquina interna manejar arriba o hacia abajo también cambia el grosor, 

pero no el tamaño de la estrella. Arrastrando el mango izquierda o la derecha gira el interior de la estrella. 

También crea un espectro mucho más amplio de posibilidades de diseño: 

 

        

 

 

          

 

 

   3 esquinas           6 esquinas        10 esquinas          25 esquinas        

Drag inward/ 
Arrastre interior 

Drag 

outward/ 
Arrastre hacia 

el exterior 

Drag further 

inward/ Arrastre 

más hacia 

dentro 

Drag further 

outward/ 
Arrastre más 

hacia afuera 

 Rotate/ 
Girar 

Drag up and to 

the right/ 
Arrastre hacia 

arriba y hacia la 

derecha 

Drag down and 

to the left/ 
Arrastre hacia 

abajo ya la 

izquierda 

Drag up/ 
arrastre hacia 

arriba 

Drag down/ 
Arrastre hacia 

abajo 

Drag to the left/ 
Arrastre hacia la 

izquierda 

Drag to the right/ 
Arrastre hacia la 

derecha 

Rotate 

clockwise / 
Rotar las agujas 

del reloj 

Rotate further 

clockwise / Gire 

más hacia la 

derecha 
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 Si mantiene presionada la tecla Ctrl mientras arrastra cualquiera de mango, no se producirá la rotación. 

 Rounded /Redondeado: Esta función se utiliza para la curva de los lados de una estrella. El valor predeterminado 

es 0. Mientras que usted puede mantener pulsada la tecla Mayús y arrastre el control para cambiar el valor, el 

rango es mucho más grande (-10,0 a 10,0), si usted los valores de entrada en la ventana de ajuste en la parte 

superior. Éstos son sólo algunos de los miles de posibilidades: 

 

                                             

 

 

 Outlined: Esta característica elimina la totalidad o parte de los caminos interiores de una estrella que puede dar 

lugar a formas más adecuadas para el corte: 

 

                 

 

 

Polygon/Polígono 

 Para dibujar un polígono, establezca primero el tipo de polígono. A continuación, manteniendo pulsado el botón 

izquierdo del ratón, arrastre libremente el ratón para crear un polígono en el tamaño que desee: 

  

 

 Si usted necesita mover el polígono, mantenga pulsado el botón izquierdo del ratón en cualquier lugar de la 

forma (excepto en la parte superior del mango) y arrastra a otra ubicación. Si por error dibuja un nuevo polígono 

al tratar de ajustar el polígono actual, pulse la tecla Supr para eliminarlo. 

 Hay varios ajustes utilizados para controlar la apariencia del polígono, así como un Reset. Ejemplos de cómo estos 

valores cambian un polígono se presentan en detalle. Tenga en cuenta, sin embargo, que hay miles de 

posibilidades basadas en combinaciones de estas opciones: 

Rounded: 0.5 Rounded: 1.4 Rounded:-4.25 Rounded: 6.0 Rounded: 2.43 

Rounded:  -6.0 

Outline: Off           Outline: On 

 

Outline: Off           Outline: On 

 

Rounded:  -8.5 

Seleccione Type para  

Polygon  

Un asa azul aparecerá en una 

de las esquinas.  

A medida que arrastra el 

puntero del ratón, se 

formará un polígono. 
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 Corners/ Esquinas: Controla cómo están presentes en el polígono de muchos puntos o lados. El valor 
predeterminado es cinco. Sin embargo, el rango es de 3 a muchos. Aquí están algunos ejemplos: 

 

 

 Para cambiar el tamaño de un polígono, mantenga pulsado el botón izquierdo del ratón y arrastre el mango azul 

hacia adentro o hacia afuera. También puede utilizar esta misma manija para rotar el polígono, según se desee: 

                      

 

 Rounded/redondeado: Esta función se utiliza para la curva de los lados de un polígono. El valor predeterminado es 

0. Mientras que usted puede mantener pulsada la tecla Mayús y arrastre el control para cambiar el valor, el rango 

es mucho más grande (-10,0 a 10,0), si usted los valores de entrada en la ventana de ajuste en la parte superior. 

Éstas son sólo algunas de las muchas posibilidades: 

       

 

 Outlined:  Esta característica elimina la totalidad o parte de los caminos interiores en un polígono, que pueden dar 
lugar a formas más adecuadas para el corte: 

 

 

         

 

Reset to default values  

Convert to an Outline 

version of current design  

Change the curvature of the sides  

Set number of 

sides/points 

    3 esquinas        4 esquinas        5 esquinas         6 esquinas         15 esquinas 

Arrastre hacia 

adentro para 

disminuir de 

tamaño 

Arrastre hacia 

afuera para 

aumentar de 

tamaño 

Arrastre hacia 

arriba o hacia 

abajo para girar 

Rounded: - 0.75 Rounded: - 1.5 Rounded: - 3.0 Rounded:  0.15 

Rounded:  -1.5 Rounded:  -2.5 

Outline: Off           Outline: On 

 

Outline: Off           Outline: On 
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8.05 Shadow Layer 

 

 La función de la capa de sombra le permite crear un esquema o una línea de cualquier forma, incluyendo, por 

supuesto, de texto. Después de seleccionar la forma o formas, la capa de sombra Generar ventana/Generate 

Shadow Layer se puede abrir en cualquiera de las siguientes maneras: 

o Haga clic en el icono capa Sombra/Shadow Layer  en la barra de herramientas de Magia/Magic 

Toolbar    

o Presione Ctrl + H 

o Haga clic derecho en la pantalla y seleccione Forma Magia/Shape Magic> Capa de las 

Sombras/Shadow Layer 

o Vaya a Editar> Forma Magia> Sombra de capa/Edit>Shape Magic>Shadow Layer. 

Outset Shadow/Outset Sombra 

 En este ejemplo, tres estrellas se han añadido a la pantalla de la biblioteca de formas básicas y han sido de color 

rojo, blanco y azul: 

 

 Carpa-seleccione las estrellas y luego usar Ctrl + H para abrir la ventana de capa Sombra Generar/Generate 

Shadow Layer: 

 
 

          

  

 El ancho de la sombra/ Shadow Width  se puede introducir como una fracción (¼, ½, ¾, etc.) o como un 

número (1, 0,2, 0,03, etc.). Junto a la ventana de entrada es un menú desplegable para las unidades de 

medida, con la opción de seleccionar en, cm o mm. 

 Tenga en cuenta que las sombras en las tres estrellas se suelde automáticamente entre sí para formar una 

sola sombra esquema y esta sombra se coloca en su propia capa en la barra de capa. Esta capa puede ser re-

coloreado de negro a otro color, si lo deseas: 

 

 

Vista previa de la 

sombra 

Ingrese el ancho de la sombra 

Shadow Width y seleccionar las 

unidades (en, cm o mm) 

Seleccione   tipo de  Corner Join  

Miter Limit (si es tipo  Mitered) 

Click  en Accept.  

Opcional Blackout and Auto 

Simplify ajustes 

https://vimeo.com/77041649
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Blackout Option/Opción Blackout 

 La opción del apagón se puede activar y desactivar a cualquiera de aplicar la sombra de caminos interiores o 

al negro a cabo la sombra y sólo tienen un único principio: 

                                                                 
 

Corner Join Option/  Opción Unir esquinas 
La opción unir esquinas  controla el estilo o la forma de la sombra en las esquinas. Hay tres opciones: 

 

 

                            

                                                                          

 

 El límite angular/ Miter Limit afecta hasta qué punto la capa de sombra se extiende en las esquinas 
 

 

 

 

Inset Shadow/ Recuadro Sombra 

 Una Sombra recuadro es lo contrario de un Shadow Outset - en lugar de crear un contorno que es mayor 

que la forma original, se crea un contorno que es más pequeño y se ajusta dentro de la forma original. 

 Por ejemplo, digamos que usted va a crear un signo de vinilo de dos colores que dice “Se vende”: 

 

 

 Si Outset Sombra se utiliza para crear la segunda capa, las letras serán automáticamente soldados debido a 

su proximidad entre sí. Esto puede no ser adecuado para su aplicación: 

 

 

 En lugar de ello, crear una sombra de la inserción/ Inset Shadow mediante la introducción de un número 

negativo para el ancho de las Sombras/ Shadow Width: 

Blackout aplicado Blackout no aplicado 

Mitered/ 
inglete  

Beveled/ 
biselado  

Rounded / 
redondeado 

Observe cómo la 

sombra se ajusta a la 

serif de la carta 

1.0  1.2  1.4 1.6 1.8 
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 El resultado, después de volver a colorear las capas: 

 

 

 

8.06 Weld Tool/ Herramienta de soldar 
 

 La herramienta de soldadura elimina el vacio entre dos o más seleccionados formas. Después de seleccionar las 

formas, se puede aplicar en cualquiera de las siguientes maneras: 

o Haga clic en el icono de soldadura/ Weld  en la Barra de Magia/ Magic Toolbar.  

o Presione Ctrl + W 

o Haga clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic> Weld/ Weld 

o Vaya a Editar> Forma Magia> Weld/ Edit>Shape Magic>Weld. 

 

Designing a Balloon/El diseño de un globo 

 En la Sección 5.03, se utilizó la herramienta de soldadura para eliminar el solapamiento con las letras. También se 

puede utilizar para diseñar artículos de uso diario de formas básicas: 

                                                                                                    

Círculo, corazón, triángulo      Superposicion de formas        Aplique  Weld (Magic Toolbar)    Resultado globo 

Designing a Border/El diseño de un Border 

  

 Otro uso de la herramienta de soldadura es en el diseño de las fronteras. En primer lugar crear la forma que se 

repita. Se crea un círculo con un círculo más pequeño en la parte superior. Aplique la función Join (Ctrl + J) para 

hacer que los dos círculos en una sola forma: 

Previews  

Introduzca un número negativo 

para crear una sombra de 

inserción 

Seleccione el estilo  Corner Join e 

ingrese Miter Limit, if Mitered  

Click  en  Accept  

https://vimeo.com/43267030
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 Seleccione la forma y el uso Ctrl + D para iniciar la función Duplicar 

 

 

 

 Añadir un largo rectángulo para solapar la parte inferior y luego aplicar la herramienta de soldadura/ Weld tool  a 

las formas seleccionadas: 

      
                                       

Designing a Wreath/El diseño de una corona 

  

 En la Sección 3.10.6, se demostró cómo organizar una forma en un patrón de círculo utilizando la función de rotación 

de Duplicados/ Rotated Duplicates. Esta característica abre un mundo de posibilidades de diseñar. En este tutorial, 

vamos a crear una corona de flores con la siguiente floreo que se encuentra en la fuente Wingdings que viene con 

Windows: 

 

 

 Seleccione la forma y abrir la ventana de Duplicados/ Duplicates haciendo clic derecho y seleccionando Duplicar> 

Girado duplicados/ Duplicate>Rotated Duplicates. Introduce el número de florituras que desea utilizar en la corona 

y haga clic en el icono de sigma. Luego doblar la Girada Estableciendo para organizar los duplicados en un patrón 

circular por igual-space: 

Añadir 2 círculos de 

Formas básicas 

Cambiar el tamaño de 

un solo y colocar en la 

parte superior de la 

otra 

Seleccionar los dos y  

aplicar  Ctrl+J para 

unir  

Click en  Apply  

Ingrese  1 Row, 12 o mas Columns, y un 

espacio  Spacing por lo que las formas 

se solaparán 

https://vimeo.com/63373280
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 Experimentar con Desplazamiento X/ Offset X y Desplazamiento Y/ Offset Y  para crear un diseño que te gusta! 

Una vez satisfecho, haga clic en Aceptar y luego haga clic en la función de soldadura para eliminar la superposición: 

  

    
 

 

Para ver más ejemplos de cómo la función de rotación de duplicados se puede utilizar para el diseño, visite este 

enlace: http://teamknk.com/rotated-duplicate-a-reason-to-upgrade-to-mtc-4-6/ 

 

8.07 Boolean Join/ union de valores 

 

 El menú  Boolean Join/ union de valores contiene cinco opciones de soldadura, pero sólo se puede aplicar a dos 

formas seleccionadas a la vez. Si usted tiene más de dos formas, a continuación, sólo aplicar el booleano Únete a 

cualquiera de los dos a la vez o, en la mayoría de los casos, puede utilizar la función de soldadura/Weld  (Ctrl + W) 

o el Join (Ctrl + J) herramienta de primera para reducir sus múltiples formas a dos y luego usar la función de 

Boolean Join/ union de valores se necesita para completar su diseño de Ingreso. 

 Por ejemplo, si usted tiene el texto que se ha dividido por Glifos/ Split by Glyphs y hay 5 cartas en su palabra, 

entonces usted tiene 5 formas individuales. Usted tendría que aplicar bien Weld o  Join para que esos 5 letras se 

convierten en una sola forma. Posteriormente, se podría realizar una Boolean Join/ union de valores con ese 

texto y alguna otra forma de lograr el diseño deseado. Esto se aclarará más adelante en esta sección. 

 Después de seleccionar dos formas, el  menú  Split by Glyphs  se puede abrir en cualquiera de las siguientes 

maneras: 

Ingrese  Dup Count y 

haga click en el icono 

Ingrese el doble en 

Rotate By el 

establecimiento de 

formas de 

organizar en un 

círculo 

Experimente 

con Offsets 

Diseño final después de la 

soldadura/ welding 

http://teamknk.com/rotated-duplicate-a-reason-to-upgrade-to-mtc-4-6/
https://vimeo.com/70912578
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o Haga clic en Boolean Join/ union de valores en  el icono barra de herramientas de Magia/ Magic 

Toolbar   

o Presione Ctrl + T 

o Haga clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic > Boolean Join 

o Ir a Editar> Forma Magia> Boolean  Join/ Edit>Shape Magic> Boolean Join. 

 

 El menú contiene las siguientes opciones: 

  

 

 

 Cuando se aplica Boolean Join/ union de valores  a las formas de dos colores diferentes, la forma resultante será 

el color de la forma que estaba en la capa superior. 

 Tenga en cuenta: Hay una opción Auto Simplifique en Boolean Join/ union de valores ventana. Puede que tenga 

que desactivar esa opción para obtener el resultado deseado. Por ejemplo, la Función Excluir no realizará 

correctamente sin desactivando esa opción. 

 

 

Cutting One Shape from Another/Cortar Una Forma de otro 
 

 Si desea cortar una forma de otra, entonces en el  menú Boolean Join/ union de valores proporciona la solución 

que necesita. En este ejemplo, dos corazones se cortan a partir de un título. 

  En primer lugar, escriba la palabra "MAMÁ" usando la fuente de su opción. Asegúrese de tener "No Splitting" 

seleccionado en la ventana Agregar grupo Texto/ Add Text Group. De esta manera el texto será una sola forma. 

Entonces importar uno de los corazones de la biblioteca de formas básicas/ Basic Shapes, cambiar el tamaño y 

duplicar para crear el diseño que desea hacer: 

 

 Haga una tercera copia del corazón y dejar de lado. Después de organizar los primeros dos corazones en la parte 

superior del texto, seleccione los dos y aplicar Join (Ctrl + J), por lo que ahora será una forma. Por lo tanto, ahora 

tiene sólo dos formas para Boolean Join/ union de valores: el texto y los corazones unidos: 

Igual es soldadura/ 

Weld 

Cinco herramientas se muestran con 

el propósito de cada herramienta. La 

pantalla también mostrará el 

resultado neto mientras selecciona 

cada una. 

Organizar corazones, si lo 

deseas, sobre el texto 
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 Carpa-seleccionar las dos formas e ir al menú de Boolean Join/ union de valores (Ctrl + T) . Seleccione la segunda 

opción: B-A Diferencia/: B-A Difference. Tenga en cuenta que si los corazones habían estado detrás del título 

(colocado en una capa más baja que la del título), entonces la diferencia AB/ A-B Difference habría dado el resultado 

deseado. 

 

                                                                                 

 Seleccionar el corazón dejar de lado y disminuir el tamaño para caber dentro de la zona de corte del título, por lo 

que un poco de borde blanco rodea el corazón. Tenga en cuenta que con algunas formas puede que tenga que 

utilizar la función de inserción Sombra/ Inset Shadow presentado en la Sección 8.05. 

 Haga un duplicado del corazón más pequeño y organizar dentro de la otra zona de corte. Cambiar el color del texto 

original "MAMÁ" a rosa (consulte la Sección 3.14): 

 

 

8.08 Wrap Objects to Path/ Envolver objetos en camino 

 Wrap Objects to Path se puede utilizar para alinear repeticiones de una forma a lo largo del camino de la otra forma. 

Para abrir Wrap Objects to Path, seleccione la forma más pequeña, mantenga presionada la tecla Ctrl y arrastre 

esta forma en el centro de la forma más amplia. Tan pronto como usted ve el cambio cursor del ratón, suelte el 

botón izquierdo del ratón antes de soltar la tecla Ctrl. 

8.08.1 Designing a Scalloped Oval / Diseño de un festoneado Oval 

                               

 Importar un círculo de Formas básicas/ Basic Shapes y cambiar el tamaño para crear un óvalo. Entonces también 

importar o abrir cualquier diseño. En este diseño, nos unimos a un círculo más grande con una más pequeña para 

crear una forma de ojal: 

 

 

 Seleccione el diseño, mantenga presionada la tecla Ctrl y arrastre la forma en el círculo. Una vez que vea el 

cambio de icono de cursor, suelte el botón del ratón y la tecla Ctrl. 

 

 

Dos cuadros 

delimitadores, así dos 

formas 

El texto constituye una forma. Los dos 

corazones son ahora la segunda forma 

Forma de corazón se cortan de 

texto y el texto cambia al color de 

los corazones. 

https://vimeo.com/52428083
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 Al soltar, la ventana de Wrap Objects to Path se abrirá. Comience marcando la casilla de la repetición/Repeat, 

establecer un espaciado/ Spacing negativo de acuerdo a la superposición que desee y comenzar aumentando el 

número de repeticiones/ Repeat Count hasta que la última imagen se superpone a la primera: 

                   
 

 Con el fin de conseguir la igualdad de espacio y para que las imágenes se superponen para la soldadura, comience 

ajustando el Vert. Alinear/ Vert. Align y la configuración del espacio/ Space. La configuración del espacio / Spacing 

es en realidad cambiando el ajuste que originalmente introducido por algún porcentaje por lo que se puede lograr 

visualmente igual espaciamiento de las repeticiones de todo el círculo de espaciado. Si la separación ha entrado no 

son positivos, entonces un valor espacio más grande será, lógicamente, aumenta el espaciado entre los objetos. 

Pero con una separación negativa, como en este ejemplo, un valor espacio más grande disminuye la separación, 

resultando en más de solapamiento: 

 

                                     

 

 

 

 Una vez que tengas los ajustes necesarios para obtener la superposición deseada, haga clic en Aceptar. Se le dará la 

opción de soldar y usted debe responder Sí. A continuación, aplicar Break y quite la forma interior. Mueva el óvalo 

de distancia u ocultarla para que la vieira restante con ojales puede tener Join aplicada: 

 

Cursor se convierte en un arco con pequeñas 

formas. Esto indica que ahora puede soltar el 

botón del ratón y Ctrl  

Cursor comienza como una 

flecha de dos puntas 

El objetivo es lograr 

un patrón simétrico Ajuste la configuración para 

lograr el objetivo. Usa las 

flechas del teclado para 

cambiar los valores en 

incrementos más pequeños. 

Si es necesario, haga clic 

aquí para restablecer los 

valores predeterminados 
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 A continuación, podemos crear una sombra de la inserción/ Inset Shadow del óvalo original, para hacerlo más 

pequeño. A continuación, retire el óvalo original, seleccione todo y aplicar un Ingreso/ Join: 

 

 

 

 

 

8.08.2 Warp Objects to Path/ Deformacion Objetos de Ruta 

Parte 1:    Parte 2:    Stretch Extend:    Filling a Frame  

 Warp Objects to Path/ Deformacion Objetos de Ruta obliga a la forma o formas poner en un camino, para doblar o 
distorsionar el fin de abrazar la forma de ese camino. Para aplicar Warp, marque la casilla en Warp Objects to Path/ 
Deformacion Objetos de Ruta. He aquí un ejemplo de la diferencia en lo que se vería si Warp no se aplica frente aplicado 
con la misma forma, la misma repetición, mismo camino: 

                                           

 

 

 Hay tres ajustes dentro de la función de la deformación/warp: 

 

 

o Stretch: El ajuste de estiramiento se extenderá la forma o formas para adaptarse a lo largo de toda 

la longitud de la trayectoria. En el siguiente ejemplo, un hexágono estiramiento de las formas 

básicas se utiliza para crear una curva con puntos cónicos 

Despues de click Accept Despues de  borara su 

interior 

Se añade  Inline Oval Original ovalo es 

borrado y  Join es 

aplicado 

Fill  es activado 

Warp: Off Warp: On Coloque una llave a 

una curva 

Observe cómo las 

teclas bend / 

urdimbre para 

abrazar la forma de la 

curva 

 Estiramientos forma (s) para llenar la longitud de la trayectoria 

Previene scrunching de formas en curvas cerradas 

Reduce nodos para suavizar la forma (s) 

http://www.screenr.com/X4l7
http://www.screenr.com/r4l7
http://www.screenr.com/8NL7
https://vimeo.com/76704254
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o Parameterize: El ajuste Parametrizar mantendrá formas individuales de manera más uniforme de 

tamaño y espaciados a lo largo de una curva Bezier. En el siguiente ejemplo, un saludo feliz 

cumpleaños se coloca en una curva. Las dos versiones ilustran el efecto de tener Parameterize 

encendido frente apagado: 

 
 

                

    

 Flatten: El ajuste Acoplar suavizará formas (añadir curvatura) mediante la adición de nodos. Hay cinco opciones: 

x1 - x5. En el siguiente ejemplo, una flecha está en condiciones de la curva: 

  
 

      

 

 

 Utilice los otros ajustes de Wrap Objects to Path, para controlar el punto de partida (Offset), la posición de la curva 

(Vert. Align) y la superposición de repeticiones (space), al igual que presentó al inicio de esta sección. Existe una 

cuarta opción, San Extend, que es similar al espacio, sino que se utiliza para crear igualdad de separación entre 

repeticiones cuando se aplica la función de estiramiento. En el siguiente ejemplo, la frontera creado en la Sección 

8.06 se estira para adaptarse alrededor de un círculo: 

 

 

Stretch: Off Montar un 

hexágono 

  a una curva 

Stretch: On 

Parameterize: Off 

 

Parameterize: On 

Montar una 

flecha 

  a una curva 

Flatten: Off Flatten: x1 Flatten: x2 Flatten: x5 
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 Después de introducir los Wrap Objects to Path, Repeat se comprueba y se incrementó primero. Entonces, Warp 

está encendido: 

 

             

 Observe que donde termina una frontera y el siguiente comienza (indicado por las flechas verdes más adelante), 

la separación de vieira es mayor que entre las vieiras a lo largo de una frontera. En otras palabras, las 

repeticiones deben solaparse más de manera que el espaciado se parece más uniforme. Esto se lleva a cabo 

primero por la disminución de la configuración de Separación: 

                                                       

 Sin embargo, todavía existe la misma diferencia entre el inicio y el final del tramo inicial, como se indica por la 

flecha azul arriba. Aquí es donde el St. Extender establecer corregirá la brecha. Al cambiar desde 0% a 50%, el 

inicio y el final ahora se superponen y el espaciado es correcta: 

                                           

 

 Al hacer clic en Aceptar, una ventana emergente proporciona la opción de soldar las fronteras repetidas. 

Respondiendo Sí, seguido por la eliminación de círculo, da el marco festoneado final: 

Encender 

Repeat 

Encender  

Warp 

Cuatro fronteras se 

colocan alrededor 

del círculo 

Los cuatro fronteras 

ahora doblan a 

abrazar el círculo 

Disminuir  Spacing hasta vieiras se ve 

incluso entre las fronteras repetidas. 

Un cambio en Spacing espacio afecta el inicio y 

el final del tramo 

Incrementar St. Extend 

al  50% 

El espaciamiento es ahora la 

misma que entre las otras 

fronteras. 
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8.08.3 Live Edit Window / Edición dinámica Ventana 

 Una última característica de Wrap Objects To Path es una ventana de edición en vivo/ Live Edit que le permite 

modificar, a nivel de nodo, el objeto que se coloca en el camino. En este ejemplo, la forma básica llamada Amplio 

2 se está aplicando a una curva y se estiró. Nota la redondez en el medio de la forma de amplio 2 tanto en el inicio 

y el final de la curva: 

 
 

                    

 Sin necesidad de dejar  la función Wrap Objects to Path , la forma Amplio 2 se puede modificar haciendo clic en 

el icono de color rojo  en la parte inferior de la ventana. La ventana Wrap Objects to Path ampliarán y 

mostrar el objeto actual: 

      

 En este punto, el objeto puede ser editado como si estuviera usando las rutas de acceso a la herramienta Edit Paths 

at Node Level presentado en la Sección 7.13. Las curvas pueden ser re-forma, los nodos se pueden arrastrar a nuevos 

lugares y agregar ni eliminar. En este caso, la parte interna de la forma Amplio 2 será editado a ser más "puntiagudo" 

con el fin de alterar la forma alargada de la curva: 

 

Centros son un poco 

redondeado. 

Click para abrir 

ventana de  Live Edit  Se muestra el objeto 

Antes de edición de 

objetos 

Después de la edición de 

objetos 
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 Hay iconos adicionales justo por encima de la forma que se muestra que permiten acercarse o alejarse, e incluso 

auto-suavizado. Si mantiene la barra espaciadora, puede desplazarse por la pantalla chica, de trasladarse a otras 

partes de la forma, que es conveniente si se ha enfocado en estrecha en áreas particulares para editar. 

 
 

 

                                                                              

 

 Un cuadro de opciones en la parte inferior de la ventana le permite copiar el objeto actualmente modificado y 

colocarlo en una nueva capa en las capas de barras/ Layers Bar (para su uso posterior, según sea necesario). 

También puede ser que desee a continuación, guarde esta nueva forma a sus formas/ Your Shapes en la 

biblioteca de formas básicas/ Basic Shapes, también (consulte la Sección 4.10). 

 

8.09 Auto 4-Point Warp 

 Esta función se utiliza para llenar una cara de cuatro cuadrilátero cóncavo con una forma o formas seleccionadas. 

¿Qué es exactamente cuatro cuadrilátero cara? Hay tres tipos, como se muestra a continuación, sin embargo, 

sólo uno de estos tres trabajarán: 

 
 
 
 
 
 
 

Las curvas se hacen más recto y 

nodos centrales arrastrados hacia 

adentro 

Resultando cambio de 

objeto modificado: 

Tenga en cuenta el 

redondeo del 

interior 

Undo/Redo Zoom Auto-Smoothing 

Opción para tener un 

duplicado de la forma actual 

modificado añadido al Layers 

Bar 
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 Un segundo requisito para Auto 4-Point Warp es que el modo necesita ser cambiado a la deformación. Esto se 

hace haciendo clic en el cuadrilátero para recorrer los tres modos disponibles (consulte la Sección 3.13): 

                  
 

 

 Para activar la función 4-Point Warp automática, mantenga presionada la tecla Ctrl y el botón izquierdo del ratón 

mientras arrastra la forma o formas en el cuadrilátero. En este caso, la forma seleccionada es texto. Tan pronto 

como el icono del cursor cambia, suelte el ratón. Esto funciona igual en  Wrap Objects to Path, pero con un icono 

diferente. (consulte la Sección 8.08): 

   

 

 

 

 

 

 

 

 

 

 

cuadrilátero cóncavo Cuadrilátero convexo:Nota 

de la esquina que "caídas 

en" 

Cuadrilátero 

Complex:Nota de los lados 

que se cruzan 

¡Trabajará! ¡No funcionará! ¡No funcionará! 

Modo Redimensionar: no 

va a funcionar! 

Modo Rotar / Slant: no va 

a funcionar! 

Warp mode: ¡Trabajará! 

Icono del cursor comienza 

como una flecha de dos 

puntas Tan pronto como el icono del cursor cambia, 

suelte la tecla Ctrl y el botón del ratón 
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 En la siguiente ventana se abre y el texto llena el cuadrilátero. Tenga en cuenta los ajustes disponibles en esta 

ventana : 

 

 

 

                                               

 

o Las ajuste bilineal / Perspectiva / Bilinear / Perspective cambios cómo la forma se ha pervertido: 

  

              

 

o El Rotate Warp Point / La Girar Warp Point Solicitar gira la forma 90 grados, siendo ajustados al 
texto dentro de los confines del cuadrilátero inicial: 

 

                              

 

o El Warp Point Orden inverso/ Reverse Warp Point Order refleja la imagen: 

             

Escoja Bilinear o 

Perspective 

Restablecen a los 

predeterminados 

Reverse Warp 

Point Order 

Rotate Warp 

Point Order 

Valores de ajuste 

Click  en  Accept 

cuando termine 

Bilinear Perspective 
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o La ajustar todos/ Adjust All y ajustar cada / Adjust Each configuración le permiten mover el texto a 

partir de los límites originales del cuadrilátero: 

     

 

 

                         

 

 

 Al alcanzar la forma deseada, haga clic en Aceptar. 

• A veces, usted no puede conseguir lo que esperas cuando primero la aplicación del Auto de 4 puntos Warp. Por 

ejemplo, cuando añadimos KNK una imagen especular de la misma cuadrilátero a, que se utilizó para "TEAM", esto 

es lo que se obtiene: 

    

 Tanto el Point Solicitar Girar Warp/ Rotate Warp Point Order y Reverse Warp Point/ Reverse Warp Point Order 

Solicitar deben aplicarse: 

 

 

    

 

Adjust All: -50% Adjust All: 0% Adjust All: 15% 

 

Top only: 25% 

 

Bottom only: -25% 

 

Left only: 15% 

 

Right: 15% 

Bottom: -25% 

 

Click doble 

 

Click una vez 
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 Después de aplicar Rotate Warp Point Order dos veces y Reverse Warp Point  una vez, nos encontramos con el 

KNK en la orientación correcta. Después de eliminar los cuadriláteros, y recoloring nuestro texto, tenemos el 

resultado final: 

 

 

8.10 Conical Warp/  Deformacion Conica 

 

 La función Warp cónico se puede utilizar para diseños para adaptarse a la conformación de formas cónicas 

alrededor, que son formas tubulares en la que la parte superior es un diámetro diferente de la parte inferior. Lo 

que hace esta característica especialmente divertido de usar en el diseño es la simulación 3D increíble, como se 

puede ver en el ejemplo Tumbler Wrap que sigue a continuación. 

 

  La función cónico Warp se accede de la siguiente manera: 

 

o Haga clic en el icono cónico Warp/ Conical Warp en la barra de herramientas de Magia/ Magic 

Toolbar   

o Presione Ctrl + Q 

o Haz clic derecho en la pantalla y seleccione Forma Magia> cónico Warp/ Shape Magic>Conical Warp 

o Vaya a Editar> Forma Magia> cónico Warp/ Edit> Shape Magic>Conical Warp 

 

Tumbler Wrap 

 Un diseño ha sido creado para la envoltura. La calabaza es de  Create-A-Card establecido en la ventana de 

Lettering Delights window. Una fuente aleatoria fue elegido para crear las letras: 

 

 

 Seleccionar todo el diseño y luego haga clic en el icono cónico Warp. La ventana de seguimiento se abre: 

 

 

 

 

 

http://vimeo.com/user8812763/review/31899983/b93ddc5051
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 Antes de hacer clic en Importar, haga clic en la pestaña Vista de laminado/ Rolled View. Usted será capaz de 

arrastrar el puntero del ratón por la pantalla para girar el vaso y ver desde prácticamente cualquier dirección: 

 

 

 

 Si desea guardar esta imagen a tu computadora, haga doble clic en la imagen mientras que en Vista laminado y una 

ventana se abrirá con la opción de guardar como archivo .png. 

 Usted puede continuar haciendo cambios en la configuración en la vista de laminado, así, y haga clic en Importar 

cuando haya terminado. Si ha seleccionado Importar Cono, entonces usted verá tanto la forma exterior de la 

envoltura de la secadora, así como la imagen original, remodelado para adaptarse a la envoltura: 

El diseño 

aparece en 

el contorno 

del abrigo. 

Los ajustes pueden ser 

guardados para su uso futuro. 

Seleccione la vista que desee./ View.    

Ingrese medidas  superior /Top e 

inferior/  Bottom Diameters, alto/ 

Height del vaso,. 

Desplácese para mover el Position de  the 

Design o modifique  en tamano/ Size. 

Si el diseño se extiende más allá de la parte 

inferior, usted tiene la opción de recortar el 

voladizo. 

Vaya a disminuir la Width de 

la envoltura 

Opción para importar la forma exterior de la envoltura / 

cono 
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 Esta función también se puede utilizar en el diseño de envolturas de la magdalena/cupcakes warppes!  

 

8.11 Lattice/Entramado 

  

 La función del enrejado se puede utilizar para crear un diseño de enrejado dentro de una forma o de una parte de 

la totalidad de la propia forma. Se puede acceder en cualquiera de las siguientes maneras: 

 Haga clic en el icono del enrejado en la Barra de Magia/ Magic Toolbar   

  Presione Ctrl + E 

 Haz clic derecho en la pantalla y seleccione Forma Magia> Entramado/ Shape Magic>Lattice 

  Vaya a Editar> Forma Magia> Entramado./ Edit>Shape Magic>Lattice 

Latticed Circle/Entremado en Círculo  

 Comience con un círculo, y seleccione a continuación, haga clic en el icono del enrejado en la Barra de Magia. Esta 

ventana se abrirá 

                                              
 

 

 El círculo seleccionado indica que la configuración actual de Entramado/ Lattice se traducirá en una mirada 

detallada mucho más pequeño que se desea. Pero con el ajuste de la configuración de Ancho/width y Gap 

(tanto hizo más grande), el resultado es mucho más práctico para el corte: 

Una vista previa de cómo 

aparecerá la red de la 

forma seleccionada 

Ajustes que alterarán la 

apariencia de entrenado 

en circulo 

Click en  Apply & Preview On 

Mat para ver cómo los 

ajustes actuales realmente se 

ven en su forma 

seleccionada. 

http://vimeo.com/user8812763/review/31899838/ab54ac8185
http://vimeo.com/user8812763/review/31900346/11ad72be2e
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 Ahora el diseño mostrado reduciría exactamente como se muestra. Usted tendría una sola pieza cortada. Pero para 
algunos diseños de celosía, lo contrario es buscado. Por ejemplo, al cortar un diseño de la parte frontal de la tarjeta 
postal, va a mantener la tarjeta y no el propio diseño. En este caso, se marcará la opción inversa del enrejado/ 
Inverse Lattice y quizás ajustar la configuración Ancho/ Width y Gap algunos más 

 

                                             

 

 

 

8.12 Rhinestone Design/Diseno con diamantes de imitacion 
 

                                 

  Comprobacion del tamano del circulo:   Tamano de diseño de patron:   Re-tamano exitente de patron: 

 

 La función Rhinestone del MTC proporciona tanto esquematización y llenado horizontal de formas con el tamaño 

de los círculos necesarios para sus diamantes de imitación y de la separación deseada. Se puede acceder en 

cualquiera de las siguientes maneras: 

 Haga clic en Rhinestone en la Barra de Magia/ Magic Toolbar   

 Presione Ctrl + K 

 Haz clic derecho en la pantalla y seleccione Forma Magia/ Shape Magic > Rhinestone 

 Vaya a Editar> Forma Magia> Rhinestone./ Edit>Shape Magic>Rhinestone. 

 

 Hay algunas pautas muy específicas a seguir en el diseño de un patrón de diamantes de imitación: 

Vista preliminar indica 

la red es ahora mucho 

más grande. 

Widht y Gap 

incrementar ambos 

Opcion borrar / Delete 

Original forma, si ya 

no se necesita 

Click en  Accept si el 

diseño es completa. 

Note la diferencia. En 

este caso, la parte del 

enrejado se adjuntará 

al material de corte Click en Inverse Lattice 

para revertir el tipo 

creado 

Click en Accept si el 

diseño es completa 

Width y Gap 

modificado después de 

cambiar a Inverse 

Lattice 

Editando: Desenando: Aplicando simulaciones: 

http://vimeo.com/user8812763/review/31900821/e510683fd3
https://vimeo.com/54645841
https://vimeo.com/35544566
https://vimeo.com/58134563
https://vimeo.com/58134938
https://vimeo.com/58152571
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 La forma tiene que ser de un tamaño antes de aplicar los círculos de diamantes de imitación. Si espera 

hasta después y luego darse cuenta de que usted quiere que su diseño general a ser el doble de 

grande, a continuación, cambiar el tamaño hará que los círculos dos veces más grandes y el espaciado 

doble de grande, también! Por lo tanto, antes de acceder a la función Rhinestone, decidir sobre el 

tamaño total que desea utilizar. 

  El tamaño del círculo seleccionado tendrá que ser más grande que el tamaño de la piedra que ha 

adquirido. Como regla general, seleccione un tamaño de tres números más grandes que sus piedras. 

Por lo tanto, en caso de adquirir piedras 10ss, a continuación, en la ventana de diseño de diamantes 

de imitación, tendrá que ser la selección de piedras 13SS. Este mayor tamaño permitirá que las piedras 

10ss a cepillarse más fácilmente en los agujeros. 

 Al seleccionar un tipo de letra a utilizar, ser recelosos de las "fuentes de lujo". ¿Quieres las letras sea 

legible después de que se convierte en círculos. En caso de duda, tener a alguien que no conoce las 

palabras que ha escrito intento de leer el diseño del círculo en la pantalla. Si no pueden descifrar sus 

palabras, y luego tratar un tipo de letra más básico. 

 Rhinestone diseña casi siempre necesita "ajustes", que consiste en añadir, borrar, mover o círculos 

re-espaciado. Usted tendrá que solicitar a Break (Ctrl-B) para separar el patrón en círculos 

individuales. Para agregar rápidamente un círculo, seleccione uno, haga clic en el icono Copiar y 

luego haga clic en el icono Pegar in situ y arrastrar el círculo a su nueva ubicación. A continuación, 

puede seguir simplemente haga clic en Pegar en lugar de añadir más. Para volver a espacio de una 

fila o columna de círculos, la marquesina de selección y luego usar las teclas de acceso directo, [y] 

para proporcionar igual espaciamiento vertical horizontal e igualitaria, respectivamente. 

 

 

Rhinestone Outline/Rhinestone Esquema 

 En este ejemplo, se pondrá de relieve las iniciales de una escuela secundaria. Como se mencionó en la introducción 

a esta sección, el primer paso es la anchura y la altura de las letras de tamaño. Asegúrese de que hay suficiente 

espacio entre las letras para que los círculos no se solaparán. Además, es posible que desee cambiar el tamaño de 

las letras en vertical para hacer las letras más alto. Esto permite que más círculos que se aplicarán y pueden mejorar 

la capacidad de leer el texto: 

                                                                   

 

 Para aplicar un esquema de diamantes de imitación, seleccione la forma y, a continuación, haga clic en el icono 

de diamantes de imitación. Esta ventana se abre: 

 

Carta es de 6 "de 

ancho, pero sólo 2.3" 

de altura 

Carta sigue siendo 6 

"de ancho, pero ahora 

es de 3,6" de altura y 

se mostrará mejor en 

la camiseta 
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 Se recomienda que se marca la opción original Supr/ Delete Original durante la vista previa de su diseño en la 

pantalla. Sin embargo, antes de hacer clic en Aceptar, quite la marca. Puede que tenga que volver a crear su diseño 

en algún momento y que tiene la forma original, será beneficioso. 

• El paso final será la de modificar el diseño usando las teclas de atajo mencionadas al principio de esta sección. 

Rhinestone Fill/Rhinestone relleno 

• La otra opción en la función Rhinestone es Rellene Formas. En lugar de delinear la forma, la imagen se llena con los 

círculos en filas horizontales. En nuestro ejemplo anterior, las mismas letras ahora aparecerá así: 

 
 

 Tenga en cuenta que en el título de esta ventana, se muestra el número de círculos en el diseño. Rhinestones 

suelen ser vendidos por el bruto y el 1 bruta es igual a ~ 144 piedras. 

 
 

 

Additional Tips on Rhinestone Designing/Consejos adicionales sobre Rhinestone Proyectos 
• A veces los círculos que quieren volver a espacio igualmente puede caer más cerca de un ángulo de 450 frente a 

vertical u horizontalmente. Seleccionar todo su diseño y girar hasta que la línea de círculos está más cerca de vertical 

u horizontal. Re-espacio utilizando los [o] teclas de acceso directo y luego girar en su lugar. 

Vista previa 

del diseño 

Click en Accept  
Click en Preview 

botón para ver los 

efectos de los ajustes 

Seleccione un tamaño de 

círculo más grande que 

sus piedras 

Seleccione el espacio 

deseado/Spacing 

Click en Outline 

Shapes 

Opcion de borar original/ 

Delete Original  

Número de 

círculos en el 

diseño 

Click en Fill Shapes 

Vista previa  de diseno 
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• Si desea perfilar su diseño, a continuación, crear el contorno primero usando la función de capa Sombra (Ctrl-H). 

Elija una sombra Ancho/ Shadow Width mínimo el tamaño de los círculos más el espaciado. En el ejemplo 10SS, los 

círculos eran 0,13 "de diámetro y la separación era 0,03". Si los mismos ajustes se utilizan en el siguiente ejemplo, 

entonces el ancho de la sombra tiene que ser 0,16 "(nótese que mm o cm también se puede utilizar): 

 
 

       

 El diseño resultante con la sombra se establece en el tamaño del círculo más la separación, se ve así: 

 

 Con diseños rhinestone simétricas, considere usar el siguiente proceso para perfeccionar su diseño: 

o Este esquema del corazón no es claramente simétrica: 

 

                                                                                      
 

 Eliminar la mitad derecha y la posición de los círculos superiores e inferiores a la posición 

deseada: 

                                                                                         

 

 Seleccionar círculos y luego realizar los siguientes pasos muestran: 

 

Ajuste el ancho de la 

sombra/  Shadow 

Width a por lo menos 

el tamaño de los 

círculos más el 

espacio 

Medio derecho del 

corazón no es 

simétrica con la mitad 

izquierda 

Derecha medio se 

elimina y entonces los 

círculos ajustado a las 

posiciones deseadas 
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13 Texture Snapshot / Textura Instantanea 

 

 La función de la textura  instantánea se utiliza para crear una textura de una o más formas seleccionadas. Tras la 

ejecución, cualquier coincidencia entre las formas se retira y se conserva una sola línea de traza alrededor del 

exterior. El relleno se convierte en cualquier color o textura de las formas seleccionadas tenían. Se puede acceder 

en cualquiera de las siguientes maneras: 

o Haga clic en el icono de la textura de instantáneas/ Texture Snapshot en la barra de herramientas de 

Magia/ Magic Toolbar  

o Presione Ctrl + 1 

o Haz clic derecho en la pantalla y seleccione Forma Magia> Textura Magia/ Shape Magic>Texture 

Magic 

o  Vaya a Editar> Forma Magia> Textura Magia./  Edit>Shape Magic>Texture Magic. 

 

 Esta función es muy útil para aplicaciones de impresión y corte. Por ejemplo, un documento detallado patrón de 

empalme se puede convertir instantáneamente a una impresión y corte utilizando esta función: 

 

 

    
 

Click en el icono Copy, 
seguido del icono  Paste In 

Place, y luego el icono 

Mirror. 

. 

Con lado derecho aún 

seleccionado, pulse la 

flecha derecha tecla 

hasta que la derecha está 

en su lugar. 

 

Eliminar los círculos 

superiores e inferiores ya 

que son copias idénticas en 

uno encima del otro 

 

Aplicar la función 

de Ingreso/Join  y el 

diseño es completa 

 

Un muñeco de nieve de papel juntar 

las piezas, donde hay 17 formas 

individuales 

Despues de aplicar  Texture Snapshot: 

línea de corte exterior con un relleno de 

textura 
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Creating a Gradient Texture Fill/La creación de un relleno de degradado textura 
 

 La función anidada Duplicar/ Nested Duplicate se puede utilizar para crear una textura de color degradado 

para cualquier forma dada. Decida qué color que desea utilizar para la forma principal, por ejemplo 

amarillo. Añadir un rectángulo de Formas básicas y cambiar el rectángulo para que el color: 

 

 
 

 Seleccione el rectángulo y aplicar la función de la textura de instantáneas/ Texture Snapshot. 

  Crear la forma que desea llenar. En este ejemplo se utilizará una flor. Seleccione la forma, haga clic 

derecho y seleccione Cambiar color / textura / Line./ Change Color/Texture/Line Elija Seleccionar textura / 

Select Texture y la siguiente ventana se abrirá donde puede seleccionar la textura de color amarillo y 

también marcar la opción de segmentación de modo que toda la forma se llenará con el color, sin importar 

el tamaño del rectángulo original: 

 

                                        

 Ahora, con aún seleccionado la forma, el acceso a la función anidada Duplicar/ Duplicate Nested haciendo clic 
derecho y seleccionando Duplicar/Duplicate> anidados Duplicar/ Duplicate Nested. La siguiente ventana se abrirá: 

Rectangulo de cualquier dimension 

 

Marque la casilla y luego 

elegir la textura del 

menú desplegable. 

Marque  opciones enTile 

Texture  

Click  en  OK. 
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 La función de rotación de Hue/ Rotated Hue se utiliza para esta aplicación. Para un espectro de colores que 
comienzan y terminan con el mismo color, los grados se calculan dividiendo 360 por el número de duplicados. En 
este caso, 36 duplicados son elegidos, por lo que la hace girar por ajuste entrado/ Rotated By es de 10 grados. 
Después de hacer clic en Aceptar, tenemos nuestra flor acabada. Textura de instantáneas/ Texture Snapshot de 
nuevo se puede aplicar: 

 

 

 

8.14 Jigsaw Puzzle/  Rompecabezas 

  

 

 La función de Puzzle Jigsaw se instala como una aplicación independiente. Para abrirlo, vaya a su botón de Inicio de 

Windows, seleccione Todos los programas/ All Programs, localice el que la carpeta Cut/ Make The Cut y luego 

seleccione Jigsaw Puzzle generador. 

• La siguiente ventana se abrirá: 

 
 

Introduzca conteo duplicado 

Marcar  Adjust Color  

Para un espectro de colores, 

introduzca 10 (= 360/36) 

Click  en vista previa/ Preview 

Click en Accept 

Ingrese el valor deado en  Width and 

Height (que se puede cambiar después de 

la importación en MTC). 

http://vimeo.com/user8812763/review/31900107/c49077cec4
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 Si va a aplicar este rompecabezas sobre una imagen específica, es posible que desee elegir las dimensiones que 

corresponden a la imagen. Por ejemplo, supongamos que usted ha importado un "x 6" en MTC 4 y un plan para 

hacer una impresión y corte rompecabezas. Ingrese esas dimensiones en el rompecabezas del generador/ Jigsaw 

Puzzle Generator, como se muestra arriba. 

 Además, para mantener las piezas a ser demasiado distorsionada (o peor, la superposición); usted debe hacer que 

el número de filas/ Rows y columnas/ Columns  similares a las dimensiones, como se muestra. Si desea más piezas 

entonces usted puede aumentar el número de filas y columnas proporcionalmente. Por ejemplo, en vez de tener 4 

filas y 6 columnas utilizar el doble del número de 8 filas y 12 columnas (o 1,5 veces a 6 filas y 9 columnas). Tenga en 

cuenta cómo las piezas resultarían si un proporción aproximada no se mantuvieron. Las piezas se cortan en el uno 

al otro: 

 

 

                              

                    

 También hay una ficha Opciones avanzadas/ Advanced que puede utilizar para modificar el diseño de las piezas e 

incluso guardar la nueva configuración. 

 Cuando esté satisfecho con la apariencia de sus piezas de un rompecabezas, haga clic en el botón Exportar/ 

Export y una ventana se abrirá y usted puede guardar su rompecabezas como un archivo SVG. 

 En MTC, importar el archivo de rompecabezas SVG y alinearlo sobre la imagen que desea convertir en un 

rompecabezas. Realice una impresión y corte tal como se presenta en el Capítulo 9. Por otra parte, si imprime su 

Vista 

preliminar del 

rompecabezas 
Ingrese numero de filas/ Rows y columnas/Columns 

para determiner el numero de piezas de rompecabezas 

Disminuir o aumentar las esquinas/ Corners para 

cambiar la redondez de las 4 esquinas del 

rompecabezas. 

Click en  Generate Puzzle después de cada configuración 

de cambiar para actualizar la vista previa. 

Click en  Export Puzzle cuando el 

rompecabezas está completo. 

En lugar de seguir las 

dimensiones del rompecabezas, 

los números introducidos para 

Rows y  Columns son opuestas a 

lo que se utilizó anteriormente. 

Pedazos del 

rompecabezas 

se 

superponen! 
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imagen un poco más grande que el diseño general del rompecabezas, usted puede configurar su origen justo en 

la esquina de la imagen impresa y luego se corta el diseño usando Knife Point (Consulte la Sección 2.02). 

 He aquí un ejemplo de una imagen importada y el rompecabezas importado y dimensionado para ajustar en la 

parte superior 

 

   

 

 

 

 

8.15 Notes Window / Notas Ventana 
 

 La ventana de Notes/ Notes en MTC se puede utilizar en una variedad de maneras: (1) proporcionar instrucciones 

para el corte y montaje del proyecto, (2) la adición de su nombre, los derechos de autor y Condiciones de uso, (3) 

que explica el propósito de las diferentes páginas o capas, (4) que acrediten los demás para obtener ayuda con el 

diseño, (5) citando fuentes de clipart o nombres de las fuentes utilizadas, y (6) que unen los archivos que desea 

brindarle su proyecto. 

 La ventana de Notes se puede abrir usando las siguientes maneras: 

 Haga clic en el icono de la ventana Toggle Notes/ Toggle Notes Window en la barra de herramientas 

Archivo/ File Toolbar  

 Ir a Ver> Notas Ventana./ View>Notes Window. 

 Hay dos pestañas en la ventana Notas - Notas y Archivos. La ventana de Notes se utiliza para introducir el texto 

que desee incluir en su proyecto 

 

                                                          

Click en Notes t 

Haga clic aquí para 

cambiar el tipo de letra 

utilizado y el color, tamaño 

y estilo del texto. 

Introduzca el texto aquí 
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 Si usted elige su propia fuente y luego compartir el archivo con alguien más, las notas sólo se mostrará en esa 

fuente, si el destinatario tiene la misma fuente instalada en su / su ordenador. De lo contrario, las notas se 

mostrarán en una fuente por defecto del sistema, como Arial. 

 La ficha Archivos se puede utilizar para adjuntar archivos a su archivo de proyecto. Por ejemplo, es posible que 

desee adjuntar una fotografía de su proyecto terminado, o un tutorial PDF, u otro archivo MTC que se asocia con 

este. Cualquier archivo se puede conectar: 

 

                                                         
 

 Si usted tiene cualquier información introducida en su ventana de Notes o un archivo adjunto, a continuación, se 

abrirá automáticamente cuando se abre el archivo por usted o por otra persona. Sin embargo, a partir de la versión 

4.2.0, puede desactivar esta función, vaya a Ayuda> avanzadas> Configuración avanzada y desmarcando la casilla 

junto a "Enable Automatic Notas", bajo Habilitar vista de notas: 

 
 

 Si abre un archivo de proyecto MTC de alguien que ha conectado uno o más archivos en la ventana de Notes, puede 

intentar hacer doble clic en el nombre del archivo para abrir automáticamente ese archivo. Con algunos formatos 

de archivo, como PDF, tendrá que guardar el archivo en su ordenador y abra fuera del MTC. 

 Para guardar un archivo adjunto, haga clic en el nombre de archivo y haga clic en el botón Guardar archivo para 

abrir una ventana donde se puede navegar por su ordenador para localizar una carpeta para guardar el archivo.

  

 

                                          

Click en Files  

Click  en Add Files para navegar 

por su ordenador y seleccionar 

archivos para adjuntar. 

Lista de los archivos que se 

han añadido a esta projecto 
Tamaño de cada archivo que se 

ha añadido a este proyecto 

Desactive la opción para desactivar la 

visualización automática de Notes al 

abrir un MTC con notas. 

Click en  Save File para 

guardar el archivo resaltado a 

una ubicación de su elección 

en el equipo. 

Para guardar un archivo, 

primero resalte el 

nombre haciendo clic una 

vez. 
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8.16 Design Contest Tutorials /  Concurso de Diseño Tutoriales 
 

 En octubre de 2011, un concurso fue patrocinado por KNK EE.UU.. El reto era tomar diseños o formas 

existentes y transformarlos en nuevas formas con diferentes funciones en el MTC. Los siguientes tutoriales 

son de las dos obras ganadoras y son excelentes ejemplos de cómo las herramientas disponibles en el MTC 

se pueden utilizar de forma creativa. 

Designing a Whale by Brigit Mann/El diseño de una ballena por Brigit Mann 
 

 

 Comience con las siguientes formas básicas/ Basic Shapes: 

 

 Seleccione el Yin Yang, cambiar el tamaño de alrededor de 3 "de altura. Aplique la función Break. Elimine 

el círculo inferior y ajuste el lado derecho del Yin Yang a un lado. Hacer que el círculo un poco más 

pequeño (este será el ojo de la ballena). Aplique una Únete a la parte izquierda de recombinar el círculo 

para el Yin Yang: 

  

 
 

 Cambiar el tamaño de la media luna y rotar y lo puso parcialmente en el cuerpo de la ballena en la boca 

sería. Seleccione ambas piezas y aplicar booleana Únete/ Boolean Join, seleccionando Diferencia BA/ B-A 

Difference: 

 

 Desbloquear la relación de aspecto/ Aspect Ratio y cambiar el tamaño del desgarro de 2,5 "W x 0.8" H. Seleccione 

y haga clic en la herramienta Bézier Warp. En Tamaño y Posición, deslice la izquierda y la derecha hasta alrededor 

de 37: 
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 Gire la cola para alinearse con el cuerpo y la superposición de ballenas. Aplicar la herramienta de 

soldadura: 

                                                               
 

 

 Bloqueo de la relación de aspect/ Aspect Ratio y redimensionar el tamaño del triángulo a 

aproximadamente 1,1 ". Insertar nodos en cada lado como se muestra. A continuación, arrastre la parte 

superior nodo a la izquierda: 

                                             
 

 

 Las rutas de curva hacia el exterior para formar la aleta: 

                           
 

 Gire la aleta, se superponen sobre el cuerpo de la ballena y aplicar la herramienta de soldadura/ Weld 

                                                              
 Cambiar el tamaño de la otra sección de Yin Yang a un ancho de 1 "Uso de la herramienta Cuchillo/ Knife, 

rebanada en la mitad y eliminar la pieza superior, se unen los dos nodos juntos esta es la trampa/flapper: 

 

                                                                      

 

Inserte un nodo 

aproximadamente 1/3 

de la distancia desde 

la parte superior de la 

ruta: 

Inserte un nudo 

alrededor de ¼ 

a la forma de la 

parte superior 

de la ruta: 

Arrastre 

nodo 

superior a la 

izquierda 

curva de 

Arrastre curva de 

Arrastre 

Fin is 

formed 
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 Seleccione la ballena y aplicar una capa de sombra/ Shadow Layer (con apagón seleccionado). Luego 

disponer la aleta en la parte superior: 

   

 Para agregar algunas salpicaduras, comience con formas adicionales de lágrimas, cambiar el tamaño para 

hacer más delgado, y aplicar Warping u otro método de distorsión de la forma. Gire y organizar bajo la 

ballena para completar el diseño: 

             

Designing a Flower by Laury Vaden/Disenando la flor de Laury Vaden 
 

 

 Esta flor colorida está hecho de sólo unos pocos de formas básicas: círculo, remolino, Heart2, Lágrima, y 

ondulada 2. 

 Set Snap Posición/  Snap Position en No rotura/ No Snapping. Elija una de las esteras sin contraste, como 

la alfombra verde estándar. 

 Seleccione el círculo y se mueven hacia abajo y lejos de las otras formas. A continuación, seleccione la 

Lágrima y moverlo hacia abajo. Haga clic en el lagrimal hasta iconos rojos cambian al modo de muestra a 

continuación. Este es el modo de escala. Alargar el desgarro y delgado como se muestra: 

 Manteniendo pulsada la tecla Ctrl, mueva el rasgón sobre el Círculo y la liberación. Esto abrirá los 

objetos Ajustar a la ventana Wrap Objects to Path. (Consulte la Sección 8.08) para obtener más 

información sobre cómo activar esta función): 
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 En primer lugar, active la casilla Repetir/ Repeat. A continuación, aumentar el número de repeticiones/ 

Repeat Count. Utilice un valor negativo para el espaciado de modo que las lágrimas se superponen 

ligeramente. El espaciado / Spacing es controlada tanto por el establecimiento que escriba en el espaciado 

y el ajuste deslizante espacio justo sobre el botón Aceptar. Esto puede ser un poco confuso, 

especialmente cuando se utiliza los números negativos en comparación con los números positivos. 

Practique un poco para ver cómo funciona con ambos. El control deslizante vertical Alinear controla hasta 

qué punto en el círculo se ubicarán las Lágrimas. El control deslizante/ Offset de compensación no se 

utiliza debido a que las lágrimas se están alineados a lo largo de un círculo: 

 

 Seleccione el círculo y todas las lágrimas / Pétalos y aplicar la función de soldadura/weld: 

 

 Haga clic en la flor y aplicar un copiar/ Copy y pegar en su lugar/ Paste In Place para crear un duplicado. 

Haga doble clic en el duplicado hasta que la forma está en el modo Girar/ Rotate. A continuación, gire 

lentamente la copia, arrastre el icono de la esquina alrededor hasta que las líneas de copia hasta con los 

espacios del original: 

 

 Centro de la flor: Seleccione una de las flores y realizar otra Copiar/ Copy y Pegar en el lugar/ Paste in Place. 

Mueva la copia lejos de las otras flores y hacer clic en el icono de la capa de sombra/ Shadow Layer: 
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 Aparecerá el menú desplegable de arriba. Marque la casilla de la inserción de las Sombras/ Inset 

Shadow. Desactive la casilla de salida Auto Simplificar/ Auto Simplify Output. Se recomienda que en 

inglete/ Mitered ser seleccionado como el Rincón Únete / Corner Join  vez de redondeado/ Rounded.. 

La forma para el centro de la flor es sólo la forma central. Utilice el control deslizante Sombra Ancho 

para crear la inserción. Haga clic en Aceptar cuando haya terminado: 

 

 Para eliminar los pétalos, primero seleccione la forma de inserción y luego aplicar la función Break. Ahora 

eliminar cada una de las inserciones de pétalos. Una vez más, sólo está interesado en la inserción centro. 

La forma original (el que se utilizó para la capa de sombra/ Shadow Layer) también puede ser eliminado. 

  Coloque otro círculo en el tapete de la biblioteca de formas básicas/ Basic Shapes. Seleccione tanto el 

nuevo Círculo y la inserción centro y pulse S para el apilado/ Stack de ellos: 

 

 

 Seleccione sólo la forma de inserción y, a continuación, haga clic en el icono del enrejado/ Lattice para 

abrir la ventana de Lattice. Marque las casillas para Inverse del enrejado/ Inverse Lattice, Auto Simplificar 

salida/ Auto Simplify Output,  y Eliminar original/ Delete Original. Tenga en cuenta los otros ajustes 

utilizados y haga clic en Aceptar: 
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 Inscripción en el Círculo/ Join the Circle y la red/ lattice mediante la selección de los dos y la aplicación de 

la función de Ingreso/ Join. Para eliminar los diminutos recortes, presione F8 para activar la herramienta 

Borrador/ Eraser. Marque la casilla Inverse Borrador y ajustar el tamaño a 1. A continuación, borrar los 

pequeños cortes que usted no desea. 

 

 Este es el centro de la flor. Seleccione ambos conjuntos de pétalos y el centro y pulse S para Stack: 

 

 Sombra flor o Mat: La última parte de la flor principal es crear una sombra de inicio de la flor entera. El 

primer paso es seleccionar toda la cabeza de la flor y aplicar Copiar/ Copy y Pegar en lugar/ Paste in Place 

de crear una nueva copia en la parte superior de la vieja. Mueva la nueva copia de distancia de la flor y 

aplicar la herramienta de soldadura/ Weld: 

 

 Seleccione el esquema de la flor y pulse el icono de la capa de sombra/ Shadow Layer: 

 

 Utilice la configuración de arriba para hacer una sombra de la flor. Pulse Aceptar cuando haya terminado. 

Eliminar el contorno original (la más pequeña). Seleccione la flor y la sombra y pulse S para el apilado/ 

Stack juntos. 
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 Color: Ajuste el tapete de contraste en la ficha Mat virtual. Asegúrese de que cada forma es en su propia 

capa, a continuación, pasar las capas hacia arriba o hacia abajo para que el centro de la flor es en la parte 

superior. Cambie los colores de los dos conjuntos de pétalos y el centro: 

 

 Flower Stem /Vástago de la flor: Seleccione la forma ondulada y moverlo lejos de las otras formas. Haga 

clic en el icono Girar 90 grados/ Rotate 90 degrees: 

 

 

 Haga clic en la forma hasta que vea los iconos del modo de escala/ Scale de color rojo y luego se alargan 

la forma, arrastrando los iconos de color rojo, hasta que tenga el tamaño y la apariencia de la madre que 

desea: 

 

 

 Hoja: Seleccione la forma del corazón y la bajará al tallo. Manipula hasta que sea la forma y el tamaño 

que desee para una hoja. Para ello, el uso de los diferentes iconos de escala de color rojo en el modo de 

escala/Scale. También es posible que desee probar algunos de los iconos rojos de deformación en el modo 

Warp (flechas Quad rojo): 
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 Coloque la hoja cerca de la madre. Más tarde va a utilizar la ruta / Fat Path en la herramienta Pluma / Pen 

Tool en el modo de edición de nodos/ Node Edit Mode para agregar un poco de madre al tallo principal. 

 Espiral: (Tenga en cuenta que dado que este tutorial fue escrito, una herramienta Espiral se ha añadido al 

MTC Así consulte la Sección 8.03, si lo deseas.) Por un método más rápido para crear la hoja espiral añadido 

a la madre) 

 El remolino Forma Básica/ Basic Shape Swirl es un camino abierto / forma de una sola línea que se debe 

convertir en la espiral que se cortó. También tiene demasiadas vueltas para la flor: 

 

 Use utilizar el nodo Editar Herramienta/ Node Edit Tool para eliminar nodos al comienzo y al final del 

remolino para reducir el número de vueltas 

 

 Para convertir a la espiral que se suelda al tallo de la flor, seleccione el remolino modificado y utilizar 

Copiar/ Copy y Pegar en el lugar/ Paste In Place  para hacer una copia. Seleccione la copia, y reducir su 

tamaño para hacerlo más pequeño, pero no cambiar la forma. Organizar las dos formas y pulse S para el 

Stack de ellos: 

 

 Combinar los dos caminos en una sola forma mediante el uso de la herramienta Pluma en el modo Editar 

Nodos/ Edit Node Mode  (presione F5): 

 



230 
 

 Cuando se activa la herramienta de pluma/ Pen Tool te darás cuenta de cuatro nodos aparecen ahora en 

los extremos de las dos espirales. Conecte los nodos haciendo clic izquierdo en un nodo y hacer clic 

derecho en el nodo al que desea conectarse: 

 

 Repita con el otro conjunto de puntos / nodos para terminar de cerrar el camino abierto en una forma. 

 Posicionar a la forma de remolino, selecciónelo y haga clic en el icono de Espejo/Mirror. Siguiente haga clic 

en el icono de rotación de 90 grados/ Rotate 90 degrees. Mueva la espiral en su lugar contra el vástago. 

Seleccione el tallo y en espiral y haga clic en el icono de soldadura/ Weld: 

 

 

 Agregar una Tallo Hoja/ Add a Leaf Stem: Haga clic en la hoja y coloque un poco lejos de la madre. Haga 

clic en la herramienta de la pluma/ Pen Tool de nuevo. Compruebe Esta vez el cuadro Ruta de grasa. 

Seleccione un tamaño para el Camino de grasa / Fat Path  a utilizar para dibujar el tallo de la hoja. Haz clic 

izquierdo en el tallo de la flor y haga clic derecho en el centro de la hoja: 

 

 Seleccione el tallo de la flor, las hojas y el tallo de la hoja y haga clic en el icono de Weld. 

 Agregue tres círculos y cambiar el tamaño de dos a ser progresivamente menor. Colóquelos en el tallo 

como se muestra a continuación. Seleccione la madre y los pequeños círculos y aplicar Ingreso/ Join: 

 

 Cambiar el color de la madre para ser verde. El diseño se completo! 
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9. Print And Cut / Imprimir y Cortar 
9.01 What Is a Print And Cut (PNC)?/ ¿Qué es una impresión y corte (PNC)? 

 

 El proceso de impresión y corte implica imprimir una imagen del MTC a cualquier impresora del 

propietario y, a continuación, con la ayuda del láser del Zing, que tiene la imagen o imágenes recortadas 

con una precisión perfecta. A continuación se presentan tres tipos típicos de aplicaciones de impresión y 

corte, pero hay más, así que asegúrese de revisar la Sección 9.06 y 9.07: 

o  La línea de corte es a lo largo de la frontera real de la imagen impresa (s): 

                                  

 

o La línea de corte se encuentra fuera de la frontera, pero sigue la forma de la imagen impresa (s): 

                           

 

 

o La línea de corte sigue una forma diferente de la de las imágenes impresas (s): 

                   

La imagen se corta con 

precisión a lo largo de las 

fronteras impresos 

La imagen se reduce a la 

misma forma pero desplazada 

de las fronteras fuera de 

impresos 

http://www.youtube.com/watch?v=VN_mPhc9Ajs
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9.02 What is a PNC Calibration?/ ¿Qué es una calibración PNC? 

 Con el fin de obtener resultados precisos de la PNC, debe ajustar la calibración Desplazamiento láser/ Laser Offset. 

Esto no es más que determinar a qué distancia de la luz láser en su Zing se encuentra respecto a la punta de la 

cuchilla. Debido a que el láser está instalado manualmente en un pequeño agujero en el interior del carro de la 

cuchilla, la distancia de la luz láser a la punta de la cuchilla puede variar de una Zing a la siguiente. Además, usted 

tendrá que usar el mismo soporte de la hoja con todas las aplicaciones de la PNC, como la distancia también puede 

cambiar con los titulares de diámetro mayor o menor. 

 La distancia se mide en mm en una dirección X y en una dirección Y: 

                                                                               

 

 

 Esta calibración única que hay que hacer una sola vez, para un soporte de la cuchilla dado, y entonces usted puede 

grabar esta calibración en el caso de que tenga que instalar el MTC en un equipo nuevo o tienes que formatear el 

disco duro de su equipo actual. Las unidades están en mm, que son más fáciles de medir en distancias muy 

pequeñas. 

 El Zing plug-in tiene un conjunto de números de calibración por defecto que serán cerca de los números finales, 

pero no exactamente lo mismo. Para acceder a estos números, haga clic en el icono de llave inglesa pequeña indican 

a continuación y en la ventana Calibrar/ Calibrate window abrirá: 

 

 

      

Una forma personalizada se 

corta alrededor de la imagen 

impresa. 

X Offset 

Y Offset 

Laser 

dot/Punto de 

laser 
Tip of blade 

Haga clic en la llave para abrir la 

ventana de calibración 

Laser Offset 
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 El proceso consiste en realizar y repetir una PNC para ver la cantidad que necesita para ajustar los valores X e Y con 

el fin de obtener resultados perfectos. Y usted debería ser capaz de obtener PNC es perfecto! :) 

 

9.03 PNC Procedure Part 1: Setting Up and Printing / Procedimiento PNC Parte 1: Configuración e Impresión 

• ¿Qué se necesita antes de comenzar un PNC? 

 En primer lugar, usted necesita una imagen para imprimir, una impresora y el soporte de la hoja va a utilizar 

para todas sus PNC de. El diámetro del soporte de la cuchilla tendrá un impacto en la calibración láser. Nota: 

Si va a importar una imagen a utilizar, entonces por favor consulte el Capítulo 6 para más detalles sobre el 

proceso de seguimiento de píxeles. 

 Tienes que estar bien descansado! Usted no quiere empezar a aprender el proceso de la PNC cuando estás 

cansado, estresado, o en un apuro. El dominio de una PNC viene cuando usted tiene el tiempo para repetirlo 

unas 4 veces seguidas. En ese punto, usted no sólo ha repetido el proceso suficientes veces como para sentirse 

muy cómodo con el orden de los pasos, pero usted tendrá que perfeccionó su calibración y entonces estará 

listo para hacer el futuro de la PNC de forma rápida y con facilidad. 

 

 

 

 Si bien es posible hacer PNC de, ya sea en modo horizontal o vertical, es muy recomendable que 

seleccione la misma orientación que suele utilizar para el otro corte en el MTC. Si usted prefiere trabajar 

en el retrato, por favor vaya a la sección Opción Modo Retrato/ Portrait Mode Option después de la sección 

Opción modo horizontal/ Landscape Mode Option. 

 

Landscape Mode Option /  Opción Modo Horizontal 
 

 Para comenzar, cree una nueva alfombra de encargo que se ha configurado para el tamaño carta o A4 o 

lo que sea el tamaño de la impresión será. Consulte la Sección 3.04 si necesita instrucciones para crear 

un tapete personalizado. Desactive la casilla Márgenes/ Margins. Para el tamaño de letra, que el ancho/ 

Width 11 "y la Altura/ Height  8.5". Para A4, ajuste el ancho/ Width de 11.69 "y la altura/ Height de 8,27". 

 Puesto que usted está leyendo la sección Opción modo horizontal del manual de usuario, establezca el 

Mat virtual a Horizontal y seleccione su nueva estera personalizado. 

  ¿Cuál es la mejor imagen que se utilizará para la calibración Desplazamiento láser? Una flecha es ideal, 

ya que será capaz de verificar rápidamente si usted tiene la impresión colocado correctamente en la base 

de corte. Además, es una gran forma de ver cómo ajustar su X y los números de calibración y. Usted puede 

utilizar casi cualquier imagen, pero para seguir el resto del tutorial con más facilidad, una flecha de la 

biblioteca Formas básicas es muy recomendable: 

 

 

IMPORTANTE: No utilice altas velocidades cuando se realiza muy preciso de la PNC, incluyendo lo 

siguiente calibración. Establezca tanto las velocidades de corte y hasta 11 (uso 9 en el Zing el 

original). 

IMPORTANTE: la flecha al menos 6 "de alto (como se muestra a continuación) para una calibración precisa. 
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 Observe que la flecha apunta hacia arriba en la pantalla. Asegúrese de que su flecha también se apunta 

hacia arriba! Más tarde, al imprimir la flecha y colocar el papel en la colchoneta, la flecha estará 

apuntando hacia la derecha como se inserta la colchoneta en el Zing. 

 A continuación, vaya a Archivo/ File > Configurar impresión/ Print Setup, seleccione la impresora que va a 

utilizar, y establecer la orientación/ Orientation a horizontal/ Landscape: 

 

                                                                 
 

 A continuación, vaya a Archivo/ File > Opciones de impresión/ Print Options y marque las siguientes 

casillas: 

                                                               

 Después de hacer clic en Aceptar, debería ver las fronteras verdes en el tapete virtual, indicando cómo se colocará 
la copia impresa en el tatami y donde será impreso en la flecha. Si la flecha está fuera de las fronteras verdes, 
moverlo para que caiga dentro de los límites: 

 

Escoja 

Landscape 

Mat dimensiones deben 

coincidir con la impresión 

Importar una flecha y 

gire para mirar hacia 

arriba 

Seleccionar  Landscape 

Seleccione la impresora 

Click en OK  

Verificar tamano de 

papel 

Click en OK  

Marque esta opción si quiere un 

esquema única de la flecha 

impresa (para ahorrar en tinta!) 

Compruebe estas tres opciones 

Opción para cambiar el color del contorno de la 

imagen 

Se establece en 0 ya que 

esto no se aplica a los 

cortadores KNK. 
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 Vaya a Archivo/ File > Vista preliminar/ Print Preview y usted será capaz de ver la flecha más las cuatro marcas de 
registro que deben ser alineados con los límites de la flecha 

 

                                           

                                            
 

 Asegúrese siempre de que usted puede ver las cuatro marcas de registro antes de continuar, ya que son 

una parte integral del proceso de PNC. Si su vista previa de impresión coincide con el de arriba y ves las 

cuatro marcas, haga clic en el botón Imprimir. Compruebe también que lo que se está impreso es lo que 

necesita. Por ejemplo, si se ha añadido una forma adicional a cortar, pero no desea que aparezcan en la 

copia impresa. Aquí es donde usted tendrá que usar las capas de entidades para controlar lo que se va a 

imprimir, así como lo que se cortará después. 

Información sobre la 

configuración actual de la 

impresora se muestra aquí. 

Verde líneas discontinuas 

indican la parte de la 

pantalla que se va a 

imprimir. 

Cuatro marcas de 

registro deben aparecer 

en las esquinas del 

cuadro delimitador. 

Click aqui para 

imprimir. 

Compruebe esta previsualización 

cuidado. 

¿Ves las cuatro marcas de registro? 

(flechas rojas señalan los 4 puntos 

reg) 

¿Va a conseguir lo que necesitas 

impreso?(Tenga en cuenta que la 

opción de carcasa se apagó para 

esta captura de pantalla para que la 

imagen más claramente se podía ver 

en este tutorial). 
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 Es posible que desee imprimir varias (4 o 5) copias desde que se quiere repetir este proceso varias veces 

con el fin de obtener sus ajustes de calibración perfecta. 

 Después de la impresión, colocar la impresión sobre la alfombra. A medida que se enfrentan a la Zing, la 

impresión debe estar en el tapete en una orientación vertical con la flecha apuntando hacia la tapa del 

extremo derecho: 

 

 

                                                             
 

 Vaya a la Sección 9.04 de continuar con los siguientes pasos! 

Portrait Mode Option/Opción modo vertical 
 

 Para comenzar, cree una nueva alfombra de encargo que se ha configurado para el tamaño carta o A4 o 

lo que sea el tamaño de la impresión será. Consulte la Sección 3.04 si necesita instrucciones para crear 

un tapete personalizado. Desactive la casilla Márgenes. Para el tamaño de letra, que el ancho 11 "y la 

Altura 8.5". Para A4, ajuste el ancho de 11.69 "y la altura de 8,27". 

 Puesto que usted está leyendo la sección Opción Modo Retrato del manual de usuario, establezca el Mat 

virtual de Retrato y seleccione su nueva estera personalizado 

  ¿Cuál es la mejor imagen que se utilizará para la calibración Desplazamiento láser? Una flecha es ideal, 

ya que será capaz de verificar rápidamente si usted tiene la impresión colocado correctamente en la base 

de corte. Además, es una gran forma de ver cómo ajustar su X y los números de calibración y. Usted puede 

utilizar casi cualquier imagen, pero para seguir el resto del tutorial con más facilidad, una flecha de la 

biblioteca Formas básicas es muy recomendable: 

 

 

Establezca el origen en la esquina 

inferior derecha de la copia 

impresa, utilizando el láser! 

Coloque su impresión 

sobre la base de corte 

en esta orientación. 

Alimente el tapete 

esta dirección en el 

Zing 

IMPORTANTE: la flecha al menos 6 "de ancho (como se muestra a continuación) para una calibración 

precisa. 
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 Observe que la flecha apunta hacia la derecha en la pantalla. Asegúrese de que su flecha también se apunta a la 
derecha! 

  A continuación, vaya a Archivo/ File > Configurar impresión/ Print Setup, seleccione la impresora que va a 
utilizar, y establecer la orientación a vertical/ Orientation to Portrait: 

                                                                  

 A continuación, vaya a Archivo/ File > Opciones de impresión/ Print Options y marque las siguientes casillas: 

 

                                                                                   

 

Seleccione 

Portrait 

Mat dimensiones deben 

coincidir con la impresión 

Importar una flecha y 

verifique que se enfrenta 

a la derecha 

Seleccione  Portrait 

Seleccione su impresora 

Click en OK 

Verifique tamano del papel 

Click en OK 

Marque esta opción si quiere un 

esquema única de la flecha 

impresa (para ahorrar en tinta!) 

Compruebe estas tres opciones 

Opción para cambiar el color del contorno de la 

imagen 

Se establece en 0 ya que 

esto no se aplica a los 

cortadores KNK. 
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 Después de hacer clic en Aceptar, debería ver las fronteras verdes en el tapete virtual, indicando cómo se 

colocará la copia impresa en el tatami y donde será impreso en la flecha. Si la flecha está fuera de las 

fronteras verdes, moverlo para que caiga dentro de los límites: 

                 

 Vaya a Archivo/ File > Vista preliminar / Print Preview y usted será capaz de ver la flecha más las cuatro marcas de 
registro que deben ser alineados con los límites de la flecha: 

                                            

Información sobre la configuración 

actual de la impresora se muestra 

aquí. 

Verde líneas discontinuas indican la 

parte de la pantalla que se va a 

imprimir. 

Cuatro marcas de 

registro deben aparecer 

en las esquinas del 

cuadro delimitador. 

Click aqui para 

imprimir. 

Compruebe esta 

previsualización cuidado. 

¿Ves las cuatro marcas de 

registro? (flechas rojas señalan 

los 4 puntos reg) 

¿Va a conseguir lo que 

necesitas impreso? 

(Tenga en cuenta que la opción 

de carcasa se apagó para esta 

captura de pantalla para que la 

imagen más claramente se 

podía ver en este tutorial). 
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 Asegúrese siempre de que pueda ver esas marcas de registro antes de continuar, ya que son una parte integral 
del proceso de PNC. Si su vista previa de impresión coincide con el de arriba y ves las cuatro marcas, haga clic en 
el botón Imprimir. Compruebe también que lo que se está impreso es lo que necesita. Por ejemplo, si se ha 
añadido una forma adicional a cortar, pero no desea que aparezcan en la copia impresa. Aquí es donde usted 
tendrá que usar las capas de entidades para controlar lo que se va a imprimir, así como lo que se cortará 
después. 

 Es posible que desee imprimir varias (4 o 5) copias desde que se quiere repetir este proceso varias veces con el 
fin de obtener sus ajustes de calibración perfecta. 

 Después de la impresión, colocar la impresión sobre la tabla de corte, con la misma orientación que se ve en la 
ventana principal e insertar el tapete en el Zing. A medida que se enfrentan a la Zing, la impresión debe estar en el 
tapete en una orientación vertical con la flecha apuntando hacia la tapa del extremo derecho: 

 

                                                               

 

9.04 PNC Procedure Part 2: Aligning and Calibrating /PNC Procedimiento Parte 2: Alineación y Calibración 

Aligning the Laser with the Registration Marks/ Alineación del láser con las marcas de registro 
 

 

 

 Haga clic en Cut Project With icono para ir a la ventana de corte. Si usted todavía no ha realizado un corte 

de prueba, hágalo ahora utilizando la configuración cuchillo Point/ Knife Point o WYSIWYG. Realice la 

prueba de corte en un lugar que no será parte de su corte final o utilizar un trozo del mismo material que 

se está cortando. 

• Después de que el corte de prueba tiene éxito, haga clic en la ventana de Blade Set Origen. Mueva la luz 

láser hasta que esté directamente sobre la esquina inferior derecha de la impresión, como se indicó 

anteriormente. Haga clic en Terminado para establecer el origen. 

• En Cut Type, seleccione Imprimir y cortar/ Print And Cut. También establecer su corte y hasta velocidades 

tanto de 11 (9 en Zing original). Con el fin de obtener resultados perfectos y repetibles de la PNC, es 

Establezca el origen en la esquina 

inferior derecha de la copia 

impresa, utilizando el láser! 

Coloque su impresión 

sobre la base de corte 

en esta orientación. 

Alimente el tapete 

esta dirección en el 

Zing 

IMPORTANTE: Set Up Cortar y envío a 11 (9 en 

Zing originales) 
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necesario asegurarse de que no está moviendo la base de corte demasiado rápido a través del cortador. 

Además, yo no uso la guía estera lado izquierdo durante la PNC de. Así aflojar ese puesto y deslice hacia la 

izquierda, fuera del camino. 

• Haga clic en Cortar Proyecto / Cut Project  y el láser debe moverse automáticamente a dentro de una 

distancia muy corta de la primera marca de registro. La siguiente ventana se abrirá: 

                                               

 

 

 

 

 Asegúrese de que el láser se ha movido dentro de una pulgada o menos de la marca de registro indicado 

por el parpadeo punto rojo se muestra arriba. Si no, usted querrá revisar los pasos que ha utilizado hasta 

el momento para asegurarse de que tiene todos los mismos valores que se muestran y tienes la impresión 

en el tapete en la misma orientación que se muestra anteriormente. 

 El siguiente paso es mover el punto láser de modo que es precisamente en la esquina de la marca de 

registro impreso. Esta ventana es muy similar a la ventana Blade Set Origin. Haga clic en las flechas en la 

pantalla o utilizar las teclas de flecha del teclado. Importante: una vez que esté cerca de la marca, 

disminuir el Movimiento Al establecer/ Move By a 4 para que usted tendrá un control preciso sobre la 

alineación. Una vez que el punto láser es muerto-en, haga clic en Siguiente/ Next o pulse la tecla Intro/ 

Enter. 

 

                                                                                         

 El láser se moverá a la proximidad de la siguiente marca de registro y la luz roja intermitente en el software se mueve 
al mismo punto relativo: 

 

 

 

Este punto se parpadea 

en rojo. Tenga en cuenta 

la orientación de esta 

pantalla con respecto a la 

impresión en la lona. Esta 

será la marca reg arriba a 

la derecha, según se mira 

el KNK porque su flecha 

debe apuntar hacia la 

derecha. 

Controles paso tamaño para cada movimiento, pulse 

la flecha 

Click en Next(o pulse la tecla 

Enter) después de haber 

movido el láser a la esquina 

de la marca reg 

Haga clic en las flechas 

para mover la luz láser (o 

utilice las flechas en el 

teclado) 

Mueva la luz láser al punto 

muerto del punto impreso. 

Usted se dará cuenta de que la intensidad de 

la luz láser cambiará cuando está en la parte 

superior de las líneas negras impresas. Esto 

puede ser muy útil! 
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 Repita el proceso con la nota final reg: 

 

                                                    

 

 Después de hacer clic terminado/ Finished,, la siguiente ventana se abrirá y  le recordara que esperar hasta que el 
corte se haya completado antes de regresar a la corte con ventana Klic-N-Kut Zing: 

 

 Una vez que se hace clic en Aceptar/ok, la forma de flecha será cortada. 

 

Adjusting the Laser Offset/Ajuste del láser Offset 

 Una vez finalizada la impresión y corte, examinar cómo se hicieron las líneas de corte con respecto a las líneas 
impresas. Si el desplazamiento es lo suficientemente grande, usar una regla para medir mm. Si el desplazamiento 
es muy pequeño, entonces sólo la estimación va a estar bien como a refinar su calibración. 

 En el siguiente diagrama, las líneas rojas representan las líneas de corte y las líneas negras representan las líneas 
impresas. Utilice este diagrama para determinar si los valores de offset tienen que subir o bajar de su láser: 

 

Este punto será ahora parpadea en 

rojo 

Una vez más, haga clic en 

estas flechas o las flechas del 

teclado hasta el punto láser 

está en la esquina marca reg. 

Una vez que la luz se 

centra en el punto marca 

reg, haga clic en Next o 

presione   Enter 

Este punto será 

ahora parpadea en 

rojo 

Una vez más, haga clic en estas 

flechas o las flechas del teclado 

hasta el punto láser está en la 

esquina marca reg. 

Una vez que la luz se centra 

en el punto marca reg, haga 

clic en Finished o  Enter  

Si la línea de corte roja 

está por debajo de la 

línea de impresión 

negro, a continuación, 

disminuir el valor de X. 

Si la línea de corte de 

color rojo que queda de 

la línea de impresión 

negro, a continuación, 

aumentar el valor de Y. 

(Nota: Y es un número 

negativo) 

Si la línea de corte rojo es 

derecho de la línea de 

impresión negro, a 

continuación, disminuir el 

valor de Y. (Nota: Y es un 

número negativo) 
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 Modificar la X e Y Offset valores de la ventana que se muestra al final de la Sección 9.02. Comience con 1 

ajustes mm (como se muestra arriba). Al introducir un número menor que 1, recuerde incluir un 0. Por 

ejemplo, no entrar "0.4". En cambio, entre "0,4". 

  Es una buena idea llevar un registro de los valores anteriores, de modo que usted sabrá qué dirección 

para cambiar de pruebas de calibración posteriores. Recuerde que usted debe esperar para obtener 

resultados perfectos, por lo que seguir ajustando los valores X e Y hasta que llegue allí. Después de ajustar 

por 1 mm, tendrá que ajustar en 0,5 mm e incluso más pequeño para hacerlo perfecto 

  Es posible que un lado está alineado, pero el otro no lo es. Por ejemplo, la línea de corte puede estar 

perfectamente alineado con la línea de impresión en la parte inferior de la flecha, pero tal vez 0,5 mm por 

encima de la flecha a lo largo de la parte superior. Ajuste de la calibración basado en el lado que está 

apagado. 

 Una vez que el PNC es perfecto, anote estos valores X e Y en caso de que comprar un nuevo ordenador o 

tienes que formatear el disco duro. 

 

 

 

9.05 Print and Cut Tips / Imprimir y consejos de corte 
 

 Cuando el rastreo de píxeles importada imágenes, las líneas de traza no necesariamente estar 

perfectamente alineados con la imagen. Esto puede resultar en pequeños trozos de blanco que aparece 

en ciertos puntos, lo que sugiere la PNC no era exacta. Zoom en estrecha en la imagen de modo que usted 

puede ver la línea de traza siguiendo el contorno de la imagen. Mira los mismos lugares donde la PNC no 

siguieron la imagen perfectamente. Esto podría ser la causa de la inexacta PNC. Hay tres maneras de 

hacer frente a esta situación: 

 Vuelve sobre la imagen importada, aumentando el ajuste Volver a mostrar/ Resample. Esto 

dará lugar a un mayor ajuste de la línea de rastreo en el gráfico original. 

Si la línea de corte roja 

está por encima de la 

línea de impresión negro, 

a continuación, aumentar 

el valor de X. 

La línea roja es más baja 

que la línea negro: el 

cambio X 0,3--0,7 (nota: 

añadir signo negativo) 

La línea roja es más alta 

que la línea negro: el 

cambio X 0,3-1,3 

La línea roja se deja de línea 

de negro: el cambio Y desde -

24,0 a  -23,0 (Un aumento a 

un numero negativo). 

 

La línea roja es la derecha de 1 

mm de la línea de negro: el 

cambio de Y  -24,0--25,0 (Una 

disminución de un número 

negativo). 

IMPORTANTE: Cuando esté listo para probar este proceso en una imagen de trama real, no se olvide 

de apagar el Wireframe opción bajo File>Print Options. 
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  Uso Nodo Edición/ Node Editing y Segmento de edición/ Segment Editing para mover las líneas 

de traza para ajustarse más a la gráfica original. Esto se explica en detalle en la última parte 

de la Sección 7.13. 

 Crear una línea de inserción de usar para el corte en lugar de la línea de trazo inicial. Esto se 

presenta en la Sección 9.06 - PNC con una línea de corte de la inserción. 

 

 

 Si un PNC no es preciso y la causa no es la alineación de las líneas de traza, a continuación, intente reducir 

la velocidad aún más. Si la estera se está moviendo en numerosas ocasiones, dentro y fuera de la cuchilla, 

puede ocurrir un ligero desplazamiento, especialmente a altas velocidades. Pruebe a reducir las 

velocidades de corte y Up/ Cut y  Up Speeds. 

 Recuerde que la calibración del láser Offset es específica para el tipo de soporte de la hoja que se 

utiliza. Por lo tanto, si cambia marcas, será necesario modificar la calibración láser. 

 Si su flecha de prueba es de corte perfecto, lo que indica que tiene la calibración correcta, pero su 

próxima impresión y corte está muy lejos, entonces tal vez su situación es algo fuera de lo común. Por 

favor revise la siguiente sección que abarca diferentes escenarios en los que se requieren algunos pasos 

adicionales al configurar las capas para su impresión y corte. 

 No es necesario para establecer el origen o incluso poner la copia impresa en la estera antes de comenzar 

el procedimiento de PNC. Vea este vídeo de una manera de hacer el proceso un poco más rápido! 

 

 

 

 

9.06 Print and Cut Scenarios/ Imprimir y Cortar  Escenarios  

 

9.06.1 Cutting Multiple PNC Images on the Same Page/Corte de varias imágenes de la PNC en la misma 

página 

 

 Al realizar una PNC en múltiples imágenes (si son todos la misma imagen o diferentes imágenes), el 

procedimiento es el mismo. Un conjunto de cuatro marcas de registro será impreso a lo largo de los 

bordes exteriores de la zona de delimitación de todas las imágenes de la página 

https://vimeo.com/42564839
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9.06.2 PNC With a Contour Shape Larger Than the Printed Image/ PNC con una forma de contorno más 

grande que la imagen impresa 

 
 

 En la Sección 9.01, se muestran otras dos aplicaciones de la PNC. En un caso, se cortará un contorno exterior. En el 

otro, se añade una forma alternativa, tal como la forma tag se muestra a continuación. 

      

 

Adding a Contour/Adición de un contorno 

 Desea agregar un corte de contorno y retire la línea de corte en la vaca, que se creó durante la traza de píxeles, por 

lo que la única corte de línea será el contorno. Hacer esto: 

o  Seleccione la forma y el uso de la función de Sombra/ Shadow Function para añadir un contorno alrededor 

de la imagen. Consulte la Sección 8.05 para obtener instrucciones sobre cómo utilizar esta función. 

o Asegúrese de que la imagen de trama (la vaca, en este ejemplo) está en una capa superior a la sombra a 

cortar. 

Multi-imagen  PNC 

horizontal /Landscape Multi-imagen en  PNC 

Vertical/ Portrait  

Contorno  se añade en  

el uso de Shadow Layer 
Se añade de forma Tag 

https://vimeo.com/43821153
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o Seleccione tanto la imagen de la vaca y de la sombra y aplicar la función de soldadura/ Weld de la barra de 

herramientas de la Magia/ Magic Toolbar. La línea de corte interno desaparece dejando la imagen de trama 

original, ahora llenando la Capa de las Sombras/ Shadow Layer: 

 
 

 El proceso de corte procede como se describe en la Sección 9.04. 

 

Adding a Shape Around the Image/Cómo añadir una figura alrededor de la imagen. 
 

 En el otro caso, con la forma de etiquetas añadido alrededor de la imagen trazado original, el mismo proceso se 

puede utilizar siempre que la forma exterior será blanco. Sin embargo, si se prefiere un fondo de color, entonces el 

proceso es un poco diferente: 

o Color de la etiqueta, según se desee. En este caso, la etiqueta es de color rosa 

                                                 
 Organizar la vaca dentro de la forma, asegurándose de que la vaca es visible. A continuación, seleccione 

los dos y aplicar la función de la textura de instantáneas/ Texture Snapshot de la Barra de herramientas de 
la Magia/ Magic Toolbar. Esto hace que la parte de imagen de la vaca de la textura de relleno sobre la 
etiqueta: 

 

                                                  
 
 El proceso de corte procede como se describe en la Sección 9.04. 

 

 

Imagen contorneada con 

una sola línea de corte 

exterior. 

A partir de las líneas de 

límite se puede ver que hay 

dos formas: la imagen de la 

vaca etiqueta rosa y. La 

forma de vaca se 

desconectará si no se 

oculta. 

Despues de aplicar Texture 

Snapshot, sólo hay una 

forma: la etiqueta con un 

relleno de color rosa, 

además de la imagen de la 

vaca. La forma de vaca no se 

corte. 
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9.06.3 PNC With a Contour Shape Smaller Than the Printed Image/PNC con una forma de contorno más pequeña 

que la imagen impresa 

 
 En esta situación, una forma va a ser cortado que es menor que los límites externos del gráfico importado. Por 

ejemplo, digamos que un borde festoneado se desea que la línea de corte: 

                        
     

 

 Debido a que no se necesita nada fuera de la vieira, esa parte será eliminado. Esto se hace por primera 

organización de la vieira sobre la imagen, y luego mover la capa de vieira a su propia capa y al fondo de 

las capas Bar/ Layers Bar: 

                                                      

                                                    

Una vieira interior se va a agregar y cortar. Imagen importada original 

Vieira se mueve a la 

capa inferior por lo 

que está detrás de la 

imagen original. 

Se añade y se alinea 

Una forma de vieira, 

si lo deseas. 

https://vimeo.com/79411594
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 A continuación, carpa-seleccionar tanto la imagen original y la vieira (o use Ctrl + A para seleccionar todo/ Ctrl+A 
to Select All) y después aplicar la función Únete a la barra de herramientas Magia/ Magic Toolbar. La vieira 
aparecerá ahora en la parte superior: 

 

 Aplique inmediatamente la función de la rotura/ Break de la barra de herramientas de la Magia/ Magic Toolbar. La 
imagen original aparece ahora, pero con la forma de vieira a su alrededor 

 

 Haga clic en otra parte de la pantalla para que no hay nada seleccionado. Luego haga clic en la imagen y arrastre 
una imagen de distancia de la otra: 

                                       

 El original ahora se puede eliminar y la versión festoneado duplicado (si se desea) y el proceso de la PNC a cabo, 
de manera normal. 

 

 

 

Esta original ahora se 

puede eliminar. 
Nueva versión 

festoneado   
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9.06.4 PNC with a Contour Shape Overlapping the Printed Image/ PNC con una forma del contorno 

Superposición de la imagen impresa 

    

 Esta situación es similar a la anterior, sin embargo, en este caso la vieira se superpone a los bordes de la imagen 
impresa de una manera tal que es más pequeña en una dirección pero más grande en el otro: 

                      

 

 

 En este caso, el mismo de Ingreso/ Join y el método de rotura / Break se aplica como se muestra en el ejemplo 
anterior. Asegúrese de que la forma del corazón es de color como usted desea y está en la capa inferior. Después 
de la aplicación de las dos funciones, arrastre una forma lejos de la otra: 

  

 

 

 Una vista preliminar muestra que sólo el gráfico original se imprimirá. Observe cómo las marcas de registro se 
imprime en función de la gran rectángulo blanco: 

Se va a agregar y corte original importado de 

imagen de forma de un corazón. 

Imagen importada original 

Imagen importada original puede 

ser desechada o escondido 
Forma ya está lista para PNC 

https://vimeo.com/43821152
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 Después de la impresión, continúe con el proceso habitual. 

 

9.06.5 PNC with an Inset Cut Line/ PNC con una línea de corte de la inserción 

 

 Esta situación puede parecer ser idéntica a la presentada en 9.06.3. La diferencia es que la línea de traza original no 
se elimina porque no es deseable eliminar partes de la imagen original. Al utilizar el siguiente método, se introduce 
una asignación. 

 Una traza de píxeles a menudo puede tener áreas donde la línea trace (línea de corte) será fuera de la imagen 
original. Esto es especialmente cierto de las esquinas interiores estrechos o giros bruscos en la imagen. Esto 
se traduce en áreas blancas que aparecen alrededor de la impresión y corte: 
 

                                                     

 Al final de la Sección 7.13, se muestra cómo utilizar la edición de nodo y segmento de corregir la línea de la traza, 
que mejor se ajusta a la imagen original. A veces, sin embargo, puede haber una edición más necesaria que sería 
práctico hacerlo. En estos casos, una línea de corte de inserción puede ser creado. Si bien el mismo método 
presentado en la Sección 9.06.3 podría ser utilizado, en este caso se desea tener lo que se llama una asignación 
de purga (un margen de error para el corte) al permitir que la imagen más grande original aún se imprimirá. 

 Seleccione la imagen trazada y acceder a la función de la capa de la sombra/ Shadow Layer en cualquiera de las 
siguientes maneras: 

 Haga clic en el icono de capa Sombra/ Shadow Layer en la barra de herramientas de Magia/ Magic 

Toolbar   

 Presione Ctrl + H 

Las flechas rojas indican puntos alrededor 

de la oreja izquierda de nuestra vaca en 

áreas blancas se muestran cuando se 

corta. La línea de trazo original no encaja 

en la imagen en esos puntos.  

https://vimeo.com/59272932
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 Haga clic derecho en la pantalla y seleccione Forma Magia> Capa de las Sombras/ Shape 
Magic>Shadow Layer 

 Vaya a Editar> Forma Magia> Sombra de capa./ Edit>Shape Magic>Shadow Layer. 

 Seleccione la Sombra Ancho/ Shadow Width deseado con un número negativo para que se cree un recuadro. Tenga 
en cuenta que este es típicamente menos de 0,03 ". Seleccione una opción Corner Únete y se refiere de nuevo a la 
Sección 8.05 de referencia. Haga clic en Aceptar cuando haya terminado. 

     

 

  

 Por lo general estas líneas inserción están muy cerca de las líneas de trazas originales y cortar ambas líneas podrían 
conducir a la reducción de cuestiones, como desgarro o finas rodajas de papel que se han desprendido. Por esa 
razón, tendrá que apagar las líneas de trazas originales para que no se cortan. Sin embargo, las marcas de registro 
están ligadas a estas líneas de trazas originales, ya que son más grandes que las nuevas líneas de inserción. Si 
simplemente apaga la capa impresa original cuando se inicia el proceso de la PNC de impresión y corte no funcionará 
correctamente. Pero, hay una manera fácil de hacer este trabajo. 

  Mueva la nueva capa de la línea de corte de inserción a la parte inferior de la barra de capas de modo que está 
detrás de la imagen importada originales. 

 Agregue un gran rectángulo blanco con el proyecto. Si la página se llenará con varios objetos entonces el rectángulo 
debe rodear todas las imágenes. Si sólo hay una imagen, entonces el rectángulo puede ser dimensionado para 
adaptarse a esa imagen. Coloque en su propia capa y pasar a la parte inferior: 

 

Nótese cómo la nueva línea de inserción 

será claramente cortar dentro de la imagen 

impresa de manera que no aparecerán áreas 

blancas alrededor del recorte. 

Seleccione  tipo de  Corner Join   

Set deseado Shadow Width utilizando un número 

negativo de modo que se crea una sombra de inserción. 

   Click en  Accept  
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If there are multiple images: 

                                               

 

 La capa del rectángulo debe estar activada para la impresión y el corte. Debido a que la capa de sombra inserción 
se oculta detrás de las imágenes originales, también se puede dejar en para imprimir. Sin embargo, cuando usted 
está listo para cortar, la imagen original debe estar oculto para que sólo el rectángulo y la capa de la línea de corte 
de inserción se envían a cortar. 

  

    
 
 

 
9.07 Print and Cut without Printing from MTC/ Imprima y corte sin Impresión desde MTC 

Las siguientes secciones cubren situaciones de la PNC en el que no habrá impresión realizada desde el interior de la 
MTC. 

 

9.07.1 Printing from another Program/ Impresión desde otro programa 

 A veces los usuarios prefieren diseñar e imprimir desde un programa informático diferente. En esta situación, el 
mejor curso de acción es agregar un rectángulo que completa encierra las imágenes que se van a imprimir y luego 
cortan de MTC. Las cosas importantes a tener en cuenta son: 

One rectangle is placed 

around the original 

image and its inset.  

Un rectángulo se 

coloca alrededor de 

todas las imágenes y 

sus inserciones. 

Original image should be 

top layer 

Imágenes originales deben ser de 

primera capa 

Inset shadow 

sombras inserción 

Surrounding white 

rectangle 

rectángulo 

Todas las capas se dejan en la impresión 

(aunque capa de sombra es opcional) 

Apague capa de la imagen original para proceso de PNC. 

Asegúrese de sombra (línea de corte recuadro) capa se 

muestra, así como la capa del rectángulo 

Esconde

r 
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o  El tamaño del rectángulo que se añade debe ser de un tamaño específico y señalado de modo que 
un rectángulo idéntico se puede añadir en MTC. Las fronteras de este rectángulo definirán las 
ubicaciones de las marcas de registro para el proceso de la PNC. 

o Si un programa de vectores (por ejemplo, Adobe lIlustrator, Corel Draw, Inkscape) se utiliza y la forma 
(s) de corte es / son definidos en este programa, a continuación, exportar tanto el rectángulo y la 
forma (s) de corte. MTC puede importar .eps, .ai, .pdf y otros formatos. Consulte el Capítulo 4 para 
obtener más información acerca de la importación y exportación. También, al importar el archivo, 
cambiar el tamaño de todo junto para que el rectángulo exterior coincide con el tamaño exacto que 
utilizó al crearla. 

o Si se utiliza un programa de trama (por ejemplo, elementos, Word, Paint), entonces usted tendrá que 
escanear su impresión y luego usar la opción de seguimiento de píxeles en la MTC para importar la 
imagen de modo que la forma (s) de corte se puede agregar a la archivo. En este caso, crear un 
rectángulo exterior para coincidir con el escaneado, tanto en tamaño y ubicación. Esto es importante 
porque el escáner puede haber escaneado en un tamaño ligeramente diferente y los resultados serán 
más precisos cuando se emparejan las dimensiones del rectángulo con lo que el escáner lee. 

 

9.07.2PNC Applications with Existing Image/ Aplicaciones de la PNC con imágenes existentes 

  

 Con MTC, incluso es posible hacer una impresión y corte sin impresión involucrados en absoluto! Dos de estas 
situaciones son: (1) cortar formas que se han elaborado o estampadas a mano y (2) Recorte de las imágenes 
impresas de una revista, calendario, periódico, etc. 

 Al igual que en la sección anterior sobre Impresión desde otro programa, lo único que se necesita es un rectángulo 
que está impreso o dibujado en la página que incluye las imágenes que desea cortar. Ese rectángulo podría estar 
impreso en hojas de papel o cartulina de usar para estampar o dibujar imágenes o puede ser impreso en el papel 
/ cartón después de que las imágenes se estampan o dibujado o incluso uno podría utilizar un objeto rectangular 
en mano dibujar las fronteras del rectángulo. Lo importante es que las esquinas sean ángulos rectos precisos. 

 Una vez que tenga el rectángulo en la página, escanear la imagen en MTC y Pixel Trace. A continuación, gire las 
formas, según sea necesario, para que las líneas del rectángulo están perfectamente alineados con la red en el 
tapete virtual. En otras palabras, asegúrese de que las líneas horizontales del rectángulo son perfectamente 
horizontal y las líneas verticales del rectángulo son perfectamente vertical. 

 Llevar a cabo el proceso de la PNC como de costumbre. Las esquinas del rectángulo sirven como las marcas de 
registro 

 

 

 

 

 

https://vimeo.com/42691635
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10. Applications/Aplicaciones  
 

10.01 Cardstock and Paper / Cartulina y Papel 

 

Selecting Cardstock/Cartulina Selección 
 

 Blanco de papel de tarjetas básico no produce la misma calidad de corte como cartulinas núcleo de color sólido. 

 Algunas marcas de cartulina o tipos simplemente no cortan bien. Utilice los algo más, aparte de cortar formas 

complejas. Otros cartulina, como Bazzill batidos, Worldwin Cutmates, Colormates y Recuerdos de Michael, cortó 

maravillosamente. 

 Si una textura recortes de cartulina mal, trate de darle la vuelta y colocando la cara lateral de textura abajo. 

Recuerde que debe reflejar las formas antes de cortar, según sea necesario (por ejemplo, texto). 

 Si el cartón ha sido expuesto a la humedad, a continuación, secar la cartulina por cerca de 15 - 30 minutos en un 

horno que ha estado precalentado a ~ 100 - 150 F, pero luego se apaga antes de colocar la cartulina dentro. 

 Con cada marca de papel de tarjetas, registrar los ajustes que funcionaron bien para que la próxima vez, tendrás 

un buen punto de partida para su corte de prueba. 

 

Settings/Ajustes 

 Recuerde establecer su exposición cuchilla para cortar solamente a través del material. Para papel fino, se 

necesitará más que la punta más pequeña de la hoja. Para cartulina gruesa, use un poco más de la hoja, pero no 

tanto como usted puede pensar. Vuelve a la Sección 2.01 de recordatorios en tanto el ajuste de la longitud de la 

cuchilla y la altura de la hoja. 

  Hay fuerzas que se muestran en los Ajustes sugeridos para la mesa Varios Materiales cerca del final del capítulo 

2. Utilice estos como guías para sus cortes de prueba y ajuste recomendado, según sea necesario. Recuerde que 

debe registrar sus propios éxitos 

 Una velocidad de 15 (10 en el Zing originales) debería funcionar bien para la mayoría de corte de papel y 

cartulina. Sin embargo, se recomienda disminuir la velocidad de corte hacia abajo si se siente el ajuste 

recomendado es demasiado rápida. 

 Para la mayoría de papel y cartulina, utilice la hoja tapado rojo. Para cartulina muy gruesa o con mucha textura, 

es posible que desee utilizar la hoja tapado azul. 

  La fuerza de corte variará dependiendo de la densidad del papel o cartulina, cualquier exposición a la humedad, 

falta de brillo de la hoja, e incluso el tinte usado para colorear el material! Dos pases a menudo pueden ser 

necesarios con un poco de cartulina, independientemente de la fuerza de corte disponible. 

  Mantenga la base de corte limpio y pegajosa. Brayering cartulina a la lona asegurará firme y uniforme 

adherencia. Brayering nuevo después de la corte puede ayudar en el deshierbe de los residuos de las formas 

cortadas. 

 

 

http://www.youtube.com/watch?v=Jzl7Uu2zGN8
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Troubleshooting /Solución de problemas 

 La siguiente lista presenta las diversas causas de la rotura. 

  El exceso de cuchilla está expuesto. Si usted ve que la hoja está recortando en su estera, acortar la 

exposición de la cuchilla. Sólo debe estar cortando a través del material en sí y luego, tal vez, poner 

el mat con adhesivo.. 

 La  cuchilla esta quebrada. Pruebe una cuchilla  diferente. 

  El papel no se adhiere bien al mat. Asegúrese de que la alfombra es limpia, pegajoso, y el 

documento se presiona suave y uniformemente en la superficie. 

 Puede que esté utilizando demasiada fuerza de corte. Pruebe a reducir y hacer cortes de prueba. 

 Es posible que tenga demasiados nodos en la forma. Consulte la Sección 7.02 

  Si la cartulina ha estado expuesto a la humedad, a continuación, la humedad en el material puede 

hacer que sea difícil para cortar limpiamente. Trate de secar la cartulina. 

 El material en sí puede estar sujeto a la rotura, especialmente en cortes intrincados. Pruebe con un 

papel de tarjetas diferente. 

 

 Si el papel de tarjetas tiene manchas que no se cortan por completo: 

 

 Intente aumentar la altura de punta de pala (no exposición) y / o la fuerza de corte y verificar la 

cartulina se va a adherir a la lona. Además, algunas marcas cartulina requieren dos pasadas, por lo 

que reducen la fuerza de corte y establecer Multi-Cut 2 pases. 

 

  Para "salvar el corte", dar la vuelta a toda la sábana, y el uso de papel de lija para lijar los puntos 

donde los cortes no se completó. Usted debe ser capaz de arena hasta donde la hoja se corta en 

esos lugares y su diseño será entonces liberado de los residuos. Esta es la mejor manera de 

mantener los bordes exteriores lisas. 

 Mis formas no son muy recortadas. La mayor parte de ellos todavía están unidos a los residuos en un solo lugar: 

 Es probable que tenga la hoja Offset apagado o ajustado demasiado bajo. Asegúrese de que el 

ajuste coincida con lo que se necesita para la hoja que está utilizando. Consulte la Sección 2.06. 

 

 

10.02 Chipboard/Aglomerado 
 

Demostración:            Cutting 0.02 "aglomerado blanco:       

Cortar 0.03" tableros de partículas:  

 

 

 

http://www.youtube.com/watch?v=gtS52GRddv0
http://www.youtube.com/watch?v=gtS52GRddv0
http://www.youtube.com/watch?v=gtS52GRddv0
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Selecting Chipboard/Selección de aglomerado 
 

 Hay muchos tipos de materiales que se consideran aglomerado. Algunos pueden ser cortados por el KNK Zing y 

otros no pueden. Las mejores directrices son: 

o  Si el aglomerado es más gruesa que la longitud máxima de hoja, entonces no puede ser cortado. 

o Si el aglomerado es muy rígido y no es fácil ser doblado, entonces probablemente no se puede 

cortar. 

o Aglomerado fino y flexible es la mejor opción. Vale la pena la búsqueda de una determinada marca 

de tableros de partículas, tales como el vendido en KNK EE.UU., para utilizar en tus proyectos para 

que usted sabrá que las cuchillas y los ajustes funcionan mejor cada vez. 

o  Para una mirada más gruesa, considere cortar dos copias de la misma forma de aglomerado más 

delgado y adherirse juntos, especialmente si el diseño es un poco complicado. 

o Al igual que con algunas marcas de textura de papel de tarjetas, algunos tipos de aglomerado 

producirán cortes limpios en la parte inferior. Por lo tanto, reflejar sus imágenes primero después de 

verificar de modo que usted puede utilizar el otro lado de la forma de corte. 

 

Settings /Ajustes 
 

 Al igual que con todos los materiales, ajuste la longitud de la hoja a ser sólo una fracción mayor que el espesor de 

la madera aglomerada y utilizar los materiales gruesos, azul hoja tapado. Para aglomerado delgada puede utilizar 

la hoja tapado rojo. Ajuste la compensación en consecuencia hoja. 

 Aglomerado puede fácilmente soltado de la colchoneta. Trate de usar cinta adhesiva o cinta de pintor azul 

alrededor de los bordes exteriores de la madera aglomerada para evitar que el aglomerado se deslice durante el 

corte. También puede aplicar un estabilizador tal como papel para congelar o Heat n 'Bond para mejorar en gran 

medida tanto la consistencia de corte, así como la complejidad de lo que se puede cortar limpiamente. 

 Algunos aglomerados suaves delgadas, como caja de cereales, pueden cortar con un ajuste de 110, por lo tanto 

tratar este ajuste para su corte de prueba. Aumenta en incrementos de 10, según sea necesario. Para más densas, 

aglomerados más gruesos, es probable que tenga que aumentar la presión bastante alta y utilizar varias pasadas. 

Establecer Multi cortó a dos, tres, o incluso más pases, según sea necesario. Utilice una de las opciones de corte de 

prueba o una de sus propias formas pequeñas, para asegurarse de que un corte limpio se puede lograr antes de 

intentar cortar su forma más grande o más formas. 

 El Zing ofrece algunas velocidades muy lentas y cortar madera aglomerada puede requerir estos. No dudes en 

reducir la velocidad de un ajuste de 8 o más lento, si usted encuentra el cortador está luchando para cortar la 

madera aglomerada o las formas de ser de corte están distorsionados. 

 Al cortar materiales más gruesos, el soporte de la hoja debe ser planteado en el asiento del soporte de la cuchilla 

para mejorar la fuerza hacia abajo. Para hacer esto, pruebe a utilizar una pila de 13 Publicar Toma nota, como se 

describe en la Sección 2.01. 

Troubleshooting/Solución de problemas 
 

 Algunos aglomerado producirá una gran cantidad de "migajas" durante el corte y esto puede acumularse dentro 

del soporte de la hoja, así como construir en torno a las líneas de corte que causan interferencia con la cuchilla 

durante la segunda pasada. Por esta razón, algunos usuarios se utilice aire comprimido para soplar las migajas de 
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distancia de la superficie entre cada pasada. También puede ser necesario para limpiar el interior del soporte de la 

hoja mediante la eliminación de la hoja y de tomarlo aparte, de modo que los trozos pequeños se pueden quitar. 

 Si el corte de prueba era perfecto, pero las formas no logró cortar limpiamente, la estera puede no haber sido lo 

suficientemente pegajosa para mantener el aglomerado en todo el corte. En lugar de añadir más adhesivo, es 

posible que desee utilizar un estabilizador como se describe en Selección de aglomerado. Proveedores frenar la 

corte que las formas eran bastante detallado y las secciones sin cortar estaban en curvas cerradas. 

 Si no se oye un sonido tartamudez durante el corte y / o las formas se distorsionan, y luego reducir la velocidad y 

la fuerza y aumentar el número de pasadas. La hoja está alcanzando en el aglomerado causando la colchoneta a 

deslizarse. Usted necesita hacer las cosas más fáciles en el cortador cuando la hoja se abre camino a través del 

conglomerado denso. 

 

 

 

 

10.03 Vinyl/ Vinilo 

                                

 

Types of Vinyl/Tipos de Vinilo 
 

 Hay un número de diferentes tipos de vinilo disponibles en KNK EE.UU. 

o Decal/Sign vinyl /Tatuajes de vinilo / sesión que puede ser utilizado para hacer pegatinas para 

ventanas, vasos, proyectos de grabado, etc. 

o Wall vinyl/  pared de vinilo que se puede retirar sin daños a las paredes interiores. Tiene un hermoso 

acabado mate y también se puede aplicar a los azulejos, cargadores, e incluso tarjetas de 

felicitación. 

o Outdoor Vinyl vinilo al aire libre que tiene una duración prolongada al aire libre (3-5 años). También 

hay un 5.8 años variedad de alto rendimiento. 

o Metallic Vinyl/ metálico de vinilo que tiene un adhesivo permanente y es adecuado para el uso al 

aire libre o para la decoración del partido, tarjetas de felicitación, ordenador portátil cubre, etc. 

o Accupro Wrap Vinyl/Accupro vinilo del abrigo para envolver los teléfonos celulares, computadoras 

portátiles, ordenadores portátiles, etc. 

o Iron-on Vinyl/ Hierro-en vinilo para la decoración de prendas u otras superficies como cartulina. 

Consulte la Sección 10.05 para más detalles sobre el corte y la aplicación. 

 

Settings/Ajustes 
 

 Vinilo tiene una hoja de soporte que puede servir como vehículo / estera durante el corte. Si desea cortar el vinilo 

sin utilizar una base de corte, el vinilo tiene que ser de al menos 4 "de ancho por lo que ambas partes serán 

agarrados por las dos ruedas de presión más a la derecha. (Para los modelos Zing mayores, el vinilo tiene que ser 

por lo menos 13 "de ancho.) Si está cortando de vinilo que es más estrecha que este o el corte de los desechos, a 

http://knkusa.com/shop/decal-vinyl-glossy/
http://knkusa.com/shop/wall-vinyl-matte/
http://knkusa.com/shop/decal-vinyl-glossy-copy/
http://knkusa.com/shop/gemstone-vinyl/
http://knkusa.com/shop/accupro-wrap-vinyl/
http://knkusa.com/shop/category/iron-on-fabric-material/
http://www.youtube.com/watch?v=Ss1ZdyFHHpk
http://www.youtube.com/watch?v=Ss1ZdyFHHpk
http://www.youtube.com/watch?v=Ss1ZdyFHHpk
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Vinyl_Multi-Color_Designs_LynnK.pdf
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continuación, utilizar una base de corte para mantener el vinilo durante el corte. Alternativamente, usted puede 

grabar el vinilo a un medio más amplio, como el papel de contacto, y que puede servir como un portador en el 

Zing. 

  En cortes largos, es importante contar con el vinilo alineado directamente en la máquina. Cortar la longitud 

necesaria del rollo de vinilo (añadiendo unas pulgadas para tolerancia de error). Pase el vinilo a mitad de camino 

a través de la cuchilla y luego dejar caer las ruedas de presión. Utilice las flechas arriba y abajo en la ventana de 

Blade Set Origen para alimentar el vinilo dentro y fuera de la Zing, para asegurarse de que el vinilo se mantiene 

alineado. 

 Establecer el origen al menos 1/2 "de distancia del lado derecho y un poco retirado de la parte inferior. 

 Si bien existen muchos tipos y espesores de vinilo, en general, es muy fácil de cortar. Por lo tanto, comenzar con 

una estimación conservadora para el ajuste en el corte de prueba inicial de la fuerza, decir la cuchilla 5. Utilice la 

tapa roja y comenzar con apenas ninguna hoja expuesta. Haga un corte de prueba y luego levante suavemente la 

esquina del vinilo de la hoja de soporte. Asegúrese de que el corte de prueba es un corte limpio y la hoja no 

penetró el papel de soporte. 

 Vinilo normalmente se puede cortar a una velocidad de 15 (10 en el Zing original), a no ser muy pequeñas formas, 

complejos están involucrados. Entonces es posible que desee utilizar una velocidad de corte más baja. 

 Si almacena su vinilo en un lugar cálido, el adhesivo puede verse afectada y que a continuación, puede afectar a 

la corte. También tenga en cuenta que algunos colores de vinilo tienen una tendencia a alejarse de la hoja de 

soporte con mayor facilidad que otros. Si se observa el vinilo tirando hacia arriba en esquinas y lugares estrechos, 

intente frenar la velocidad de corte. 

 

 

 

 

Applying Vinyl/La aplicación de vinilo 
 

 

 Para facilitar su retiro de los residuos desde el respaldo, agregue un rectángulo alrededor del perímetro de la forma 

(s) que se está cortando. Seleccionar todo y aplicar un Ingreso. Esto luego asegurar que las formas interiores se 

cortan primero, con cortar última rectángulo exterior. 

 Cuando la escarda, puede que tenga que cortar y eliminar partes de desecho más pequeños en comparación con 

tratar de levantar la sección de residuos de todo a la vez. Usted no quiere que el vinilo de residuos sin querer entrar 

en contacto con las formas que desea conservar. Utilice un cuchillo o perforador de papel para levantar suavemente 

piezas de vinilo de residuos para desechar. 

 Si usted está solicitando letras pequeñas o haciendo una aplicación de grabado, NO eliminar el vinilo residuos. Toda 

la pieza se debe aplicar a la superficie del proyecto, se alisó firme y uniformemente, y luego desmalezado. La 

adhesión entre el vinilo y la superficie dura hará escarda mucho más fácil, con menos probabilidad de pequeñas 

formas que se afloje. 

 Para transferir el vinilo a una pared (o ventana u otra superficie), aplicar cinta de transferencia a través de la vinilo, 

repitiendo filas de cinta para cubrir completamente las formas. En la parte superior, tienen una capa de cinta con 

sólo la mitad inferior que cubre el vinilo de manera que la mitad superior se puede presionar a la pared y se utiliza 

como una bisagra. Una vez que tenga el vinilo alineado lo deseas, dar la vuelta, dejando que la pieza superior de la 
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cinta adherida / articulada a la pared. Retire la hoja de soporte del vinilo. A continuación, llevar con cuidado el vinilo 

hacia abajo y comenzar a presionar a la pared, sin problemas y de manera uniforme. Utilice una tarjeta de crédito 

de edad o espátula de plástico para suavizar las arrugas y obtener una mejor adherencia. Que despegar la cinta de 

transferencia de la parte superior y pulse de nuevo con la tarjeta de crédito o un raspador. 

 

 

 

10.04 Fabric and Felt/  Tela y fieltro 

 

                     

 

 Es altamente recomendamos que la Espada Zing Tela utilizarse cuando se corta la tela y fieltro. Está diseñado para 

dar más nítida de corte en las esquinas y puntos apretados. 

 Al cortar con la hoja de la tela, no es necesario aplicar un estabilizador para todas las telas. Si bien algunas telas 

más gruesas cortarán mucho mejor con un hierro en estabilizador tal como vapor-a-Seam 2 o Heat n de Thermo-

Web 'Bond, otros seguirán dar buenos resultados cuando se corta sin ella. Algunos usuarios también prefieren para 

limar sus telas al congelador de papel antes de cortar. 

 Con o sin un estabilizador, se recomienda que se utilice una estera limpia y pegajosa. Si se ha aplicado ningún 

estabilizador, entonces Brayer la tela con firmeza y de manera uniforme a la lona. Con la mayoría de los tejidos 

será necesario el uso de esteras pegajosos de lo normal y la cinta de los bordes exteriores de la tela. 

 Debido a que las hojas de respaldo en Steam-a-Seam 2 y n del calor Bond son resbaladizas, rociándolas con Odif 

EE.UU. 505 adhesivo temporal puede entonces hacer que se peguen firmemente a la lona y no resbalen durante el 

corte. Algunos residuos de la 505 puede conseguir sobre el tapete, por lo tanto la razón de utilizar una estera 

dedicado para tela. Este residuo se sumará a la unión para futuros recortes. (Gracias a Lynn Keniston para esta 

idea!) 

 Algunos usuarios también prefieren quitar las hojas de respaldo en tejidos estabilizados antes brayering a las 

esteras de corte. Esto funciona así. 

 El mejor sin rigidizar (suave) consideró a utilizar es 100% lana. Se corta más limpio que otros tipos. Una mezcla de 

lana también debería funcionar bien. El Nonwovens woolfelt es 35% lana, 65% Dacron y tiende a cortar muy 

limpiamente. Si el fieltro que tiene no es así enfriamiento, así, considerar la aplicación de uno de los estabilizadores 

mencionados anteriormente. 

  Si se pre-se tensó el fieltro, entonces debería cortar bien utilizando los azules cubiertas de materiales gruesos 

cuchilla contra la hoja de la tela. Debido al grosor, es posible que necesite para grabar el fieltro a la lona para evitar 

el deslizamiento durante el corte. 

 En general, usted tendrá que usar 2 o 3 pases al cortar la mayoría de las telas y fieltros. Es necesario para que todas 

las fibras serán cortadas limpiamente. 

 Para la fuerza de corte, que dependerá de la tela. Consulte la tabla al final del capítulo 2 para los ajustes 

recomendados. 

 

http://www.youtube.com/watch?v=A3vA1cj8L2I
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Fabric_Cutting_With_KNK_LynnK.pdf
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Felt_Cutting_With_KNK_LynnK.pdf
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10.05 Iron-On Transfer / Transferencia térmica 

        

Types of Iron-On Transfer/Tipos de Transferencia térmica 
 

 Hay un número de diferentes tipos de vinilo disponibles en KNK EE.UU.: 

 Regular Iron-On Transfer (T-Shirt Vinyl)/Regular Transferencia térmica (T-Shirt Vinilo) 

 Iron-On Flock/Hierro-En Flock 

 Glitter Flex/Glitter Flex y  Glitter Flex Ultra/ Glitter Flex Ultra 

  ¡Y más! 
 

Cutting Iron-On/Cortando para  planchar 
 

 Transferencia de vinilo y rebaño Iron-on se compone de tres capas: 

 

 

 

 

 Para un corte, tener el lado opaco hacia arriba (lado adhesivo hacia arriba): 

 

 

 

 

 

 

 Debido a transferencia térmica tiene la capa de protección contra el calor, que no se va a cortar, esto puede servir 
como el portador / colchoneta durante el corte. El material tendrá que ser al menos 13 "de ancho por lo que 
ambas partes serán agarrados por las ruedas de presión. Si está cortando de hierro en la que es más estrecha que 
este o el corte de los desechos, a continuación, utilizar una base de corte para mantener el material durante el 
corte. Alternativamente, usted puede grabar el hierro a un medio más amplio, como el papel de contacto, y que 
puede servir como un portador en el Zing. 

  La fuerza requerida es de ~ 20 - 30 para el hierro-en regular. Otros tipos pueden requerir ajustes más altos. 
Asegúrese de hacer un corte de prueba primero y luego ver si la capa de vinilo pelará lejos de respaldo. Usted 
debe ser capaz de cortar a una velocidad de 15 (o 10 en el Zing original). 

  Recuerde que debe revertir su imagen antes de cortar! Debido a que usted está cortando con el lado adhesivo 
hacia arriba, se le dar la vuelta al material sobre, después de escarda, pero antes de pulsar. Para reflejar su imagen, 
seleccionarla y luego aplicar la función de espejo. 

Capa resistente al calor 

(lado brillante) 

Vinilo de plancha 

Adhesivo (lado opaco) 

Cuchilla sólo corta a través del adhesivo y de vinilo y 

no a través de la capa resistente al calor más grueso 

http://knkusa.com/shop/iron-on-transfer-t-shirt-vinyl/
http://knkusa.com/shop/flock/
http://knkusa.com/shop/glitter-flex-iron-on-material/
http://knkusa.com/shop/glitter-flex-ultra-iron-on-material/
http://www.youtube.com/watch?v=OUz66j1t-O4
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Iron-on_Vinyl_Application_LynnK.pdf
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 Cortar alrededor de su imagen con tijeras antes de escarda. Tenga en cuenta que es muy difícil de ver la imagen 
de corte, así que ten cuidado! 

 Use un perforador de papel o cuchillo para agarrarse a un trozo de vinilo de residuos y luego tire de quitar. 
Recuerde que debe eliminar las pequeñas piezas internas, también. 

  

Adhering Iron-On/La adhesión de plancha  

 Utilice una plancha caliente seca (ajuste de algodón) y con vapor desactivado. 

 Utilice una superficie bastante firme .... No es una tabla de planchar altamente acolchada. 

 Inserte un paño entre las capas de una camisa en el adhesivo caso derrite a través de otro lado 

  Pulse la camisa primero en crear una superficie seca plana y lisa. 

  Organizar patrón en camisa, centrado cuidado. 

  Presione firmemente durante 10 segundos completos. No te muevas de hierro alrededor ... simplemente 
presione firmemente. 

 Permitir a ligeramente frío y luego retire la capa resistente al calor superior. Si el patrón comienza a subir, luego 
cubrir con la capa resistente al calor y reprimir de inmediato por otros 10 segundos. 

 Algunas personas también le dará la vuelta camisa adentro hacia afuera y de prensa del otro lado por otros 5 
segundos. Nota: otros tipos de hierro en puede requerir tiempo de prensado adicional o incluso menos tiempo 
de prensado. Comuníquese con su proveedor para obtener información. 

 Espere 24 horas antes de lavar. 

  
10.06 Rhinestone Templates/ Plantillas Rhinestone 

Designing Rhinestone Patterns/Patrones Proyectos Rhinestone 

 Consulte la Sección 8.12 para obtener instrucciones específicas sobre el diseño de patrones de diamantes de 
imitación en el MTC. Las cosas más importantes a tener en cuenta son: 

 Los círculos deben ser aproximadamente 0,4 mm mayor que las piedras reales que has comprado. Por 
ejemplo, si usted tiene cálculos 10ss, luego diseñar usando 13SS o 14SS piedras en el software. Esto 
permite que las piedras caigan más fácilmente en los orificios durante el cepillado. 

 Siempre Tamaño tu forma primero antes de convertirlo en un diseño de diamantes de imitación. Una vez 
que los círculos se crean para el patrón, el patrón no puede cambiar el tamaño sin cambiar el tamaño de 
esos círculos. 
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Cortar Rhinestone Material de la plantilla 

 

 Plantillas Rhinestone se pueden usar cientos de veces. Hay varios materiales comúnmente utilizados para la 
fabricación de estas plantillas. Las actuales opciones más populares son: 

 El material plantilla rhinestone verde vendido en KNK EE.UU. es el más popular, ya que es menos costoso 
que las otras opciones y ha sido por más tiempo. Se recomienda más de un caucho más delgada similares 
vendidos por las empresas que comercializan su material para los cortadores de fuerzas inferiores. Las 
desventajas de utilizar cualquier material plantilla de goma es que es necesario aplicar un respaldo sólido 
después se corta la plantilla y también el polvo de la plantilla con un polvo para que el polvo cubrirá 
cualquiera de adhesivo permanente expuesta en los agujeros. El sólido respaldo normalmente elegido es 
tablero de la espuma o cartón plantilla. 

  El Rock-it negro acuden, también se vende en KNK EE.UU., es más caro que los materiales de la plantilla de 
goma, pero no requiere un respaldo que se aplicará después del corte. También no requiere quitar el polvo. 
Las plantillas de Rock-It se puede utilizar para mezclar y diseños, como la combinación de letras e imágenes 
igualar. 

  Sticky Flock es un material similar a Rock-it, pero es más caro aún y ligeramente más delgado. Tiene las 
mismas ventajas que Rock-it. 

 El primer paso antes de cortar la plantilla es para comprobar el tamaño del diseño que ha creado y luego se corta 
un trozo de material plantilla de diamantes de imitación que es al menos 1 "más grande en altura y anchura con 
respecto a su diseño. Es beneficioso tener un poco de material alrededor de los bordes del diseño en el que el exceso 
de pedrería todavía se pueden cepillar hacia atrás sobre el diseño. 

 Retire la hoja de soporte primera y pulse el material de diamantes de imitación de una estera pegajosa limpio. Brayer 
con firmeza para asegurarse de que el caucho tiene un excelente contacto con la colchoneta. 

 Ajuste Multicut 2 veces, una vez más para ayudar en la escarda los círculos cortados. Utilice una hoja de 60 grado 
para el corte y una fuerza de alrededor de 90 para el caucho verde y el 80 - 85 para los rebaños. Realizar cortes de 
prueba de un pequeño número de círculos (por ejemplo, alrededor de 8 a 10) para asegurarse de que la fuerza que 
está utilizando es suficiente. 

 
 

Weeding and Brushing in Rhinestones/Weeding y Cepillado de diamantes de imitación 

 Después de cortar, Brayer el material de la plantilla de nuevo. Al levantar el patrón, la mayoría de los pequeños 
círculos debe permanecer pegado a la lona. Si todavía hay círculos unidos, a continuación, presione con firmeza y la 
elevación en otras partes de su base de corte. Con el tiempo, usted debe tener la mayoría eliminado. 

 Si la plantilla se redujo de un caucho, aplicar su patrón a un material de soporte, tales como tablero de la plantilla o 
cartón pluma. Asegúrese de que sea un color diferente a la goma. Es posible que desee cubrir primero la placa de 

http://www.youtube.com/watch?v=7oknoQLXGTM
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respaldo con un claro cinta de correo para un impermeable, la superficie más permanente. Compruebe que ninguno 
de los pequeños círculos todavía están unidos a la parte posterior de la plantilla y causando una "protuberancia" en 
el patrón. 

 De nuevo, si la plantilla se redujo de caucho, utilizando un cepillo de dientes y cepillo un poco de polvo (talco, 
bicarbonato, facial) en los agujeros. Toque boca abajo para eliminar el exceso de polvo y limpie la parte superior del 
patrón limpio. El polvo se pega a cualquier adhesivo dentro de los agujeros y prevenir pedrería de quedarse atascado 
en los agujeros. 

 Coloca el molde en el fondo de una bandeja de grano, torta de pan u otro recipiente grande plana. Aquellos que 
usan los materiales rebaño menudo cubrir la parte inferior de su contenedor con una capa del mismo rebaño. Vierta 
la pedrería en la parte superior de la plantilla. 

 Utilice un Shur-Line Recortar y Bloc de retoque para cepillarse los diamantes de imitación en un movimiento circular. 
Sigue el cepillado y usted encontrará que las piedras que cayeron boca abajo se cepillan hacia fuera y las correctas 
serán reemplazarlos. Este cepillo tipo de pad es esencial para la facilidad y el éxito de este importante paso! 

 Cuando ~ 95% de la pauta se llena correctamente, a continuación, utilizar pinzas, un palillo de dientes, o 
simplemente el dedo para colocar los últimos pedrería en el patrón. 

 Cortar la cinta de transferencia rhinestone de tamaño y luego se presiona sobre sus piedras. Presione con firmeza, 
pero no empuje las piedras profundamente en los agujeros. Si usted tiene un problema con las piedras saltando 
como usted deja la cinta de transferencia, a continuación, pruebe a utilizar una hoja de rebote o aerosoles 
antiestáticos en la cinta antes de pulsar. 

 Al levantar la cinta, comience en una esquina y mantener a un lado presionado y mirar para asegurarse de que todas 
las piedras están siendo levantadas. Si una piedra no puede levantar, presione hacia abajo para recogerlo. Una vez 
que las piedras se levantan, ahora se puede colocar la cinta de transferencia de nuevo en su soporte o seguir 
adelante y presione las piedras a su camisa, otra tela, o incluso cartulina! 

 Tenga en cuenta que la cinta de transferencia es reutilizable! Usted debe ser capaz de obtener 4 o 5 prensados en 
una sola pieza, a pesar de que se arruga del prensado. Siga usando hasta que no se recupera y mantenga las piedras. 

 

Heat Pressing Rhinestones/Calor Pulsando Rhinestones 

 Si utiliza la plancha casa para presionar las piedras a una camisa: 

  Utilice un hierro caliente y seco (ajuste de algodón o superior con opción de vapor apagado). 

 Utilice una superficie firme ... no es una tabla de planchar altamente amortiguado 

 Inserte un paño entre las capas de una camisa. 

 Prensa camisa de primera para crear una superficie seca plana y lisa. 

  Organizar patrón en camisa, centrado cuidado. 

 Presione firmemente durante 10 segundos. A continuación, mueva alrededor de ½ "en los orificios 
de vapor de casos tenían más áreas de algunas piedras y luego presione firmemente durante otros 
10 segundos. 
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  Mover a otra zona de piedras y de repetición. 

 Voltear la camisa adentro hacia afuera y de prensa por otros 10 segundos en el lado donde se 
aplican piedras. 

 Se deja bien fría antes de quitar la cinta de transferencia transparente. 

 Si está usando una prensa de calor para presionar las piedras a una camisa: 

  Ajuste la temperatura a ~ 330-350 grados F (165 - 175 grados C) y ajuste la presión a medio. 

 Prensa prenda primero para una superficie plana y seca. 

 Organizar patrón en camisa, centrado cuidado. Presione durante 10-12 segundos. 

 Peel frío, cubrir con lámina de teflón, y volver a pulsar otra 10-12 segundos. Alternativamente, 
voltear la camisa adentro hacia afuera y de prensa de la espalda durante 10-12 segundos. 

 Utilice una temperatura más baja, si pulsa en 50/50 tela poli algodón. Utilice una temperatura más 
alta en denim o bolsas de mano. 

 

Extra tips on Rhinestone Applications/Consejos adicionales sobre Aplicaciones Rhinestone 

 Si usted está combinando transferencia térmica con diamantes de imitación, no presione los diamantes de imitación 
en el hierro en vinilo. Si bien se parecen haber funcionado bien, las piedras se caen una vez que se lava la prenda. 
Cuando se usa tanto, crear una línea de contorno alrededor de su patrón de hierro en las piedras. 

 Pedrería apremiante de cartulina también funciona muy bien. Si pulsa sobre el frente de la tarjeta postal, despliegue 
la tarjeta de primera. 

 Después de pulsar y dejar enfriar, usar la uña o una vieja tarjeta de tarjeta de crédito / regalo para raspar el patrón 
para ver si las piedras se aflojan. Si es así, vuelva a colocar las piedras por otras nuevas y pulse de nuevo. 

 
 

10.07 Drawing with a Pen or Glue Pen / Dibujar con un lápiz o pluma de cola 

 Con el Zing, puede dibujar con cualquier pluma, lápiz, rotulador, o cola de la pluma, que se puede agarrar de 
forma segura por el asiento de soporte de la hoja y no se arrastra a través del material. El Titular de Zing pluma 
opcional también se puede utilizar para mantener las plumas más finas. La ventaja del titular de la pluma es que 
el centro de la pluma se colocará la misma que la cuchilla en el Titular Zing Blade, lo que le permite dibujar con el 
lápiz y luego cortar una forma. La pluma se basará en las posiciones relativas correctas para el corte: 

 

                                                                

Fuera del círculo de 

corte está alineada con 

la pluma dibujada 

círculo 

Corte fuera del círculo no 

está alineado con la pluma 

dibujada círculo 
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 Si usted no posee el Titular Zing Pluma o desea utilizar una pluma que no encaja en el soporte, entonces 

consulte la siguiente sección: Ajuste por diferencias en los diámetros de Herramientas y portacuchillas. 

 Cuando el proyecto involucra tanto de dibujo y corte, usted tendrá que usar WYSIWYG para el modo de 

corte de manera que se alinearán las formas. 

 Dibujar Siempre corte primero y después. Apague la Espada Offset para el dibujo, ya que no es necesario 

y puede dar resultados no deseados. Pero entonces recuerde volver a encenderlo para el proceso de 

corte. 

 No tener el lápiz colocado demasiado bajo en el asiento de soporte de la hoja o la punta de la pluma 

podría arrastrar a través del papel al pasar de una forma a otra. 

 Asegúrese de que sus formas no se dibujarán en cualquiera de las ruedas de presión viajan sobre el 

material. De lo contrario, la tinta o pegamento podrían manchar. Esto también puede ser un problema 

con los pequeños anillos de prensa. Es posible que desee para deslizar los anillos a los lados del Zing (al 

lado de los rodillos de presión), por lo que no van a manchar la tinta o pegamento durante el proceso de 

dibujo. 

 Las plumas de cola Sakura Quickie funcionan bien en el Zing. Ellos encajan en el soporte Zing Pen, así 

como directamente en el asiento del soporte de la hoja (si no es necesaria la alineación con el corte). 

 Las fuentes disponibles El camino abierto en MTC debería funcionar bien para la elaboración, ya que 

proporcionan líneas dibujadas individuales y curvas frente a una forma de esquema. Consulte la Sección 

5.11. 

  El siguiente video muestra cómo utilizar el sostenedor de la pluma Zing y el soporte de la cuchilla para 

un alineado "dibujar y cortar." 

 

 El siguiente video muestra cómo utilizar una pluma de cola y el soporte de la cuchilla para un alineado 

"dibujar y cortar." 

 

 

Adjusting for the Difference in Diameters of Tools and Blade Holders/Ajuste de la diferencia de 

diámetros de Herramientas y portacuchillas 

 

El siguiente método fue presentado por primera vez por Bryan Williams en un webinar MTC Foro. Diane 

Hiscoe hizo el vídeo de arriba, utilizando el método de Bryan y me inspiró para crear el siguiente tutorial. 

Gracias, Diane! 

 Si va a utilizar dos herramientas con diferentes diámetros, a continuación, que se enfrentará a un 

problema de alineación. En el siguiente ejemplo, dos vasos y un círculo interior se dibujan con una 

pluma de gel de plata y luego el círculo exterior cortan.  

http://www.youtube.com/watch?v=ePjDZVMRPcg
http://www.youtube.com/watch?v=ePjDZVMRPcg
http://www.youtube.com/watch?feature=player_embedded&v=bueh3dslCMY
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 Debido a que la pluma de gel es delgada, que se encuentra más atrás en el asiento del soporte de la hoja 

que el soporte de la cuchilla. Sin ajustes realizados, la imagen dibujada resultante y círculo cortado están 

fuera de alineación: 

 

 Sin embargo, hay un método recta hacia adelante se puede utilizar para compensar las herramientas con 

diferentes diámetros. Este método implica la adición de un rectángulo, dentro de MTC, alrededor de las 

formas. Este rectángulo se dibuja con el lápiz y luego las esquinas se utilizará como marcas de registro 

para un proceso de impresión y corte: 

 

                                                               

 Las capas que se pueden extraer (vasos, círculo interior y exterior del rectángulo) se muestran en las capas de 
Abogados y la capa con la línea de corte se apaga: 

                                                                              

 Establecer el origen utilizando el láser y seleccione WYSIWYG para el tipo de corte/ Cut Type. Apague la hoja offset/ 
Blade Offset y luego establecer la Fuerza/ Force y velocidad adecuada/ Speed. Dibuja las formas con la pluma. 

 Apague la capa con las gafas y el círculo, pero deja la capa rectángulo exterior encendida. Además, ahora mostrar 
la capa con el círculo a cortar: 

 

La línea roja es la línea de corte. 

Las otras líneas se dibujarán con 

el bolígrafo de gel. Estas líneas 

son las gafas, el círculo íntimo, y 

rectángulo exterior. 

Un rectángulo se añade que 

rodea completamente las 

formas en el proyecto.Este 

rectángulo debe estar en su 

propia capa. 

Ocultar la capa a cortar 
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 Una vez establecido el origen utilizando el láser. Encienda el offset de hoja/ Blade Offset  y establecer la Fuerza/ 
Force y velocidad adecuada/ Speed. Establezca el tipo de corte/ Cut Type de impresión y corte/ Print and Cut. 
Ejecutar el corte, utilizando las esquinas del rectángulo como las marcas de registro. Las líneas y corte pluma de 
gel resultantes serán ahora alineados 

 

 
10.08 Embossing and Scoring/ Repujado y que alcanzaron 

 La Herramienta de Repujado Zing tiene dos cabezas de grabación en relieve de diferentes tamaños. La más pequeña 
se recomienda al anotar cartulina para proyectos plegables, como las tarjetas pop-up, bolsas de regalo y cajas 
pequeñas. Cualquiera de cabeza se puede utilizar para formas de gofrado. 

 Cuando el proyecto involucra tanto relieve / de puntuación y corte, usted tendrá que usar WYSIWYG para el modo 
de corte de manera que se alinearán las formas. 

 Cuando el gofrado, se recomienda que un material suave sea el lugar por debajo de la de papel o cartulina para 
permitir una impresión más profunda que se hizo. Una excelente material a utilizar es forro plataforma 
antideslizante. A pesar de que la superficie es algo desigual, se obtiene muy buenos resultados. Otros materiales 
que se pueden usar incluyen rhinestone caucho, goma espuma, y sintieron. Asegúrese de que el material está bien 
adherido a la lona (cinta hacia abajo, si es necesario). Luego pegue su papel o cartulina en la parte superior de este 
material. 

 Al puntuar, el papel o la cartulina se pueden aplicar directamente a la lona, tal como lo hace para el corte. Esto 
hace que sea mucho más sencillo cuando se necesita para marcar y luego se corta inmediatamente. 

 Asegúrese de hacer algunas pruebas primero para obtener la mejor configuración para el marcador o gofrado que 
usted necesita. Para puntuar cartulina, esto implica típicamente una fuerza superior (~ 150) y dos o tres pasadas. 
Consulte la tabla Configuración sugerida al final de este capítulo. Si usted tiene un material suave debajo de su 
papel / cartón, entonces una fuerza inferior puede ser utilizado, pero usted todavía puede necesitar varias pasadas. 
También aumentar la herramienta en el asiento de soporte de la hoja de la misma manera que se hace con el 
soporte de la hoja, para conseguir más fuerza aplicada. 

  Recuerde que debe desactivar el ajuste de compensación de la lámina al anotar o gofrado, sino volver a encenderlo 
cuando te preparas para cortar. 

 Cuando el gofrado de papel o cartulina, se recomienda que utilice la función de capa de sombra para crear un 
pequeño esquema y en línea, por ejemplo 0,01 ". Estos diminuta compensación líneas se producirá entonces un 
esquema general ligeramente más grueso de sus formas. Esto funciona mejor que llenar gofrado que puede insistir 
en la cartulina y formar arrugas. Estos son los pasos: 

o Crear la forma que desea estampar. En este ejemplo, los números 25 se utilizan para un aniversario 
de boda 25a: 

Ocultar la capa con el 

círculo y las gafas 
Mostrar la capa con el círculo a 

cortar.Deje el exterior que muestra la 

capa rectángulo. 



267 
 

 

 

 Seleccione la forma e ir a la función de la capa de la sombra/ Shadow Layer:   y realizar lo siguiente: 

 

  
 

 Después de hacer clic en Aceptar, vuelva a seleccionar sólo la imagen original, y vaya a la función de capa 

Sombra/ Shadow Layer de nuevo y realice lo siguiente:  

 

  
 

 Ahora usted tiene tres versiones de su forma y cuando se utiliza la herramienta de estampado, tendrá un 

contorno más grueso de la forma: 

  
 El siguiente video muestra la herramienta de estampación Zing se utiliza para estampar un diseño en 

metal.  

10.09 Engraving/Grabado 

 

Diseñar un grabado Rellena MTC:         Grabado precortadas Artículos:  

 La herramienta de grabado Zing se puede utilizar para grabar vitela, láminas, acrílico, y la mayoría de los 

metales, incluyendo etiquetas de trofeos, placas de identificación, y los encantos de la joyería. 

 Las mismas pautas básicas se aplican al grabado como en relieve y de puntuación: 

Seleccionar  Shadow Width para  0.01” 

Seleccionar  Estilo Corner Join  

Click en Accept. 

Seleccionar  Shadow Width para  0.01” 

Seleccionar  Estilo Corner Join  

Click en Accept. 

http://youtu.be/qm_BCeaZYfc
https://vimeo.com/68701818
https://vimeo.com/68701818
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 Usted probablemente tendrá que usar el modo de corte WYSIWYG. 

 Usted tendrá que apagar la hoja Offset ajuste de grabado. 

 Usted probablemente tendrá que utilizar varias pasadas para obtener los resultados 

deseados. 

 En los metales más blandos, puede que no desee la punta de grabado demasiado por encima del metal, 

ya que puede dejar una marca viruela cuando baje para comenzar el grabado. Si es posible, probar en 

pedazos primero. 

 Consulte la tabla Configuración sugerida al final de este capítulo o de la fuerza y de la configuración de 

velocidad en varios materiales. Tenga en cuenta que usted puede grabar en los materiales que no se 

pueden cortar en el Zing, como encantos joyas, placas de identificación, y placas de trofeo. 

 Las fuentes de camino abierto disponibles en MTC deben funcionar bien para el grabado. Contienen líneas 

de trayectoria individuales y curvas frente a esquemas y suelen ser más deseable al grabar letras. Consulte 

la Sección 5.11. 

 

Project: Engraving a Dog Tag/ Grabado de Tag para perro o mascota 

 

 Al grabar objetos que ya están cortadas (como los elementos enumerados anteriormente), a veces puede 

ser difícil conseguir la alineación perfecta que usted necesita. He aquí un método que funciona bien 

(gracias a Michelle Hessler por publicar esta técnica): 

 Mida cuidadosamente las dimensiones del elemento. Por ejemplo, si es una etiqueta de perro 

circular, a continuación, medir el diámetro. Recrear la forma en MTC y tamaño que sea el mismo. 

En el ejemplo de seguimiento, el diámetro de la placa de identificación es de 1-1 / 8 ", por lo que 

se dibuja un círculo del mismo tamaño: 

 

                                            
 

 Debido a que esta forma se reducirá de otro material a utilizar en el proceso de alineación, la 

forma cambia de tamaño para ser un poquito más grande. Para un círculo, sólo tiene que cambiar 

su tamaño en el Propiedades Sel Bar. Si la forma es algo no simétrica, a continuación, utilizar la 

función de Sombra con un ancho de Sombra de aproximadamente 0,04 ". 

 Se añaden Siguiente las letras y / o formas deseadas. En este caso, el nombre del perro y un 

número de teléfono con "Favor Llamar" son elegidos. Porque también hay un agujero en la parte 

superior de esta etiqueta de perro, un ¼ "se añade gran plaza justo para mostrar el límite superior 

de donde se pudo localizar las letras. Esto se elimina tan pronto como se añade las letras y 

posicionado: 

 

Foto de la 

etiqueta real de 

perro 

Círculo creada en MTC en el 

mismo diámetro que la 

etiqueta 
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 Las letras se coloca en una capa en MTC, mientras que el círculo es el lugar en una capa 

diferente. Una hoja de aglomerado delgada se coloca sobre la estera de corte. Uso del modo 

de corte WYSIWYG, el círculo se envía a cortar: 

   
 

 Después de que el agujero se corta en el aglomerado, la alfombra se deja en su lugar en el 

Zing! Esto es importante. El círculo de corte se retira y la etiqueta real del perro se coloca en 

el interior del agujero de corte. La cinta se utiliza para asegurar la etiqueta: 

 
 El soporte de la cuchilla se sustituye con la herramienta de grabado Zing. En la ventana de 

Blade Set origen, uso Última se selecciona de modo que la luz láser volverá al mismo lugar 

que fue utilizado para el corte. Offset hoja se apaga y una fuerza de 140 y 3 pases Multicut 

se establecen. La carta está grabado en la misma ubicación en la etiqueta como se diseñó en 

el tapete virtual: 

    

 

10.10 Using the Punch Tool/ Uso de la herramienta del sacador 

 

 La herramienta de sacador Zing/Zing Punch Tool se puede utilizar para crear diseños decorativos (como 

Pergamano y otras artes de pergamino) o para crear pequeños agujeros para el bordado de papel. 

Aglomerado de 

cinta al principio 

de la estera 

Círculo capa se envía a 

cortar y se retira del 

resto de la madera 

aglomerada. 

http://knkusa.com/shop/punch-tool/
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  Para proteger la alfombra y el punzón fino, se recomienda que un material blando de espesor puede 

utilizar como un cojín entre el papel / cartón y la estera de corte. Materiales que se sugieren que funcionan 

bien incluir forro plataforma antideslizante, goma espuma, y endurecidas sentían. 

 Los mismos principios básicos se aplican a puñetazos como en repujado y puntuación: 

 Usted probablemente tendrá que usar el modo de corte WYSIWYG. 

 Usted tendrá que desactivar el ajuste de desplazamiento de la lámina. 

  Usted posiblemente necesite utilizar varias pasadas para obtener los resultados deseados. 

 Consulte la tabla Configuración sugerida al final de este capítulo o de la fuerza y de la configuración de 

velocidad en varios materiales. 

  Diseñar un patrón de golpe, utilice la función Rhinestone presentado en la Sección 8.12, sin embargo, 

seleccionar el tamaño más pequeño disponible desde el menú desplegable. Esto creará agujeros 

adecuados en tamaño para el bordado de papel. Después de hacer clic en Aceptar, puede que tenga que 

aplicar una rotura con el fin de volver a espacio y ajustar su diseño general. 

  Si el tamaño del círculo de los agujeros de la función de producir Rhinestone que son mayores que lo que 

usted desea, y luego repetir el proceso de diseño, pero en primer lugar, que su diseño general dos veces 

mayor que tiene previsto utilizar. En la ventana de función Rhinestone, seleccione de nuevo el tamaño 

más pequeño, pero el doble de la distancia. Entonces, después de hacer clic en Aceptar, reduzca el diseño 

general a la mitad! Sus agujeros ahora reducirán a la mitad del tamaño del primer diseño que ha creado. 

 Al igual que con las otras herramientas, la prueba es necesario que obtenga los ajustes perfectos para el 

material particular que usted está perforando. No se olvide de ajustar la altura de la punta punzón 

superior, tal como lo hace con el soporte de la hoja, con el fin de conseguir más fuerza aplicada. 

 

10.11 Cake Decorating/ Decoración de Pasteles 

          

 Estas son algunas maneras de utilizar el KNK Zing en decoración de pasteles (gracias a Rebecca Stewart 

para la publicación de la información en esta sección): 

 Cupcake wrappers /envolturas de la magdalena (consulte la Sección 8.10 

 Icing sheet/ hojas formación de hielo: los recursos ordinarios y de impresión y corte 

 Plantillas para pasteles aerografía 

 Fondant, gum paste, Sugar Veil/ pasta de azúcar, pasta de goma, azúcar Velo cortar formas 

 Plantillas de aglomerado fino para utilizar como patrones al cortar gruesas capas de pasta de 

goma 

  Hojas de formación de hielo/ Icing sheets se pueden cortar en mat  regular, a pesar de que es una buena 

idea tener uno dedicado a  uso  de pastel. Lo mismo es cierto para el soporte de la cuchilla y la cuchilla. 

  Pulse la ficha de la formación de hielo/ fondant or gum paste al mat, asegurándose de que los rodillos de 

presión no estén asegurados sobre mat o icing! El respaldo de plástico en los actos de hoja al igual que el 

respaldo en vinilo - cortar a través de la guinda, deja intacto el respaldo. Despegar la corte y poner la hoja 

sobrante en la bolsa. Recomendar ajustes para cortar láminas de formación de hielo se presentan en la 

tabla al final del capítulo 2. 

http://www.youtube.com/watch?v=T4KsdIXEygE
http://www.youtube.com/watch?v=T4KsdIXEygE
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• Al cortar la pasta de azúcar o goma de pegar, extenderla y colocarlo en una pieza ligeramente engrasada 

de papel encerado, y el palo que en la estera pegajosa. Si se corta a través del papel de cera o no, el papel 

de cera hace que sea más fácil conseguir las formas de corte de la colchoneta sin distorsionar ellos. Algunas 

personas prefieren usar manteca aplicado a una estera sin adhesivo, sin embargo, puede ser difícil obtener 

las formas limpiamente de la colchoneta. 

 

 

 

 

 

 

10.12 Additional Applications/Aplicaciones adicionales 

 

Wood/Madera 

  

 La madera de corte puede ser complicado debido a que está sujeta a astillas. Se adhieren a piezas muy 

delgadas de madera de balsa o abedul (1/16 "o más finas). 

 Utilice una fuerza baja (~ 80) y no a la altura de punta de pala típico utilizado para otros materiales, lo que 

puede aumentar el riesgo de astillamiento cuando la hoja se reduce a perforar la madera. Trate de usar 6 

Post  para ajustar la altura de la punta de la cuchilla. 

  Tape la balsa a una estera pegajosa para evitar que se mueva durante el corte. También disminuye el 

compensados de manera que las esquinas se cortarán más redondeado hoja. Utilice una velocidad baja (~ 

8), pero se puede mantener la velocidad hasta en 15 o más alto (10 o más en el Zing original). 

 Si va a grabar la madera primero, utilice el extremo pequeño de la Herramienta de Repujado Zing. A 

diferencia del procedimiento cuando estampado o grabado otros materiales, realice el corte primero y 

luego relieve / grabado. Si intenta estampar en primer lugar, la madera puede ser debilitada e hizo más 

susceptibles a astillarse. 

 

Craft Plastic/Artesanía plástico 

 

 Plástico Artesanal  (PET-G) se vende en una variedad de sitios de Internet, incluyendo E-Bay, Dick Blick, 

Clear Recortes y Scrapbook.com. No sólo puede ser cortado en el Zing, pero doblar líneas se pueden crear 

http://www.youtube.com/watch?v=Zlp_u--_lvg
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utilizando la herramienta de grabado Zing. La ventaja de PET-G es que se puedan doblar estas líneas de 

puntuación y venir muchas veces sin el chasquido de plástico. Si lo prefiere, también puede crear líneas 

de plegado cortando líneas discontinuas. Estos también son muy fuertes y pueden plegarse docenas de 

veces antes de debilitarse. 

 

 PET-G viene en 0.015 "y 0.02" de espesor con láminas de protección en la parte delantera y trasera para 

proteger de los arañazos. Estas hojas protectoras se hacen parece ser de color, pero es perfectamente 

claro cuando se retiran las hojas. Puede eliminar tanto antes de cortar, pero es posible que prefiera dejar 

una de las hojas adjuntas para proteger la parte inferior de cualquier adhesivo en la base de corte. Esta 

lámina inferior también puede servir como un estabilizador durante el corte. 

• PET-G no tiene que ser cortado totalmente limpia. Por lo tanto, si hay partes que no se cortan limpiamente, 

intente romper la forma lejos de los residuos. Eso debería funcionar bien. Lo ideal sería, por supuesto, el 

corte será limpio y este paso no es necesario. Consulte la tabla al final del capítulo 2 para los ajustes de corte 

y la tabla al final de este capítulo, para la configuración de puntuación. 
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Suggested Settings for Various Accessories1/Configuración recomendada para 

Varios Accesorios 
 

 

 

Aplicacion   Herramienta Fuerza velocidad # Veces Superficie 
Otros 

comentarios 

Material     Zing Zing Air       

Dibujando en 
Papel 

Sharpie Marcador 20 10/10 15/15 1 Mat 

Marcador  casi 
toca el papel con 
el fin de ser 
agarrado por el 
tornillo delantero 

Dibujando en 
Papel 

Sharpie Liquido 
marcador 

40 10/10 15/15 2 Mat 

Usado 2 veces  
porque lápiz 
vacila para 
empezar a dibujar 
cada vez. 

Dibujando en 
Papel 

Uni-ball Signo Blanco 
Boligrafo 

30 9/10 11/15  1 - 2 Mat 

Ruedas de seguro  
no deben  pasar  
por las letras; 
Asegúrese que la 
tinta fluye antes 
de dibujar ' probar 
antes" 

Dibujando con 
boligrafo con 
pegamento 

Sakura Boligrafo 
Pegante 

30 9/10 11/15 2 Mat 

Utilice 0.01 
"Inserción Sombra 
y Outset Sombra 
para proporcionar 
un contorno más 
grueso de la 
forma. 

Repujado 
Cardstock - 
Georgia 
Pacific 100# 

Embosser/Estampacion 
Extremo Largo 

95 9/10 11/15 3 Shelf Liner 

Usado 0,01 
"Inserción Sombra 
y Outset Sombra 
para proporcionar 
un contorno más 
grueso de la 
forma. 

Repujado 
Pizarra 
Cartulina 

Embosser/Estampacion 
Extremo Largo 

160 10/10 15/15 2 Mat 

Más claro 
resultado blanco 
(consulte 
grabador/engrave) 

Repujado  
Worldwin 
Colormates 

Embosser/Estampacion 
Extremo Largo 

130 10/10 15/15 3 Shelf Liner 

Usado 0,01 
"Inserción Sombra 
y Outset Sombra 
para proporcionar 
un contorno más 
grueso de la 
forma. 

Importante: Recuerde seleccionar  Blade Offset de nuevo 

después de usar herramientas de accesorios y antes de cortar 

con su cuchilla de nuevo! 
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Grabado 
Acrílico 

Engraver 160 10/10 15/15 2 Mat 
Acrilico  duro (que 
no se puede 
cortar) 

Grabado 
Balsa - 1/16" 

Embosser/Estampacion 
Extremo Peq. 

80 8/10 9/15 2 Mat 

Balsa was more 
likely to split if the 
engraving was 
done first, thus cut 
shape first; use 6 
Post It notes for 
height. 

Grabado  
Balsa - 1/32" 

Embosser/Estampacion 
Extremo Peq. 

110 8/10 9/15 2 Mat 
Usar 13  post de 
notas para altura 

Grabado  
Bassword - 
1/16" 

Embosser/Estampacion 
Extremo Peq. 

160 10/10 15/15 6 Mat 
Usar 6  post de 
notas para altura 

Grabado en 
plastico 
artesanal 

Engraver/Grabador 160 9/10 11/15 2 Mat 0.03" PET-G 

Grabado 
Pizarra 
Cartulina 

Engraver/Grabador 30 10/10 15/15 2 Mat 

Más pesado 
resultado blanco 
(consulte 
impresora arriba) 

Grabado en 
Pergamino- 
48# 

Engraver/Grabador 100 10/10 15/15 2 Mat 

Usado 0,01 
"Inserción Sombra 
y Outset Sombra 
para proporcionar 
un contorno más 
grueso de la 
forma. 

Grabado 
Pergamino 
delgado 

Engraver/Grabador 50 10/10 15/15 2 Mat 

Usado 0,01 
"Inserción Sombra 
y Outset Sombra 
para proporcionar 
un contorno más 
grueso de la 
forma. 

Grabando  
Metal Tag 
Perro 

Engraver/Grabador 140 9/10 11/15 3 Mat   

Tipografia eb 
cartulina - 220 
lb Crane 

Embosser/Estampación 160 11/11 18/18 6 Mat 

probados ambos 
extremos grandes 
y pequeñas de 
impresora 

Perforación 
cartulina - 
Georgia 
Pacific 100#  

Piercer/Perforador 85 10/10 15/15 2 Craft Foam 

Utilice espuma de  
arte . Es 
importante que la 
aguja perforadora 
no golpea la tabla. 
Se puede romper. 

Perforacion 
Vellum 

Piercer/Perforador 10 10/10 15/15 1 Shelf Liner 

Debido a la baja 
fuerza, forro para 
estantes se 
colocó 
directamente 
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sobre estera de 
corte. 

 

 

 

Aplicacion   Herramienta Fuerza velocidad # Veces Superficie 
Otros 

comentarios 

Material     Zing Zing Air       

Doblez 
Cartulina - 
Bazzill 

Embosser/Estampacion 
Extremo Peq. 

160 10/10 15/15 4 Mat   

Doblez 
Cartulina - 
Georgia 
Pacific 100# 

Embosser/Estampacion 
Extremo Peq. 

160 10/10 15/15 3 Mat   

Doblez 
Cartulina- 
Recollections 

Embosser/Estampacion 
Extremo Peq. 

160 10/10 15/15 2 Mat   

Doblez 
Plastico 
artesanal 

Engraver/grabado 150 9/10 11/15 1 Mat 

0.03" PET-G; 
Doblez para 
proyectos 
plegables 
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Apéndice A Métodos abreviados de teclado 
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Shortcut Icon Description Menu, Other Location

Standard Functions

Ctrl+N Open a new file/project File>New  or  Tab bar

Ctrl+O Open an existing .mtc file/project File>Open

Ctrl+S Save a file/project File>Save

Ctrl+Shift+P Print File>Print

Ctrl+Z / Ctrl Y Undo last action  /  Redo last action Edit>Undo  /  Edit>Redo

Ctrl+F6 Go to next window/project Top left icon in Menu Bar

Ctrl+Tab Go to next window/project Window>Next Window

Ctrl+F4 Close current project Top left icon in Menu Bar

Alt+F4 Close all projects and MTC, as well

Viewing and Zooming Tools

Ctrl+3 Zoom to Virtual Mat View>Zoom To>Mat

Ctrl+4 Zoom to All Shapes on Screen View>Zoom To>All

1 Zoom to 100% View>Zoom To>100%

2 Zoom to 20% View>Zoom To>20%

3
Moves display to selected shape(s), keeps current zoom 

level
View>Zoom To>Selected

4 Zoom to 300% View>Zoom To>300%

5 , 6, 7, 8, 9, 0 Zoom to 500%, 600%, 700%, 800%, 900%, 1000% View>Zoom To>500% … 1000%

+    or     - Zoom in  or  Zoom out
Press +  (or  - )   key on the numeric keypad; icons 

on File Toolbar

D Display textures while other shapes are selected

Roll mouse wheel Move workspace up and own

Ctrl+roll mouse wheel Zoom in and out, centered on location of mouse cursor

Spacebar+drag left 

mouse button
Pan workspace

Ctrl+Shift+I Toggle the showing of nodes for selected shapes Edit>Shape Magic>Advanced>Nodes On Mat

Selecting Shapes

Ctrl+A Select all Edit>Select All

Shift+Esc Select next shape Edit>Previous Shape

Shift+Tab Select previous shape Edit>Next Shape

Esc Select none Edit>Select None

Shift Hold Shift and click on shapes to add to selection  
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Shortcut Icon Description Menu, Other Location

Duplicating Shapes

Ctrl+C Copy to clipboard Edit>Copy

Ctrl+V Paste from clipboard Edit>Paste

Ctrl+Shift+V Paste in Place from clipboard Edit>Paste in Place

Ctrl+Shift+drag Create a duplicate of selected shape(s)

Ctrl+D Create duplicate copies of selected shape (s) Edit>Duplicate

Cutting/Deleting Shapes

Ctrl+X Cut to clipboard Edit>Cut

Del Delete selected shape(s) Edit>Delete

Shift+Del Delete all shapes in the file Edit>Delete All

Ctrl+Shift+R Delete all shapes smaller than specified area (W x H) Edit>Delete By Area

Manipulating Shapes

[    or    ]
Arrange shapes with equal vertical  (or equal horizontal) 

spacing 

Edit>Align & Space>Space>Vertically ( or 

Horizontally)

B   or  T
Align selected shapes along bottom of bottommost  shape  

(or along top of  topmost shape)
Edit>Align & Space>Align>Bottom (or Top)

L  or  R
Align selected shapes along left side of leftmost shape (or 

along right side of rightmost shape)
Edit>Align & Space>Align>Left  (or Right)

S Center / stack selected shapes Edit>Align & Space>Align>Stack

H  or   V Align selected shapes along horizontal (or vertical) center
Edit>Align & Space>Align>Horz. Center (or Vert. 

Center)

Ctrl+F Vertically flip selected shape(s) Edit>Shape Magic>Flip

Ctrl+M Horizontally mirror selected shape(s) Edit>Shape Magic>Mirror

Ctrl+G Rotate selected shape(s) 90 degrees clockwise Edit>Shape Magic>Rotate 90 deg

Ctrl+Drag middle right 

icon on selected shapes
Modify spacing between selected shapes

Opening Windows

Ctrl+I Open "Add Text Group" window Icon on Text and Fonts tab, Main Bar

Ctrl+Shift+U Open "Color" window Right click>Change Color/Texture/Line>Color

Ctrl+Shift+O Open "Choose Texture" window Right click>Change Color/Texture/Line>Texture

Ctrl+Shift+Y Open "Choose Line Style" window Right click>Change Color/Texture/Line>Line

Ctrl+Shift+X Open "Shape View window" Edit>Shape Magic>Advanced>View Path Detail

Open "Project Notes" window View>Notes Window
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280 
 

Shortcut Icon Description Menu, Other Location

Layers Window Icons

Move this layer up  /  down On any given layer

Layer is visible  /  hidden On any given layer

Set color, texture or line style for this layer On any given layer

Layer is unlocked  /  locked On any given layer

Delete this layer On any given layer

Create a new layer Bottom of Layers window

Place current selection on a new layer Bottom of Layers window

Open Layer Options Menu Bottom of Layers window

Delete empty layers Bottom of Layers window

Open Visible Toggle menu Bottom of Layers window

Open Lock Toggle menu Bottom of Layers window

Text and Fonts Icons

Bold  /   Italic On Text and Fonts tab of Main Bar

Refresh installed fonts list On Text and Fonts tab of Main Bar

Open TTF/OTF font file On Text and Fonts tab of Main Bar

Open Add Text Group window On Text and Fonts tab of Main Bar

Importing

Ctrl+Shift+A Open "Make The Cut Gallery" import/download window File>Import>From  MTC Gallery

Ctrl+Shift+B Open "Basic shapes" window import window File>Import>From Basic Shapes

Ctrl+Shift+D "Open Adobe File" import window File>Import>Vector PDF/PS/EPS/AI

Ctrl+Shift+G "Open SVG File" import window File>Import>SVG/SVGZ File

Ctrl+Shift+H "Open Font File" import window
File>Import>True/Open Type Font File or Icon 

on Text and Fonts tab (Main Bar)

Ctrl+Shift+Q "Open WPC File" import window File>Import>WPC File

"Open GSD File" (or  "Open SCUT File") import window File>Import>GSD File (or SCUT File)

Ctrl+Shift+T Open "Pixel Trace" import window File>Import>Pixel Trace

Open "Lettering Delights" import window File>Import>From Lettering Delights
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Shortcut Icon Description Menu, Other Location

Exporting

Ctrl+Shift+L Open "Add Basic shape" window File>Export>Sel. To Basic Shapes 

Ctrl+Shift+S Open "Save SVG as" window File>Export>Sel. To SVG File

Ctrl+Shift+W
Open "Upload" window to upload as SVG file to MTC 

Gallery  
File>Export>Sel. As SVG To MTC Gallery

Editing Tools

Ctrl+B Break a shape into all of its individual paths Edit>Shape Magic>Break

Ctrl+J Join selected shapes into a single shape Edit>Shape Magic>Join

Ctrl+P Split typed text into individual characters (glyphs) Edit>Shape Magic>Split

Ctrl+R Remove all interior paths from selected shapes Edit>Shape Magic>Blackout

Ctrl+L Break apart selected shape(s) into layers Edit>Shape Magic>Layer

Ctrl+Shift+F Apply "Flatten Paths" function Edit>Shape Magic>Advanced>Flatten Paths

Ctrl+Shift+J Smooth and simplify shapes Edit>Shape Magic>Advanced>Smooth & Simplify

Ctrl+Shift+M Open "Fuse and Weld" window Edit>Shape Magic>Advanced>Fuse n' Weld

Ctrl+Shift+N Open T iler window Edit>Shape Magic>Advanced>Tiler…

Ctrl+Shift+Z Open "Auto Simplify" window to reduce nodes Edit>Shape Magic>Advanced>Auto Simplify Path

Toggle Auto Simplify Welds
Edit>Shape Magic>Advanced>Auto Simplify 

Welds

Designing Tools

Ctrl+1 Apply "Texture Snapshot" Edit>Shape Magic>Texture Snapshot

Ctrl+E Open "Lattice" window Edit>Shape Magic>Lattice

Ctrl+H Open "Generate Shadow Layer" window Edit>Shape Magic>Shadow Layer

Ctrl+K Open "Rhinestone" window Edit>Shape Magic>Rhinestone

Ctrl+Q Open "Conical Warp" window Edit>Shape Magic>Conical Warp

Ctrl+Shift+K Apply "Thin Paths" function to create a center line trace Edit>Shape Magic>Advanced>Thin Paths

Ctrl+Shift+N Open "T iler" window Edit>Shape Magic>Advanced>Tiler…

Ctrl+T Open "Bézier Warp" window Edit>Shape Magic>Bezier Warp

Ctrl+U Open "Boolean Join" window Edit>Shape Magic>Boolean Join

Ctrl+W Weld selected shapes to remove overlap Edit>Shape Magic>Weld

Ctrl+Drag one shape onto 

another 
Open "Wrap Objects to Path" window
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Shortcut Icon Description Menu, Other Location

Output

Ctrl+Shift+C Open controller window for current default cutter Cut Project With>current default sel. Cutter

Ctrl+Shift+E Show preview of cut shapes Cut Project With>Cut Preview

Ctrl+Shift+P Print File>Print

Reverse Paths (change direction of cut on selected 

shape)
Edit>Shape Magic>Advanced>Reverse Paths

Node Editing Tools

W Toggle Node Mode Toolbar on/off Upper left corner of Virtual Mat

F1 Edit This Project Normally On the node editing toolbar

F2 Edit Paths at Node Level On the node editing toolbar

F3 Draw Freehand Lines On the node editing toolbar

F4 Draw Bezier Curves and Straight Lines On the node editing toolbar

F5 Add basic shapes On the node editing toolbar

F6 Create spirals On the node editing toolbar

F7 Create stars and polygons On the node editing toolbar

F8 Erase sections of paths On the node editing toolbar

F9 Slice shapes and lines On the node editing toolbar

F10 Measure shape lengths and angles On the node editing toolbar

Zing Plug-In

F1 Cut Project Connected>Cut Project

F2 Toggle Laser On/Off Connected>Toggle Laser On (or Off)

F3 Reconnect Connected>Connection>Reconnect

F4 Toggle Zing Speak On/Off Drop Down Menu>Zing Speak

F5 Create Preset Drop Down Menu>Presets>Create Preset
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Appendix B  Troubleshooting FAQ’s/ Apéndice B Solución de problemas FAQ 

 
Communication Issues/ Problemas de comunicación 

 

No ocurre nada cuando intento utilizar las teclas de flecha en la ventana Blade Set Origen. Pero muestra 

que el Zing está conectado con Klic-N-Kut Zing. 

• Lo más probable es seleccionado el mal puerto COM. Haga clic en el botón verde conectado a 

continuación, seleccione Conexión. El correcto puerto COM será el que dice "USB-serie". 

____________________ 

No hay conexión "USB-serie" Puerto COM disponible en la lista de puertos COM disponibles. 

 Desenchufe  Zing de su equipo. En MTC, vaya a Ayuda> Avanzado> Descargar e instalar FTDI D2XX 

Drivers./ Help>Advanced>Download and Install FTDI D2XX Drivers.  Una vez que los conductores se han 

instalado, reinicie el equipo. Cuando su equipo haya terminado de reiniciar, vuelva a conectar el Zing 

a su computadora. Usted debe obtener un pop-up que terminará la instalación. 

o Si esto no funciona, de nuevo desenchufe  Zing de su equipo. Descargue e instale el 

controlador para el KNK Zing desde aquí, o en la pagina de internet : 

http://knkusa.com/resources/ 

o Una vez que haya descargado e instalado el controlador, reinicie el ordenador. Cuando su 

equipo haya terminado de reiniciar, vuelva a conectar el Zing a su computadora. Usted debe 

obtener un pop-up que terminará la instalación. Si continúa teniendo problemas, póngase en 

contacto con su distribuidor o Zing KNKUSA. 

____________________ 

 

El Proyecto Cut Con/ Cut Project With  muestra  Zing como No conectado/ Not Connected. 

 Compruebe el cable USB para asegurarse de que está correctamente insertada en el Zing y en un 

puerto USB de su ordenador. A continuación, cierre el Proyecto Cut Con/ Cut Project With y volver a 

abrir. Pruebe a pulsar F3 si todavía dice "No conectado/ Not Connected ". 

  Haga clic en el botón No Conectado/ Not Connected y seleccione Conexión / Connection y elegir el 

puerto COM / COM Port que dice "USB-Serial COM X" de la lista. 

  Póngase en contacto con su distribuidor para obtener ayuda si la Zing sigue sin ser reconocido. Es 

probable que tenga que volver a instalar el controlador para el Zing. 

____________________ 

Estoy usando Parallels en un Mac y el KNK no está siendo reconocido. 
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 Vaya a Dispositivos> USB/ Devices>USB  y asegúrese de que la conexión USB UART FT232R está 

marcada. 

____________________ 

 

 

La conexión Zing se cae a pesar de que no ha sido apagado o el software cerrado. 

 Esto es probablemente debido a un ajuste en Windows 7. Abra el Panel de control de Windows/ 

Control Panel y seleccione Sistema y seguridad/ System and Security. A continuación, seleccione 

Opciones de energía. Balanceado/ Power Options. Balanced deben ser seleccionados. A la derecha de 

eso, haga clic en Cambiar la configuración del plan/ Change plan settings.  

Haga clic en Cambiar la configuración avanzada de energía/ Change advanced power settings. Abra la 

opción del modo USB/ USB Settings en la lista y localizar USB selectivo/ USB Selective. Cambie a 

Desactivado/ Disabled y luego haga clic en Aceptar/ OK. Esto mantiene el USB de un modo normal, 

no un modo de ahorro de energía 

 

 Si el Zing todavía se desconecta, asegúrese de que está utilizando la última versión del plugin Zing. 

Compruebe haciendo clic en el pequeño triángulo en la esquina superior derecha de la Corte con 

Zing/ Cut with Zing y seleccionando Acerca de. Usted debe estar ejecutando al menos la versión 2.0.5 

(si usa Windows) y la versión 2.0.3 (si utiliza un Mac). 

 Trate de aplicar Aplanar Caminos antes de enviar a la ventana de corte. Seleccione sus formas, haga 

clic en el icono de llave inglesa en la parte inferior de la pantalla, y seleccione Aplanar Caminos en el 

menú emergente. 

 Intente cambiar el puerto COM que se ha asignado.    

____________________ 

Mi corte arranca pero se detiene durante el corte con el soporte de la hoja que se sienta en el lugar donde 

se detuvo el  corte. Estoy muy seguro de que no va fuera de rango. Estoy usando una computadora Mac 

para ejecutar la versión del Vino  de MTC. 

 Hay un ajuste llamado Datos del acelerador/Data Throttle que se puede utilizar para solucionar este 

problema. En la ventana de recorte, haga clic en el pequeño triángulo se muestra a continuación. A 

continuación, seleccione Opciones avanzadas/ Advanced Options. La caída de la Pausa/ Pause para 3. 

Intente de nuevo y puede que tenga que dejarlo a 2. Si continúa teniendo problemas, intente 

aumentar el ms del 10 al 15. 

 

https://vimeo.com/76545720
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____________________ 

 

Operating Issues/Problemas de funcionamiento 

 

La primera vez que enciendo la Zing, el carro cuchilla se mueve hacia la derecha y comienza a hacer un ruido 

terrible! 

 Hay una pieza de goma clara que se encuentra justo debajo de la parte superior de la Zing ya veces 

pueden quedar enrollado un poco fuera de lugar cuando se inserta o retira el protector de espuma. 

Mueva esa pieza de caucho de modo que el lado plano está abajo y el carro de la cuchilla será capaz 

de limpiar, ya que se mueve a la derecha y en posición de reposo. Si esto no resuelve el problema, 

póngase en contacto KNK EE.UU. al 800-268-3672 o con su distribuidor KNK. 

____________________ 

 

Cuando hago clic en Proyecto Cut/ Cut Project,, el carro cuchilla regresa al hogar de origen/ Home Origin en 

lugar de ejecutar mi corte. 

 Asegúrese de que está utilizando la versión 2.0 (o posterior) del Zing plug-in. Consulte la Sección 

2.10. 

 Seleccione su forma y haga clic en la opción Advanced (icono de llave inglesa) en la parte inferior de 

la pantalla. A continuación, seleccione Auto Simplificar Sendero/ Auto Simplify Path.  . Intente enviar 

el archivo a cortar de nuevo. 

____________________ 

 

Mi tabla de corte  está girando cuando el Zing comienza a cortar! 

 Ambas ruedas de presión deben estar agarrando la tabla. Mueva la tabla a la izquierda o a la derecha 

de manera que sea bajo las dos ruedas. 

____________________ 

No puedo conseguir uno (o ambos) de las palancas de rueda pellizque para mover correctamente. 

Haga clic aquí y seleccione 

Configuración 

avanzada/Advanced Settings 
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 Utilice un destornillador para apretar el tornillo de la palanca. Recuerde que las agujas del reloj es 

más apretado, la izquierda es más flojo. Evite aflojar ya que hay una bola y el resorte que caerse y es 

un poco difícil conseguir la palanca vuelto a montar y se atornilla en su lugar. 

 Aplique un poco de WD40 a un hisopo de algodón y aplíquelo en la placa en el interior, donde la 

barra de rodillo de presión entra en la tapa del extremo. 

 Si una o ambas palancas son todavía muy difícil de mover, ver este video:  

____________________ 

¡Ayuda! Giré el tornillo en mi palanca de la manera incorrecta y el muelle y la pelota cayó fuera! 

  

1. Desconecte el cable de alimentación y el cable USB. A continuación, deslice el carro de la cuchilla 

hacia el extremo opuesto de modo que usted tendrá espacio para usar un destornillador. 

2.  Coloque el Zing en su lado de modo que los agujeros que llevan la pelota están hacia arriba. 

3. Coloque el cojin de bolas en el agujero que se coloque la barra del rodillo hacia abajo. Consulte 

el lado opuesto a asegurarse de que tiene el agujero correcto. 

4. Coloque un extremo del resorte en el agujero de la palanca y luego alinear el otro extremo del 

resorte sobre el cojinete de bolas. Presione hacia abajo la palanca y mantenerla en su lugar. Girar 

de modo que el orificio del tornillo está alineado con el orificio necesario para la fijación de la 

palanca a la Zing. 

5. Inserte el tornillo y utilice un destornillador para girar el tornillo en sentido horario hasta que 

quede apretado. 

____________________ 

Cutting/Drawing Issues/ Situacones de corte 

 

Me estoy haciendo grandes líneas diagonales en rodajas a través de todas mis cortes. 

 Su Marca El software Cut está todavía en modo de prueba. Usted debe registrar su copia del MTC 

usando el pin de activación que se incluye en el CD de software. Aquí está el enlace: 

https://www.make-the-cut.com/Register.aspx 

____________________ 

 

Mis formas están dibujando fuera del material. ¿Qué estoy haciendo mal? 

 Si está utilizando Cuchilla Point/ Knife Point,, asegúrese de que está configurando el origen basado 

en la posición de la pluma de prueba/test pen o soporte de la hoja, no a la luz láser. La luz láser se 

utiliza para el modo WYSIWYG. 

http://www.youtube.com/watch?v=Zzw1UbOrqc8
http://www.youtube.com/watch?v=Zzw1UbOrqc8
http://www.youtube.com/watch?v=Zzw1UbOrqc8
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 Compruebe si su Mat virtual está en modo vertical u horizontal. Esto va a cambiar si la imagen parece 

de la misma manera que lo veas en la pantalla o girar 90 grados con respecto a la pantalla. 

 Los detalles sobre estos distintos ajustes están cubiertos en la Sección 2.07. 

____________________ 

 

Al dibujar con el lápiz prueba, tengo líneas adicionales están elaborando. 

 Asegúrese de que usted levanta la pluma en el asiento de soporte de la hoja en el Zing antes de 

apretar el tornillo frontal. El asiento de soporte de la hoja tiene que ser capaz de soltar la pluma 

cuando alcanza el punto para dibujar la forma. De lo contrario, la punta del lápiz se arrastraba a 

través del papel desde el origen hasta donde comenzará la forma que se elaborará y luego de vuelta 

al origen al final de la "corte". 

____________________ 

Estoy dibujando con el lápiz de prueba y hay burbujas en las esquinas. 

 Para las esquinas perfectas, apague Offset Hoja/ Blade Offset (puesto a 0), ya que no es necesario un 

desplazamiento para las plumas. Consulte las Secciones 2.01 y 2.06. 

____________________ 

Mi corte comenzó bien, pero al final del corte, no es cortar a través del material. 

 Asegúrese de que la carcasa del soporte de la hoja no tiene ningún trozos de material en el interior 

de la misma. 

  Asegúrese de que el tornillo frontal es apretado para que el titular de la hoja no se está deslizando 

hacia arriba durante el corte. 

____________________ 

 

 

Mi corte es limpio en algunos lugares pero no en otros. ¿Por qué no recibo de corte consistente? 

 Trate de elevar el soporte de la hoja un poco retirado en el asiento soporte de la hoja (~ 1/16 "). Si 

la hoja está demasiado cerca del material, se está aplicando no suficiente fuerza. 

 Asegúrese de que el material se presiona firmemente sobre una estera limpia y pegajosa 

(suponiendo que se está cortando un material como el papel o cartulina). 

 Su material puede requerir dos pases. Si un material no es homogéneo o si es mucha textura, con 

dos pasadas a veces es necesario para obtener toda la forma cortar limpiamente. Además, si el 

material ha sido expuesto a la humedad, entonces se convertirá difícil de cortar en una pasada. Usted 

puede secar papel y cartulina en un horno de 150 grados precalentado durante media hora o más 

para liberar la humedad. Apague el horno antes de abrir y poner el papel en el interior. Esto debería 

proporcionar una buena temperatura de secado. 
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____________________ 

Me estoy haciendo un montón de desgarro en mis cortes. 

 Un número de cosas puede causar lagrimeo así trabajar a través de esta lista de verificación: 

o El exceso de cuchilla está expuesto. Si usted ve las líneas de corte en su estera, acortar la 

exposición de la cuchilla. Sólo debe estar cortando a través del propio material. 

o La cuchilla esta quebrada. Pruebe una hoja diferente. 

o  El papel no se adhiere bien a la tabla. Asegúrese de que la alfombra es limpia, pegajoso, y el 

documento se presiona suave y uniformemente en la superficie. 

o  Puede que esté utilizando demasiada fuerza de corte. Pruebe a reducir y hacer cortes de 

prueba. 

o Es posible que tenga demasiados nodos en la forma. Consulte la Sección 7.02 

o El material en sí puede estar sujeto a la rotura, especialmente en cortes intrincados. Además, 

si la cartulina ha estado expuesto a la humedad, a continuación, la humedad en el material 

puede hacer que sea difícil para cortar limpiamente. Pruebe el brushing la cartulina o colocar 

en un horno ligeramente caliente durante media hora. Peor de los casos, pruebe con un papel 

de tarjetas diferente. 

____________________ 

 

Estoy cortando un archivo con líneas discontinuas para pliegues y los guiones son  terribles en algunos 

lugares. ¿Cómo puedo arreglar esto? 

 Esos guiones son probablemente una serie de rutas de líneas rectas separadas o incluso rectángulos, 

frente a ser una línea de corte sólido con un estilo de línea discontinua asignado. Pruebe su 

sustitución por líneas continuas (Sección 7.10) y luego convertir el estilo de línea de sólido a lanzarse 

como se muestra en la Sección 3.14.  

__________________ 

Mis formas no están cortando por completo. Todavía están unidos a la parte de residuos del material. 

 Asegúrese de que ha convertido la hoja Offset / Blade Offset  de nuevo al valor apropiado para la hoja 

que está utilizando. Si el desplazamiento es a 0, entonces sus caminos cerrados serán no muy cerca 

al cortar con una cuchilla. 

____________________ 

 

Mi cartulina no esta cortando  hasta el final. Tengo lacuchilla por  todo el camino y el uso de la fuerza máxima. 

 Por favor, consulte la Sección 2.01. Es importante sólo para tener tanta cuchilla expuesta como sea 

necesario para penetrar en la cartulina. También puede ser necesario para elevar la altura de la punta 

https://vimeo.com/43219601
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de la cuchilla. Reducir su fuerza de volver a los valores sugeridos para el material que se está cortando 

y hacer un corte de prueba. 

  No utilice más presión de la necesaria. Si la cartulina está cortando a través de alrededor del 90% de 

la corte, a continuación, encienda Multi-cut. Algunas cartulinas les va mejor con un segundo pase. 

____________________ 

Cuando trato de seleccionar mis marcas de registro durante una impresión y corte la cabeza se niega a ir 

todo el camino hasta la marca. 

 Se recomienda encarecidamente que el Mat virtual se establece en las mismas dimensiones que la 

impresión y el origen pueden establecer en la esquina inferior derecha de su impresión. Esto dará 

lugar a la luz del láser se mueve automáticamente más de cerca a cada marca reg. A continuación, 

puede utilizar las teclas de flecha para mover el láser para el centro exacto de cada marca. 

 Por otra parte, hay un error de software que puede prevenir el láser de ir a las tres marcas. La 

solución actual es establecer el origen de modo que hay poca necesidad de ajustar el movimiento en 

la primera marca de reg. Entonces los otros dos deben estar bien. Otra forma de hacerlo es ajustar 

la colocación de la alfombra después de que el láser se mueve automáticamente a la primera marca, 

por lo que se necesita muy poco de ajuste. 

____________________ 

Software Issues/Problemas de software 

 

No puedo conseguir el Puente MTC para instalar en mi Mac. 

 El Mac O / S debe ser 10.5.8 o posterior. 

 Es posible que necesite cambiar un ajuste que permite a los programas no descarga desde la tienda 

de Apple para ser instalado. Consulte este enlace: http://knkusa.com/resources/ 

____________________ 

Hacer el corte no aceptará el número de registro en el CD que viene con mi Zing. 

 El PIN de activación es el número que aparece en el sobre del CD. Este número debe ser utilizado 

para registrar su copia del software en el sitio web que aparece en la Guía de inicio rápido (también 

se muestra en la Sección 1.06). Una vez registrado, se le dará un número de registro para usar 

después en MTC. 

____________________ 

Tengo un equipo nuevo y quiero instalar el corte. No puedo encontrar mi número de registro para el MTC. 

 Ir a este enlace para tener su número de registro enviado por correo electrónico a la dirección de 

correo electrónico que utilizó al registrar su copia de MTC: http://www.make-the-

cut.com/LostRegKey.aspx 

 Si la dirección de correo electrónico que utilizó para registrarse ya no es válida, haga clic aquí y 

presentar un ticket de soporte al MTC: http://www.make-the-cut.com/Support/ 

http://www.make-the-cut.com/LostRegKey.aspx
http://www.make-the-cut.com/LostRegKey.aspx


291 
 

____________________ 

 

Prefiero trabajar en unidades métricas frente pulgadas. ¿Cómo cambio al sistema métrico? 

 En este momento, el MTC sólo mostrará las reglas  y posición  / dimensionamiento en pulgadas. Sin 

embargo, se puede introducir una dimensión en la métrica escribiendo el tamaño y luego seguido 

por mm o cm. Consulte la Sección 3.13. Para verificar la dimensión de formas en unidades métricas, 

utilice la herramienta Medir/ Measure Tool en la barra de herramientas Nodo Editar/ Node Edit. 

Consulte la Sección 7.08. 

____________________ 

¿Hay una manera de ver imágenes en miniatura de los archivos de mi MTC en el Explorador? 

 Sí. El enlace para descargar el MTC Visor y las instrucciones del archivo para el uso se detallan en la 

Sección 3.06.3. 

____________________ 

Tengo un archivo muy complicado que yo estoy tratando de editar. Hacer el corte sigue fallando. 

 Puede asignar más memoria, vaya a Ayuda> Avanzada> Configuración avanzada/ 

Help>Advanced>Advanced Settings y permitiendo que el límite de tamaño de deshacer / rehacer/ Limit 

Undo/Redo Size. O puede borrar los pasos de deshacer por ir a Edición> Limpiar historial de deshacer/ 

Edit>Clean Undo History. Consulte la Sección 3.11 para más detalles. 

____________________ 

Al importar imágenes en ventana Seguimiento Pixel, MTC está congelando. 

 Vaya a Ayuda> Avanzada> Configuración avanzada/ Help>Advanced> Advanced Settings. Desactive la 

casilla junto a Activar Twain/ Enable Twain: 

 

____________________ 

Estoy teniendo problemas con el uso de la vista 3D bajo cónico Warp. 

 Vaya a Ayuda> Avanzada> Configuración avanzada/ Help>Advanced> Advanced Settings. Desactive la 

casilla junto a Activar OpenGL/ Enable OpenGL. La vista 3D ahora será desactivado. 

 

___________________ 

MTC se estrelló y yo pensé que tenía guardado automático encendido. Pero mi archivo no se recupera. 

 La última versión que fue auto-guardado debe estar disponible en la carpeta especificada aquí: 

Ayuda> avanzadas> Configuración avanzada/ Help>Advanced> Advanced Settings. Desmarca y vuelva 
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a comprobar la casilla junto a Activar guardado automático / Enable Automatic Saving  y la ventana de 

configuración se abrirá. Compruebe la ubicación para el archivo de copia de seguridad se muestra 

por Auto-save Sendero/ Auto-save Path. 

____________________ 

 

Cuando importo archivos vectoriales en MTC, pierdo los colores individuales. Todas las formas terminan el 

mismo color. ¿Cómo conservo los colores que se utilizaron en el programa original? 

 Algunos formatos de archivo no podrán importar con los colores asignados originales. Si es posible 

elegir SVG como formato de importación cuando MTC no está disponible. 

____________________ 

Estoy tratando de importar un archivo PDF, pero nada está apareciendo. 

 Los archivos PDF se pueden hacer de vector o trama o una combinación. Si MTC no detecta ningún 

trazados vectoriales, entonces usted debería ser capaz de hacer clic en un enlace en la parte inferior 

de esta ventana de importación (en versiones MTC 4.3 y mayores). La ventana Seguimiento Pixel se 

abrirá y le permitirá luego vectorizar la imagen de trama (s) dentro de ese archivo PDF. 

____________________ 

Estoy tratando de usar mi escáner para importar un archivo a Pixel Trace, pero el botón de Twain que 

muestra en el Capítulo 6 no está allí. ¿Cómo puedo recuperarlo? 

 Vaya a Ayuda> Avanzada> Configuración avanzada/ Help>Advanced>Advanced Settings. Marque la 

casilla junto a Activar Twain/ Enable Twain: 

 

____________________ 

Estoy tratando de mover un nodo pero sigue saltando. No puedo moverlo a donde quiero. 

 Es probable que tenga rotura/ Snapping encendido. Compruebe la configuración actual en el Mat 

Virtual y cambie a N de rotura/ No Snapping.. 

____________________ 

Cuando se trata de cambiar el tamaño de una imagen mediante el uso de las cajas en la esquina de la imagen, 

estoy teniendo un problema para controlar el tamaño. 

 Es probable que tenga rotura/ Snapping encendido. Compruebe la configuración actual en el Mat 

Virtual y cambie a N de rotura/ No Snapping. 

____________________ 
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Tengo Pixel Trazado/ Pixel Traced una imagen y lo importó para una impresión y corte. Pero mi imagen 

original se desvaneció. ¿Cómo puedo importar la imagen para que se vea como el original? 

 En la Mat virtual, seleccione Contraste de la lista de colores disponibles. Tenga en cuenta que su 

imagen imprimirá al igual que el original, independientemente del color tapete seleccionado. Pero si 

usted prefiere ver la imagen a todo color, a continuación, utilice la opción Contraste/ Contrast. 

____________________ 

Mis imágenes raster causan MTC sea muy lento. ¿Hay alguna solución para esto? 

 A partir de la versión 4.2.0, esto ya no debería ser un problema. Vaya a Ayuda> Avanzada> 

Configuración avanzada/ Help>Advanced>Advanced Settings. Marque la casilla junto a Activar 

almacenamiento en caché de archivo/ Enable Image Caching:  

 

 

____________________ 

Mi imagen de trama no aparece cuando imprimo para mi impresión y corte. 

 Dos posibilidades: Compruebe la barra de capa/ Layer Bar y asegúrese de que no está siendo cubierta 

por otra capa. Además, ir a Archivo> Opciones de impresión/ File>Print Options y asegúrese de que 

usted no tiene Imprimir Wireframe Sólo/ Print Wireframe Only marcada. 

____________________ 

Estoy tratando de utilizar Boolean Únete/ Boolean Join pero está en gris. Tengo mis formas seleccionadas. 

¿Por qué no puedo seleccionar esta función? 

 Boolean Join sólo puede ser aplicado a dos formas de una sola vez. Si, por ejemplo, que está tratando 

de stencil algunas letras usando rectángulos, a continuación, todas las letras tienen que haber Únete 

aplicado primero. Y todos los rectángulos tienen que haber Únete aplicado primero. Entonces usted 

tiene dos formas. Alternativamente, usted podría stencil un rectángulo y una letra a la vez. 

____________________ 

He estado usando la herramienta Borrador / Eraser tool y mi imagen se ha distorsionado! ¡Ayuda! 

 Antes de utilizar la función de borrado (o inversa Borrar), debe hacer clic en el icono de Avance/ 

Advance en la barra de herramientas de Magia/ Magic Toolbar  y apagar (desactivar) Auto 

Simplificar soldaduras/ Auto Simplify Welds. Luego, cuando haya completado la edición, que su forma 

o formas seleccionadas e ir al mismo menú y seleccione Auto Simplificar Sendero/ Auto Simplify Path. 

Se reducirán los nodos. Luego vuelva a revisar Auto Simplificar soldaduras/ Auto Simplify Welds. 

____________________ 

¿Hay una manera de mover todas las cartas en mi texto más juntos a la vez? 
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 Sí. Al escribir el texto, asegúrese de que ha Split por glifos / Split by Glyphs seleccionados. Si se 

olvida, a continuación, seleccione el título y haga clic en el icono de Split, en la barra de herramientas 

de la Magia/ Magic Toolbar . A continuación, asegúrese de que está en el modo en que el texto 

seleccionado tiene las flechas de dos cabezas apuntando hacia el exterior Cambio de tamaño 

(consulte la Sección 3.13 del Manual del usuario). Luego mantenga pulsada la tecla Ctrl mientras 

arrastra la flecha central derecha del texto seleccionado. Esto le permitirá separar las letras 

individuales o los hacen más juntos. 

____________________ 

He ido con cuidado a través de la configuración en la Sección 3.06 varias veces para mostrar miniaturas de 

mis archivos MTC en el Explorador de Windows, sin embargo todavía no puedo conseguir que aparezcan. 

 En el Explorador de Windows (Windows 8), haga clic en la ficha Ver, luego Opciones y seleccione 

Cambiar carpeta y Opciones de búsqueda. Haga clic en la ficha Ver y asegúrese de que la opción de 

arriba (Mostrar siempre iconos, nunca miniaturas) no está marcada. Si usted es dueño de una versión 

anterior de Windows, a continuación, utilizar el vídeo para localizar esta misma carpeta,  

pero a continuación, asegúrese nos fijamos en esa misma opción superior sobre los iconos y 

miniaturas. 

 

Appendix C  Zing Speak Quick Reference1/Apéndice C Zing Speak Referencia1 Rápida 
 

Esto es una referencia rápida para muestras de consultas y comandos dentro Zing Speak. Hay muchas otras 

combinaciones que trabajarán. Para obtener una lista más completa, consulte la Guía de Zing Hable Vocab 

aquí: http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/ 

 

 

 Para una lista más completa de Zing Habla comandos, consulte este enlace: 

http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/ 

 

  

http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/
http://www.iloveknk.com/Support/Tutorials/Make-The-Cut/
http://www.iloveknk.com/FreeVideos/Support/ShowingFileExtensions
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Appendix D Connecting Via Bluetooth on a Mac/Apéndice D Conexión mediante Bluetooth en un Mac 

 

Si bien es posible conectar a un Mac a través de Bluetooth, es muy recomendable que el USB se utiliza en su 

lugar. La conexión Bluetooth en un Mac puede resultar en el corte errático y una necesidad para ajustar una 

posición del acelerador de datos basándose tanto en el propio Mac, así como el archivo que se envían a 

cortar. Si aún desea probar Bluetooth en tu Mac, a continuación, siga estos pasos y asegúrese de anotar la 

posición del acelerador de datos al final de las instrucciones, ya que inevitablemente necesitar un ajuste. 

(1) Para verificar que tiene Bluetooth disponibles en su Mac, vaya a Preferencias del sistema/ System 

Preferences y busque el icono Bluetooh:  

 
(2)Si usted no tiene Bluetooth, a continuación, insertar el dispositivo USB Bluetooth que viene con el 

Zing Aire y reinicie el Mac. Vuelva a Preferencias del sistema/ System Preferences para verificar que 

usted ahora ver el icono de Bluetooth se muestra arriba. 

(3) Haga clic en el icono de Bluetooth y el siguiente debe aparecer: 

 

 
 

4) Haga clic en par y usted debe obtener lo siguiente: 

 
 

(5) Haga clic en Opciones e introduzca el código "1234". Haga clic en Par. A continuación, el Zing aire 

debe conectarse: 
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(6) Si quieres pasar a la siguiente ventana, haga clic en la "X" y seleccione Quitar. Reinicie el Mac y siga 

las instrucciones anteriores de nuevo. 

 
(7) En la carpeta Aplicaciones, inicie el programa de MTC COM Bridge. Si recibe un mensaje de error, 

haga clic en "Continuar/ Continue Anyway ". La siguiente ventana se abrirá y usted debe seleccionar la 

conexión en el menú que dice "tty.CUTTER": 

 

                                                                             

 

(8) Haga clic en Guardar y cerrar. 

(9) Ahora está listo para hacer la prueba presentada en la Sección 1.10. Tenga en cuenta sin embargo, que lo más probable 
es necesario experimentar con el ajuste de los datos del acelerador. Para acceder a esta opción, envíe una forma a la 
ventana de corte y, a continuación, haga clic en el pequeño triángulo se muestra a continuación. A continuación, 
seleccione Opciones avanzadas. Usted encontrará una pestaña a la derecha de la ficha Baud información sobre tarifas 
denominado acelerador de Datos. Seleccione esa ficha y tratar de disminuir la pausa y el aumento de las ms. 

 

 

 

Click on Save before Close. 

Haga clic en el pequeño 

triángulo. 
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